# Table of contents

1 **General information on this documentation** .......................... 12  
   1.1 © YASKAWA Europe GmbH ....................................................... 12  
   1.2 Purpose of the documentation .............................................. 13  
   1.3 Validity of the documentation .............................................. 13  
   1.4 Structure and contents of the documentation ....................... 13  
   1.5 Presentation and tags .......................................................... 14

2 **To the SPEED7 Studio program** ........................................... 16  
   2.1 Product description ............................................................. 16  
   2.2 Technical features ............................................................. 16  
   2.3 Target group and qualification ............................................ 17  
   2.4 Software identification ...................................................... 17

3 **Installation and activation of SPEED7 Studio** ....................... 18  
   3.1 System requirements .......................................................... 18  
   3.2 Installation of SPEED7 Studio ............................................. 18  
   3.3 Activate SPEED7 Studio .................................................... 18  
   3.4 Uninstallation of SPEED7 Studio ......................................... 22

4 **Working with SPEED7 Studio** ............................................. 23  
   4.1 Overview .............................................................................. 23  
   4.2 Start SPEED7 Studio ............................................................ 23  
   4.3 End SPEED7 Studio .............................................................. 23  
   4.4 Select language .................................................................... 23  
   4.5 Select syntax language (mnemonics) .................................... 24  
   4.6 Select interfaces ................................................................... 24  
   4.7 Symbolic and absolute addressing ...................................... 24  
   4.8 User interface ....................................................................... 26  
   4.9 Project tree .......................................................................... 28  
   4.9.1 Moving, copying and pasting objects ................................. 33  
   4.10 Catalog .............................................................................. 34  
   4.11 Properties .......................................................................... 37  
   4.12 Area of operations ............................................................. 38  
   4.13 Start page ........................................................................... 41  
   4.14 Output range ....................................................................... 43  
   4.14.1 Output ............................................................................ 43  
   4.14.2 Programming events ..................................................... 44  
   4.14.3 Communication events .................................................. 44  
   4.14.4 Project logbook .............................................................. 45  
   4.14.5 Consistency messages .................................................... 45  
   4.14.6 EtherCAT messages ....................................................... 46  
   4.15 Search / Replace in block ................................................... 46  
   4.16 Typed representation ........................................................ 49  
   4.17 CPU control centre ............................................................ 49  
   4.18 Mouse and keyboard operation ......................................... 52  
   4.18.1 Adjusting the user interface ........................................... 52  
   4.18.2 Mouse operation – context menu .................................... 53  
   4.18.3 Mouse operation – drag & drop ...................................... 54  
   4.19 Help and support during editing ........................................ 55  
   4.19.1 Overview ....................................................................... 55
5 Managing and editing projects................................................................. 65
  5.1 Project.............................................................................................. 65
  5.2 Create a new project.......................................................................... 65
  5.3 Open project..................................................................................... 66
  5.3.1 Migration for symbolic programming.......................................... 67
  5.4 Closing a project.............................................................................. 67
  5.5 Editing a project................................................................................ 68
  5.6 Saving a project................................................................................ 68
  5.7 Save local project as.......................................................................... 68
  5.8 Rename project................................................................................ 68
  5.9 Delete project................................................................................... 68
  5.10 Transfer project............................................................................... 69
  5.11 Export project.................................................................................. 70
  5.12 Import project.................................................................................. 70
  5.13 Print.................................................................................................. 71
  5.13.1 General print configurations...................................................... 71
  5.13.2 Select print areas.......................................................................... 73
  5.14 Print Preview................................................................................... 74
  5.15 "Documentation" folder.................................................................. 74
  5.16 Create new text document.............................................................. 75
  5.17 Text editor (text document)............................................................. 75

6 Selecting and configuring devices and components.............................. 76
  6.1 "Project overview" editor.................................................................. 76
  6.2 "Devices and networking" editor..................................................... 77
  6.2.1 Local components (= local modules)......................................... 79
  6.2.2 Connections.................................................................................. 80
  6.3 Add new device (PLC)..................................................................... 81
  6.4 Add new device (HMI/Movicon)...................................................... 82
  6.4.1 Adding a Movicon project........................................................... 84
  6.5 Adding a new device (slave).............................................................. 85
  6.6 Add control (CPU) as PROFIBUS DP slave (I-Slave)......................... 86
  6.7 Add control (CPU) as a PROFINET IO device (I device).................... 90
  6.8 Removing devices............................................................................. 93
  6.9 Duplicate device............................................................................... 93
  6.10 Installing device description files.................................................... 93
  6.11 PROFIBUS – GSD.......................................................................... 94
  6.11.1 New GSD file.............................................................................. 94
  6.11.2 Installed GSD files....................................................................... 95
  6.12 PROFINET – GSDML...................................................................... 96
  6.12.1 New GSDML file......................................................................... 97
### Table of contents

6.12.2 Installed GSDML files........................................................................ 98
6.13 EtherCAT – ESI .................................................................................. 99
6.13.1 New ESI file................................................................................... 99
6.13.2 Installed ESI files............................................................................ 100
6.14 “Device configuration” editor (PLC) .................................................. 101
6.14.1 Display output current and add power modules (SLIO only) .......... 104
6.14.2 Show output signals....................................................................... 104
6.15 “Device configuration” editor (slave) .................................................. 104
6.16 Adding components............................................................................ 106
6.17 Removing components........................................................................ 108
6.18 Printing labels..................................................................................... 109
6.19 Changing device properties.................................................................. 109
6.20 “Device properties” editor (PLC) ....................................................... 110
6.20.1 General device properties (PLC)...................................................... 110
6.20.2 Communication settings (PLC)........................................................ 111
6.20.3 Server configuration......................................................................... 114
6.21 Search for accessible partners.............................................................. 115
6.22 Interface properties (Ethernet).............................................................. 116
6.23 Properties of the module (CPU) ............................................................ 118
6.23.1 General............................................................................................ 119
6.23.2 Feature Sets..................................................................................... 120
6.23.3 Start-up............................................................................................. 120
6.23.4 Synchronous cycle interrupts........................................................... 121
6.23.5 Cycle / Clock memory................................................................. 122
6.23.6 Retentive memory......................................................................... 123
6.23.7 Local data....................................................................................... 123
6.23.8 Interrupts........................................................................................ 123
6.23.9 Time of day interrupts................................................................... 124
6.23.10 Cyclic interrupts.......................................................................... 124
6.23.11 Diagnostics/Clock............................................................ 125
6.23.12 Protection..................................................................................... 125
6.23.13 Advanced Configurations............................................................ 126
6.23.14 PG/OP Ethernet............................................................................ 128
6.23.15 General........................................................................................ 128
6.23.16 I/O addresses.............................................................................. 128
6.23.17 Inputs (digital)............................................................................. 130
6.23.18 Outputs (digital).......................................................................... 130
6.23.19 Inputs (analogue)........................................................................ 130
6.23.20 Outputs (analogue)...................................................................... 130
6.23.21 Basic parameters.......................................................................... 131
6.23.22 Channel....................................................................................... 131
6.23.23 Parameter.................................................................................... 131
6.24 Properties of the module (SLIO modules) ........................................ 131
6.24.1 General........................................................................................ 132
6.24.2 I/O addresses.............................................................................. 132
6.24.3 Parameter..................................................................................... 134
6.25 Component properties (MICRO modules) ........................................ 134
6.25.1 General........................................................................................ 134
6.25.2 I/O addresses.............................................................................. 135
6.25.3 Parameter..................................................................................... 136
7 Connect devices ........................................................................................................ 153
  7.1 Bus system properties (PROFIBUS DP) ................................................................ 153
  7.1.1 DP master system – General configurations................................................. 154
  7.1.2 DP master system – Bus parameter............................................................... 155
  7.1.3 DP master system – Address overview......................................................... 155
  7.1.4 DP master – General configurations............................................................... 157
  7.1.5 DP master – Addresses.................................................................................. 157
  7.1.6 DP slave – General configurations................................................................. 158
  7.1.7 DP slave – Station parameters........................................................................ 159
  7.1.8 Component – General configurations............................................................. 160
  7.1.9 Component – I/O addresses............................................................................ 160
  7.2 Online diagnostics of the bus system (PROFIBUS DP) ...................................... 161
  7.2.1 PROFIBUS DP – General.............................................................................. 163
  7.2.2 Controller – General..................................................................................... 164
  7.2.3 Device – General.......................................................................................... 165
  7.2.4 Device – Diagnostics.................................................................................... 166
  7.2.5 Module – General......................................................................................... 167
  7.2.6 Module – Diagnostics................................................................................... 168
  7.3 Bus system properties (PROFINET-IO system) .................................................. 168
  7.3.1 PROFINET-IO system – General configurations........................................... 170
  7.3.2 PROFINET-IO system – IO cycle................................................................... 171
  7.3.3 PROFINET-IO system – Address overview.................................................. 172
  7.3.4 IO controller – General configurations............................................................ 173
  7.3.5 IO controller – addresses................................................................................ 174
  7.3.6 IO controller – I device.................................................................................. 175
  7.3.7 IO controller – I/O configuration..................................................................... 176
  7.3.8 IO device – General configurations................................................................. 178
  7.3.9 IO device – IO cycle....................................................................................... 179
  7.3.10 IO device – Parameter.................................................................................. 180
7.3.11 IO module – General configurations............................................. 181
7.4 Online diagnostics of the bus system (PROFINET-IO system)............... 181
7.4.1 PROFINET-IO system – General..................................................... 183
7.4.2 IO controller – General................................................................. 184
7.4.3 IO controller – Interface................................................................. 185
7.4.4 IO controller – Network connection.............................................. 186
7.4.5 IO device – General..................................................................... 187
7.4.6 IO device – Diagnostics............................................................... 188
7.4.7 IO device – Interface................................................................. 189
7.4.8 IO device – Network connection................................................. 190
7.4.9 Port – General........................................................................... 191
7.4.10 Port – Network connection......................................................... 192
7.4.11 IO module – General................................................................. 193
7.4.12 IO module – Diagnostics........................................................... 194
7.5 IO module – Diagnostics................................................................. 194
7.6 Configure Ethernet connections....................................................... 195
7.6.1 Insert new connection................................................................. 195
7.6.2 Connection settings – General.................................................... 196
7.6.3 Connection settings – Local ID.................................................... 196
7.6.4 Connection settings – Special properties..................................... 197
7.6.5 Connection settings – Address details....................................... 198
7.7 Configure OPC UA........................................................................ 199
7.7.1 Overview.................................................................................. 199
7.7.2 Server configuration................................................................. 199
7.7.3 Server settings – Connection.................................................... 200
7.7.4 Server settings – Certificate..................................................... 201
7.7.5 Data access................................................................................ 202
7.7.6 User management................................................................. 203
7.7.7 Role management................................................................. 204
7.7.8 Client.................................................................................. 205
8 Creating, transferring and testing the user program.......................... 207
8.1 Program blocks......................................................................... 207
8.2 Device overview (PLC)............................................................... 207
8.3 Add new block (OB, FB, FC)............................................................. 209
8.4 Editing program blocks................................................................. 210
8.5 Block editor for program blocks (OB, FB, FC)................................ 210
8.5.1 Declaration section................................................................. 212
8.5.2 Edit and use variables............................................................... 213
8.5.3 Move, copy, paste and delete variables..................................... 216
8.5.4 Instruction section................................................................. 217
8.5.5 Create / edit symbol................................................................. 221
8.6 Programming languages............................................................ 223
8.6.1 Instruction list (IL)................................................................ 223
8.6.2 Function block diagram (FBD)-------------------------------------- 226
8.6.3 Ladder diagram (LD)............................................................... 231
8.7 Adding new data blocks (DB)....................................................... 233
8.8 Block editor for data blocks (DB).................................................. 235
8.8.1 Edit and use variables............................................................... 237
8.8.2 Move, copy, paste and delete variables..................................... 238

Table of contents
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.9</td>
<td>Adding a new structure block (UDT)</td>
<td>239</td>
</tr>
<tr>
<td>8.10</td>
<td>Block editor for structure blocks (UDT)</td>
<td>240</td>
</tr>
<tr>
<td>8.10.1</td>
<td>Edit and use variables</td>
<td>242</td>
</tr>
<tr>
<td>8.10.2</td>
<td>Move, copy, paste and delete variables</td>
<td>244</td>
</tr>
<tr>
<td>8.11</td>
<td>PLC variables</td>
<td>245</td>
</tr>
<tr>
<td>8.11.1</td>
<td>Adding and editing a new variable table</td>
<td>245</td>
</tr>
<tr>
<td>8.11.2</td>
<td>All variables</td>
<td>246</td>
</tr>
<tr>
<td>8.11.3</td>
<td>System hardware configuration</td>
<td>249</td>
</tr>
<tr>
<td>8.11.4</td>
<td>Variable tables and &quot;Standard project configuration&quot;</td>
<td>252</td>
</tr>
<tr>
<td>8.12</td>
<td>Address overview</td>
<td>255</td>
</tr>
<tr>
<td>8.13</td>
<td>Cross-reference list</td>
<td>258</td>
</tr>
<tr>
<td>8.14</td>
<td>Assignment list</td>
<td>262</td>
</tr>
<tr>
<td>8.15</td>
<td>Check and restore consistency</td>
<td>267</td>
</tr>
<tr>
<td>8.16</td>
<td>Compile user program</td>
<td>268</td>
</tr>
<tr>
<td>8.16.1</td>
<td>Compile</td>
<td>269</td>
</tr>
<tr>
<td>8.16.2</td>
<td>Compile all</td>
<td>269</td>
</tr>
<tr>
<td>8.17</td>
<td>Simulate user program</td>
<td>270</td>
</tr>
<tr>
<td>8.17.1</td>
<td>PLC simulation settings</td>
<td>270</td>
</tr>
<tr>
<td>8.18</td>
<td>Transfer the hardware configuration and user program to the control</td>
<td>272</td>
</tr>
<tr>
<td>8.18.1</td>
<td>Transfer hardware configuration</td>
<td>272</td>
</tr>
<tr>
<td>8.18.2</td>
<td>Transfer user program</td>
<td>273</td>
</tr>
<tr>
<td>8.18.3</td>
<td>Transfer all</td>
<td>274</td>
</tr>
<tr>
<td>8.19</td>
<td>Load blocks from the device</td>
<td>275</td>
</tr>
<tr>
<td>8.20</td>
<td>Compare blocks</td>
<td>278</td>
</tr>
<tr>
<td>8.21</td>
<td>Watch block</td>
<td>281</td>
</tr>
<tr>
<td>8.21.1</td>
<td>Set program status display</td>
<td>282</td>
</tr>
<tr>
<td>8.21.2</td>
<td>Instruction list (IL)</td>
<td>283</td>
</tr>
<tr>
<td>8.21.3</td>
<td>Function block diagram (FBD)</td>
<td>284</td>
</tr>
<tr>
<td>8.21.4</td>
<td>Data block (DB)</td>
<td>285</td>
</tr>
<tr>
<td>8.22</td>
<td>Add watch table</td>
<td>285</td>
</tr>
<tr>
<td>8.23</td>
<td>Watch table</td>
<td>286</td>
</tr>
<tr>
<td>8.24</td>
<td>Logic analysis</td>
<td>291</td>
</tr>
<tr>
<td>8.24.1</td>
<td>Overview</td>
<td>291</td>
</tr>
<tr>
<td>8.24.2</td>
<td>Carry out logic analysis</td>
<td>293</td>
</tr>
<tr>
<td>8.24.3</td>
<td>Edit operand table</td>
<td>294</td>
</tr>
<tr>
<td>8.24.4</td>
<td>Start recording</td>
<td>295</td>
</tr>
<tr>
<td>8.24.5</td>
<td>Stop recording</td>
<td>296</td>
</tr>
<tr>
<td>8.24.6</td>
<td>Show time</td>
<td>296</td>
</tr>
<tr>
<td>8.24.7</td>
<td>Measure a period of time</td>
<td>297</td>
</tr>
<tr>
<td>8.24.8</td>
<td>Change section</td>
<td>298</td>
</tr>
<tr>
<td>8.24.9</td>
<td>Show/hide operands</td>
<td>300</td>
</tr>
<tr>
<td>8.24.10</td>
<td>Saving and opening a record</td>
<td>300</td>
</tr>
<tr>
<td>8.24.11</td>
<td>Make configurations</td>
<td>300</td>
</tr>
<tr>
<td>8.25</td>
<td>Import S7 program</td>
<td>301</td>
</tr>
<tr>
<td>8.26</td>
<td>Export ASCII sources</td>
<td>302</td>
</tr>
<tr>
<td>8.27</td>
<td>Import ASCII sources</td>
<td>305</td>
</tr>
<tr>
<td>8.28</td>
<td>Install block library</td>
<td>309</td>
</tr>
<tr>
<td>8.29</td>
<td>Keyboard commands in the block editor</td>
<td>311</td>
</tr>
</tbody>
</table>
### 9 Creating a visualisation

9.1 WebVisu and Movicon projects ............................................. 312
9.2 "Device overview" editor (HMI device) .......................................... 312
9.3 "Device properties" editor (HMI device) ......................................... 313
9.3.1 General device properties .......................................................... 313
9.3.2 Communication settings ......................................................... 314
9.3.3 Configurations ........................................................................... 315
9.4 "Standard variables table" editor .................................................... 316
9.5 HMI elements ............................................................................... 318
9.6 HMI library .................................................................................. 319
9.6.1 Create, edit and use new element .................................................. 319
9.6.2 Importing and using resources ..................................................... 319
9.6.3 Delete element ............................................................................ 320
9.7 Add new sub display ....................................................................... 320
9.7.1 Configurations ............................................................................ 320
9.7.2 Background ................................................................................ 320
9.8 Delete image .................................................................................. 320
9.9 "Image" editor ................................................................................ 321
9.9.1 Drawing a shape .......................................................................... 321
9.9.2 Inserting elements from the catalog .............................................. 322
9.9.3 Align and arrange objects .............................................................. 322
9.9.4 Edit object ................................................................................... 323
9.9.5 Edit object properties ................................................................. 325
9.9.6 Edit dynamic samplings – "Simple dynamics" ................................. 326
9.10 Add new enumeration .................................................................... 330
9.11 Edit and use enumeration ............................................................... 330
9.12 Translations .................................................................................. 331
9.13 User management .......................................................................... 332
9.14 Movicon projects .......................................................................... 333
9.14.1 Opening a Movicon project ........................................................ 333
9.14.2 Changing the project path ............................................................ 334
9.15 Simulate HMI visualisation ............................................................ 334
9.16 Keyboard commands in "Image" editor (HMI) ...................................... 335

### 10 Motion Control ........................................................................... 337

10.1 Functions of Motion Control ......................................................... 337
10.2 Add drive ...................................................................................... 337
10.2.1 Adaptation of the Sigma 5/7 drives, which are integrated via ESI file........................................................................ 339
10.3 Start SigmaWin+ or DriveWizard .................................................... 340
10.4 Editor "Motion Control Overview" .................................................. 340
10.4.1 General settings .......................................................................... 340
10.4.2 Axis overview ............................................................................. 342
10.4.3 Diagnostics .................................................................................. 343
10.5 Add new axis .................................................................................. 344
10.6 Editor "Motion Control axis" ................................................................ 345
10.6.1 Basic settings .............................................................................. 345
10.6.2 User units ..................................................................................... 346
10.6.3 Limit values .................................................................................. 349
10.7 Create cams ................................................................................... 350
10.7.1 The "Electronic cam" .................................................................... 350
Table of contents

10.7.2 Add new cam ................................................................. 350
10.7.3 Cam editor ................................................................. 351
10.7.4 Motion functions........................................................ 363

11 Deployment **SPEED7 EtherCAT Manager** ........................................ 378

11.1 Overview............................................................................ 378
11.2 Automatic configuration of a slave system............................ 379
11.3 Manual configuration of a slave system............................... 381
11.4 Configuration - EC-Mastersystem....................................... 381
11.4.1 Preparation.................................................................... 381
11.4.2 Master........................................................................... 382
11.4.3 Process Data Image....................................................... 383
11.4.4 Advanced Options (Expert mode)................................. 383
11.4.5 Distributed Clocks (Expert mode)................................. 386
11.4.6 I/O Address Overview.................................................. 387
11.5 Configuration - slave station.............................................. 388
11.5.1 Preparation.................................................................... 388
11.5.2 General.......................................................................... 389
11.5.3 Modules........................................................................ 390
11.5.4 PDO Mapping............................................................... 391
11.5.5 Advanced Options (Expert mode)................................. 394
11.5.6 Ethernet (EoE)............................................................... 397
11.5.7 Distributed Clocks (Expert mode)................................. 398
11.5.8 Init Commands (Expert mode)....................................... 399
11.5.9 CoE Object Dictionary (Expert mode)............................. 401
11.5.10 Process Image............................................................. 402
11.5.11 I/O Address Overview................................................ 402
11.5.12 Parameter.................................................................... 403
11.6 Configuration - modules.................................................... 403
11.6.1 Please note..................................................................... 403
11.6.2 Preparation.................................................................... 403
11.6.3 MDP Slot Properties..................................................... 404
11.6.4 Process Image............................................................. 404
11.6.5 I/O Address Overview.................................................. 405
11.6.6 Parameter..................................................................... 405
11.7 Diagnostics - EC-Mastersystem.......................................... 406
11.7.1 Preparation.................................................................... 406
11.7.2 General.......................................................................... 406
11.7.3 CoE Object Dictionary.................................................. 408
11.7.4 History (Expert mode)................................................... 408
11.8 Diagnostics - slave station................................................ 409
11.8.1 Preparation.................................................................... 409
11.8.2 General.......................................................................... 409
11.8.3 ESC Register (Expert mode)......................................... 410
11.8.4 EEPROM (Expert mode).............................................. 411
11.8.5 Extended Diagnosis (Expert mode)............................... 411
11.8.6 DC Diagnosis (Expert mode)....................................... 412
11.8.7 CoE Object Dictionary.................................................. 412
11.8.8 FoE Download/Upload.................................................. 413
11.9 Grouping logic.................................................................... 414

VIPA SPEED7 Studio
HB50 | SW | SPEED7 Studio | en | 19-40
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>11.9.1</td>
<td>Overview</td>
<td>414</td>
</tr>
<tr>
<td>11.9.2</td>
<td>Create group with pinned process data offset</td>
<td>416</td>
</tr>
<tr>
<td>11.9.3</td>
<td>Create Hot Connect group</td>
<td>417</td>
</tr>
<tr>
<td>11.10</td>
<td>EtherCAT State Machine</td>
<td>419</td>
</tr>
<tr>
<td>11.11</td>
<td>Firmware update - VIPA System SLIO IM 053-1EC0x</td>
<td>420</td>
</tr>
<tr>
<td>12</td>
<td>Index</td>
<td>421</td>
</tr>
</tbody>
</table>
General information on this documentation

1.1 Copyright © YASKAWA Europe GmbH

This document contains proprietary information of YASKAWA and is not to be disclosed or used except in accordance with applicable agreements.

This material is protected by copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either internal or external to YASKAWA) except in accordance with applicable agreements, contracts or licensing, without the express written consent of YASKAWA and the business management owner of the material.

For permission to reproduce or distribute, please contact: YASKAWA Europe GmbH, European Headquarters, Hauptstraße 185, 65760 Eschborn, Germany

Tel.: +49 6196 569 300
Fax.: +49 6196 569 398
Email: info@yaskawa.eu.com
Internet: www.yaskawa.eu.com

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information.

This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

EC conformity declaration

Hereby, YASKAWA Europe GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions. Conformity is indicated by the CE marking affixed to the product.

Conformity Information

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local representative of YASKAWA Europe GmbH.

Trademarks

VIPA, SLIO, System 100V, System 200V, System 300V, System 300S, System 400V, System 500S and Commander Compact are registered trademarks of YASKAWA Europe GmbH.

SPEED7 is a registered trademark of YASKAWA Europe GmbH.

SIMATIC, STEP, SINEC, TIA Portal, S7-300, S7-400 and S7-1500 are registered trademarks of Siemens AG.

Microsoft and Windows are registered trademarks of Microsoft Inc., USA.

Portable Document Format (PDF) and Postscript are registered trademarks of Adobe Systems, Inc.

All other trademarks, logos and service or product marks specified herein are owned by their respective companies.
1.2 Purpose of the documentation

This documentation describes the VIPA SPEED7 Studio software package. Please also note Chap. 1.4 ‘Structure and contents of the documentation’ page 13.

The manual is intended for persons who implement control functions for VIPA SPEED7 automation systems using VIPA SPEED7 Studio.

1.3 Validity of the documentation

This software description is valid for the VIPA SPEED7 Studio software package from version 1.9.0

Please also note Chap. 2.4 ‘Software identification’ page 17

Information on more recent versions or service packs which will be issued after the publication of this software description are provided at www.vipa.com

1.4 Structure and contents of the documentation

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chap. 1 ‘General information on this documentation’ page 12 (of this chapter)</td>
<td>Information on this documentation and on further documentations</td>
</tr>
<tr>
<td></td>
<td>Form of notes and information</td>
</tr>
<tr>
<td></td>
<td>Designation of interface elements</td>
</tr>
<tr>
<td>Chap. 2 ‘To the SPEED7 Studio program’ page 16</td>
<td>Product description and technical features of SPEED7 Studio</td>
</tr>
<tr>
<td></td>
<td>Information on the target group and its qualifications</td>
</tr>
<tr>
<td></td>
<td>Identification and scope of delivery</td>
</tr>
<tr>
<td>Chap. 3 ‘Installation and activation of SPEED7 Studio’ page 18</td>
<td>How to install, uninstall and activate (license) SPEED7 Studio</td>
</tr>
<tr>
<td>Chap. 4 ‘Working with SPEED7 Studio’ page 23</td>
<td>Explanation of the user interface, menus and functions</td>
</tr>
<tr>
<td></td>
<td>Adaptation and operation options of SPEED7 Studio</td>
</tr>
<tr>
<td>Chap. 5 ‘Managing and editing projects’ page 65</td>
<td>Information and operating instructions regarding project administration and processing</td>
</tr>
</tbody>
</table>
null
Every operating step tells you what to do. The individual steps of any operating instruction consisting of several steps will be successively numbered.

⇒ Here, the result of the operating step is presented.

**Further tags and formatting**

The following tags are used in this documentation for highlighting certain information:

<table>
<thead>
<tr>
<th>Tags/formatting</th>
<th>Explanation</th>
</tr>
</thead>
</table>
| ‘Menu ➔ Menu item’ | Menu command  
Example: ‘File ➔ Open project’ |
| ‘Text’ | Text of the programming interface, e.g. edit field in a dialogue window  
Example: ‘User name’  
- or -  
push button  
Example: ‘Cancel’ |
| [Key] | Key or key combination of the computer keyboard  
Example: [Ctrl]+[C] |
| **Product** | Product designation (italics)  
Example: SPEED7 Studio |
| **Program code** | Program code (monospace font) |
| ![Icon](image) (Icon / button of the programming interface) |  |
| ![Reference number](image) (Reference number in the illustrations (encircled consecutive number)) |  
Example:  
(1) Toolbar |
| ![List](image) (List, e.g. for listing several operating options) |  |
| ![Cross-reference](image) (Cross-reference to further information) |  
Example:  
 Chap. 1.4 ‘Structure and contents of the documentation’ page 13 |
2 To the SPEED7 Studio program

2.1 Product description

Controls based on SPEED7 technology can be used to an optimum with the SPEED7 Studio engineering tool.

SPEED7 Studio maps the complete automation process - from hardware configuration, communication and programming to visualisation.

Intuitive user interfaces allow for the immediate access to different modules. Thus, additional tools of third-party suppliers for hardware configuration, for linking different field buses, for programming or for the visualisation and operation of the systems are no longer necessary.

**Hardware configuration**

With SPEED7 Studio, it is possible to directly configure System MICRO and System SLIO systems with their product-specific parameters and their PROFIBUS, EtherCAT and PROFINET bus systems. Pre-defined device templates can be added in the appropriate position using Drag & Drop for configuration.

**Networking**

No specific bus system knowledge is required for the configuration of networking via PROFIBUS, PROFINET and EtherCAT with SPEED7 Studio. SPEED7 Studio provides various device templates which allow for the graphic networking configuration.

**Programming**

The programming languages IL and FBD can be used in the current version for programming.

For easier textual programming, texts are structured by syntax highlighting. Moreover, it is possible to save notes in the code or define “regions” which allow for the clearly structured display of IL.

The graphic programming languages use different colours for different block groups which allows for easy functional allocation.

When entering the program code, the syntax is checked and the user is immediately informed about possible errors.

For diagnostics purposes, the current values can be displayed in the blocks or online in watch tables. A history and trend display are also available.

**Visualisation**

With SPEED7 Studio, it is possible to create a web-based visualisation. For this purpose, a SVG graphic editor is available which is used for the creation of individual pages. Ready-made elements provided in a library allow for very easy design.

The central data management in SPEED7 Studio allows for the access to all variables of the control.

The visualisation function is not only accessible via a conventional touch panel but also via any browser-enabled mobile end device such as a tablet PC or a smart phone. The only thing required is a Java-enabled web browser.

Further visualisation properties include loss-free scalable SVG vector graphics, pre-configured dynamic samplings and objects, object-oriented parametrising and client scripting.

2.2 Technical features

For SPEED7 Studio design, technologies and tools such as .net 4.0 and vector-based UI visualisation with Windows® Presentation Foundation are used.
### Central data management
Hardware configuration, networking, programming and visualisation use a central data-base based on a central SQL server. This allows, for example, for the direct access to control variables for visualisation creation without having to synchronise the data of the different tools.

### Vector-based graphics
Any graphics used in SPEED7 Studio are vector-based and used, for example, for the photo-realistic illustration of components which can thus be zoomed without losses.

### Multilingualism
All graphic user interfaces are available in different languages. The interface and menu language in SPEED7 Studio can be changed during programming.

### 2.3 Target group and qualification
SPEED7 Studio may be used only by qualified personnel. Due to their training and experience, the qualified personnel are capable of recognising risks and avoiding possible dangers when using SPEED7 Studio.

### 2.4 Software identification
In order to get information on the installed SPEED7 Studio version and on the plug-in modules, select ‘Help ➔ Info’ in the menu bar.

⇒ The dialogue window with information on SPEED7 Studio will open.

Please also note ➖ Chap. 1.3 ‘Validity of the documentation’ page 13
3 Installation and activation of SPEED7 Studio

3.1 System requirements

The minimal system requirements for the installation of the SPEED7 Studio software package include:

- Processor: Intel® Pentium® 4 or AMD Athlon® 64
- Operating system: Microsoft® Windows 7®, Windows 8® or Windows 10®
- Working memory: At least 2 GB RAM
- Hard disk space: At least 12 GB (installation on portable flash memories not possible)
- Monitor and graphics card: Monitor resolution 1024 x 768 pixel (1920 x 1080 recommended), a colour depth of 16 Bit and 256 MB VRAM

3.2 Installation of SPEED7 Studio

You can install SPEED7 Studio with a downloaded file.

- Double-click on the installation diagram. Follow the instructions on the monitor.

You must agree to the licensing agreement before you can use SPEED7 Studio. This must be confirmed during installation.

Further components are required in order to operate SPEED7 Studio. If the following programs are not already available on your PC, they are installed automatically:

- Microsoft .NET Framework 4.52
- Microsoft SQL Server® 2014 SP1
- WinPcap

3.3 Activate SPEED7 Studio

You can use a 30-day demo version or activate a licence.

In order to use SPEED7 Studio without restrictions, you require a licence, which you can obtain from your local YASKAWA customer service organisation.

Use 30-day demo version

With the demo version, you can use SPEED7 Studio with no obligation and free of charge for 30 days. After this time has expired, you can use SPEED7 Studio again only when you activate a licence.

1. Start SPEED7 Studio. Chap. 4.2 ‘Start SPEED7 Studio’ page 23
   - If no licence is activated, the dialogue window for activating the licence will open each time you start SPEED7 Studio.

2. Click on ‘No’.
   - SPEED7 Studio is started.

Each time you start SPEED7 Studio, it is shown for how many days you can still use the demo version.
Activate licence online

If the PC on which you would like to use SPEED7 Studio is connected to the internet, you can activate the licence online.

1. Start SPEED7 Studio. Chap. 4.2 ‘Start SPEED7 Studio’ page 23
   ⇒ If no licence is activated, the dialogue window for activating the licence will open each time you start SPEED7 Studio.

2. Click on ‘Yes’.
   ⇒ The ‘Product activation’ dialogue window will open.

   ![Activation Dialogue Window]

3. Enter the serial number that you received with your order of SPEED7 Studio in the ‘Licence key’ input field.

4. Enter your name in the ‘Your name’ input field.

5. If you enter your e-mail address in the ‘Email address’ input field, you receive an e-mail confirmation regarding the product activation.
6. Click on ‘Activate’.
   ➞ The licence is activated and SPEED7 Studio is started.

Activate licence offline

If the PC on which you would like to use SPEED7 Studio is not connected to the internet, you can activate the licence offline. For this, you need to obtain an activation key via another PC that is connected to the internet.

1. Start SPEED7 Studio. Chap. 4.2 ‘Start SPEED7 Studio’ page 23
   ➞ If no licence is activated, the dialogue window for activating the licence will open each time you start SPEED7 Studio.

2. Click on ‘Yes’.
   ➞ The ‘Product activation’ dialogue window will open.
Enter the serial number that you received with your order of SPEED7 Studio in the ‘Licence key’ input field.

Enter your name in the ‘Your name’ input field.

If you enter your e-mail address in the ‘Email address’ input field, you receive an e-mail confirmation regarding the product activation.

Click on ‘Activate offline’.
  ⇒ A dialogue window with information on the subsequent steps will open.

Click on ‘OK’ in the dialogue window.
  ⇒ The ‘Save as’ dialogue window will open.

Save the HTML file and transfer this file (e.g. with copy and paste) to a PC that is connected to the internet.
   ⇒ The HTML page is opened in the browser. The activation key is accessed by the VIPA licence server and is shown in the browser.

10. Enter the activation key into the ‘Activation key’ input field in the ‘Product activation’ dialogue window.

11. Click on ‘Activate offline’ again.
   ⇒ The licence is activated and SPEED7 Studio is started.

3.4 Uninstallation of SPEED7 Studio

You can use the system control to uninstall SPEED7 Studio. Follow the instructions on the monitor.

A dialogue window will open, where you can select whether your stored projects should be retained or deleted.

**NOTICE!**

Data loss!

- All project data are removed from the data carrier!
  - Make sure that the project data are no longer needed.
4 Working with **SPEED7 Studio**

4.1 Overview

This chapter explains the user interface of **SPEED7 Studio**. Chap. 4.8 ‘User interface’ page 26

Moreover, it contains a description of various operating options with mouse and keyboard. Chap. 4.18 ‘Mouse and keyboard operation’ page 52

4.2 Start **SPEED7 Studio**

Click on the program button. You can find **SPEED7 Studio** in Windows Start under ‘VIPA GmbH’.

⇒ **SPEED7 Studio** is started. The "start page" appears.

It is possible to run **SPEED7 Studio** simultaneously several times on one PC if you want to use it for various projects. It is not possible to open the same project in different instances of **SPEED7 Studio**.

When **SPEED7 Studio** is restarted, the working interface is restored in the same position and size as when it was last used.

4.3 End **SPEED7 Studio**

Select one of the following options if you want to end the program:

- **Main window**: Click on the Close button of the **SPEED7 Studio** program window.
- **Menu bar**: Select ‘File ➔ Exit’.
- **Keyboard**: Press [Alt]+[F4].

After you have made changes to the project, a dialogue window will open, where you can select whether to save or ignore the changes.

⇒ **SPEED7 Studio** is ended.

4.4 Select language

You can select the language in which the user interface is to be displayed.

Select the menu command ‘Language’ and click on the desired language.

⇒ The user interface is displayed in the selected language.

If you change to another language while a project is open, not all elements can be changed to the selected language. Close the project and open it again to change all elements into the selected language.
4.5 Select syntax language (mnemonics)

You can select the language in which the language elements (mnemonics) of the user program are to be displayed.

1. Select the menu command ‘Extras ➔ Configurations’.
2. Under ‘Mnemonic configurations’, select the desired syntax language.
   ⇒ The language elements are displayed in the selected language.

**Example**

IL syntax in different languages:
- German: U E0.1 (AND Input 0.1)
- International: A I0.1 (AND Input 0.1)

4.6 Select interfaces

You can choose which interfaces to use for the data exchange.

1. Select the menu command ‘Extras ➔ Configurations’.
2. Under ‘Standard interfaces’, select the desired network adapter or port:
   - ‘Standard adapter Ethernet’ – Data exchange via an Ethernet interface between the programming device and the connected devices
   - ‘Standard adapter simulation’ – To test (simulate) the user program on the programming device
   - ‘Standard port serial’ – Data exchange via a serial interface between the programming device and the connected devices

Under “communication settings”, you can change further configurations. ⇒ Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

4.7 Symbolic and absolute addressing

You can select whether the operands in the block editor should be shown as symbolic or absolute:

1. Select the menu command ‘Extras ➔ Configurations’.
2. Select type of addressing under ‘Programming’:
   - ‘Symbolic’ (default setting) – Displays symbolic addresses upon entry and upon observation, e.g. ‘MySymbol’
     If an absolute address is entered in the block editor, SPEED7 Studio replaces this address with the available symbol, e.g. from the variable table. If no symbol is available, SPEED7 Studio automatically generates a symbol, e.g. entry: E0.1, symbol: “x_E0.1”. The new symbol is saved in the ‘standard project configuration’ variable table. ⇒ Chap. 8.11.4 ‘Variable tables and “Standard project configuration”’ page 252
   - ‘Absolute’ – Displays absolute addresses (direct addresses) upon entry and upon observation, e.g. E0.1, MW8, FB1
     If a symbolic address is entered in the block editor, SPEED7 Studio replaces this address with the absolute address, e.g. entry: “x_E0.1”, display: E0.1.
A symbol is always automatically created for each newly added operand, even if the "absolute" addressing type is selected.

**Symbol format for automatically generated symbols**

From Version 1.8 of *SPEED7 Studio*, symbols are automatically created for all absolute addresses used in the project for which no symbol yet exists.

You can define the prefix for all automatically generated symbols:

Select symbol format under 'Programming':

- **'User-defined prefix'** (default setting) — In the input field, define the character string which will be placed at the beginning of an automatically generated variable. Example prefix: sym_, address entry E0.1, automatically generated symbol: "sym_E0.1"
- **'Hungarian notation'** — In "Hungarian notation", a letter and an underscore are placed at the beginning of an automatically generated variable in order to indicate the data width of the operands:

<table>
<thead>
<tr>
<th>Data type</th>
<th>Prefix</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOL</td>
<td>x_</td>
<td>x_E0.0</td>
</tr>
<tr>
<td>BYTE, CHAR</td>
<td>b_</td>
<td>b_MB1</td>
</tr>
<tr>
<td>WORD, INT, S5TIME, DATE, COUNTER, TIMER</td>
<td>w_</td>
<td>w_MW20, w_T1</td>
</tr>
<tr>
<td>DWORD, DINT, REAL, TIME, TIME_OF_DAY, DATE_AND_TIME</td>
<td>d_</td>
<td>d_MD2</td>
</tr>
</tbody>
</table>

The settings are saved for all future processing of symbols. If, for example, you switch from a user-defined prefix to "Hungarian notation", this symbol format is only used for symbols which are subsequently newly generated.

**Dialogue support for symbol input**

If you activate 'dialogue support', a dialogue window in which the operand, data type and other properties can be defined for the new symbol opens upon entry of a new symbolic address. Chap. 8.5.5 'Create / edit symbol' page 221

**Type checking for operands**

For the graphic programming languages LD and FBD, you can specify whether just the data width is checked or whether the data type of an operand is checked as well:

- Type checking activated: An error message is displayed if the data type of the operand does not match the data type of the input or output parameter.
- Type checking deactivated: An error message is only displayed if the data wider of the operand does not match the data width of the input or output parameter.

![Data types do not correspond](image)

*Fig. 3: Error message if the data type of the operand does not match the data type of the input or output parameter*
Additional information in IL editor

You can define whether the additional information for newly added blocks should be shown or hidden in IL editor. You can also show or hide the additional information individually for each block in IL editor, see Chap. 8.5.4 ‘Instruction section’ page 217.

4.8 User interface

Fig. 4: SPEED7 Studio user interface (example)

1. Menu bar
2. Toolbar
3. Project tree
4. Area of operations
5. Catalog/properties
6. Output range
7. Status line

You can show and hide further windows and adjust the arrangement and size of the windows. Chap. 4.18.1 ‘Adjusting the user interface’ page 52

Information on the general use of SPEED7 Studio: Chap. 4.18 ‘Mouse and keyboard operation’ page 52

(1) Menu bar

Most of the commands you need for working with SPEED7 Studio are provided in the menu bar. Further commands can be accessed via the context menus using the right mouse button, e.g. functions of a device in the project tree. Chap. 4.18.2 ‘Mouse operation – context menu’ page 53

The menu commands ‘Project’ and ‘Device’ are only shown if a project is open.
You can use the menus with the mouse or the keyboard. Chap. 4.20 ‘Menu and keyboard commands’ page 61

(2) Toolbar

Important commands you need for working with SPEED7 Studio are provided in the toolbar. More commands can be accessed via the toolbars and push buttons of different editors.

Some of the commands in the toolbar are only shown if a project is open.

(3) Project tree

Any project device and project data can be accessed via the project tree. The project tree includes any object which you have created in the project, e.g. devices, components, program blocks, HMI images. Here you can add or remove devices and components. Furthermore, you can open editors in order to edit settings, configurations, the control program and visualisation.

Chap. 4.9 ‘Project tree’ page 28

(4) Area of operations

Devices and project data can be edited in the area of operations. You can open different editors for this purpose. The register in the area of operations is divided into two register levels. You can switch through the editors in the area of operations via the tabs.

Chap. 4.12 ‘Area of operations’ page 38

(5) Catalogue/properties

Devices and components which you want to add to the project can be selected in the catalog. You can also select objects which you want to add to the PLC program or to HMI images.

Chap. 4.10 ‘Catalog’ page 34
Chap. 4.11 ‘Properties’ page 37

(6) Output range

Information on executed activities and background operations are displayed on the output range.

Chap. 4.14 ‘Output range’ page 43

(7) Status line

The version of SPEED7 Studio is displayed at the left edge of the status line. The progress bar for background operations and status messages is shown at the right edge. As long as there are no background operations, the status message created at last is shown.
Any project device and project data can be accessed via the project tree. The project tree includes any object which you have created in the project, e.g. devices, components, program blocks or HMI images.

**Fig. 5: Project tree, example**

1. Title and author
2. Project
3. Documentation
4. PLC
5. Motion Control
6. PLC program
7. Local components (= local modules)
8. Decentralised periphery
9. HMI
In the project tree, you can access commands in order to add or delete objects, e.g. add/delete devices or add/delete blocks.

You can select individual or several objects in the project tree to move them or copy and paste them in another location. See Chap. 4.9.1 ‘Moving, copying and pasting objects’ page 33.

You can open editors via the project tree if you want to edit settings, configurations, the control program and visualisation. Moreover, you can retrieve information, e.g. project overview, device properties or bus system properties.

---

### Show project tree

If the project tree is not displayed, select ‘View → Project tree’ or press [Ctrl]+[Shift]+[P].

### Show projects in the project tree

In order to display the project in the project tree, you must create a new project See Chap. 5.2 ‘Create a new project’ page 65 or open a stored project See Chap. 5.3 ‘Open project’ page 66.

It is not possible to edit several projects at the same time. It is possible to run SPEED7 Studio simultaneously several times on one PC if you want to use it for various projects.

### Show/hide objects

The objects in the project tree are arranged in a tree structure. You can show or hide objects:

- Hide all objects (‘Project → Collapse project tree’)
- Show all objects (‘Project → Expand project tree’)
- Hide slave objects / close folder
- Show slave objects / open folder

### Recognise object state

Symbols behind an object in the project tree provide indications of the object state. See Chap. 4.19.3 ‘Markings of changes and states’ page 56.

---

### (1) Title and author

<table>
<thead>
<tr>
<th>Title and author</th>
</tr>
</thead>
<tbody>
<tr>
<td>Here, project name and user are displayed See Chap. 5.2 ‘Create a new project’ page 65</td>
</tr>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the project</td>
</tr>
</tbody>
</table>

### (2) Project

<table>
<thead>
<tr>
<th>Project name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Here, the project name is displayed.</td>
</tr>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the project</td>
</tr>
<tr>
<td>[F2]: Rename project</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Project overview</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single click: Open &quot;Project overview&quot; See Chap. 6.1 “Project overview” editor page 76</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Devices and networking</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single click: Open &quot;Devices and networking&quot; See Chap. 6.2 “Devices and networking” editor page 77</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add new device</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single click: Open &quot;Add new device&quot; dialogue window See Chap. 6.3 ‘Add new device (PLC)’ page 81</td>
</tr>
</tbody>
</table>
## (3) Documentation

**Documentation**
- Contains text documents and further sub-folders
  - Chap. 5.15 “Documentation” folder  page 74
  - Chap. 5.17 ‘Text editor (text document)’  page 75

**Text document**
- Name of the text document
  - Right mouse button: Context menu with commands and functions regarding the text document
  - Double-click: Open text document in the editor  Chap. 5.17 ‘Text editor (text document)’  page 75
  - [F2]: Rename text document

## (4) PLC

**Device name**
- Here, the device name of the PLC is displayed.
  - Right mouse button: Context menu with commands and functions regarding the PLC
  - Double-click: Open the "Device configuration" of the PLC  Chap. 6.14 “Device configuration editor (PLC)”  page 101

**Device overview**
- Single click: Open the "Device overview" of the PLC  Chap. 8.2 ‘Device overview (PLC)”  page 207

**Device properties**
- Single click: Open the "Device properties" of the PLC  Chap. 6.20 “Device properties” editor (PLC)”  page 110

**Device configuration**
- Single click: Open the "Device configuration" of the PLC  Chap. 6.14 “Device configuration editor (PLC)”  page 101

**Address overview**
- Single click: Open the "Address overview" of the PLC  Chap. 8.12 ‘Address overview”  page 255

## (5) Motion Control

**Motion Control Overview**
- Single click: Open configurations for the Motion Control functions  Chap. 10.4 ‘Editor "Motion Control Overview”’  page 340

**Motion Control axes**
- Single click: Open dialogue window “Add new axis”  Chap. 10.5 ‘Add new axis”  page 344

**Axis**
- Name of the Motion Control axis
  - Right mouse button: Context menu with commands and functions regarding the Motion Control axis
  - Double-click: Open the editor of the Motion Control axis  Chap. 10.6 ‘Editor "Motion Control axis”’  page 345

## (6) PLC program

**Cams**
- Includes cams for controls with Motion Control functionality  Chap. 10.7 ‘Create cams’ page 350

**PLC program**
- Right mouse button: Context menu with commands and functions regarding the user program (PLC program)
### Program blocks

Contains all blocks of the user program
- Right mouse button: Context menu with commands and functions regarding the blocks, e.g. add, open, rename, delete, transfer block, or add rename, delete folder
- [F2]: Rename directory

<table>
<thead>
<tr>
<th>Add new block</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the blocks, e.g. add, open, rename, delete, transfer block, or add rename, delete folder</td>
</tr>
<tr>
<td>[F2]: Rename directory</td>
</tr>
</tbody>
</table>

#### Organisation block [OB]

Name of the block
- Right mouse button: Context menu with commands and functions regarding the block
- Double-click: Open block in the editor
- [F2]: Rename program block

#### Function block [FB]

[Chap. 8.5 ‘Block editor for program blocks (OB, FB, FC)’ page 210]

#### Function [FC]

#### Data block [DB]

#### Structure block [UDT]

[Chap. 8.8 ‘Block editor for data blocks (DB)’ page 235]

[Chap. 8.10 ‘Block editor for structure blocks (UDT)’ page 240]

### PLC variables

<table>
<thead>
<tr>
<th>All variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the variable table</td>
</tr>
<tr>
<td>Double-click: Open variable table [Chap. 8.11 ‘PLC variables’ page 245]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Add new variable table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single click: Open &quot;Add variable table&quot; dialogue window [Chap. 8.11 ‘PLC variables’ page 245]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System hardware configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the variable table</td>
</tr>
<tr>
<td>Double-click: Open variable table [Chap. 8.11.3 ‘System hardware configuration’ page 249]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Standard project configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the variable table</td>
</tr>
<tr>
<td>Double-click: Open variable table [Chap. 8.11.4 ‘Variable tables and &quot;Standard project configuration&quot;’ page 252]</td>
</tr>
<tr>
<td>[F2]: Rename variable table</td>
</tr>
</tbody>
</table>

### Watch tables

<table>
<thead>
<tr>
<th>Add watch table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single click: Open &quot;Add watch table&quot; dialogue window [Chap. 8.22 ‘Add watch table’ page 285]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Watch table</th>
</tr>
</thead>
<tbody>
<tr>
<td>Right mouse button: Context menu with commands and functions regarding the watch table</td>
</tr>
<tr>
<td>Double-click: Open watch table [Chap. 8.23 ‘Watch table’ page 286]</td>
</tr>
<tr>
<td>[F2]: Rename watch table</td>
</tr>
</tbody>
</table>

### OPC UA configuration

<table>
<thead>
<tr>
<th>OPC UA configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Chap. 7.7 ‘Configure OPC UA’ page 199]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Server settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Chap. 7.7.3 ‘Server settings - Connection’ page 200]</td>
</tr>
<tr>
<td>[Chap. 7.7.4 ‘Server settings - Certificate’ page 201]</td>
</tr>
</tbody>
</table>
### Project tree

<table>
<thead>
<tr>
<th>(7) Local components</th>
<th>Chap. 6 'Selecting and configuring devices and components’ page 76</th>
</tr>
</thead>
<tbody>
<tr>
<td>(8) Decentralised periphery</td>
<td>Chap. 6.5 ‘Adding a new device (slave)’ page 85</td>
</tr>
<tr>
<td>(9) HMI</td>
<td></td>
</tr>
</tbody>
</table>

### Data access

- Chap. 7.7.5 ‘Data access’ page 202

### User management

- Chap. 7.7.6 ‘User management’ page 203
- Chap. 7.7.7 ‘Role management’ page 204

### Local components

- Local components

### Decentralised periphery

- Decentralised periphery

### HMI

- Right mouse button: Context menu with commands and functions regarding visualisation (HMI)

### Device overview

- Single click: Open the "Device overview" of the HMI device Chap. 9.2 “Device overview” editor (HMI device) page 312

### Device properties

- Single click: Open the “Device properties” of the HMI device Chap. 9.3 “Device properties” editor (HMI device) page 313

### HMI project

#### Variables

- Double-click: Open variable table Chap. 9.4 “Standard variables table” editor page 316

### Images

- Single click: Open "Add new image" dialogue window

#### Image

- Name of the HMI image
- Right mouse button: Context menu with commands and functions regarding the HMI image
- Double-click: Open HMI image in the editor Chap. 9.9 “Image” editor page 321
- [F2]: Rename HMI image
- [Del]: Delete HMI image

#### Resources

- Single click: Open "Add resource" dialogue window Chap. 9.6 ‘HMI library’ page 319

#### Resource

- Name of the resource
- Right mouse button: Context menu with commands and functions regarding the resource
- [F2]: Rename resource
4.9.1 Moving, copying and pasting objects

In the project tree, you can select individual or several objects to move them or copy and paste them in another location.

**Select an object**

- Click on the desired object.

**Select several objects**

- Press and hold the [Ctrl] key and click on the objects you want to select.
- or -

  In order to select a row of objects, press and hold the key [shift] and click on the first and the last element of the row.
- or -

  In order to select a row of objects, click on the first object of the row. Press and hold the key [shift] and use the keys [↑] or [↓], to select further elements.
- or -

  You can also highlight a folder to select all elements contained. However, system folders such as e.g. ‘Program blocks’, ‘PLC variables’ or ‘Watch tables’ cannot be selected.

- You can only select objects of the same type. Example: You can select several program blocks, but not program blocks and variable tables at the same time.

- You can only select objects within one control (CPU). Example: You can select several program blocks from PLC_01 but are not able to add program blocks from PLC_02.

After selecting objects, proceed as follows:

- Drag & drop objects
- Copy objects
- Paste objects

**Drag & drop objects**

1. Left-click with the mouse on an object and hold the mouse button pressed down. To copy objects, also keep the [Ctrl] key pressed down.

2. Drag the object in the desired position, e.g. an organisation block from one control to another.

3. Release the mouse button.

While dragging the object, the mouse pointer changes its form (see example).
At each permitted dropping position, the mouse pointer changes its form again (see example).

Copy objects
- Press \([\text{Ctrl}]+[\text{C}]\).
- or -
  - Right-click with the mouse button on an object and select ‘Copy’ or ‘Copy to clipboard’.
  - The selected objects are copied to the clipboard. When copying a function block, all related instance data blocks are also copied to the clipboard.

Paste objects
1. Select the folder or the element, where you want to paste the content of the clipboard.

   You can only paste elements to positions matching the type of the elements on the clipboard. Example: You can only paste program blocks within the node ‘Program blocks’.

2. Press \([\text{Ctrl}]+[\text{V}]\).
- or -
  - Right-click with the mouse button on the target object and select ‘Paste’ or ‘Paste from clipboard’.
  - The objects copied to the clipboard are pasted.

Pasting objects with the same name or same number

<table>
<thead>
<tr>
<th>Object type</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>Program blocks</td>
<td>A dialogue window will open, where you can change the names or numbers of the blocks to be pasted. Only when all block names and numbers are distinct, the blocks can be added.</td>
</tr>
<tr>
<td>System blocks</td>
<td>A dialogue window will open, in which you can select whether present system blocks shall be overwritten or not.</td>
</tr>
<tr>
<td>Watch tables and variable tables</td>
<td>The watch and variable tables to be pasted will receive a new distinct name automatically.</td>
</tr>
</tbody>
</table>

4.10 Catalog

Devices and components which you want to add to the project can be selected in the catalog. You can also select objects which you want to add to the PLC program or to HMI images.
Fig. 6: Catalog, "Device templates" example

(1) Switching to another view
(2) Register
(3) Show/hide objects
(4) Search
(5) Filter
(6) Objects
(7) Catalog information
If the catalog is not displayed, select ‘View ➔ Catalog’ or press [Ctrl]+[Shift]+[C].

(1) Switch to another view
If the properties are displayed instead of the catalog, you must click on ‘Catalog’ at the lower screen edge.

(2) Register
Certain tabs are displayed in the catalog, depending on which editor window is opened in the foreground.

Example
In the area of operations, the ‘Devices and networking’ editor is opened and visible in the foreground. The ‘Device templates’ and ‘Components’ tabs are available in the catalog.

<table>
<thead>
<tr>
<th>Editor in the area of operations</th>
<th>Tabs in the catalog</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices and networking</td>
<td>Device templates</td>
</tr>
<tr>
<td>Device configuration</td>
<td>Components</td>
</tr>
<tr>
<td>Organisation block [OB]</td>
<td>Components</td>
</tr>
<tr>
<td>Function block [FB]</td>
<td>Graphics library (IL, LD, FBD)</td>
</tr>
<tr>
<td>Function [FC]</td>
<td>Code library</td>
</tr>
<tr>
<td>HMI image</td>
<td>HMI elements</td>
</tr>
</tbody>
</table>

(3) Show/hide objects
The objects in the catalog are arranged in a tree structure. You can show or hide objects:

- Hide all objects (‘Project ➔ Collapse catalog tree’)
- Show all objects (‘Project ➔ Expand catalog tree’)
- Hide slave objects / close folder
- Show slave objects / open folder

(4) Search
You can search for certain objects in the catalog.

1. Enter a search text in the input field.
   - Only those objects which contain the search text are displayed in the catalog.
2. Click on to delete the search text.
   - All objects are displayed in the catalog.

(5) Filter

(6) Add object
Drag the desired object from the catalog to a suitable position. Chap. 4.18.3 ‘Mouse operation – drag & drop’ page 54
- The object is added.
Example

(1) Select the desired object (hold left mouse button down)
(2) Drag the object
(3) Drop the object at a suitable place (release the mouse button)
(4) The object is added

**7) Catalog information**

The catalog information show details about the selected object, e.g. name, vendor, version, order information.

**4.11 Properties**

Element properties can be displayed and edited in HMI images in the "Properties" window.
Fig. 7: Properties

Show "Properties" window
If the properties are not displayed, select ‘View ➔ Properties’ or press [Ctrl]+[Shift]+[M].

(1) Switch to another view
If the catalog is displayed instead of the properties, you must click on ‘Properties’ at the lower screen edge.

(2) Show/hide properties
The properties are arranged in a tree structure. You can show or hide the properties:
- Hide all properties (‘Project ➔ Collapse property tree’)
- Show all properties (‘Project ➔ Expand property tree’)
  - Hide slave properties
  - Show slave properties

(3) Properties of an element
Click on an element in the HMI image.
⇒ The properties of the element are displayed.

4.12 Area of operations
Editors in the area of operations
Devices and project data can be edited in the area of operations. You can open different editors for this purpose, e.g. via the menu bar, the toolbar or the project tree.
‘Overview of tabs and editors’ page 40

Fig. 8: Editors in the area of operations, "Devices and networking" example

The register is located above the editors. It is divided into two register levels and contains the following tabs:

1. Main register
   - The ‘General’ tab contains sub-registers of the project.
   - Further tabs (e.g. "PLC01", "DPSlave_001", "HMI01") contain sub-registers of the devices.

2. Sub-register
   - Contains tabs with editors for the project (e.g. start page, devices and networking) or for the selected device (e.g. device properties, program blocks, images).

Fig. 9: Register and tabs

1. Main register
2. Sub-register

You can enlarge or reduce the area of operations.

Switching to another editor

You can switch through the editors in the area of operations via the tabs. A tab for each open editor is displayed. Only the selected editor is visible.
If you want to switch to another editor, you must proceed as follows:

1. Click on the desired tab (Device or "General") in the main register.
   ⇒ The editors corresponding to the selected device or to "General" are displayed in the sub-register.

2. Click on the desired tab in the sub-register.
   ⇒ The editor is displayed in the area of operations.

**Example**

You want to access the start page. First click on ‘General’ and then on ‘Start page’.

You can also switch to another editor via the project tree. Click on the desired function in the project tree.

**Closing the editor**

1. Move the mouse pointer to the right edge of the tab.
   ⇒ The icon is automatically displayed.

2. Click on the icon.
   ⇒ The editor is closed.

**Closing all editors**

Select in the menu bar ‘Window → Close all documents’.
 ⇒ All editors in the area of operations are closed. Only the start page remains open.

**Overview of tabs and editors**

<table>
<thead>
<tr>
<th>Main register</th>
<th>Sub-register</th>
<th>Editor in the area of operations</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>Start page</td>
<td>Chap. 4.13 ‘Start page’ → page 41</td>
</tr>
<tr>
<td></td>
<td>Devices and networking</td>
<td>Chap. 6.2 “Devices and networking” editor → page 77</td>
</tr>
<tr>
<td></td>
<td>Project overview</td>
<td>Chap. 6.1 “Project overview” editor → page 76</td>
</tr>
<tr>
<td>PLC</td>
<td>Device overview</td>
<td>Chap. 8.2 ‘Device overview (PLC) → page 207</td>
</tr>
<tr>
<td></td>
<td>Device properties</td>
<td>Chap. 6.20 “Device properties” editor (PLC) → page 110</td>
</tr>
<tr>
<td></td>
<td>Device configuration</td>
<td>Chap. 6.14 “Device configuration” editor (PLC) → page 101</td>
</tr>
<tr>
<td></td>
<td>Organisation block [OB]</td>
<td>Chap. 8.5 ‘Block editor for program blocks (OB, FB, FC) → page 210</td>
</tr>
<tr>
<td></td>
<td>Function block [FB]</td>
<td>Chap. 6.14 “Device configuration” editor (PLC) → page 101</td>
</tr>
<tr>
<td></td>
<td>Function [FC]</td>
<td>Chap. 8.5 ‘Block editor for program blocks (OB, FB, FC) → page 210</td>
</tr>
<tr>
<td></td>
<td>Data block [DB]</td>
<td>Chap. 8.8 ‘Block editor for data blocks (DB) → page 235</td>
</tr>
<tr>
<td></td>
<td>Structure block [UDT]</td>
<td>Chap. 8.10 ‘Block editor for structure blocks (UDT) → page 240</td>
</tr>
</tbody>
</table>
4.13 Start page

The major functions for project management are provided on the start page. The start page is always displayed. It cannot be closed.
Fig. 10: Start page

(1) Start
(2) Project
(3) Recently used projects

(1) Start
You can create a new project, open a stored project or delete projects.

To create a new project, click on the icon 📁.
⇒ The dialogue window ‘Create new project’ will open. Chap. 5.2 ‘Create a new project’ page 65

To open a stored project, click on the icon 📁.
⇒ The ‘Open project’ dialogue window will open. Chap. 5.3 ‘Open project’ page 66

In order to import a project in VPP or VPZ file format, click on the icon 📁.
⇒ The ‘Import project’ dialogue window will open. Chap. 5.12 ‘Import project’ page 70
To delete a project, click on the icon.

The 'Delete project' dialogue window will open. Chap. 5.9 ‘Delete project’ page 68

(2) Project

If a project is open, you can open the "Project overview" or add a new device.

Click on the icon to open the project overview. Chap. 6.1 “Project overview” editor page 76

- or -

Click on the icon to add a new device. Chap. 6.3 ‘Add new device (PLC)’ page 81

(3) Recently used projects

A list of recently opened projects appears.

‘Project solution’ – project name
‘Source’ – memory location of the project
‘Last access’ – date and time when the project has been opened or saved for the last time

Double-click on the project you want to open.

4.14 Output range

Information on executed activities and background operations are displayed on the output range.

Fig. 11: Output range, "Output" example

(1) Switching to another view

(1) Switch to another view

In order to switch between different views, you must click on the desired output window at the lower screen edge, or select the appropriate menu command under ‘View’.

4.14.1 Output

Information on executed activities and background operations are displayed in the "Output" window.
Delete all messages in the output window

4.14.2 Programming events
Information on events in the PLC program are provided in the "Programming events" window.

Show/hide messages

Show/hide details
You can show or hide further details on a message:
- Hide message details
- Show message details

4.14.3 Communication events
Information on communication events between the programming device and the connected devices are provided in the "Communication events" window.
4.14.4 Project logbook

All activities are chronologically listed in the "Project logbook" window.

![Project logbook](image)

**Fig. 15: Project logbook**

4.14.5 Consistency messages

If you edit blocks, inconsistencies can arise, e.g. interface conflicts between two blocks. If you transfer inconsistent blocks into the control, this can lead to processing errors in the user program. In the "Consistency messages" window you are provided with information on block consistency.

![Consistency messages](image)

**Fig. 16: Consistency messages**

(1) Restore consistency
(2) Show/hide messages
(3) Filter devices
Search / Replace in block

**Restore consistency**
- Click on the button 🔄 to remove existing inconsistencies.
- A dialogue window will open. ✪ Chap. 8.15 ‘Check and restore consistency’ page 267

**Show problem area**
- Double-click on a consistency message.
- The inconsistent block is opened in the block editor and the problem area is shown.

4.14.6 EtherCAT messages

All EtherCAT messages of the individual devices are listed chronologically in this window.

**Show EtherCAT messages**
- To open the "EtherCAT messages" window, select ‘View ➤ EtherCAT messages’.

4.15 Search / Replace in block

You may search for and replace text or certain character patterns in the user program using the "Search in block" window.
Fig. 17: Search / Replace in block
(1) "Search" and "Replace" tabs
(2) Advanced Configurations

Show Search / Replace
To open the "Search in block" window, select one of the following options:
- Menu bar: Select 'View ➤ Search in block'.
- Keyboard: Press [Ctrl]+[B].
- Block editor: Click on (Search) or (Replace).

(1) Switch to another view
You can switch between "Search" and "Replace" using the two tabs.

You must open the block editor ➤ Chap. 8.4 ‘Editing program blocks’ page 210 before you can search for or replace text.
Show/hide Advanced Configurations

Show/open Advanced Find options

Hide/close Advanced Find options

1. Select the ‘Search’ tab.
2. Enter the text that you want to search for in the input field ‘Search for’.
3. Click on ‘Find Next’.

Replace

1. Select the ‘Replace’ tab.
2. Enter the text that you want to search for and replace in the ‘Search for’ input field.
3. Enter the new text in the ‘Replace with’ input field.
4. Click ‘Find Next’ and carry out one of the following actions then:
   - If you want to replace the found text, click ‘Replace’.
   - If you want to replace the text in the entire block, click ‘Replace All’.
   - If you do not want to replace this text, but the next found text, click ‘Find Next’.

(2) Search with advanced search settings

Here you can choose if only the current network or all networks of the block are to be searched.
You may select the search direction.
Moreover, you can choose if, in the search, only entire words are to be found and if the search is to be case-sensitive.

For the option ‘Regular expressions’, see below.

Search by means of regular expressions

You may use wildcard characters within so-called regular expressions to automate search or replace tasks.

Select the ‘Regular expressions’ option under ‘Advanced Configurations’.

Example of wildcards:

<table>
<thead>
<tr>
<th>Wildcard</th>
<th>Meaning</th>
<th>Search example</th>
<th>The following is found</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>or</td>
<td>U</td>
<td>UN</td>
</tr>
<tr>
<td>\s+</td>
<td>at least one white-space character</td>
<td>U\s+A0.0</td>
<td>U A0.0 U A0.0</td>
</tr>
<tr>
<td>\s*</td>
<td>any number of white-space characters</td>
<td>E\s*0.0</td>
<td>E0.0 E 0.0 E 0.0</td>
</tr>
<tr>
<td>()</td>
<td>Subexpression</td>
<td>(U</td>
<td>UN)\s*(E</td>
</tr>
</tbody>
</table>
4.16 Typed representation

A list of the control variables for "HMI images" is shown in the "Typed representation" window.

Fig. 18: Typed representation

The variables of all elements of the current HMI image are shown in the table. Chap. 9.9 "Image" editor page 321

Show typed representation

If the window is not displayed, select ‘View ➔ Typed representation’ or press [Ctrl]+[Shift]+[T].

You can use the mouse to drag control variables to the HMI image, thereby inserting a new element.

Drag one variable from the "Typed representation" window to the desired position in the HMI image (drag & drop).

A new element is inserted in the HMI image. The control variable is entered in the element’s input field.

4.17 CPU control centre

In the CPU control centre, the current operating mode and other control data are shown. You can also control the CPU here.
If the CPU control centre is not displayed, select ‘View → CPU control centre’ or press [Ctrl]+[Shift]+[U].

If, in the project, a control is configured and a communication connection has been created with this control, you receive the current information from the CPU and can control the CPU.

If several controls are configured in the project, highlight the control that is to be shown and controlled in the CPU control centre.

Here you are provided with information on the communication connection between the programming device and the connected control:

- Devices are connected – The current information from the CPU is shown.
Information is updated

Communication error – There is no current information from the CPU.

(2) Control CPU

You can control the connected control:

- **Start CPU** – The CPU is switched to operating mode RUN.
- **Stop CPU** – The CPU is switched to operating mode STOP.
- **Memory reset of CPU** – The CPU is returned to its initial state. Chap. 6.32 ‘Memory reset’ page 149
- **Open component state** – Here you are provided with further information on the connected control. Chap. 6.30 “Component state” editor page 138
- **Refresh view** – The information is read again from the connected control, e.g. after removal of a communication error.

(3) Show operating mode

Here, the LEDs and the switch setting of the connected CPU are shown. The display is constantly updated. If there is no communication connection or there is a communication error, no modes are shown.

<table>
<thead>
<tr>
<th>LED/switch</th>
<th>Operating mode of the CPU</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘Run’</td>
<td>RUN</td>
</tr>
<tr>
<td>‘Stop’</td>
<td>STOP</td>
</tr>
<tr>
<td>‘SF’</td>
<td>Collection error</td>
</tr>
<tr>
<td>‘Bus1’</td>
<td>Bus error interface 1</td>
</tr>
<tr>
<td>‘Bus2’</td>
<td>Bus error interface 2</td>
</tr>
<tr>
<td>‘Run/Stop/MRES’</td>
<td>Current setting of the operating mode switch: RUN, STOP or memory reset</td>
</tr>
</tbody>
</table>

(4) CPU data

Here, further data concerning the connected control are shown:

- **Device name** – Device name of the control Chap. 6.5 ‘Adding a new device (slave)’ page 85
- **Order number** – Order number of the control (CPU)
- **Firmware** – Firmware version of the control (CPU)
- **Active interface** – communication connection with the control Chap. 6.20.2 ‘Communication settings (PLC)’ page 111
- **Address** – IP address (Ethernet connection) or MPI-address (serial connection) of the control
- **Cyclic data**
  - **Show/open cyclic data**
  - **Hide/close cyclic data**
- **Shortest cycle time** – Shortest measured program processing cycle since the last transition from STOP to RUN (time base: milliseconds)
- **Current cycle time** – Duration of the most recently run program processing cycle (time base: milliseconds)
4.18 Mouse and keyboard operation

*SPEED7 Studio* offers various operating options with mouse and keyboard.

- The arrangement and size of the windows can be adjusted:
  - Chap. 4.18.1 ‘Adjusting the user interface’ page 52
- Functions can be accessed via the context menu:
  - Chap. 4.18.2 ‘Mouse operation – context menu’ page 53
- Objects can be added to the project using the mouse:
  - Chap. 4.18.3 ‘Mouse operation – drag & drop’ page 54
- Many functions can be accessed via the menu bar, toolbar or keyboard:
  - Chap. 4.20 ‘Menu and keyboard commands’ page 61

### 4.18.1 Adjusting the user interface

There are various options of adjusting the user interface.

#### Closing windows which are not required

If you want to enlarge a certain window of the user interface, you can close another window, see the following table. The closed windows can be opened at any time.

<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘View ➔ Project tree’</td>
<td>[Ctrl]+[Shift]+[P]</td>
</tr>
<tr>
<td>‘View ➔ Catalog’</td>
<td>[Ctrl]+[Shift]+[C]</td>
</tr>
<tr>
<td>‘View ➔ Properties’</td>
<td>[Ctrl]+[Shift]+[M]</td>
</tr>
<tr>
<td>‘View ➔ Typed representation’</td>
<td>[Ctrl]+[Shift]+[T]</td>
</tr>
<tr>
<td>‘View ➔ Output’</td>
<td>[Ctrl]+[Shift]+[O]</td>
</tr>
<tr>
<td>‘View ➔ Programming events’</td>
<td>[Ctrl]+[Shift]+[E]</td>
</tr>
<tr>
<td>‘View ➔ Consistency messages’</td>
<td>[Ctrl]+[Shift]+[K]</td>
</tr>
<tr>
<td>‘View ➔ Communication events’</td>
<td>[Ctrl]+[Alt]+[C]</td>
</tr>
<tr>
<td>‘View ➔ Project logbook’</td>
<td>[Ctrl]+[Shift]+[H]</td>
</tr>
<tr>
<td>‘View ➔ CPU control centre’</td>
<td>[Ctrl]+[Shift]+[U]</td>
</tr>
<tr>
<td>‘View ➔ EtherCAT messages’</td>
<td>—</td>
</tr>
<tr>
<td>‘View ➔ Logic analysis’</td>
<td>—</td>
</tr>
</tbody>
</table>
If you want to change the size of the area of operations, you must drag the left, right or lower frame of the area of operations.

There are edit windows which are divided into two sections e.g. the Device topology (top) section and Device details (bottom) section in the ‘Devices and networking’ editor.

Draw a line between both sections so that you can shift them.

- or -

Click on the ↑, ↓ buttons in order to show or hide a section.

Many edit windows have a slider which is used to change the zoom factor.

Move the slider or click on ‘+’ or ‘-’ to change the zoom factor.

The current zoom factor is displayed as percentage value at the bottom right of the area of operations.

Functions and commands for many objects and elements of the SPEED7 Studio user interface are provided via the context menu. A right-click with the mouse button on an object or element will open the corresponding context menu.
4.18.3 Mouse operation – drag & drop

If you want to add objects to the project using the mouse, you can drag objects from the catalog to a suitable place in the area of operations and drop them there. This approach is referred to as "drag & drop".

This mouse pointer is displayed while you drag the object.

The object can be dropped at any position in the area of operations where the mouse pointer changes.
4.19 Help and support during editing

4.19.1 Overview

You will get the following help and support when working with SPEED7 Studio:

- Messages are displayed.
- Changes in the project and the input fields are marked.
- Points where objects can be added are highlighted.
- In many input fields, the admissible value range is monitored.
- When entering a symbol name, it will be checked whether it has been allocated already.
- Information on interface elements and input fields is displayed (tool tips).
- Context help can be accessed, e.g. regarding the current editor or regarding menu functions.

4.19.2 Messages

Messages regarding accomplished activities and background operations are displayed. Different colours differentiate between status messages and error messages.

Messages in the output range

<table>
<thead>
<tr>
<th>Message</th>
</tr>
</thead>
<tbody>
<tr>
<td>The connection test was successful.</td>
</tr>
</tbody>
</table>

Fig. 24: Example of a status message
4.19.3 Markings of changes and states

Objects in the project tree

Symbols behind an object in the project tree provide indications of the object state.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌟️</td>
<td>A new object was added</td>
<td>A new device was added. This icon is no longer shown once the project has been saved.</td>
</tr>
<tr>
<td>✏️</td>
<td>Object was changed</td>
<td>A block was processed. This icon is no longer shown once the project has been saved.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Object must be compiled</td>
<td>A block was changed and has not yet been compiled. The user program is not consistent.</td>
</tr>
<tr>
<td>⚠️</td>
<td>Error in the object</td>
<td>During compilation, a syntax error was recognised in a block.</td>
</tr>
<tr>
<td>🚨️</td>
<td>Consistency message: Warning</td>
<td>When checking the consistency, a problem was recognised in a block. The block needs to be recompiled.</td>
</tr>
<tr>
<td>🚨️</td>
<td>Consistency message: Error</td>
<td>When checking the consistency, an error was recognised in a block. The error needs to be resolved and the block needs to be recompiled.</td>
</tr>
</tbody>
</table>
### Changes in an input field

Chap. 4.19.5 ‘Input fields’ page 57

### 4.19.4 Points where objects can be added

Colours or highlights show the positions where elements can be added.

#### Points where components can be added

If you select a component in the catalog, the admitted positions where you can add the component are marked in green in the device configuration.

![Fig. 30: Example of positions where components can be added (green marking)](image)

### 4.19.5 Input fields

#### Admissible value range

Many input fields check already during input whether the admitted value range is compliant with. Incorrect values are automatically corrected to the next possible value which is admitted.

#### Changing default values

If you overwrite the standard value (also: presetting, default value) with another value in the input or selection field, the frame of the input field changes.
Help and support during editing > Tool tips

4.19.6 Tool tips

Tool tips are brief descriptive texts with information on the operating and input elements. If you rest the mouse pointer on an element, the tool tip is displayed.

Fig. 32: Example of a push button tool tip

Fig. 33: Example of an input field tool tip
4.19.7 Automatic completion

When you enter declarations or instructions, a selection list with input suggestions and other information will be shown as a tool tip. With each additional letter you enter, the suggestions are narrowed down.

**Examples of input and selection fields**

![Example of input and selection fields](image)

Fig. 35: Input suggestions in the selection field ‘Data type’ (input: B)
4.19.8  Check symbol name

When entering a symbol name which has been allocated already, an error message is displayed.

4.19.9  Calling up and using help

*SPEED7 Studio* help contains the complete software description. Help is context-sensitive, i.e. it refers to a certain interface element or a certain section.

**Calling up help with *F1***

1.  Click in the section (e.g. project tree, editor) for which you need information.
2.  Press *F1* to call up help.

⇒  The help window will open.
Structure of the help window

The navigation frame is located at the left side of the help window. It contains three registers:
- Contents: Table of contents
- Index: Searching keywords in the index directory
- Search: Full-text search

The help topic is displayed at the right side of the help window.

4.20 Menu and keyboard commands

- Chap. 8.29 ‘Keyboard commands in the block editor’ page 311
- Chap. 9.16 ‘Keyboard commands in "Image" editor (HMI)’ page 335

<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘File ➔ New project’</td>
<td>[Ctrl]+[N]</td>
<td>Chap. 5.2 ‘Create a new project’ page 65</td>
</tr>
<tr>
<td>‘File ➔ Open project’</td>
<td>[Ctrl]+[O]</td>
<td>Chap. 5.3 ‘Open project’ page 66</td>
</tr>
<tr>
<td>‘File ➔ Close project’</td>
<td>[Ctrl]+[W]</td>
<td>Chap. 5.4 ‘Closing a project’ page 67</td>
</tr>
<tr>
<td>‘File ➔ Save’</td>
<td>[Ctrl]+[S]</td>
<td>Chap. 5.6 ‘Saving a project’ page 68</td>
</tr>
<tr>
<td>‘File ➔ Save as’</td>
<td>[Ctrl]+[Shift]+[S]</td>
<td>Chap. 5.7 ‘Save local project as’ page 68</td>
</tr>
<tr>
<td>‘File ➔ Delete project’</td>
<td>[Ctrl]+[L]</td>
<td>Chap. 5.9 ‘Delete project’ page 68</td>
</tr>
<tr>
<td>‘File ➔ Import project’</td>
<td>[Ctrl]+[F12]</td>
<td>Chap. 5.12 ‘Import project’ page 70</td>
</tr>
<tr>
<td>‘File ➔ Print’</td>
<td>—</td>
<td>Chap. 5.13 ‘Print’ page 71</td>
</tr>
<tr>
<td>‘File ➔ Print preview’</td>
<td>—</td>
<td>Chap. 5.14 ‘Print Preview’ page 74</td>
</tr>
<tr>
<td>— ‘File ➔ Recently opened projects’</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>‘File ➔ Exit’</td>
<td>[Alt]+[F4]</td>
<td>Chap. 4.3 ‘End SPEED7 Studio’ page 23</td>
</tr>
</tbody>
</table>

View

<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View</td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘View ➔ Project tree’</td>
<td>[Ctrl]+[Shift]+[P]</td>
<td>Chap. 4.9 ‘Project tree’ page 28</td>
</tr>
<tr>
<td>‘View ➔ Catalog’</td>
<td>[Ctrl]+[Shift]+[C]</td>
<td>Chap. 4.10 ‘Catalog’ page 34</td>
</tr>
<tr>
<td>‘View ➔ Search in block’</td>
<td>[Ctrl]+[B]</td>
<td>Chap. 4.15 ‘Search / Replace in block’ page 46</td>
</tr>
<tr>
<td>‘View ➔ Properties’</td>
<td>[Ctrl]+[Shift]+[M]</td>
<td>Chap. 4.11 ‘Properties’ page 37</td>
</tr>
<tr>
<td>‘View ➔ Typed representation’</td>
<td>[Ctrl]+[Shift]+[T]</td>
<td>Chap. 4.16 ‘Typed representation’ page 49</td>
</tr>
<tr>
<td>‘View ➔ Output’</td>
<td>[Ctrl]+[Shift]+[O]</td>
<td>Chap. 4.14.1 ‘Output’ page 43</td>
</tr>
<tr>
<td>‘View ➔ Programming events’</td>
<td>[Ctrl]+[Shift]+[E]</td>
<td>Chap. 4.14.2 ‘Programming events’ page 44</td>
</tr>
<tr>
<td>‘View ➔ Consistency messages’</td>
<td>[Ctrl]+[Shift]+[K]</td>
<td>Chap. 4.14.5 ‘Consistency messages’ page 45</td>
</tr>
<tr>
<td>‘View ➔ Communication events’</td>
<td>[Ctrl]+[Alt]+[C]</td>
<td>Chap. 4.14.3 ‘Communication events’ page 44</td>
</tr>
<tr>
<td>‘View ➔ Project logbook’</td>
<td>[Ctrl]+[Shift]+[H]</td>
<td>Chap. 4.14.4 ‘Project logbook’ page 45</td>
</tr>
</tbody>
</table>
## Menu and keyboard commands

<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘View → EtherCAT messages’</td>
<td>—</td>
<td>Chap. 4.14.6 ‘EtherCAT messages’ page 46</td>
</tr>
<tr>
<td>‘View → Logic analysis’</td>
<td>—</td>
<td>Chap. 8.24 ‘Logic analysis’ page 291</td>
</tr>
<tr>
<td>‘View → CPU control centre’</td>
<td>[Ctrl]+[Shift]+[U]</td>
<td>Chap. 4.17 ‘CPU control centre’ page 49</td>
</tr>
</tbody>
</table>

### Language

- ‘Language → German’ — Chap. 4.4 ‘Select language’ page 23
- ‘Language → English’ —

### Theme

- ‘Theme → Small font size’ —
- ‘Theme → Normal font size’ —
- ‘Theme → Large font size’ —

### Simulation

- ‘Simulation → Start PLC simulation’ — Chap. 8.17 ‘Simulate user program’ page 270
- ‘Simulation → End PLC simulation’ —
- ‘Simulation → PLC simulation configurations’ [Alt]+[I] Chap. 8.17.1 ‘PLC simulation settings’ page 270

### Extra

- ‘Extras → Install device description file (PROFIBUS – GSD)’ — Chap. 6.11 ‘PROFIBUS – GSD’ page 94
- ‘Extras → Install device description file (PROFINET – GSDML)’ — Chap. 6.12 ‘PROFINET – GSDML’ page 96
- ‘Extras → Install block library’ — Chap. 8.28 ‘Install block library’ page 309
- ‘Extras → Edit Ethernet partners’ — Chap. 6.21 ‘Search for accessible partners’ page 115
- ‘Extras → Configurations’ — Chap. 4.5 ‘Select syntax language (mnemonics)’ page 24 Chap. 4.6 ‘Select interfaces’ page 24

### Project (is shown only if a project is open)

- ‘Project → Collapse project tree’ — Chap. 4.9 ‘Project tree’ page 28
- ‘Project → Expand project tree’ —
- ‘Project → Collapse catalog tree’ — Chap. 4.10 ‘Catalog’ page 34
- ‘Project → Expand catalog tree’ —
- ‘Project → Collapse property tree’ — Chap. 4.11 ‘Properties’ page 37
- ‘Project → Expand property tree’ —
- ‘Project → Project overview’ — Chap. 6.1 ‘Project overview’ page 76
<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Project ➔ Devices and networking'</td>
<td>—</td>
<td>Chap. 6.2 “Devices and networking” editor page 77</td>
</tr>
<tr>
<td>'Project ➔ Add new device'</td>
<td>[Ctrl]+[Shift]+[N]</td>
<td>Chap. 6.3 ‘Add new device (PLC)’ page 81</td>
</tr>
<tr>
<td>'Project ➔ Consistency test/restoration'</td>
<td>[Ctrl]+[Alt]+[K]</td>
<td>Chap. 8.15 ‘Check and restore consistency’ page 267</td>
</tr>
<tr>
<td>'Project ➔ Compile'</td>
<td>[F6]</td>
<td>Chap. 8.16.1 ‘Compile’ page 269</td>
</tr>
<tr>
<td>'Project ➔ Compile all'</td>
<td>[Shift]+[F6]</td>
<td>Chap. 8.16.2 ‘Compile all’ page 269</td>
</tr>
<tr>
<td>'Project ➔ Transfer'</td>
<td>[Shift]+[F9]</td>
<td>Chap. 5.10 ‘Transfer project’ page 69</td>
</tr>
<tr>
<td>'Project ➔ Export'</td>
<td>[F12]</td>
<td>Chap. 5.11 ‘Export project’ page 70</td>
</tr>
<tr>
<td>'File ➔ Print'</td>
<td>—</td>
<td>Chap. 5.13 ‘Print’ page 71</td>
</tr>
<tr>
<td>'File ➔ Print preview'</td>
<td>—</td>
<td>Chap. 5.14 ‘Print Preview’ page 74</td>
</tr>
</tbody>
</table>

Device (is shown only if a control is present in the project)

<table>
<thead>
<tr>
<th>Icon and menu command</th>
<th>Keyboard command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>'Device ➔ Device overview'</td>
<td>—</td>
<td>Chap. 8.2 ‘Device overview (PLC)’ page 207 Chap. 9.2 “Device overview” editor (HMI device) page 312</td>
</tr>
<tr>
<td>'Device ➔ Device properties'</td>
<td>—</td>
<td>Chap. 6.20 “Device properties” editor (PLC) page 110</td>
</tr>
<tr>
<td>'Device ➔ Device configuration'</td>
<td>—</td>
<td>Chap. 6.14 “Device configuration” editor (PLC) page 101</td>
</tr>
<tr>
<td>'Device ➔ Address overview'</td>
<td>—</td>
<td>Chap. 8.12 ‘Address overview’ page 255</td>
</tr>
<tr>
<td>'Device ➔ Transfer all'</td>
<td>[F9]</td>
<td>Chap. 8.18.3 ‘Transfer all’ page 255</td>
</tr>
<tr>
<td>'Device ➔ Transfer user program'</td>
<td>—</td>
<td>Chap. 8.18.2 ‘Transfer user program’ page 273</td>
</tr>
<tr>
<td>'Device ➔ Transfer hardware configuration'</td>
<td>—</td>
<td>Chap. 8.18.1 ‘Transfer hardware configuration’ page 272</td>
</tr>
<tr>
<td>'Device ➔ Export all (WLD)'</td>
<td>—</td>
<td>Chap. 6.26 ‘Export all (WLD)’ page 136</td>
</tr>
<tr>
<td>'Device ➔ Export user program (WLD)'</td>
<td>—</td>
<td>Chap. 6.27 ‘Export user program (WLD)’ page 137</td>
</tr>
<tr>
<td>'Device ➔ Export hardware configuration (WLD)'</td>
<td>—</td>
<td>Chap. 6.28 ‘Export hardware configuration (WLD)’ page 137</td>
</tr>
<tr>
<td>'Device ➔ Copy RAM to ROM'</td>
<td>—</td>
<td>Chap. 6.29 ‘Copy RAM to ROM’ page 137</td>
</tr>
<tr>
<td>'Device ➔ Component state'</td>
<td>[Ctrl]+[D]</td>
<td>Chap. 6.30 “Component state” editor page 138</td>
</tr>
<tr>
<td>'Device ➔ Set time'</td>
<td>—</td>
<td>Chap. 6.31 ‘Set time’ page 147</td>
</tr>
<tr>
<td>'Device ➔ Memory reset'</td>
<td>—</td>
<td>Chap. 6.32 ‘Memory reset’ page 149</td>
</tr>
<tr>
<td>'Device ➔ Load blocks from device'</td>
<td>—</td>
<td>Chap. 8.19 ‘Load blocks from the device’ page 275</td>
</tr>
<tr>
<td>'Device ➔ Compare blocks'</td>
<td>—</td>
<td>Chap. 8.19 ‘Load blocks from the device’ page 275</td>
</tr>
<tr>
<td>Icon and menu command</td>
<td>Keyboard command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------</td>
<td>-------------</td>
</tr>
<tr>
<td><strong>Window</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘Window ➔ Switch all ToolWindows’</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td>‘Window ➔ Close all documents’</td>
<td>—</td>
<td></td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>‘Help ➔ View help’</td>
<td>[F1]</td>
<td>Chap. 4.19.9 ‘Calling up and using help’ page 60</td>
</tr>
<tr>
<td>‘Help ➔ Info’</td>
<td>—</td>
<td>Chap. 2.4 ‘Software identification’ page 17</td>
</tr>
</tbody>
</table>
5 Managing and editing projects

5.1 Project

Projects contain the configuration data of the devices which are required for the operation of a machine or system, e.g. control and components, visualisation devices, I/O components. Projects also contain the configurations of the communication connections as well as the control program.

- New projects can be created and existing projects can be edited.
- Projects can be renamed or deleted.
- Projects can be exported and imported so that they can be used on different computers.
- Transfer the completed project to the control together with the user program and activate it there.

5.2 Create a new project

Make sure that no other project is open.

1. Select one of the following options if you want to create a new project:
   - **Menu bar**: Select 'File ➔ New project'.
   - **Toolbar**: Click on 🗄.
   - **Keyboard**: Press [Ctrl]+[P].
   - **"Start page"**: Click on ‘New project’.
   - ➔ The dialogue window ‘Create new project’ will open.

![Fig. 39: New project via the "Start page"](image)
Managing and editing projects

Open project

Fig. 40: Dialogue window "Create new project"

2. ‘Project name’ – Enter the name under which the project data are to be saved.

3. Click on ‘OK’.

⇒ The project is created and displayed in the project tree. The ‘Devices and networking’ editor will open. Device templates and components are now available in the ‘Catalog’.

5.3 Open project

It is not possible to edit several projects at the same time. It is possible to run SPEED7 Studio simultaneously several times on one PC if you want to use it for various projects.

1. Select one of the following options if you want to open a project:
   - **Menu bar**: Select ‘File ➔ Open project’.
   - **Toolbar**: Click on 📥.
   - **Keyboard**: Press [Ctrl]+[O].
   - "Start page ➔": Click on ‘Open project’ or double-click on the desired project in ‘Recently used projects’.

⇒ The ‘Open project’ dialogue window will open.

2. You can choose whether all the projects or only the most recently used projects are to be shown in the dialogue window.

3. Select the desired project.
4. 
   Click on ‘Open’. 
   ⇒ The project is displayed in the project tree. Device templates and components are now available in the ‘Catalog’. Any other open project will be closed.

5.3.1 Migration for symbolic programming

From version 1.8 of SPEED7 Studio, the operands can optionally be shown as symbolic or absolute in the block editor. Projects which were created before version 1.8 must be converted (migrated) into the new format. In the process, symbols are automatically created for all absolute addresses used in the project for which no symbol yet exists.

If you open a project which was created with SPEED7 Studio before version 1.8, the migration for symbolic programming dialogue window opens. In it, you can select what settings should be used for migration and further processing of the project.

1. Select the type of addressing (see Chap. 4.7 ‘Symbolic and absolute addressing’ page 24):
   - ‘Symbolic’ – Displays symbolic addresses upon entry and upon observation, e.g. “MySymbol”
   - ‘Absolute’ – Displays absolute addresses upon entry and upon observation, e.g. E0.1, MW8, FB1

   New symbols are still created if you select the "absolute" type of addressing.

2. Select symbol format (see Chap. 4.7 ‘Symbolic and absolute addressing’ page 24):
   - ‘User-defined prefix’ – In the input field, define the character string which will be placed at the beginning of an automatically generated variable.
   - ‘Hungarian notation’ – In "Hungarian notation", a letter and an underscore are placed at the beginning of an automatically generated variable in order to indicate the data width of the operands.

3. Click on ‘Next’. 
   ⇒ The migration process is started. Symbols are automatically created for all absolute addresses used in the project for which no symbol yet exists.

   Carry out migration at a later point in time

   Click on ‘Cancel’ in order to carry out the migration at a later point in time. The dialogue window for migration for symbolic programming is shown again the next time you open the project.

5.4 Closing a project

Select one of the following options if you want to close an open project:

- **Menu bar**: Select ‘File ➔ Close project’.
- **Keyboard**: Press [Ctrl]+[F4].

After you have made changes to the project, a dialogue window will open, where you can select whether to save or ignore the changes.

⇒ The project is closed and the ‘Start page’ is displayed.
5.5 Editing a project

You can select devices from the catalog and add them to the project tree. Then you can access the functions available in for devices and project slave components.

Chap. 6 ‘Selecting and configuring devices and components’ page 76

5.6 Saving a project

Save the open project in order to save all project data on the data carrier.

Select one of the following options if you want to save a project data:

- **Menu bar**: Select ‘Saving ➔ file …’.
- **Toolbar**: Click on 
- **Keyboard**: Press [Ctrl]+[S].

Project data are saved.

5.7 Save local project as

1. Select one of the following options if you want to save the project data under a different project name:

   - **Menu bar**: Select ‘File ➔ Save as’.
   - **Keyboard**: Press [Ctrl]+[Alt]+[S].

   A dialogue window for the input of the new project name will open.

2. Enter the new project name in the input field and click on ‘Save as’.

   Project data are saved under a new name.

5.8 Rename project

The project has to be open.

1. Right-click with the mouse button on the project name in the project tree and select ‘Rename project’ or press [F2].

2. Enter the new project name in the input field.

3. Confirm your input with [Enter].

   The icon indicates that you have already changed but not yet saved the project name.

4. Save the project. Chap. 5.6 ‘Saving a project’ page 68

   The project is saved under the new name, and the symbol is no longer displayed.

5.9 Delete project

Delete any project which is no longer needed.
NOTICE!
Data loss!
All data of the deleted project are removed from the data carrier!
- Make sure that the project data are no longer needed.

Select one of the following options if you want to delete a project:

- **Menu bar:** Select ‘File ➔ Delete project’.
- **Keyboard:** Press [Ctrl]+[L].
- "Start page ➔": Click on ‘Delete projects’.
  ⇒ The ‘Delete project’ dialogue window will open.

### Delete project

1. Right-click on the project and select ‘Delete’.
   - or -
   Select the desired project using the left mouse button and click on the ‘Delete’ button.
   ⇒ A dialogue window will open, in which you can select whether the project should be deleted or not.

2. Click on ‘Yes’.
   ⇒ The project is deleted. All project data are removed from the data carrier.

### Delete multiple projects

1. Press and hold the [Ctrl] key and click on the projects you want to delete.
   - or -
   If you want to delete several projects from one row, press and hold the [Shift] key and click on the first and the last projects in the row.

2. Right-click on a marked project and select ‘Delete’.
   - or -
   Click on the ‘Delete’ button.
   ⇒ A dialogue window will open, in which you can select whether the projects should be deleted or not.

3. Click on ‘Yes’.
   ⇒ The projects are deleted. All project data are removed from the data carrier.

### 5.10 Transfer project

Transfer a completely edited project together with the user program and the visualisation to the connected devices.

The project has to be open.
Create a communication connection to the control. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

1. Select one of the following options if you want to transfer a project:
   - **Menu bar**: Select ‘Transfer ➔ project ...’.
   - **Keyboard**: Press [F9].
   - "Project overview 📊": Click on 📊.
     ⇒ The ‘Transfer project’ dialogue window will open.

2. Highlight the devices for which you want to transfer the project data in the first column of the list.

3. Click on ‘Check’.
   ⇒ The communication connection is checked. If no connection can be established to the selected devices, check if the connection cables are connected correctly. If required, check the communication settings. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

4. Click on ‘Transfer’.
   ⇒ The project data for the selected devices are transferred to these devices.
   The dialogue window will show if the transfer has been successful or if an error occurred.

5. Click on ‘Close’.

### 5.11 Export project

Projects can be exported and imported e.g. to use them on different computers. The open project including the user program and the visualisation can be saved in VPP format in an export file. This export file can be transferred and imported to another computer.

The project to be exported has to be open.

1. Select one of the following options if you want to export a project:
   - **Menu bar**: Select ‘Project ➔ Export’.
   - **Keyboard**: Press [F12].
   - **Project tree**: Right-click with the mouse button on the project and, from the context menu, select ‘Export’.
     ⇒ The ‘Export project’ dialogue window will open.

2. Select a directory from the ‘Export directory’ and enter a file name.

3. Click on ‘Export’.
   ⇒ The export process is started. All project data are saved in the export file (VPZ data format).

For the import of the export file: Chap. 5.12 ‘Import project’ page 70

### 5.12 Import project

Projects can be exported and imported e.g. to use them on different computers. You can import an already created export file.

For creating an export file: Chap. 5.11 ‘Export project’ page 70

If you want to import a Simatic project: Chap. 8.25 ‘Import S7 program’ page 301
Select one of the following options if you want to import a project:

- **Menu bar**: Select 'File ➔ Project import...'.
- **Keyboard**: Press `[Ctrl]+[F12]`.
  - The ‘Import project’ dialogue window will open.

2. Select the directory and the export file (VPP or VPZ file format) from the ‘Choose project file’.

3. Click on ‘Import’.
  - The import process is started. Project data are imported. The individual steps and results are shown in the dialogue window.

4. Click on ‘Done’.

### 5.13 Print 🎨

You can print the project, parts of the project or single areas. In the print preview, you can check the layout.

**Print project**

- Select one of the following options:
  - **Menu bar**: Select 'File ➔ Print' or 'Project ➔ Print'.
  - **Toolbar**: Click on †.
  - The ‘Print’ dialogue window will open. *Chap. 5.13.1 ‘General print configurations’ page 71*

**Print single area**

- In the project tree, click with the right mouse button onto the desired area and select ‘Print’.
  - The following areas can be printed:
    - Project
    - Control
    - PLC program
    - Program block
    - Variable table
    - HMI device
    - HMI image
  - The ‘Print’ dialogue window will open. *Chap. 5.13.1 ‘General print configurations’ page 71*

### 5.13.1 General print configurations

Here, you can select a logo for the header and enter information for the footer of the document. In the print preview, you can check the layout.
1. In order to output the program blocks sorted according to block type, select "Grouped according to type".
   In order to output the program blocks according to the order of calling, select "Hierarchically".

2. In order to adopt the configurations for all future print operations, select "Adopt selection as project configuration".

3. Click on 'Print' to print the document.
   The dialogue window "Print" will open.
5.13.2 Select print areas

You can select here, which parts of the project to print. In the print preview, you can check the layout.

This dialogue window is not shown if you want to print single program blocks, variable tables or HMI images.

Fig. 45: Dialogue window "Select print areas"

1. Highlight the areas you want to print. Deselect the areas you don't want to print. The symbol shows that not all parts are highlighted in one area.

2. Click on 'Print' to print the document.
   ⇒ The dialogue window "Print" will open.

3. - or -
   Click on 'Preview'.
   ⇒ The document will be generated and shown in the "Print preview". Chap. 5.14 'Print Preview' page 74
5.14 Print Preview

In the print preview, you can check the layout of the document to be printed. Then, you can print the document or save in PDF or DOC format.

In order to create and view the print preview, select one of the following options:

- **Menu bar**: Select ‘File ➔ Print preview’ or ‘Project ➔ Print preview’.
- **Toolbar**: Click on 📅.

You can also call up the print preview in the dialogue window of the print settings.

Fig. 46: Print Preview

---

5.15 "Documentation" folder

Text documents and further subfolders can be created in the ‘Documentation’ folder of the project tree.

To create a new project, click on the icon ‘Create new text document …’.

- or -

Right-click with the mouse button on the folder and select the desired command, e.g. ‘Add new folder’.

Double-click on a text document in order to open it in the text editor.

Chap. 5.17 ‘Text editor (text document)’ page 75
5.16 Create new text document

1. Click on ‘Create new text document’ in the ‘Documentation’ folder in the project tree.
   ⇒ A dialogue window for the input of a file name will open.

2. Enter the file name in the input field and click on ‘OK’.
   ⇒ A new text document is created and displayed in the project tree.
   If you have selected the option ‘Open document after creation’, the text editor is opened.

5.17 Text editor (text document)

Text documents can be edited and saved in the ‘Text editor’. In the ‘Documentation’ folder, you can create a new text document or open an existing text document in the text editor. Chap. 5.15 “Documentation” folder page 74

What is SPEED7 Studio?

The new intelligence of the hardware configuration, the intuitive user interface and the system openness makes SPEED7 Studio a powerful and easy to handle tool. We want to optimize automation tasks, reduce the development effort to a minimum, and avoid time and cost intensive software training. This allows the user to concentrate on his own engineering tasks. SPEED7 Studio consistently puts the emphasis on user friendliness. The new concept includes:

- Hardware configuration,
- Programming and networking,
- Parametrization of frequency converters and drives up to
- Visualization.

In the SPEED7 Studio editor design all functions, features and libraries are prepared and monitored automatically. Unique SPEED7 tools make the software attractive and efficient. High-Speed applications are compiled more ergonomically in the SPEED-Bus functions. EtherCAT and other fieldbusses are fully integrated. Applications are projected quickly and safely, loaded automatically and named with common symbolism in the EtherCAT configurator. Integrated S110 functionalities, such as automatic current consumption calculation and integrated process image calculation makes SPEED7 Studio a highly efficient tool that holistically integrates the products of the SPEED7 world.

Fig. 47: Text editor

Editing a text document

Click on the desired text document in the ‘Documentation’ folder in the project tree.
⇒ The text editor will open.

Enter and format text

You can enter text in the editing area. You can format text with the toolbar:

- Font type and size
- Markup bold, italics or underlined
- Font colour
- Text left-justified, centred, right-justified or fully justified
- Enlarging / reducing the indent
- Bullet points and numbering
6 Selecting and configuring devices and components

6.1 “Project overview” editor

In the ‘Project overview’ editor, the devices of the open project are listed in a table. Here you can add devices. You can also translate, transfer and export the project.

If a project is open, you can open the ‘Project overview’. Select one of the following options to this end:

- **Menu bar**: Select ‘Project ➔ Project overview’.
- **Toolbar**: Click on .
- **Project tree**: Click on ‘Project overview’.
- **“Start page”**: Click on ‘Project overview’.

![Fig. 48: Project overview](image)

(1) Toolbar
(2) List of devices

**1) Toolbar**

- **Add new device**: Add controls (PLC) or visualisation devices (HMI) ➦ Chap. 6.3 ‘Add new device (PLC)’ page 81
- **Compile blocks**: Compile (translate) all changed project blocks into error-free machine code ➦ Chap. 8.16 ‘Compile user program’ page 268
- **Transfer project**: Transfers the user program as well as all device configurations and visualisations of the project to the control
- **Export project**: Exports all project data to the VPP file

**2) List of devices**

Provides a list of projected devices.

- **‘Name’**
  - Click on the input field to change the device name.

- **‘Type’** – Device type
- **‘Comment’** – Any comment e.g. remark or explanation
  - Click on the input field to change the comment.
6.2 "Devices and networking" editor

In the ‘Devices and networking’ editor, the devices of the open project are topologically illustrated, and the device details are listed. Here you can add or remove devices and connections. You can also access further device functions.

If a project is open, you can open the ‘Devices and networking’ editor. Select one of the following options to this end:

- **Project tree**: Click on ‘Devices and networking’.
- **Menu bar**: Select ‘Project ➔ Devices and networking’.

---

**Fig. 49: Devices and networking**

(1) Device overview
(2) Device details

---

1. Device overview

All devices of the project and their networking are displayed in the device overview. Here you can add or remove devices and connections. You can also access further device functions.
Adding a device

1. Select the desired object (hold left mouse button down)
2. Drag the object
3. Drop the object at a suitable place (release the mouse button)
4. The object is added

Drag the desired device from the 'Device templates' of the catalog to a suitable place.

⇒ The device is added to the device overview.

Selecting a device

⇒ Click on the device.

⇒ The device details for the highlighted device are displayed. Fig. 49

Removing devices

Devices to which further devices are connected, e.g. via a bus system cannot be deleted. First, all connected devices must be deleted.

1. Right-click with the mouse button on the device and select ‘Delete device’.

⇒ A dialogue window will open, where you can select whether the device should be removed or not.

2. Click on ‘Yes’.

⇒ The device is removed from the device overview and the project.

Removing several devices

1. Keep the key [Ctrl] pressed down and click on the devices you want to remove.

- or -

If you want to remove several devices from one row, keep the key [Shift] pressed and click on the first and the last device in the row.
2. Right-click with the mouse button on a device and select ‘Delete selected devices’.  
   ⇒ A dialogue window will open, where you can select whether the devices should be removed or not.

3. Click on ‘Yes’.  
   ⇒ The devices are removed from the device overview and the project.

Opening device configuration or device overview  ➔ Double-click on a device.  
   ⇒ PLC: The ‘Device configuration’ editor will open.  
   ⇒ HMI: The ‘Device overview’ editor will open.

Opening the bus system properties  ➔ Double-click on the connecting line of the bus system.  
   ⇒ The ‘Bus system properties’ dialogue window will open.

Add connection  ➔ Right-click with the mouse button on the left connection point of the device from which the connection comes and select ‘Insert new connection’.  
   ⇒ Chap. 7.6.1 ‘Insert new connection’ page 195.

Accessing further functions  ➔ Right-click with the mouse button on the device or a connection point and select the desired command, e.g. ‘Device properties’ or ‘Bus system properties’.

(2) Device details

The device details contain more information on a device or connections:  
- Chap. 6.2.1 ‘Local components (= local modules)’ page 79  
- Chap. 6.2.2 ‘Connections’ page 80

Further configurations or information on a component  ➔ Double-click on a component.  
   ⇒ A dialogue window will open.

6.2.1 Local components (= local modules)

Provides a list of details on the selected device, e.g. component assignment, order numbers or I/O addresses.

Fig. 51: "Devices and networking" editor: Local components (= local modules)  
‘Device’  
   ➔ Here you can select the device for which you need details.
'Rack'

Here you can select the rack for which you need details.

'Slot' – Slot number within the rack

'Component' – Component name

'Order number' – Order number of the component

'I-Address' – Configured input address (byte address) of an input component or an input module

'O-Address' – Configured output address (byte address) of an output component or an output module

'MPI/IP address' – Address of a communication interface

'Comment' – Any comment e.g. remark or explanation

### 6.2.2 Connections

#### Show connections

To add connections: § Chap. 7.6.1 'Insert new connection' page 195.

Connections are represented by a connecting line in the "Devices and networking" editor.

![Diagram of connections between two controls in the "Devices and networking" editor](image)

*Fig. 52: Connection between two controls in the "Devices and networking" editor*

If you mark a device in the device overview, the connections for this device are shown in the table.

![Table of connections in the "Devices and networking" editor](image)

*Fig. 53: Connections of the marked device in the "Devices and networking" editor*

If you do not mark a device in the device overview, all connections are shown in the table.
6.3 Add new device (PLC)

You can add controls (PLC) to a project. The added devices can then be configured, linked with further devices or provided with components e.g. signal module.

- Please also note Chap. 6.4 ‘Add new device (HMI/Movicon)’ page 82 for adding HMI devices.
- Please also note Chap. 6.5 ‘Adding a new device (slave)’ page 85 for adding slaves.

1. Select one of the following options if you want to add a new device:
   - Catalog: Drag the desired device from the ‘Device templates’ register of the catalog (Chap. 4.10 ‘Catalog’ page 34) to a suitable place or connecting line in the ‘Devices and networking’ editor. The device is directly added and displayed in the project tree. Chap. 4.18.3 ‘Mouse operation – drag & drop’ page 54
   - Menu bar: Device ‘Project ➔ Add new device’.
   - Toolbar: Click on.
   - Keyboard: Press [Ctrl]+[Shift]+[N].
   - Project tree: Click on ‘Add new device’.
   - "Start page" ➔: Click on ‘Add new device’.
   - "Project overview“ editor ➔: Click on.

- The ‘Add new device’ dialogue window will open.
Add new device (HMI/Movicon)

2. Select the desired device template from the list.
3. ‘Device name’: Enter a device name, if required.
4. Click on ‘OK’.

If you select the option ‘Open device configuration’ and click on ‘OK’, the added device is opened in the “Device configuration” editor.

6.4 Add new device (HMI/Movicon)

You can add HMI devices to a project. HMI devices are created with the Movicon functionality. You can thus use the HMI device in a SCADA (Supervisory Control and Data Acquisition) system.

For subsequent configuration of HMI devices and for creating visualisations, please observe the following chapter: Chap. 9 ‘Creating a visualisation’ page 312

If the control has an integrated web server for the web visualisation and you want to create a visualisation without Movicon functionality, please observe the following chapter instead: Chap. 6.20.3 ‘Server configuration’ page 114.
1. Select one of the following options if you want to add a new device:
   - **Menu bar**: Device ‘Project ➔ Add new device’.
   - **Toolbar**: Click on 
   - **Keyboard**: Press [Ctrl]+[Shift]+[N].
   - **Project tree**: Click on ‘Add new device’.
   - **“Start page”**: Click on ‘Add new device’.
   - **“Project overview” editor**: Click on 

   ⇒ The ‘Add new device’ dialogue window will open.

2. Select ‘HMI’.

3. ‘Device name’: Enter a device name.

4. Select an option:
   - ‘Connect Movicon project’: Connect with Movicon project
     - Click on and select an already existing Movicon project.
   - ‘Create Movicon project’: Create a Movicon project
     - Click on and choose a directory in which the new Movicon project is to be saved.

5. Under ‘Device template’, select the operating system for the Movicon project:
   - ‘Movicon Panel CE’: Screen resolution 1024 x 600 pixels
   - ‘Movicon Panel Win 7/8/9’: Screen resolution 1920 x 1080 pixels

6. Under ‘Process image width/height’, enter different values for the screen resolution, if required.

7. Click on ‘OK’.

   ⇒ The dialogue window ‘Add Movicon project’ will open.
6.4.1 Adding a Movicon project

Depending on the option you selected earlier, carry out the following steps:

**Create a Movicon project**

1. Enter a ‘Project name’ for the Movicon project.
2. Under ‘Folder path’, you can select the target directory for the Movicon project.
3. Under ‘Process image width/height’, enter different values for the screen resolution, if required.
4. Click on ‘Next’.
5. In the following dialogue window, ‘Connection configurations’, select the devices on the left-hand side which are to be connected to the Movicon panel. Click on ‘>>’ to add devices to the list of connected devices.
6. Click on ‘Done’.
   ⇒ The HMI device is added and displayed in the project tree. The Movicon project is created. You can recognise an HMI device with Movicon functionality by the symbol 📊.
7. In the following dialogue window ‘Summary’, select the option ‘Save project’.
8. If you select the option ‘Start Movicon and open project’, the external Movicon application is started (if available) and the contained project is opened.
9. Click on ‘Done’.

**Connect with Movicon project**

1. Under ‘Folder path’, you can select the directory where the existing Movicon project is saved.
2. Click on ‘Next’.
3. In the following dialogue window, ‘Connection configurations’, select the devices on the left-hand side which are to be connected to the Movicon panel. Click on ‘>>’ to add devices to the list of connected devices.
4. Click on ‘Next’.
5. In the following dialogue window, select the link to the Movicon stations. Select one of the following options in the selection field under ‘Select Movicon PLC’ for this purpose:
   - ‘Add station:’ The control linked to the Movicon panel is created as a new station in the Movicon project.
   - Name of the Movicon station: The control linked to the Movicon panel is connected with the selected Movicon station.
6. Click on ‘Next’.
7. In the following dialogue window ‘Summary’, all devices are listed which have been assigned and require linking.
8. Click on ‘Done’.
   ⇒ The HMI device is added and displayed in the project tree. The Movicon project is created. You can recognise an HMI device with Movicon functionality by the symbol 📊.

For subsequent configuration of HMI devices and for creating visualisations, please observe the following chapter: Chap. 9 ‘Creating a visualisation’ page 312
6.5 Adding a new device (slave)

Different control systems support different bus systems e.g. PROFIBUS or EtherCAT. You can add slaves to the bus system of a control. The added slaves can then be configured or provided with components e.g. signal modules.

A control with the corresponding bus system must be already available in the project.  
\(\textit{Chap. 6.3 'Add new device (PLC)'}\) page 81

Many device types are already pre-installed in \textit{SPEED7 Studio} and are available in the ‘catalog’. To be able to use further device types in the project, you must install the device description file of the individual device types.  
\(\textit{Chap. 6.10 'Installing device description files'}\) page 93

![Fig. 59: Adding slave via "Catalog"](image)

1. Select the slave (hold left mouse button down)
2. Drag the slave
3. Drop the slave at a suitable place (release the mouse button)
4. The slave is added

Select one of the following options if you want to add a new slave:

- **Catalog**: Drag the desired slave from the ‘Device templates’ register of the catalog (  
\(\textit{Chap. 4.10 'Catalog'}\) page 34) to the connecting line of the bus system in the ‘Devices and networking’ editor. Fig. 59
  
The slave is directly added and displayed in the project tree.

- **Project tree**: Within the PLC under ‘Decentralised periphery’ and the suitable bus system (e.g. DP master system), click on ‘Add new device’. Fig. 60

- **"Devices and networking" editor**: Right-click with the mouse button on the connecting line of the corresponding bus system (e.g. DP master system) and select ‘Add new device’.

  The ‘Add new device’ dialogue window will open.
6.6 Add control (CPU) as PROFIBUS DP slave (I-Slave)

You can connect controls to a DP master system as intelligent DP slaves.

If you want to connect a control, ensure that this control supports the PROFIBUS-DP-switching-on unit as slave.

You can add the slave to a control with the DP master system in a variety of ways:

- Automatic configuration: Drag & drop control
- Manual configuration: Configure control as a slave
Add control (CPU) as PROFIBUS DP slave (I-Slave)

**Automatic configuration**

Drag the desired control from the ‘Device templates’ register of the catalogue to the connecting line of the DP master system in the ‘Devices and networking’ editor (drag & drop).

⇒ The control is automatically configured as a slave.

![Fig. 62: Controls in the “Devices and networking” editor](image)

1. Control with DP master system
2. Control added as slave

**Manual configuration**

![Fig. 63: Controls in the “Devices and networking” editor](image)

1. Control with DP master system
2. Control which is to be connected as a slave

1. Add both the control with the DP master system and the control which is to be connected as a slave to the project.
Double-click on the line with the entry "PROFIBUS..." table for the control which is to be connected as a slave.

The 'Interface properties' dialogue window will open.

Note that the PROFIBUS slave functionality must be activated for some control types. If the "PROFIBUS..." line is not shown in the table, open the 'component properties (CPU)' and activate the PROFIBUS slave functionality under 'Feature Sets'.

Chap. 6.23.2 'Feature Sets' page 120
3. Click on the ‘Operating Mode’ tab and select the control to which the device should be connected as a slave under ‘IO system’. If you want to use the device as a slave in another project, select the station address (DP address) here.

The organisation block OB82 is required to operate the device as a slave. When you activate the ‘Add OB82’ option, the block is created.

4. Click on ‘OK’.
   ⇒ The device is configured as a slave and connected to the DP master system.

Fig. 65: "Interface properties" dialogue window, "Operating Mode" tab

Fig. 66: Control with DP master system (1) and connected control as slave (2)
### 6.7 Add control (CPU) as a PROFINET IO device (I device)

You can connect controls to a PROFINET IO system as intelligent IO devices (I device). You can add the I device to a control with the PROFINET IO system in a variety of ways:

- **Automatic configuration:** Drag & drop I device
- **Manual configuration:** Configure control as an I device

#### Automatic configuration

Drag the desired control from the ‘Device templates’ register of the catalogue to the connecting line of the PROFINET IO system in the ‘Devices and networking’ editor (drag & drop).

![Fig. 67: Controls in the "Devices and networking" editor](image)

1. Control with PROFINET IO system
2. Control added as an I device
Manual configuration

Fig. 68: Controls in the "Devices and networking" editor

1. Control with PROFINET IO system
2. Control which is to be connected as an I device

1. Add the control which is to be connected as an I device to the project.

Fig. 69: Device details for the control which is to be connected as an I device

2. Double-click on the line with the entry "PROFINET IO system" in the table for the control which is to be connected as an I device.

⇒ The ‘Bus system properties’ dialogue window will open.
3. Click on the ‘I device’ tab, activate ‘I device mode’, and select the control to which the device should be connected as an I device under ‘IO system’.

The two organisation blocks OB83 and OB86 are required to operate the device as an I device. When you activate the ‘Add OB83 / OB86’ option, the blocks are created.

4. Click on ‘OK’.

⇒ The device is configured as an I device and connected to the PROFINET IO system.

Fig. 70: Dialogue window “Bus system properties”, tab “I device”

Reserving transfer areas

Where necessary, you can reserve transfer areas for I/O data interchange between the two devices. § Chap. 7.3.7 ‘IO controller – I/O configuration’ page 176
1. Open the ‘Bus system properties’ dialogue window for the I device. To do this, double-click on the line with the entry "PROFINET IO system" in the table in the ‘Devices and networking’ editor.

   ⇒ The ‘Bus system properties’ dialogue window will open.

2. Click on the ‘I device’ tab and select "—" under ‘IO system’.

3. Click on ‘OK’.

   ⇒ The device is disconnected from the PROFINET IO system. The two organisation blocks OB83 and OB86 are not deleted.

### 6.8 Removing devices

Any device which is no longer required, e.g. if you want to replace it by a new device of another type, can be removed from the project.

Select one of the following options if you want to delete a device from the project:

- **Project tree**: Right-click with the mouse button on the device and, from the context menu, select ‘Delete device’.
- **"Devices and networking" editor**: Right-click with the mouse button on the device and select ‘Delete device’.
  - or -
  - Left-click with the mouse button on the device and press [Del].

   ⇒ The device is removed from the project. The I/O addresses formerly assigned to the device are available.

**Devices to which further devices are connected, e.g. via a bus system cannot be deleted. First, all connected devices must be deleted.**

### 6.9 Duplicate device

You can duplicate a device, e.g. if you want to project several devices of the same type with similar configuration.

Select one of the following options if you want to duplicate a device in the project:

- **Project tree**: Right-click with the mouse button on the device and, from the context menu, select ‘Duplicate device’.
- **"Devices and networking" editor**: Right-click with the mouse button on the device and select ‘Duplicate device’.

   ⇒ The device is duplicated and added to the project tree with a new device name. All configuration data and the user program is copied at the same time.

### 6.10 Installing device description files

In a device description file, the properties of a device type are defined. Many device types are already pre-installed in SPEED7 Studio and are available in the ‘catalog’. To be able to use further device types in the project, you must install the device description file of the desired device type.
A variety of device description files are used for the various communication systems:

- **PROFIBUS**: GSD file (General Station Description)  
  Chap. 6.11 ‘PROFIBUS – GSD’ page 94
- **PROFINET**: GSDML file (GSD Markup Language)  
  Chap. 6.12 ‘PROFINET – GSDML’ page 96
- **EtherCAT**: ESI file (EtherCAT Slave Information)  
  Chap. 6.13 ‘EtherCAT – ESI’ page 99

### 6.11 PROFIBUS – GSD

Here you can install the GSD files for PROFIBUS DP slaves and have the installed device types shown to you.

1. Select in the menu bar ‘Extra ➔ Install device description file (PROFIBUS – GSD)’  
   ⇒ The ‘Install device description file’ dialogue window will open.

2. Click on the desired section:
   - ‘New GSD file’ – Install device description files  
     Chap. 6.11.1 ‘New GSD file’ page 94
   - ‘Installed GSD files’ – Show all installed device description files  
     Chap. 6.11.2 ‘Installed GSD files’ page 95

### 6.11.1 New GSD file

![Install GSD file](image)

**Fig. 72: Install GSD file**
Source

‘Source path’ – Directory containing the GSD files to be installed.

- Click on the field ‘...’ to select another directory.

‘Include subfolders’ – Activate this option if there are GSD files in sub-directories of the source path.

- Click on ‘Start reading’.
  - In the ‘Files found’ table, all GSD files are shown that were found in the source path.

Files found

Provides a list of GSD files found in the source path.

- To refresh the table, click on ‘Start reading’.

Install device description file

1. In the second column of the table, highlight the GSD files that you would like to install.
   - or -
   In the title row of the table, click on to select all the GSD files.

2. Click on ‘Install’.
   - The selected GSD files are installed and adopted into the catalog (Chap. 4.10 ‘Catalog’ page 34). The installed device types are shown in the ‘Device templates’ register.
   - If the selected GSD file has been installed already, a dialogue window will open. Choose whether you want to replace the GSD file or not. Select ‘Apply for all’ in order to apply the process to all files.

GSD files

GSD files are composed in ASCII format. Each GSD file contains the device description in one language. You can recognise which language the GSD file is composed in the ‘Language’ column and by the last letters of the file extension:

- .gsd: Default (standard language)
- .gse: English
- .gsd: German

The device description can be shown only in languages (Chap. 4.4 ‘Select language’ page 23) in which a GSD file is installed.

6.11.2 Installed GSD files

Here you can see a table with the GSD files installed in SPEED7 Studio. The installed device types can be used in the project. They are shown in the catalog (Chap. 4.10 ‘Catalog’ page 34) in the ‘Device templates’ register.
6.12 PROFINET – GSDML

Here you can install the GSDML files for PROFINET partners and have the installed device types shown to you.

1. Select in the menu bar ‘Extra -> Install device description file (PROFINET – GSDML)’
   - The ‘Install device description file’ dialogue window will open.

2. Click on the desired section:
   - ‘New GSDML file’ – Install device description files \(\text{\textcopyright Chap. 6.12.1 ‘New GSDML file’ page 97}\)
   - ‘Installed GSDML files’ – Show all installed device description files \(\text{\textcopyright Chap. 6.12.2 ‘Installed GSDML files’ page 98}\)
6.12.1 New GSDML file

Fig. 74: Install GSDML file

Source

‘Source path’ – Directory containing the GSDML files to be installed.

Click on the field ‘...’ to select another directory.

‘Include subfolders’ – Activate this option if there are GSDML files in sub-directories of the source path.

Click on ‘Start reading’.

In the ‘Files found’ table, all GSDML files are shown that were found in the source path.

Files found

Provides a list of GSDML files found in the source path.

To refresh the table, click on ‘Start reading’.

Install device description file

1. In the second column of the table, highlight the GSDML files that you would like to install.

- or -

In the title row of the table, click on to select all the GSDML files.
2. Click on ‘Install’.

The selected GSDML files are installed and adopted into the catalog (Chap. 4.10 ‘Catalog’ page 34). The installed device types are shown in the ‘Device templates’ register.

If the selected GSDML file has been installed already, a dialogue window will open. Choose whether you want to replace the GSDML file or not. Select ‘Apply for all’ in order to apply the process to all files.

**GSDML files**

GSDML files are composed as an XML document. The file extension is ‘.xml’.

All the languages available for a device type (see ‘Language’ column) are contained in a GSDML file. The device description can be shown only in languages (Chap. 4.4 ‘Select language’ page 23) contained in the GSDML file.

### 6.12.2 Installed GSDML files

Here you can see a table with the GSDML files installed in SPEED7 Studio. The installed device types can be used in the project. They are shown in the catalog (Chap. 4.10 ‘Catalog’ page 34) in the ‘Device templates’ register.

<table>
<thead>
<tr>
<th>File</th>
<th>Version</th>
<th>Info</th>
<th>Vendor</th>
</tr>
</thead>
<tbody>
<tr>
<td>gsdml-v2.2-yaskawa-step3-20100726.xml</td>
<td>v2.2</td>
<td>Drives</td>
<td>Yaskawa America, Inc</td>
</tr>
<tr>
<td>gsdml-v2.3-vipa-slic-20141103.xml</td>
<td>v2.3</td>
<td>I/O</td>
<td>VIPA GmbH</td>
</tr>
</tbody>
</table>

*Fig. 75: Installed GSDML files*
6.13 EtherCAT – ESI

Here you can install the ESI files for EtherCAT slaves and have the installed device types shown to you.

1. Select in the menu bar ‘Extra ➔ Install device description file (EtherCAT – ESI)’
   ⇒ The ‘Install device description file’ dialogue window will open.

2. Click on the desired section:
   - ‘Installed ESI files’ – Show all installed device description files ⇒ Chap. 6.13.2 ‘Installed ESI files’ page 100

6.13.1 New ESI file

Fig. 76: Install ESI file

Source

‘Source path’ – Directory containing the ESI files to be installed.
⇒ Click on the field ‘...’ to select another directory.

‘Include subfolders’ – Activate this option if there are ESI files in subdirectories of the source path.
⇒ Click on ‘Start reading’.
   ⇒ In the ‘Files found’ table, all ESI files are shown that were found in the source path.
Selecting and configuring devices and components

VIPA SPEED7 Studio

EtherCAT – ESI > Installed ESI files

Files found

Provides a list of ESI files found in the source path.

To refresh the table, click on ‘Start reading’.

Install device description file

1. In the second column of the table, highlight the ESI files that you would like to install.
   - or -

   In the title row of the table, click on to select all the ESI files.

2. Click on ‘Install’.

   The selected ESI files are installed and adopted into the catalog (Chap. 4.10 ‘Catalog’ page 34). The installed device types are shown in the ‘Device templates’ register.

   If the selected ESI file has been installed already, a dialogue window will open. Choose whether you want to replace the ESI file or not. Select ‘Apply for all’ in order to apply the process to all files.

ESI files

ESI files are composed as an XML document. The file extension is "xml".

6.13.2 Installed ESI files

Here you can see a table with the ESI files installed in SPEED7 Studio. The installed device types can be used in the project. They are shown in the catalog (Chap. 4.10 ‘Catalog’ page 34) in the ‘Device templates’ register.
Images of the PLC layout and a list of device details are provided in the ‘Device configuration’ editor. Here you can configure the device and included components as well as add or remove components.

If a project is opened and a PLC is included, you can open the ‘Device configuration’. Select one of the following options to this end:

- **Project tree**: Click on ‘Device configuration’ within the PLC.
- **“Devices and networking” editor**: Double-click on a PLC.
Fig. 78: Device configuration of a PLC

(1) Toolbar
(2) Device configuration
(3) Device details

(1) Toolbar

Transfer hardware configuration: The current device configuration is transferred to the control. Blocks of the user program are not transferred.

Hardware configuration online view: The condition of the input and output signals is displayed on the components. Chap. 6.14.2 ‘Show output signals’ page 104

(2) Device configuration

The device configuration shows all components which are connected with the device via the rack. Here you can add or remove components. You can also access further component functions.

Showing/hiding slots

For a clear presentation, you can show or hide several slots. The slots are displayed in groups e.g. "4..11", "12..19", etc.

Hiding slots/components

Showing slots/components
Hidden components are not displayed in the editor. They are, however, still present in the project configuration.

### Adding components

Drag the desired component from the ‘Components’ register of the catalog to a free slot. 

- The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration".

### Removing components

1. Right-click with the mouse button on the component and select ‘Delete component’.

   - A dialogue window will open, where you can select whether the component should be retained or deleted.

2. Click on ‘Yes’.

   - The component is removed from the device and the project.

### Opening the properties of the component

Double-click on a component.

- **CPU**: The dialogue window of the CPU properties will open. 
  - Chap. 6.23 ‘Properties of the module (CPU)’ page 118

   **Other components**: The dialogue window of the Component properties will open. 
  - Chap. 6.24 ‘Properties of the module (SLIO modules)’ page 131

### Accessing further functions

Right-click with the mouse button on the component and select the desired command, e.g. ‘Component properties’.

### (3) Device details

Provides a list of details on the device, e.g. component assignment, order numbers or I/O addresses.

- **Rack**

  - Here you can select the rack for which you need details.

  - **Slot** – Slot number within the rack
  - **Component** – Component name
  - **Order number** – Order number of the component
  - **I-Address** – Configured input address (byte address) of an input component
  - **O-Address** – Configured output address (byte address) of an output component
  - **MPI/IP address** – Address of a communication interface
  - **Comment** – Any comment e.g. remark or explanation
Adding components

Drag the desired component from the 'Component' register of the catalog to a free line.

The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration". Chap. 8.11.3 ‘System hardware configuration’ page 249

6.14.1 Display output current and add power modules (SLIO only)

Display output current

In the SLIO system (Slice I/O), the power consumption of the projected modules is calculated and displayed. Once approximately 70% of the maximum power consumption on the backplane bus has been reached, the colour of the arrow changes from green to orange. Once approximately 90% of the maximum power consumption has been reached, the colour changes to red.

Add power modules

You can expand the voltage supply in a SLIO system by adding power modules.

Right-click with the mouse button on the arrow at the slot position where you want to add a power module. Select ‘Add power module’.

The added power module is shown at the slot position. The power consumption on the right beside the power module is recalculated.

6.14.2 Show output signals

If you have transferred the hardware configuration and the user program into the control, you can show the condition of the output signals (green LEDs) on the components in the "Device configuration" editor.

Create a communication connection to the control. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

Select one of the following options to switch the display on or off:

- Menu bar: Select ‘Device configuration’ Hardware configuration online view’.
- "Device configuration" editor: Click on the button in the toolbar of the editor.

The condition of the output signals (green LEDs) is displayed in the editor.

6.15 "Device configuration" editor (slave)

Images of the slave layout and a list of device details are provided in the 'Device configuration’ editor. Here you can configure the device and included components as well as add or remove components.

If a project is opened and it includes a slave, you can open the 'Device configuration'. Select one of the following options to this end:

- Project tree: Click on ‘Device configuration’ within the slave.
- "Devices and networking" editor: Double-click on a slave.
The device configuration shows all components which are connected with the device via the rack. Here you can add or remove components. You can also access further component functions.

**Showing/hiding slots**

For a clear presentation, you can show or hide ten slots. The slots are displayed in groups "1..9", "10..19", etc.

- Hiding slots/components
- Showing slots/components

*Hidden components are not displayed in the editor. They are, however, still present in the project configuration.*
Adding components

Drag the desired component from the 'Components' register of the catalog to a free slot.  
⇒ The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration".  
⇒ Chap. 8.11.3 'System hardware configuration' page 249

Removing components

Right-click with the mouse button on the component and select 'Delete component'.  
⇒ The component is removed from the device and the project.

Opening the properties of the component

Double-click on a component.  
⇒ The dialogue window of the Component properties will open.  
⇒ Chap. 6.23 'Properties of the module (CPU)' page 118  
⇒ Chap. 6.25 'Component properties (MICRO modules)' page 134  
⇒ Chap. 6.24 'Properties of the module (SLIO modules)' page 131

Accessing further functions

Right-click with the mouse button on the component and select the desired command, e.g. 'Component properties'.

(2) Device details

Provides a list of details on the device, e.g. component assignment, order numbers or I/O addresses.

'Slot' – Slot number within the rack

'Component' – Component name

'Order number' – Order number of the component

'I-Address' – Configured input address (byte address) of an input component or an input module

'O-Address' – Configured output address (byte address) of an output component or an output module

'Comment' – Any comment e.g. remark or explanation

Adding components

Drag the desired component from the 'Components' register of the catalog to a free line.  
⇒ The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration".  
⇒ Chap. 8.11.3 'System hardware configuration' page 249

6.16 Adding components

You can add components e.g. signal or interface modules to a control. The order of the components in the project must comply with the order of the actually connected components.

A control must already be available in the project.  
⇒ Chap. 6.3 'Add new device (PLC)' page 81

The 'Device configuration' editor must be open.  
⇒ Chap. 6.14 "Device configuration" editor (PLC) page 101  
⇒ Chap. 6.15 "Device configuration" editor (slave) page 104
You can add components in a variety of ways:

- Drag & drop component
- Highlight slot and select component

**Drag & drop component**

You can drag the component out of the catalog and drop it either in the device configuration or in the table with the device details:

![Diagram of adding component](image)

**Fig. 80: Add the component (device configuration)**

(1) Select the component (hold left mouse button down)
(2) Drag the component
(3) Drop the component at a free slot (release mouse button)

![Diagram of adding component](image)

**Fig. 81: Add component (table with device details)**

(1) Select the component (hold left mouse button down)
(2) Drag the component
(3) Drop the component at a free slot (release mouse button)
Removing components

Drag the desired component from the 'Components' register of the catalog to a free slot.

The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration". Chap. 8.11.3 'System hardware configuration' page 249

Highlight slot and select component

Fig. 82: Add component (highlight slot and insert component)

1. With the left mouse button, highlight the slot into which the component is to be inserted.
   ➞ The slot is highlighted.

2. In the 'Components' register of the catalog, double click on the desired component
   ➞ The component is added to the device. Depending on the number of channels, a component occupies a different number of byte addresses. The necessary I/O address ranges are reserved and entered into the "system hardware configuration". Chap. 8.11.3 'System hardware configuration' page 249

6.17 Removing components

Any component which is no longer required, e.g. if you want to replace it by a component of another type, can be removed from the device.
In the "Device configuration" editor, right-click with the mouse button on the component and select 'Delete component'.

The component is removed from the device and the project. The I/O addresses formerly assigned to the component are available.

6.18 Printing labels

You can create a labelling strip as a PDF file for each component. On the labelling strip, the designations are shown that are indicated in the "Alias" column of the system hardware configuration ( Chap. 8.11.3 'System hardware configuration' page 249).

1. Mark the desired component in the 'Device configuration' editor. If you want to save labelling strips for several components in one PDF file, mark all the desired components. To do so, keep the [Ctrl] key pressed down.

2. Right-click with the mouse button on a component and select 'Printing labels'.
   ⇒ The ‘Save as’ dialogue window will open.

3. Select a directory, enter a file name and click on ‘Save’.
   ⇒ The labelling strip is saved as a PDF document.

6.19 Changing device properties

You can change the comment of PLC, HMI or slaves and perform the communication settings for PLC and HMI.

- PLC: Chap. 6.14 “Device configuration” editor (PLC) page 101
- HMI: Chap. 9.3 “Device properties” editor (HMI device) page 313
6.20 **"Device properties" editor (PLC)**

General information on the control, as well as the communication settings are displayed in the *Device properties* editor. Here you can change the device name and the comment as well as make communication settings. Further, this is where configuration of the servers for WebVisu projects and OPC UA is made.

If a project is open and a control is included, you can open the *Device properties*:

- **Project tree**: Click on *Device properties* in the PLC.
- **"Devices and networking" editor**: Right-click with the mouse button on the device and select *Device properties*.

For the device properties of a visualisation device (HMI): Chap. 9.3 **"Device properties" editor (HMI device)** page 313

The *Device properties* editor is divided into several sections.

### 6.20.1 General device properties (PLC)

To display or change the device properties of the control, you must proceed as follows:

You have accessed the *General* section in the *Device properties* editor of the control.

![General device properties](image)

**Fig. 83: Device properties of a PLC, as an example**

*Device type* – Name of the CPU
6.20.2 Communication settings (PLC)

The communication settings are used to configure the interface for the data exchange between programming device and control (PLC). You can directly connect the devices with each other or via a network. The data exchange takes place via a serial or Ethernet interface.

Under ‘Extras ➔ Configurations’ you can determine which network adapters or ports should be used as a standard. Chap. 4.6 ‘Select interfaces’ page 24

You have accessed the ‘Communication’ section in the ‘Device properties’ editor of the control. Chap. 6.20 ‘Device properties’ editor (PLC) page 110
If you wish to select the serial interface for the data exchange between the programming device and the control, continue with further information page 112.

If you wish to select the Ethernet interface for the data exchange between the programming device and the control, continue with further information page 113.

If you wish to test (simulate) the user program on the programming device, continue with further information page 113.

Setting the serial interface

1. ‘Active PC interface’: Select ‘Serial interface’.

2. ‘COM port’: Select the desired port number of the serial interface of the programming device from the list.

3. ‘Baud rate’: Select the desired transmission rate (Bit/s).

4. ‘CPU interface’: Select the desired interface of the control from the list.

5. To perform further configuration of the interface, click on ‘interface configuration’.

Chap. 6.23.1 ‘General’ page 119
6. In order to check whether a connection between the programming device and the control can be established with the selected communication settings, click on ‘Verify connection’.
   ⇒ You can see in the status line, whether the connection could be established successfully.

7. In order to check whether your programming device is connected with the correct control, you can retrieve information from the connected control. Click on ‘Accessible partners’.
   ⇒ The ‘Search for accessible partners’ dialogue window will open. Chap. 6.21 ‘Search for accessible partners’ page 115

Setting the Ethernet interface

1. ‘Active PC interface’: Select ‘Ethernet interface’.

2. ‘PC interface’: Select the network adapter for the communication connection from the list.
   ⇒ If an IP address is already configured in the network adapter, it is shown under the input field.

3. ‘CPU interface’: Select the desired interface of the control from the list.
   ⇒ If an IP address is already configured in the control, it is shown under the input field.

4. To perform further configurations of the interface, click on ‘interface configuration’.
   ⇒ The ‘Interface properties’ dialogue window will open. Chap. 6.22 ‘Interface properties (Ethernet)’ page 116

5. In order to check whether a connection between the programming device and the control can be established with the selected communication configurations, click on ‘Verify connection’.
   ⇒ You can see in the status line, whether the connection could be established successfully.

6. In order to check whether your programming device is connected with the correct control, you can retrieve information from the connected control. Click on ‘Accessible partners’.
   ⇒ The ‘Search for accessible partners’ dialogue window will open. Chap. 6.21 ‘Search for accessible partners’ page 115

Set interface for the simulation

1. ‘Active PC interface’: Select ‘Simulation’.

2. ‘PC interface’: Select the network adapter for the virtual communication connection from the list. If you select "Loopback Adapter", the simulation is run on the PC without using the network adapter.
   ⇒ If an IP address is already configured in the network adapter, it is shown under the input field. For "Loopback Adapter" the IP address is always "127.0.0.1".

3. In order to check whether a connection between the programming device and the virtual interface can be established with the selected communication setting, click on ‘Verify connection’.
   ⇒ You can see in the status line, whether the connection could be established successfully.

4. To perform further configurations and to start the simulation, click on ‘interface configuration’.

In order to perform a simulation: Chap. 8.17 ‘Simulate user program’ page 270
6.20.3 Server configuration

You have accessed the ‘Server configuration’ section in the ‘Device properties’ editor of the control. Chap. 6.20 “Device properties” editor (PLC) page 110

This section is only displayed if the control has an integrated web server for the web visualisation or a server for OPC UA.

You can add a maximum of two servers: One configuration for the CPU and one configuration for the CP (if present).

If you want to create an HMI device with the Movicon functionality, please observe the following chapter: Chap. 6.4 ‘Add new device (HMI/Movicon)’ page 82

Add OPC UA

If the control has an OPC UA server, you can configure the server for OPC UA here, see Chap. 7.7 ‘Configure OPC UA’ page 199.

Add WebVisu

1. Select ‘WebVisu’ in the selection field and click on ‘Add Server’.
   → A new WebVisu project is created and displayed in the project tree. Under ‘Server configuration web visualisation’, you can configure WebVisu further.

2. Click in the selection field ‘Active server CPU’ or ‘Active server CP’ and select the WebVisu to assign the configuration. With the selection ‘None’, the configuration remains saved in the project. However, it is not transferred into the device.

To replace the two configurations for CP and CPU, click on the button.

WebVisu - General configurations

‘Display default configurations’ – screen resolution of the display, default values: 1920 x 1024 pixels

WebVisu - Specific configurations

‘Port number’ – Access to the web visualisation:

- "8080" (standard port): Access to the web visualisation via the IP address of the CPU with indication of the port, e.g. http://192.168.72.120:8080
  Access to the device web page via the IP address of the CPU (port 80), e.g. http://192.168.72.120

- "80" (HTTP port): Access to the web visualisation via the IP address of the CPU without indication of the port, e.g. http://192.168.72.120
  Access to the device web page via the IP address of the CPU with indication of the port, e.g. http://192.168.72.120:8080

- "443" (SSL port): Secured access to the web visualisation via the IP address of the CPU with indication of the port, e.g. http://192.168.72.120:8080
  Unsecured access to the device web page via the IP address of the CPU with indication of the port, e.g. http://192.168.72.120:8080

‘Query interval (ms)’ – Interval for the cyclic update of the web visualisation

Configurations for secured access:

- ‘Activate encryption’ – Secured access to the web visualisation
- ‘Disable HTTP’ – e.g. for SSL access
- ‘Original path of the certificate used’ – Loading security certificate into CPU

Please note that the secured access may have a negative impact on the CPU's performance and on the reaction time of the entire system!
Removing WebVisu

Right-click with the mouse button on the WebVisu project in the project tree and select ‘Delete WebVisu’.

6.21 Search for accessible partners

This dialogue window will open if you click on ‘Accessible partners’ at ‘Communication’ in the ‘Device properties’ editor. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

You may also open this dialogue window if you want to transfer the hardware configuration and the user program to the control. Chap. 8.18 ‘Transfer the hardware configuration and user program to the control’ page 272

Fig. 85: Dialogue window “Search for accessible partners” (Ethernet interface)

Search for accessible partners

1. Under ‘Active CPU interface’, select the connection which connects the control with the programming device. Click on ‘Apply settings’.

2. ‘COM port’ (only for serial interface): Select the desired port number of the serial interface of the programming device for the connection test.

‘Network interface card’ (only for Ethernet interface): Select the network adapter of the programming device for the connection test.
3. If you want to find only PROFINET devices (only possible via Ethernet interface), select the option ‘Only PROFINET’.

4. ‘Active CPU interface’: Select the desired interface of the CPU from the list, if required.

5. Click on ‘Search’.
   ⇒ The search for connected devices is started and displayed at ‘Status’.
   Any device that has been found by the Search function is displayed in a table.

6. As soon as the desired device is shown in the table, you can stop the search. Select the desired device.

7. Then, click on ‘Apply settings’.

Problem with USB network adapters
If you use a USB network adapter for the first time in SPEED7 Studio, it might not be able to find the accessible partners.

- In that case, call up the Windows function "Execute" with the key combination [Windows]+[R]. Run "net stop npf".
- Call up the Windows function "Execute" again and run "net start npf".
  - or -
  Restart your PC.

Set IP address
You can change the IP address of a connected device.

1. Show the input area "Change communication settings".

2. Click on ‘Search’.
   ⇒ The search for connected devices is started and displayed at ‘Status’.
   Any device that has been found by the Search function is displayed in a table.

3. As soon as the desired device is shown in the table, you can stop the search. Select the desired device.

4. Enter the new IP address and if necessary the subnet mask and the gateway address.

5. Click on ‘Set IP address’.
   ⇒ The new address is loaded into the device.

Change PROFINET-Configurations
If you have selected a PROFINET connection under ‘Active CPU interface’, you can set the PROFINET device name or perform a factory reset of the IO controller.

6.22 Interface properties (Ethernet)
This dialogue window will open if you click on ‘interface configuration’ in the ‘Properties of Ethernet interface’ section at ‘Communication’ in the ‘Device properties’ editor.

Chap. 6.20.2 ‘Communication settings (PLC)’ page 111
Fig. 86: Dialogue window “Interface properties – General”

‘Name’ – Name of the connection point

‘Subnet ID’ – Address for the communication with connection partners via routing functions, e.g. via teleservice

‘PDU size’ – Data size of a Protocol Data Unit for the ‘Watch block’ function:
- 240 byte: Standard
- 480 byte: Siemens
- 960 byte: VIPA CPU

‘IP address’ and ‘Subnet mask’ – Address of the CPU interface of the control
6.23 Properties of the module (CPU)

You can adjust the properties of the CPU. The following configurations can be parametrised:

- General properties, e.g. device name, MPI interface (Chap. 6.23.1 ‘General’ page 119)
- Feature Sets (Chap. 6.23.2 ‘Feature Sets’ page 120)
- Starting behaviour (Chap. 6.23.3 ‘Start-up’ page 120)
- Synchronous cycle interrupts (Chap. 6.23.4 ‘Synchronous cycle interrupts’ page 121)
- Cycle and clock memory (Chap. 6.23.5 ‘Cycle / Clock memory’ page 122)
- Retentive memory (Chap. 6.23.6 ‘Retentive memory’ page 123)
- Local data (Chap. 6.23.7 ‘Local data’ page 123)
- Interrupts (Chap. 6.23.8 ‘Interrupts’ page 123)
- Time of day interrupts (Chap. 6.23.9 ‘Time of day interrupts’ page 124)
- Cyclic interrupts (Chap. 6.23.10 ‘Cyclic interrupts’ page 124)
- Diagnosis behaviour and clock (Chap. 6.23.11 ‘Diagnostics/Clock’ page 125)
- Access protection (Chap. 6.23.12 ‘Protection’ page 125)

Fig. 87: Dialogue window "Interface properties – Addresses"

‘Input addresses’ and ‘Output addresses’ – Reserved address section (byte address) for the exchange of diagnostics data between CPU and PC
Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

If a project is open and a control is included, you can open the properties of the CPU.

1. Select one of the following options:
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Local components... CPU... Component properties’.
   - **“Device configuration” editor**: Double-click on the CPU.

   The dialogue window ‘Component properties (CPU)’ will open.

2. Click on the desired parameter block, e.g. ‘Startup’.

   The page with the appropriate parameters will open.

3. Change the parameters, if necessary, and click on ‘OK’.

   The changed properties are applied in the project configuration. After the changed parameters have been transferred ( Chap. 5.10 ‘Transfer project’ page 69) and once the CPU has been started, the changed parameters are activated in the control.

### 6.23.1 General

Here you can make general configurations for the current CPU.

- **Name** – Name of the control: The name is displayed in the project tree.
- **Plant designation** – Specific plant designation: Here you can uniquely identify parts of the plant on the basis of functional aspects. The construction identification has a hierarchic structure according to IEC 1346-1.
- **Location designation** – Any comment

### MPI-Data

Here you can configure the MPI subnet (Multi Point Interface) for the serial connection between accessible MPI partners.

- **Address** – MPI address of the CPU
Address 2 for VIPA CPUs is pre-set as a standard. Address 0 is reserved for programming devices.

'Max address' – Highest address number in the MPI subnet

'Secondary baud rate' – The transmission rate (Bit/s) of the MPI subnet must not be higher than the transmission rate of the slowest accessible MPI partner.

### 6.23.2 Feature Sets

Depending on the CPU and the firmware version used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

Here you can activate the corresponding additional functions in SPEED7 Studio.

'Motion Control'
- 'inactive' – Motion Control is deactivated
- 'Motion Control + ... Axes' – Cycle synchronicity with activation of OB 60 and OB 61 for the corresponding number of axes.

'PROFIBUS'
- 'inactive' – PROFIBUS functionality is deactivated
- 'PROFIBUS-Slave functionality' – PROFIBUS functionality is activated: The control can be used as DP slave.
- 'PROFIBUS-Master functionality' – PROFIBUS functionality is activated: The control can be used as DP master.

Please be aware that the additional functions in SPEED7 Studio can be activated only if you possess a valid licence for these!

### 6.23.3 Start-up

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

Here you can make general configurations for the start-up behaviour of the current CPU.

'Startup if preset configuration does not match actual configuration'
- The expected configuration is the configuration of the components which is defined in the project and uploaded to the CPU.
- The actual configuration is the implemented configuration of the components.

If this option is deselected, the CPU remains in the operating mode STOP for the following cases:
- One or more components are not located in the configured slot.
- A component of another type is located in the configured slot.
If this option is selected, the CPU switches to the operating mode RUN even if the components are not located in the configured slots or if components of another type are located there.

'Delete PAA at hot restart' – If this option is selected, the process image of the outputs (PAA) is deleted after the warm restart of the CPU.

'Disable hot restart by operator' – The types of start-up are restricted when triggered by the operation or communication job:

If this option is selected, only restart or cold start are possible. Warm restart is not possible.

If this option is deselected, all types of start-up are possible.

Start-up after PowerON

Here you can select whether a restart, warm restart or cold start should be made after having activated the power supply (PowerON).

- Cold start: All variables and memory ranges are initialised.
- Restart (warm start): The non-retentive memory ranges are initialised, the retentive memory ranges are restored. Chap. 6.23.6 ‘Retentive memory’ page 123
- Warm restart: The user program is continued where it has been interrupted.

Monitoring time for ...

The time base of the following parameters is 100 milliseconds. Multiply the input value with the time base.

Example: Input value 650 * 100 ms = 65.000 ms of monitoring time

‘Finished message from components (100 ms)’ – Maximum duration of the Ready signal of all configured components after having switched on the power supply (netON).

‘Transfer of parameters to components (100 ms)’ – Maximum duration of the parameter transfer to the parametrisable components.

‘Hot restart (100 ms)’ – Maximum duration of the warm restart:

If the time between PowerOFF and PowerON or between the operating modes STOP and RUN is longer than the time entered here, there is no warm restart. The CPU remains in the operating mode STOP.

6.23.4 Synchronous cycle interrupts

Depending on the CPU and the firmware version used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

You can perform the cycle synchronicity configurations here.

OB 61

Currently you cannot perform any configurations here. The data serves as information on the OB 61.

Behaviour at runtime violation

‘Warn threshold’ – Here, indicate a value in µs that is to serve as the threshold for the runtime violation as soon as the application cycle time is exceeded.

‘Error behaviour’

- deactivated: Runtime violations are ignored.
- CPU stops: In the event of a runtime violation, the CPU goes to STOP.
- OB 80 is requested: In the event of a runtime violation, the OB 80 is requested.
‘Maximum number of errors’ – Indicate how often the runtime may be violated before this is reported to the system as a runtime error.

‘Synchronize all local modules’ – If this option is activated, the address range of the local system SLIO modules is placed into the process image of the OB 61.

6.23.5 Cycle / Clock memory

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

Here you can make general configurations for the cycle/clock memory of the current CPU.

‘Refresh process image cyclically’ – If this option is selected, the process image of the organisation block OB 1 is cyclically updated. This expands the cycle time.

‘Scan cycle monitoring time (ms)’ – If the run time of the user program exceeds the scan cycle monitoring time, the CPU switches to the operating mode STOP (time base: milliseconds).

Reasons for time-out:
- Communication processes
- Accumulation of interrupt events
- Error in the CPU program

‘Minimum cycle time (ms)’ – Guaranteed compliance with a minimum scan cycle time: The start of a new cycle is delayed until the minimum scan cycle time has been reached (time base: milliseconds).

‘Scan cycle load from Communication (%)’ – Percentage of communication processes compared to the complete cycle time.

Example: If set to 50% in the configuration, the cycle time might double.

‘OB 85 calling at periphery access errors’ – Reaction of the CPU after periphery access errors during the update of the process image.

‘Size of the process image inputs’ – Size of the memory range for the input operand areas (I) in byte

‘Size of the process image outputs’ – Size of the memory range for the output operand areas (O) in byte

Clock memory

Clock memories periodically change their value in pre-set intervals.

‘Clock memory’ – Select this option if the CPU is to provide clock memories.

‘Memory byte’ – Number of the memory byte for the clock memory. The memory byte is used only if you select the ‘Clock memory’ option.

The selected memory byte cannot be used for the intermediate storage of data.
6.23.6  Retentive memory

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

In order to keep data in case of power failure, certain data ranges can be marked as retentive. A restart (warm start) will restore the values of the retentive memory ranges from the last program cycle.

‘Number of memory bytes starting with MB0’ – Number of retentive memory bytes from memory byte 0

Example: Input value 16 = memory bytes 0 to 15 are retentive

‘Number of timers starting with T0’ – Number of retentive timers from T0: Each timer requires 2 bytes.

‘Number of counters starting with C0’ – Number of retentive counters from Z0

Please also note Chap. 6.23.13 ‘Advanced Configurations’ page 126.

Areas

You can define up to 8 retentive memory ranges in the data blocks:

‘DB No.’ – Number of the retentive data block

‘Byte address’ – Starting address within the retentive data block

‘Number of bytes’ – Number of retentive bytes from the starting address within the data block

6.23.7  Local data

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

Local data are the temporary data of a block.

‘1...29’ – Number of local data bytes for the priority classes 1 to 29

‘Maximum bytes’ – Display of the memory range totally available for local data

‘Occupied’ – Display of the memory range which is currently occupied by local data (total of the local data bytes of the priority classes 1 to 29)

6.23.8  Interrupts

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

Here you can define the order for processing the individual interrupt organisation blocks. OBs with the smallest number have lowest priority. OBs with priority 0 are not processed.
The following interrupt OBs are listed:

- OB 40 - OB 47: Process interrupts
- OB 20 - OB 23: Time delay interrupts
- OB 50, OB 51, OB 55 - OB 57: Communication interrupts
- OB 81 - OB 87: Async. error interrupts

### 6.23.9 Time of day interrupts

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

The time of day interrupt organisation blocks OB 10 to OB 17 can interrupt the processing of OB 1 once or at a certain interval.

Depending on the CPU used, you can parametrise up to 8 time of day interrupts:

- **Priority** – Order in which a time of day interrupt organisation block is processed: OBs with the smallest number have lowest priority. OBs with priority 0 are not processed.
- **Active** – If this option is selected, the time of day interrupt OB will be started after the next restart of the CPU. If this option is not selected, the time of day interrupt OB will be deselected after the next restart of the CPU.
- **Execution** – Execution of the interrupt once or at certain intervals (repeat period)
- **Start date** and **time** – Time of the initial execution of the time of day interrupt

**Example**

With the configuration **Execution** Last day of month, **Start date** 30/9/2013 and **Time** 8:30 am, the time of day interrupt is initially displayed on 30/9/2013 at 8:30 am and then every month at the same time at the end of the month. Every interrupt is displayed on the last day of the month.

### 6.23.10 Cyclic interrupts

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

The cyclic interrupt organisation blocks OB 30 to OB 38 can interrupt the processing of OB 1 at a certain interval.

Depending on the CPU used, you can parametrise up to 9 cyclic interrupts:

- **Priority** – Order in which a cyclic interrupt organisation block is processed: OBs with the smallest number have lowest priority. OBs with priority 0 are not processed.
- **Execution (ms)** – Interval of the periodic execution of the cyclic interrupt OB in milliseconds. The starting time is the switching from operating mode STOP to RUN.
- **Phase offset (ms)** – Time in milliseconds by which the execution time of the cyclic interrupt is to be delayed. By selecting several cyclic interrupts, you can use the phase offset to make sure that the cyclic interrupts do not start at the same time.
6.23.11 Diagnostics/Clock

Depending on the CPU used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

‘Extended functional scope’ – This parameter does not have any function. The expanded range of functions for diagnostics is not supported.

‘Report cause of STOP’ – If this option is selected and if the operating mode switches from RUN to STOP, the CPU will report the reason for STOP to the programming and/or control device.

‘Report to process control active’ – This parameter does not have any function.

Clock

Here you can define, which clock is to be synchronised with which clock.

The following synchronisations are possible:

- Synchronisation in PLC: Application memory (internal)
- Synchronisation on MPI: Multi Point Interface (external)
- Synchronisation on MFI: Multifunctional interface (external via the second interface)

‘Synchronisation type’ –

- ‘None’: The clocks are not synchronised
- ‘As master’: The clock of the CPU synchronises other clocks as the master
- ‘As slave’: The clock of the CPU is synchronised by another clock

‘Time interval’ – Time interval of the periodic execution of the synchronization

‘Correction factor (ms)’ – The correction factor adjusts any clock deviation occurring within 24 Hours. You can enter positive and negative values in milliseconds.

Example

If the clock runs slow by 1 Second within 24 Hours, you can adjust this deviation with the correction factor "+1000".

6.23.12 Protection

‘Protection level’ – Here you can configure one of 3 protection levels to protect the CPU against unauthorised access.

- ‘No protection’: Write or read access is possible without a password
- ‘Write protection’: Read access is possible without a password; for write access, a password is required
- ‘Read/write protection’: Write or read access is only possible with a password

Password

‘Password (max. 8 characters)’ – Enter a password, if you want to protect the access to the CPU.

‘Re-enter password’ – Enter the password once more.

Use alphanumeric characters and the following special characters:

!@#$%^&*(),.:;?_@-
6.23.13 Advanced Configurations

**NOTICE!**

**Loss of the password!**
- The access to the CPU is blocked!
- Store the password at a safe place.

Depending on the CPU and the firmware version used, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this CPU type.

- **Function ... X<nr>**
  If the CPU has a configurable interface (connection X<nr>, nr = any number), this interface can be configured:
  - ‘Disabled’ – Deactivates the RS485 interface
  - ‘MPI/DP’ – This configuration is to be selected for CPUs whose PROFIBUS functionality is released by means of a feature set.
  - ‘MPI’ – In this operating mode, the interface serves as a connection between the programming device and the CPU via MPI. The configuration and programming, for example, take place by this means. Additionally, MPI serves the purpose of communication between several CPUs or between HMIs and the CPU.
  - ‘PtP’ – In this operating mode, the RS485 interface works as an interface for serial point-to-point communication. Here, you can exchange data serially between two stations using protocols.
  - ‘PROFIBUS DP async’ – PROFIBUS DP master operation asynchronous to the CPU cycle: CPU cycle and the cycles of all VIPA PROFIBUS DP masters at the CPU run independently.
  - ‘PROFIBUS DP syncIn’ – The CPU is waiting for DP master input data.
  - ‘PROFIBUS DP syncOut’ – The DP master system is waiting for CPU output data.
  - ‘PROFIBUS DP syncInOut’ – CPU and DP master system are waiting for each other thus forming cycle.

- **MPI address X<nr>**
  If the configurable interface X<nr> of the CPU (connection X<nr>, nr = any number) is set to MPI, here you can specify an MPI address for the interface.

- **MPI baud rate X<nr>**
  If the configurable interface X<nr> of the CPU (connection X<nr>, nr = any number) is set to MPI, here you can specify the baud rate for the MPI communication.

- **MPI HSA ...**
  This parameter serves to specify the highest MPI address and thereby to limit the range of MPI addresses. Currently, this parameter is not evaluated in the CPU.

- **Token Watch**
  Switching on or off the monitoring of the token time (PROFIBUS bus parameter). The token time is the time it takes until the token returns at the DP master.

- **Extended retentive memories**
  Number of retentive memory bytes starting from memory byte 0: If you enter 0, the value indicated at the ‘Retentive memory’ is applied. § Chap. 6.23.6 ‘Retentive memory’ page 123
If you enter a different value (unequal to 0), the values indicated at the ‘Retentive memory’ are overwritten.

‘Extended retentive memory timers’ Number of retentive timers starting from T0: If you enter 0, the value indicated at the ‘Retentive memory’ is applied. Chap. 6.23.6 ‘Retentive memory’ page 123

If you enter a different value (unequal to 0), the values indicated at the ‘Retentive memory’ are overwritten.

‘Extended retentive memory counters’ Number of retentive counters starting from Z0: If you enter 0, the value indicated at the ‘Retentive memory’ is applied. Chap. 6.23.6 ‘Retentive memory’ page 123

If you enter a different value (unequal to 0), the values indicated at the ‘Retentive memory’ are overwritten.

‘Priority OB …’ Here you can set a priority for the corresponding OB. By changing the prioritisation of asynchronous error OBs, you can influence the behaviour of the CPU in the case of an error and keep it in RUN for longer, if needed.

‘Diagnostic interrupt …’ Activate or deactivate diagnostic interrupts

‘Direct DX transition’ If this parameter is activated, the integrated PROFIBUS DP master, which is to be activated by means of the feature set, shows the following behaviour:

- If byte 0, bit 1 and byte 1, bit 0 both have the state 0 in the received standard diagnosis data of a DP slave, this DP slave is adopted directly into the data exchange, without a SetPrm and CheckConfig telegram being sent previously to the DP slave.
- When a DP slave is adopted into the data exchange, the state of the output data is preserved.
- If the CPU goes from RUN to STOP, the DP master is deactivated at least for the duration of the response monitoring time set in the PROFIBUS parameters. Afterwards, the DP master goes into RUN again. Here, the state of the output data of the connected DP slaves is preserved.
- If the voltage supply of the CPU fails, the state of the output data of the connected DP slaves is preserved.

‘PN MultipleWrite’ In the activated state, configuration datasets are grouped into one or several Ethernet frames under PROFINET during the establishing connection. This accelerates the establishing connection, since a different Ethernet frame is not used for each configuration dataset.

‘OB 28 and OB 29 priority’ Defines the order in which the interrupt organisation blocks are interrupted: OBs with the smallest number have lowest priority. OBs with priority 0 are not processed.

‘OB 3x Offset’ With this parameter, you can shift the start time for the time error interrupt OBs (OB 28, 29, 3x) relative to the system time and thus to the PROFINET send clock of the PROFINET IO controller. In this way, the time interval between the processing of the data in the interrupt OBs and the transmission of current data via PROFINET can be minimized, thus the response time of your system can be optimized.

Range of values: 0 (default) ... 999µs
‘OB 80 for cyclic interrupt error’  Defines for which interrupt organisation blocks the time error organisation block OB 80 is to be called.

6.23.14  PG/OP Ethernet

General

‘Name’ – Here you can assign a name to the Ethernet PG/OP channel.
‘Subnet ID’ – Here you can issue a subnet ID for your network.
‘PDU size’ – Here you can indicate the buffer size for the Ethernet PG/OP communication.
‘IP address’ – Here you can indicate an IP address for the Ethernet PG/OP channel.
‘Subnet mask’ – Here you can indicate a subnet mask for the Ethernet PG/OP channel.

Addresses

Here you can adapt the address range occupied by the Ethernet PG/OP channel. By acknowledging the entry with [Enter,] the address is adopted and the ‘end address’ is automatically calculated. Should an address already be occupied, you will receive a notification. Enter a different address.

6.23.15  General

Here you will find general information about the selected component, for example the ‘info’ under which the component in the ‘device configuration’ is listed.

6.23.16  I/O addresses

In the user program, the individual channels of a CPU component can be addressed via the symbolic I/O addresses (names). The allocated input and output addresses (I/O addresses) and the transfer range in the I/O address room of the selected component are presented in a table. You can change the I/O addresses, names and comments.
Fig. 88: I/O addresses of a CPU component

Each line corresponds to a channel of the CPU:

‘Address’ – Configured input or output address. To change the addresses: see Change I/O addresses.

‘Name’ – Name of the variables: Symbolic I/O address

Click on the input field to change the variable name.

‘Data type’ – Data type of the variables, e.g. “BOOL” for bit addresses. The data type is preset according to the channels and cannot be changed.

‘Comment’ – Any comment e.g. remark or explanation

Click on the input field to change the comment.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Data type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>ED 816</td>
<td>d_DL_CH01_684</td>
<td>DINT</td>
<td>E 816 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>ED 820</td>
<td>d_DL_CH02_684</td>
<td>DINT</td>
<td>E 820 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>ED 824</td>
<td>d_DL_CH03_684</td>
<td>DINT</td>
<td>E 824 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>ED 828</td>
<td>d_DL_CH04_684</td>
<td>DINT</td>
<td>E 828 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>AD 816</td>
<td>d_DO_RESERVED1_684</td>
<td>DWORD</td>
<td>A 816 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>AD 820</td>
<td>d_DO_RESERVED2_684</td>
<td>DWORD</td>
<td>A 820 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>AD 824</td>
<td>d_DO_RESERVED3_684</td>
<td>DWORD</td>
<td>A 824 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
<tr>
<td>AD 828</td>
<td>d_DO_RESERVED4_684</td>
<td>DWORD</td>
<td>A 828 - CPU 013-CCF8000 [Device, Slot 0, Subslot]</td>
</tr>
</tbody>
</table>

Address range

Depending on the number of channels, a CPU component occupies a different number of addresses.

Changing I/O addresses

1. Enter the new input or output address (byte address) in the suitable ‘Start address’ field.
   If this address is already occupied, a note pops up. Enter a different address.

2. Confirm your input with [Enter].
   The address is changed. If the component occupies several byte addresses, the ‘End Address’ is automatically calculated and the complete address range is assigned to the channels.
6.23.17 Inputs (digital)

The configurations for the functioning of digital inputs of your CPU can be made here. The number and type of parameters as well as the configuration possibilities differ depending on the CPU type, e.g. diagnostics and interrupt configurations, selection of the triggering edge and configuration of the input delay for the corresponding channel. Thus, the parameters are precisely tailored to the task of the selected CPU.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.23.18 Outputs (digital)

The configurations for the functioning of digital outputs of your CPU can be made here. The number and type of parameters as well as the configuration possibilities differ depending on the CPU type for the corresponding channel. Thus, the parameters are precisely tailored to the task of the selected CPU.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.23.19 Inputs (analogue)

The configurations for the functioning of analogue inputs of your CPU can be made here. The number and type of parameters as well as the configuration possibilities differ depending on the component type, e.g. diagnostics and interrupt configurations, function of the measured value encoder, measuring process and measuring ranges for the corresponding channel. Thus, the parameters are precisely tailored to the task of the selected analogue component.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.23.20 Outputs (analogue)

The configurations for the functioning of analogue outputs of your CPU can be made here. The number and type of parameters as well as the configuration possibilities differ depending on the component type for the corresponding channel. Thus, the parameters are precisely tailored to the task of the selected analogue component.

You will find a more detailed description of these parameters in the relevant manual of your component.
6.23.21 Basic parameters

‘Select interrupt’ Here you can determine which interrupts the CPU is to trigger. The following parameters are supported:

- None: The interrupt function is deactivated.
- Process: The event configured under the corresponding channel triggers a process interrupt.
- Diagnostics + Process: A diagnostic interrupt is triggered only in connection with process interrupt lost.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.23.22 Channel...

‘Operating mode’ By specifying an operating mode for the corresponding channel, all the required parameters are listed with their default values.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.23.23 Parameter

‘Operating mode’ Here you can edit the corresponding parameters of the selected CPU component. All the parameters are listed with their default values.

You will find a more detailed description of these parameters in the relevant manual of your component.

6.24 Properties of the module (SLIO modules)

You can change the properties of a component (signal module of the Slize I/O system). Depending on the component type, you can perform the following configurations:

- Show general properties, e.g. designation and order number  Chap. 6.24.1 'General' page 132
- I/O addresses  Chap. 6.24.2 'I/O addresses' page 132
- Parameters of communication processors, analogue, interface or functional modules  Chap. 6.24.3 'Parameter' page 134

Depending on the component type, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this component.
Selecting and configuring devices and components

Properties of the module (SLIO modules) > I/O addresses

1. Select one of the following options if you want to change the component properties:
   - **Project tree**: Within the PLC under 'Local components', double click on the desired component.
   - "**Device configuration**" editor: Double-click on the desired component.
   - The dialogue window ‘Component properties’ will open.

2. Click on the desired section, e.g. ‘I/O addresses’.
   - The page with the appropriate configurations will open.

3. Change the configurations, if necessary, and click on ‘OK’.
   - The changed properties are applied in the project configuration. After the changed configurations have been transferred (Chap. 5.10 ‘Transfer project’ page 69) and once the CPU has been started, the changed configurations are activated in the control.

6.24.1 General

General information on the selected component are displayed here.

‘**Info**’ – The info is shown in the project tree and in the device configuration. It contains, e.g., the number of channels, the voltage and/or current range.

‘**Order number**’ – Order number of the component.

6.24.2 I/O addresses

In the user program, the individual channels of a component can be addressed via the symbolic I/O addresses (names). The allocated input and output addresses (I/O addresses) and the transfer range in the I/O address room of the selected component are presented in a table. You can change the I/O addresses, names and comments.
Fig. 89: I/O addresses of a SLIO module

Each line corresponds to a channel of the component:

‘Address’ – Configured input or output address. To change the addresses: see Change I/O addresses.

‘Name’ – Name of the variables: Symbolic I/O address

Click on the input field to change the variable name.

‘Data type’ – Data type of the variables, e.g. “BOOL” for bit addresses. The data type is preset according to the channels and cannot be changed.

‘Comment’ – Any comment e.g. remark or explanation

Click on the input field to change the comment.

Address range

Depending on the number of channels, a component occupies a different number of addresses.

Examples:

- The digital output component “DO 8xDC24V” occupies one output byte.
- The digital input component “DI 4xDC24V” occupies the first four bits of an input byte. The remaining bits of this input byte cannot be used.
- The analogue input component “AI 4x12Bit” occupies four consecutive input words (corresponding to eight input bytes).

Changing I/O addresses

1. Enter the new input or output address (byte address) in the suitable ‘Start address’ field.

If this address is already occupied, a note pops up. Enter a different address.
2. Confirm your input with [Enter].

   The address is changed. If the component occupies several byte addresses, the ‘End Address’ is automatically calculated and the complete address range is assigned to the channels.

---

6.24.3 Parameter

Here you can configure parameters of communication processors, analogue, interface or functional modules. The number and type of parameters as well as the configuration possibilities differ depending on the component type, e.g. diagnostics and interrupt configurations, parameters for analogue modules, bus parameters for interface modules. Thus, the parameters are precisely tailored to the task of the selected component.

6.25 Component properties (MICRO modules)

You can change the properties of a component (signal module of the MICRO control system). Depending on the component type, you can perform the following configurations:

- Show general properties, e.g. designation and order number
- I/O addresses

Depending on the component type, there are different configuration options. Selection or input fields highlighted in grey cannot be edited for this component.

1. Select one of the following options if you want to change the component properties:
   - Project tree: Within the PLC under ‘Local components’, double click on the desired component.
   - "Device configuration" editor: Double-click on the desired component.
     - The dialogue window ‘Component properties’ will open.

2. Click on the desired section, e.g. ‘I/O addresses’.
   - The page with the appropriate configurations will open.

3. Change the configurations, if necessary, and click on ‘OK’.
   - The changed properties are applied in the project configuration. After the changed configurations have been transferred ( Chap. 5.10 ‘Transfer project’ page 69) and once the CPU has been started, the changed configurations are activated in the control.

6.25.1 General

General information on the selected component are displayed here.
‘Info’ – The info is shown in the project tree and in the device configuration. It contains, e.g., the number of channels, the voltage and/or current range.

‘Order number’ – Order number of the component

6.25.2 I/O addresses

Fig. 90: I/O addresses of a MICRO module

Each line corresponds to a channel of the component:

‘Address’ – Configured input or output address. To change the addresses: see Change I/O addresses.

‘Name’ – Name of the variables: Symbolic I/O address

  Click on the input field to change the variable name.

‘Data type’ – Data type of the variables, e.g. “BOOL” for bit addresses. The data type is preset according to the channels and cannot be changed.

‘Comment’ – Any comment e.g. remark or explanation

  Click on the input field to change the comment.
Depending on the number of channels, a component occupies a different number of addresses.

Examples:
- The digital output component "DO 16xDC24V" occupies two consecutive output bytes, e.g. Byte A4 and A5.
- The digital input component "DI 16xDC24V" occupies two consecutive input bytes.
- The analogue input component "AI 4x16Bit" occupies four consecutive input words (corresponding to 8 input bytes).

### Address range

**Changing I/O addresses**

1. Enter the new input or output address (byte address) in the suitable ‘Start address’ field.
   
   If this address is already occupied, a note pops up. Enter a different address.

2. Confirm your input with [Enter].
   
   ⇒ The address is changed. If the component occupies several byte addresses, the ‘End Address’ is automatically calculated and the complete address range is assigned to the channels.

*To edit I/O addresses for all projected components of the control:*

Chap. 8.12 ‘Address overview’ page 255

### 6.25.3 Parameter

Here you can configure parameters of the MICRO system modules. The number and type of parameters as well as the configuration possibilities differ depending on the component type, e.g. diagnostics and interrupt configurations, parameters for analogue modules, bus parameters for interface modules. Thus, the parameters are precisely tailored to the task of the selected component.

*You will find a more detailed description of these parameters in the relevant manual of your component.*

### 6.26 Export all (WLD)

You can archive the hardware configuration along with the user program as a WLD file.

1. Select one of the following options:
   - **Menu bar:** Select ‘Device ➤ Export all (WLD).’
   - **Project tree:** Right-click with the mouse button on the desired control (PLC) and select ‘Export all (WLD).’

2. If you have made changes in the project which have not yet been compiled ( Chap. 8.16 ‘Compile user program’ page 268), a dialogue window will open. You can choose whether to cancel the procedure or to archive in the last compiled state. All uncompiled changes in the project will not be saved.
   
   ⇒ The ‘Save as’ dialogue window will open.
3. Select a directory, enter a file name and click on ‘Save’.
   ⇒ The hardware configuration and the user program are archived.

6.27 Export user program (WLD)

You can archive the user program as a WLD file.

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Export user program (WLD)’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Export user program (WLD)’.

2. If you have made changes in the project which have not yet been compiled (Chap. 8.16 ‘Compile user program’ page 268), a dialogue window will open. You can choose whether to cancel the procedure or to archive in the last compiled state. All uncompiled changes in the project will not be saved.
   ⇒ The ‘Save as’ dialogue window will open.

3. Select a directory, enter a file name and click on ‘Save’.
   ⇒ The user program is archived.

6.28 Export hardware configuration (WLD)

You can archive the hardware configuration as a WLD file.

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Export hardware configuration (WLD)’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Export hardware configuration (WLD)’.
   ⇒ The ‘Save as’ dialogue window will open.

2. Select a directory, enter a file name and click on ‘Save’.
   ⇒ The hardware configuration is archived.

6.29 Copy RAM to ROM

With this function, you can store the project from the working memory (RAM) of the control on a MMC (Multimedia Card).

1. Switch the control into the operating mode STOP.

2. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Copy RAM to ROM’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Copy RAM to ROM’.
   ⇒ A dialogue window will display whether the project has been saved successfully on the MMC.
6.30 “Component state” editor

Here you are provided with the following information on the connected control (PLC):

- General information, e.g. device name, serial number, order number, version
- Information on blocks and operands used
- Communication information
- Memory information
- Diagnostic buffer
- Cycle times
- Block, interruption and local data stack (B-Stack, U-Stack, L-Stack)

If a project is open and a control is included, you can open the ‘Component state’ editor.

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Component state’.
   - **Keyboard**: Press [Ctrl]+[D].
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Component state’.
   - **Editor "Devices and networking"**: Right-click with the mouse button on the desired control (PLC) and select ‘Component state’.
   - **CPU control centre**: Click on .

   Information is read from the connected control and shown in the ‘Component state’ editor.

2. Click on the desired section, e.g. ‘Blocks’.

   The page with the desired information will open.

Refresh information

**Refresh**: The information is read again from the connected control and shown.

6.30.1 General

Here you are provided with general information on the connected control.

To read the information again from the connected control, click on .

- ‘Name of station’
- ‘Device name’ – Chap. 6.23.1 ‘General’ page 119
- ‘Plant designation’ – Chap. 6.23.1 ‘General’ page 119
- ‘Location designation’ – Chap. 6.23.1 ‘General’ page 119
- ‘Serial number of PLC’
- ‘Serial number of the MMC or SD card’
- ‘Order number’
- ‘Version of module’ – Output status of the hardware
- ‘Name’ – Extended order designation, e.g. Version information
‘Firmware’ – Firmware version of the control (CPU)
‘Active interface’ – communication connection with the control  Ch. 6.20.2 ‘Communication settings (PLC)’ page 111
‘Address’ – IP address (Ethernet connection) or MPI-address (serial connection) of the control
‘Network’ – IP address of the network interface card of the programming device

The following information is also shown in the CPU control centre Ch. 4.17 ‘CPU control centre’ page 49:
Device name, order number, firmware, active interface, address.

6.30.2 Blocks

Here you are provided with information on the blocks of the connected control.

<table>
<thead>
<tr>
<th>Blocks:</th>
<th>Address areas:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max. number of OBs: 23</td>
<td>Process image inputs: 256 Byte From: 0 To: E255.7</td>
</tr>
<tr>
<td>Max. number of FBs: 2.048</td>
<td>Process image outputs: 256 Byte From: A0 To: A255.7</td>
</tr>
<tr>
<td>Max. number of FCs: 2.048</td>
<td>Bit Memory: 8.192 Byte From: M0 To: M8191.7</td>
</tr>
<tr>
<td>Max. number of DBs: 4.096</td>
<td>Timers: 512 Byte From: T0 To: T511</td>
</tr>
<tr>
<td>Max. number of SDBs: 4.096</td>
<td>Counter: 512 Byte From: Z0 To: Z511</td>
</tr>
<tr>
<td>Block list:</td>
<td>Local data: 11.2564 Byte</td>
</tr>
</tbody>
</table>

**Fig. 91: Component state, blocks**

To read the information again from the connected control, click on 🖼️

**Blocks**

Here, the number of different blocks is shown that can be used for the user program. In addition, the maximum size of a block is shown in kByte.
Here, the size and ranges of the inputs, outputs, memories, timers, counters and local data are shown that can be used for the user program.

Block list

Here, the number of the OB, FC, FB and DB blocks are shown that are loaded in the control.

In addition, the numbers of the SDB, SFB and SFC system blocks contained in the firmware as well as pre-defined OBs are shown.

6.30.3 Communication

Here you are provided with data on the communication information of the connected control.

<table>
<thead>
<tr>
<th>Communication information of connected component:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of reserved PG communications: 1</td>
</tr>
<tr>
<td>Number of occupied PG communications: 1</td>
</tr>
<tr>
<td>Number of reserved OP communications: 1</td>
</tr>
<tr>
<td>Number of occupied OP communications: 0</td>
</tr>
<tr>
<td>Number of unreserved communications: 30</td>
</tr>
<tr>
<td>Number of occupied, unreserved communications: 0</td>
</tr>
<tr>
<td>Number of configured communications: 0</td>
</tr>
<tr>
<td>Number of occupied, configured communications: 0</td>
</tr>
<tr>
<td>Max. communication load: 20 %</td>
</tr>
<tr>
<td>Max. number of communications: 32</td>
</tr>
<tr>
<td>Number of reserved S7 communications: 0</td>
</tr>
</tbody>
</table>

Fig. 92: Component state, communication

To read the information again from the connected control, click on 🌐.

For each communication connection, connection resources are required on the devices involved. The connection resources are the maximum possible connections of a device. The number of connections differs depending on the component. If all connection resources of a communication partner are used (occupied), no further connection can be established.
**reserved**: For connections between certain communication partners, connection resources can be reserved that cannot be occupied by other connections. You can reserve connection resources with Siemens SIMATIC NetPro.

**configured**: Number of connections configured in the project, e.g. connections between this CPU and another CPU

**occupied**: Number of actually created connections

### Example of reserved connections

If, for example, you use a type 315-2AG13 CPU, you can use a maximum of 32 connections. As standard, one connection each is reserved for communication with a programming device (PD) and an HMI device (OP). Thus, the remaining connection resources (number of unreserved connections) decrease by two connections. The following information is shown:

| Number of reserved PD connections | 1 |
| Number of reserved OP connections | 1 |
| Number of unreserved connections | 30 |
| Maximum number of possible connections | 32 |

### Example of used connections

In addition to the reserved connections, you can also create (use) further connections to a communication partner if there are still connection resources available. Example:

| Number of reserved PD connections | 1 |
| Number of PD connections used | 1 |
| Number of reserved OP connections | 1 |
| Number of OP connections used | 4 |
| Number of unreserved connections | 30 |
| Number of occupied, unreserved connections | 3 |
| Maximum number of possible connections | 32 |

### Example of configured connections

You can configure connections to a communication partner, e.g. a connection to another CPU. Example:

| Number of configured connections | 1 |
| Number of occupied, configured connections | 1 |

*‘Number of reserved/occupied PD connections’* – Connection resources that are reserved or actually created for connections between the control and programming devices

*‘Number of reserved/occupied OP connections’* – Connection resources that are reserved or actually created for connections between the control and HMI devices

*‘Number of unreserved connections’* – Free connection resources

*‘Number of occupied, unreserved connections’* – Actually created connections that are not reserved

*‘Number of configured connections’* – Other connections configured in the project
‘Number of occupied, configured connections’ – Other actually created connections configured in the project

‘Max. communication load’ – Percentage of communication processes compared to the complete cycle time. You can configure this proportion using the parameter “Scan cycle load from Communication”. § Chap. 6.23.5 ‘Cycle / Clock memory’ page 122

‘Max. number of possible connections’ – Maximum number of connections (dependent on the device type)

‘Number of reserved basic S7 connections’ – Reserved connection resources for non-projected connections, e.g. for data exchange using communication functions in the user program

6.30.4 Memory

Here you are provided with data on the memory of the connected control.

Fig. 93: Component state, memory

To read the information again from the connected control, click on 👇.
Working and load memory

- **Load memory**: The compiled user program and system data (e.g., configuration information, connection information, component parameters) are saved in the load memory.
- **Working memory**: The compiled user program is copied into the working memory. The code and the user program data are processed there.

Three bar charts show the percentage of memory occupancy:

- User program in the working memory
- Data blocks in the working memory
- Load memory

The available memory space, the occupied memory space and the percentage of occupancy of the individual memories are shown under the bar charts.

Detailed memory information

The table shows the distribution for the following memory types:

- **Working memory** – Code and user program data
- **Integrated load memory** – Permanently available load memory in the CPU
- **Plugged load memory** – External memory card connected to the CPU slot
- **Pluggable load memory** – Memory space for external memory cards

The table lines contain the following information:

- ‘**Size of memory**’ – Maximum total available memory space
- ‘**Size of non static memory**’ – Maximum memory space available in the non-retentive memory
- ‘**Assigned non static memory**’ – Actually occupied memory space in the non-retentive memory
- ‘**Largest free block in the non static memory**’ – Largest cohesive block available in the non static memory. If this block is smaller than the maximum memory space minus the occupied memory space, then the memory is fragmented.
- ‘**Size of static memory**’ – Maximum memory space available in the retentive memory
- ‘**Assigned static memory**’ – Actually occupied memory space in the retentive memory
- ‘**Largest free block in the static memory**’ – Largest cohesive block available in the static memory. If this block is smaller than the maximum memory space minus the occupied memory space, then the memory is fragmented.

6.30.5 Diagnostic buffer

The content of the diagnostic buffer of the connected control is shown here. The diagnostics messages are saved and shown in the order of their occurrence. The number of diagnostics messages that can be shown differs depending on the component, e.g., 100 messages with the CPU of type 315-2AG13. Other diagnostics messages can be present in the component that are not shown here.
To read the information again from the connected control, click on 🔄.

**Details**

Detailed information is available with some diagnostics messages.

To show further information under ‘Details’, click on a diagnostics message.

**Changing the sort sequence**

The diagnostics messages are sorted in the order of their occurrence (column ‘No.’). The newest message is first. You can also sort the diagnostics messages shown in a different order.

In the title line of the table, click on the term according to which you would like to sort the diagnostics messages, e.g. ‘Description’.

- The table entries are sorted in alphabetical or numerical order:
  - In ascending order
  - In descending order

**Export diagnostics messages**

You can export the diagnostics messages into an XPS file (XML paper specification format).

1. Click on ‘Export’.
   - A dialogue window will open allowing you to save the XPS file.

2. Select a directory and enter a file name.

3. Click on ‘Export’.
   - The export process is started. All diagnostics messages are saved in the XPS file. You can then open and print the file, e.g. with the XPS Viewer.
6.30.6 Cycle times

Here you are provided with the cyclic data of the connected control.

![Cycle data of connected device]

**Fig. 95: Component state, cycle times**

To read the information again from the connected control, click on 🔄.

'Max. parametrised cycle time' – Maximum duration of a program processing cycle (time base: milliseconds). You can configure the cycle time using the parameter "Scan cycle monitoring time". Chap. 6.23.5 ‘Cycle / Clock memory’ page 122

'Shortest cycle time’ – Shortest measured program processing cycle since the last transition from STOP to RUN (time base: milliseconds)

'Current cycle time' – Duration of the most recently run program processing cycle (time base: milliseconds)

'Longest cycle time’ – Longest measured program processing cycle since the last transition from STOP to RUN (time base: milliseconds)

The cyclic data measured is also shown in the CPU control centre. Chap. 4.17 ‘CPU control centre’ page 49

6.30.7 B-Stack/U-Stack/L-Stack

Here you are provided with information on the following memory ranges of the connected control:

- Block stack (B-Stack)
- Interruption stack (U-Stack)
- Local data stack (L-Stack)
Information is saved in the stacks if the CPU either reaches a breakpoint or changes to operating mode STOP due to a stop command or an error in the user program.

To read the information again from the connected control, click on 🔄.

**Block stack (B-Stack)**

If the following events occur, the operating system saves the CPU data in the block stack:

- The processing of a block is interrupted by the calling of another block.
- The processing of a block is interrupted by a higher priority class, e.g. interrupt OB or error treatment.

The block stack shows all the blocks the processing of which was not completed at the time when the CPU was put into operating mode STOP. The block that was called last in the calling hierarchy is shown first.

The following block data are shown:

- 'Block' – Block that was interrupted
- 'DB1 register' – Data block from the DB1 register that was open at the time of the interruption
- 'DB2 register' – Data block from the DB2 register that was open at the time of the interruption
- 'Priority class' – priority class that was interrupted
If the program processing is interrupted by an organisation block with higher priority, the operating system saves the following data in the interruption stack (U-Stack):

- Current contents of the accumulators and address registers
- Number and size of the open data blocks

In the block stack, select the organisation block for which you would like to show the interruption stack data.

⇒ The interruption stack of the selected organisation block is shown.

‘Accu 1..4’ – Contents of the accumulators
‘AR 1..2’ – Contents of the address register
‘Status word’ – Contents of the first bits (0..8) of the status word: /FC, RLO, STA, OR, OS, OV, CC0, CC1 and BR
‘Interrupted block’ – Block that was interrupted
‘Last relative byte address’ – Point in the program code at which the program was interrupted
‘Continue in block’ – Block in which the interrupted program is continued
‘Next relative byte address’ – Point in the program code at which the program is continued
‘DB1 register’ – Data block from the DB1 register that was open at the time of the interruption
‘DB2 register’ – Data block from the DB2 register that was open at the time of the interruption

Local data stack (L-Stack)

The local data stack contains the local data values of the blocks that were open at the time when the CPU was put into operating mode STOP.

Local data are the temporary data of a block. Chap. 6.23.7 ‘Local data’ page 123
Alongside the temporary and interface variables in the user program as well as intermediate results in ladder diagrams, further local data are required for each organisation block. The size of the local data stacks differs depending on the component.

In the block stack, select the block for which you would like to show the local data stack.

⇒ The local data stack of the selected block is shown.

6.31 Set time

Here you can set the clock of the connected control.
Fig. 97: Set time

If a project is open and a control is included, you can set the clock of the control. Create a communication connection to the control. © Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Set time’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Set time’.
   - **Editor “Devices and networking” ➔”**: Right-click with the mouse button on the desired control (PLC) and select ‘Set time’.
   - The ‘Set time’ dialogue window will open.
     
     The time and date of the programming device (PC) and the connected control (device) are shown in the dialogue window. Click on ‘Refreshing’ to read the time and date from the control again and to show them.

2. Select ‘Take PC time’ to adopt the time and date of the programming device into the control.
   - or -
   
   Enter a time and a date into the input fields under ‘Device’.

3. Click on ‘Apply’.
   - The desired time and the desired date are adopted into the control. The processing steps are shown in the ‘Status’ field.

Reading of time is done.
6.32 Memory reset

With memory reset, you can reset the connected control to the “initial state”:
- The working memory is completely deleted.
- The data on the memory card of the load memory are preserved.

To ensure that there are no more undesired blocks in the CPU, you must carry out a memory reset of the control before loading the user program.

Fig. 98: Memory reset

If a project is open and a control is included, you can carry out a memory reset of the CPU.
Create a communication connection to the control. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Memory reset’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Memory reset’.
   - **Editor "Devices and networking"**: Right-click with the mouse button on the desired control (PLC) and select ‘Memory reset’.
   - **CPU control centre**: Click on .

   △ The ‘Memory reset’ dialogue window will open.

   Information on the control selected in the project and the connected control as well as on the communication connection between the programming device and the control are shown in the dialogue window.

2. Click on ‘Memory reset’.

   △ If the control is not in operating mode STOP, a dialogue window will open in which you can switch the control into operating mode STOP. After having carried out a memory reset, a dialogue window will open in which you can switch the control into operating mode RUN again.

   The memory reset processing steps are shown in the ‘Status’ field.

6.33 Online diagnostics (SLIO module)

In the online diagnostics, information about SLIO module is displayed, e.g. position of the module, I/O address, status of the component and diagnostic interrupts.

Create a communication connection to the control Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

Select one of the following options:

   - **Project tree**: Right-click with the mouse button on the desired SLIO module and select ‘Online diagnostics’.
   - **“Device configuration” editor**: Right-click with the mouse button on the desired SLIO module and select ‘Online diagnostics’.

   △ The diagnostics window will open.

6.33.1 General

General diagnostic information on the selected module are displayed here.

To read the information again from the connected control, click on .

‘Short description’ – Module name
‘Order number’ – Order number of the module
‘Device name’ – Name of the control
‘Rack’ – Number of the rack if there are several racks
‘Slot’ – Slot number within the control or the rack
‘Address’ – Configured start address (byte address) of the module
6.33.2 Diagnostic interrupt

Detailed diagnostic information on the selected module are displayed here.

To read the information again from the connected control, click on "Status" – Diagnostic information about the module, e.g. “Module present”

– Diagnostic interrupt

Detailed diagnostic information on the selected module are displayed here.

To read the information again from the connected control, click on "Status" – Diagnostic information about the module, e.g. “Module present”

– Standard diagnostics – Vendor-related diagnostic texts, e.g. "Module on wrong slot"

– Channel specific diagnostics – Channel-related diagnostic texts with channel number and error code, e.g. "Line break"

6.34 Online diagnostics (MICRO module)

In the online diagnostics, information about a module of the MICRO system is displayed, e.g. position of the module, I/O address, status of the component and diagnostic interrupts.

Create a communication connection to the control Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

Select one of the following options:

- **Project tree**: Right-click with the mouse button on the desired module and select ‘Online diagnostics’.
- **Device configuration** editor: Right-click with the mouse button on the desired module and select ‘Online diagnostics’.

› The diagnostics window will open.

6.34.1 General

General diagnostic information on the selected module are displayed here.

To read the information again from the connected control, click on "Status" – Diagnostic information about the module, e.g. “Module present”

- **Order number** – Order number of the module
- **Device name** – Name of the control
- **Rack** – Number of the rack if there are several racks
- **Slot** – Slot number within the control or the rack
- **Address** – Configured start address (byte address) of the module

6.34.2 Diagnostic interrupt

Detailed diagnostic information on the selected module are displayed here.

To read the information again from the connected control, click on "Status" – Diagnostic information about the module, e.g. “Module present”
‘Channel specific diagnostics’ – Channel-related diagnostic texts with channel number and error code, e.g. "Line break"
7 Connect devices

7.1 Bus system properties (PROFIBUS DP)

Here you can configure the PROFIBUS DP master and the connected slaves.

1. In the project tree within a control, click on ‘Bus system properties’, under ‘Decentralised periphery’, ‘DP master system’.
   - The ‘Bus system properties’ dialogue window will open.

2. Select an object from the list on the left, and then a tab, in order to make configurations for this object:
   - DP master system – General configurations
   - DP master system – Bus parameter
   - DP master system – Address overview
   - DP master – General configurations
   - DP master – Addresses
   - DP slave – General configurations
   - DP slave – Station parameters
   - Component – General configurations
   - Component – I/O addresses
7.1.1 DP master system – General configurations

Fig. 101: DP master system: General configurations

‘Bus name’ – Name for the DP master system

‘IO-system-no’ – Number between 1 and 9, for the differentiation of several DP master systems within one project

‘Subnet ID’ – Address for the communication with connection partners via routing functions, e.g. via teleservice.
7.1.2 DP master system – Bus parameter

Fig. 102: DP master system: bus parameter

‘Highest PROFIBUS address’ – Highest station address (HSA) of an accessible partner in the PROFIBUS DP network

‘Baud rate’ – Baud rate of the data in the PROFIBUS DP network

7.1.3 DP master system – Address overview

Fig. 103: DP master system: Address overview
Each table line corresponds to a cohesive address range of a component:

'No.' – Consecutive number
'Device' – Device name and device type of the slave
'Component' – Component (module) within the slave
'Slot' – Slot number within the rack
'I-Address' – Configured input address (byte address) of an input component. To change the addresses, see below.
'O-Address' – Configured output address (byte address) of an output component. To change the addresses, see below.
'Order number' – Order number of the component

Editing address ranges

You can change the address areas:

1. Select ['Inputs' and/or 'Outputs'].
   - The table lists all projected input or output modules.
2. Highlight the desired module in the table.
   - In the fields 'Start address' and 'End Address', the current address attribution (byte address) of the module is displayed.
     Example of input addresses: Start address = 8, end address = 9 – The module occupies the two input bytes E8 and E9.
3. Select the new input or output address in the field 'Start address'.
   - If this address is already occupied, a note pops up. Enter a different address.
   - The address is changed in the selected module.

To edit I/O addresses for all projected components of the control:
- Chap. 8.12 'Address overview' page 255
7.1.4 DP master – General configurations

Fig. 104: Control: General configurations

‘Device name’ – Device name of the control

‘DP address master’ – Station address of the integrated PROFIBUS DP master

7.1.5 DP master – Addresses

Fig. 105: Control: Addresses
'Interface' – Input address (byte address) for the exchange of diagnostics data between CPU and DP master system

7.1.6 DP slave – General configurations

Fig. 106: Slave: General configurations

'Device name' – Device name of the slave

'DP address station' – Station address of the slave

'Interface' – Input address (byte address) for the exchange of diagnostics data between CPU and slave
7.1.7 DP slave – Station parameters

Fig. 107: Slave: Station parameters

‘DP interrupt mode’ – Mode of the interrupt version

DPV1 mode: In case of an interrupt, the slave will trigger the interrupt OB's activated here.

DPV0 mode: The slave will not trigger any interrupt.

‘Station parameters’ – Manufacturer specific parameters from the GSD file.
7.1.8 Component – General configurations

*Fig. 108: Component: General configurations*

‘Info’ – Component name

‘Order number’ – Order number of the component

7.1.9 Component – I/O addresses

*Fig. 109: Component: I/O addresses*
Each table line corresponds to a channel of the component:

‘Address’ – Configured input or output address. To change the addresses, see below

‘Name’ – Name of the variables: Symbolic I/O address

‘Data type’ – Data type of the variables, e.g. "BOOL" for bit addresses. The data type is preset according to the channels and cannot be changed.

‘Comment’ – Any comment e.g. remark or explanation

Editing address ranges

You can change the address areas:

Select the new input or output address in the field ‘Start address’.

If this address is already occupied, a note pops up. Enter a different address.

In the fields ‘Start address’ and ‘End Address’, the current address attribution (byte address of the component is displayed).

Example of input addresses: Start address = 8, end address = 9 – The component occupies the two input bytes E8 and E9.

To edit I/O addresses for all projected components of the control:

Chap. 8.12 ‘Address overview’ page 255

7.2 Online diagnostics of the bus system (PROFIBUS DP)

You can monitor the PROFIBUS DP system using the online diagnostics. You receive diagnostic information on devices and components.

1. In the project tree within a control, click on ‘Online diagnostics of the bus system’, under ‘Decentralised periphery’, ‘DP master system’.

The ‘Online diagnostics of the bus system’ dialogue window will open.
Select an object from the list on the left, and then a tab, in order to show the diagnostic information for this object.

- PROFIBUS DP – General
- Controller – General
- Device – General
- Device – Diagnostics
- Module – General
- Module – Diagnostics
7.2.1 PROFIBUS DP – General

Bus information

‘Bus name’ – Name for the PROFIBUS DP system

‘IO-system no’ – Number for the differentiation of several PROFIBUS DP systems within one project

Status

Status information of the PROFIBUS DP system:
### 7.2.2 Controller – General

**Device information**

- **Device name** – Device name of the control (controller)
- **System recognition** – Identification of the automation system
- **Diagnostic address** – Input address (byte address) for the exchange of diagnostic data between CPU and PROFIBUS DP system

**Bus information**

- **Bus name** – Name for the PROFIBUS DP system
- **IO-system no.** – Number for the differentiation of several PROFIBUS DB systems within one project

**Status**

Status information of the controller.

---

**Fig. 113: Online diagnostics controller: General**

- Connect devices
  - Online diagnostics of the bus system (PROFIBUS DP) > Controller – General

**SPEED7 Studio**

- Connect devices
  - Online diagnostics of the bus system (PROFIBUS DP) > Controller – General
7.2.3 Device – General

Fig. 114: Online diagnostics device: General

**Device information**

- *Device name* – Device name of the device (DP slave)
- *Diagnostic address* – Input address (byte address) for the exchange of diagnostic data between controller and DP slave
- *Hardware version* – Output version of the hardware of the device
- *Firmware version* – Output version of the firmware of the device

**Bus information**

- *Bus name* – Name for the PROFIBUS DP system
- *IO-system no.* – Number for the differentiation of several PROFIBUS DP systems within one project

**Status**

Status information of the device.
7.2.4 Device – Diagnostics

**Fig. 115: Online diagnostics device: Diagnostics**

**Standard diagnostics**
Vendor-related diagnostic texts of the DP slave:

**Examples of standard diagnostics**
- "Slot No. 3: Correct module"
- "Slot No. 1: Module on wrong slot"

**Channel-specific diagnostics**
Channel-related diagnostic texts for all modules of the DP slave; each channel is described by the slot of the component and the channel number:

**Examples of channel-specific diagnostics**
- "Slot No. 3 Subslot No. 1 Channel No. 0: Line break"
- "Slot No. 5 Subslot No. 1 Channel No. 3: short circuit"
7.2.5 Module – General

![Module Configuration](image)

**Device information**

- **Device name** – Name of the module
- **Input addresses** – Area of the input addresses (byte) assigned to the module
- **Output addresses** – Area of the output addresses (byte) assigned to the module
- **Slot** – Slot of the module
- **Hardware version** – Output version of the hardware of the module

**Status**

Status information of the module.
7.2.6 Module – Diagnostics

![Diagram of an online diagnostics module: Diagnostics](image)

**Fig. 117: Online diagnostics module: Diagnostics**

**Standard diagnostics**
Vendor-related diagnostic texts of the module:

- **Examples of standard diagnostics**
  - "Correct module"
  - "Module on wrong slot"

**Channel-specific diagnostics**
Channel-related diagnostic texts of the module:

- **Examples of channel-specific diagnostics**
  - "Channel No. 0: Line break"
  - "Channel No. 3: short circuit"

7.3 Bus system properties (PROFINET-IO system)

Here you can make general configurations for the PROFINET-IO system.
1. In the project tree within a control, click on ‘Bus system properties’, under ‘Decentralised periphery’, ‘PROFINET-IO system’. ⇨ The ‘Bus system properties’ dialogue window will open.

![Fig. 118: Bus system properties](image)

![Fig. 119: Dialogue window "Bus system properties"](image)

2. Select an object from the list on the left, and then a tab, in order to be able to make configurations for this object:
   - PROFINET-IO system – General configurations
   - PROFINET-IO system – IO cycle
   - PROFINET-IO system – Address overview
   - IO controller – General configurations
   - IO controller – addresses
   - IO controller – I device
   - IO controller – I/O configuration
   - IO device – General configurations
   - IO device – IO cycle
   - IO device – Parameter
   - IO module – General configurations
7.3.1 PROFINET-IO system – General configurations

Fig. 120: PROFINET-IO system: General configurations

‘Bus name’ – Name for the PROFINET-IO system

‘IO-system no’ – Number for the differentiation of several PROFINET-IO systems within one project

‘Subnet ID’ – Address for the communication with connection partners via routing functions, e.g. via teleservice.
7.3.2 PROFINET-IO system – IO cycle

Fig. 121: PROFINET-IO system: IO cycle

‘Send clock’ – Smallest possible transmission interval for the data exchange of the RT or IRT communication

Each table line corresponds to a PROFINET accessible partner:

‘No.’ – Consecutive number

‘Name’ – PROFINET accessible partner

‘Bus name’ – PROFINET device name (IO device)

‘Type’ – Device type

‘Time (µs)’ – Calculated refresh interval  © Chap. 7.3.9 ‘IO device – IO cycle’ page 179
### 7.3.3 PROFINET-IO system – Address overview

Each table line corresponds to a cohesive address range of an accessible partner:

- **‘No.’** – Consecutive number
- **‘Device’** – Device name and device type
- **‘Component’** – Component (module) within the accessible partner
- **‘Slot’** – Slot number within the rack
- **‘I-Address’** – Configured input address (byte address) of an input component. To change the addresses, see below.
- **‘O-Address’** – Configured output address (byte address) of an output component. To change the addresses, see below.
- **‘Order number’** – Order number of the accessible partner or component

#### Editing address ranges

You can change the address areas:

1. **Select** [ ] **‘Inputs’ and/or ‘Outputs’**.
   - The table lists all projected input or output modules.
2. **Highlight** the desired module in the table.
   - In the fields **‘Start address’ and ‘End Address’**, the current address attribution (byte address) of the module is displayed.
   - Example of input addresses: Start address = 8, end address = 9 – The module occupies the two input bytes E8 and E9.
3. **Select** the new input or output address in the field **‘Start address’**.
   - If this address is already occupied, a note pops up. Enter a different address.
   - The address is changed in the selected module.
7.3.4 IO controller – General configurations

In the dialogue window “Search for accessible partners”, you can set the PROFINET device name and perform a factory reset of the IO controller.

Chap. 6.21 ‘Search for accessible partners’ page 115
7.3.5 IO controller – addresses

Fig. 124: IO controller: Addresses

‘Interface’ – Input addresses (byte address) for the exchange of diagnostic data between CPU and PROFINET-IO system

‘PROFINET IO system’ – diagnostic address for fault message from the IO controller, e.g. in the event of a PROFINET IO system malfunction
7.3.6 IO controller – I device

Fig. 125: IO controller: I device

‘I device mode’ – Activate device as an intelligent IO device (I device)  Chap. 6.7 ‘Add control (CPU) as a PROFINET IO device (I device)’ page 90

‘IO system’ – Higher-level control to which the IO controller is connected as an I device:
- “PLC_xx”: Control to which the device is connected as an I device
- “—”: Disconnecting an I device from the PROFINET IO system

‘Add OB83/OB86 add’ – Add organisation blocks which are required for operating the IO controller as an I device

‘Diagnostic address’ – Input address (byte address) for exchanging diagnostic data between the higher-level control and the I-device
### 7.3.7 IO controller – I/O configuration

![Fig. 126: IO controller: I/O configuration](image)

In the I/O configuration, you can reserve address ranges as transfer ranges when you connect the device to the PROFINET IO system as an I device, see Chap. 7.3.6 ‘IO controller – I device’ page 175.

Each line of the table corresponds to a reserved transfer range for I/O data exchange between the master (higher-level control) and the slave (I device)

- **‘Slot’** – Slot number within the higher-level control rack
- **‘Address controller’** – Start address (byte address) of the transfer range in the higher-level control
- **‘I device address’** – Start address (byte address) of the transfer range in the I device
- **‘Length’** – Length of the transfer range from the start address in bytes
- **‘Direction’** – Data direction:
  - **‘Controller -> I device’**: Output data from the higher-level control = input data for the I device
  - **‘I device -> controller’**: Output data from the I device = input data for the higher-level control

#### Adding address ranges

You can add I/O address ranges:

1. Click on ‘Add’.

   ⇒ The dialogue window for configuration of the transfer range will open.
2. Select the address type ‘Output’ for the IO controller if you want to configure the transfer range for the data direction ‘controller -> I device’.

   - or -

   Select the address type ‘Input’ for the IO controller if you want to configure the transfer range for the data direction ‘I device -> controller’.

   ⇒ The opposite address type is automatically configured in the I device.

3. Enter the start address for the transfer range in the ‘Start’ input field in the address space for the higher-level control (IO controller).

4. Enter the start address for the transfer range in the ‘Start’ input field in the address space for the I device.

5. Enter the length of the transfer range which should be reserved in both devices in the ‘Length’ input field.

   If an address range is already reserved, a notification will appear. Enter another address range.

6. Click on ‘OK’ to finalise the input.

   - or -

   Click on ‘Accept’ if you want to reserve additional address ranges. Then click on ‘OK’.

   ⇒ All transfer ranges added are applied in the table.

### Deleting address ranges

Mark the desired lines of the table and click on ‘Remove’.

⇒ The lines of the table are deleted and the reservation of the transfer range is cancelled.
7.3.8 IO device – General configurations

The dialogue window includes information about the IO device, such as device type, order number, etc.

- **Device name** – Device name of the accessible partner (IO device)
- **Bus device name** – PROFINET device name (IO device)
- **Device number** – Configured device number
- **Interface** – Input address (byte address) for the exchange of diagnostics data between IO controller and IO device
- **IP Address** – Address of the accessible partner in the PROFINET-IO network

![Image of the dialogue window](image)
7.3.9 IO device – IO cycle

**Refresh interval**

The PROFINET device with the highest parametrised refresh interval determines the transmission cycle in which all PROFINET devices will receive and/or send data at least once.

The smaller the refresh interval, the more bandwidth will be occupied by the cyclic real time communication.

The bigger the refresh interval, the longer the reaction time.

'Mode':
- **Automatic** – The refresh interval is optimised so that no warnings or errors can occur.
- **Fixed refresh interval** – With this configuration, you can change the refresh interval of the IO device. If you change the refresh intervals, errors might occur in the consistency check.
- **Fixed factor** – With this configuration, you can determine how often the IO device should be refreshed. This configuration changes the response monitoring time. See 'Response monitoring time' page 179.
  
  Example: Factor = 2, send clock = 1000 µs – The IO device is refreshed after each second send clock, i.e. every 2000 µs.

'Refresh interval (µs)' – Refresh interval of the IO device

'Factor' – Number of send clocks, after which the IO device should be refreshed

'Send clock (µs)' – Smallest possible transmission interval for the data exchange of the RT or IRT communication

**Response monitoring time**

'Number of accepted refresh cycles with missing IO data' – Number of faulty telegrams until disconnection
If no valid IO data is received after this number of refresh cycles, the connection between IO device and IO controller is interrupted. The input and output data are monitored separately. If input data is still received but output data are not transmitted anymore, the connection will be interrupted after the number of accepted refresh cycles.

‘Response monitoring time’ µs – Time until fault detection, determined from refresh interval and number of accepted refresh cycles with missing IO data.

7.3.10 IO device – Parameter

Fig. 129: IO device: Parameter

‘Parameter’ – Manufacturer specific parameters from the GSDML file
7.3.11 IO module – General configurations

Fig. 130: IO module: General configurations

‘Info’ – Module or channel designation

‘Interface’ – Input address (byte address) for the exchange of diagnostics data between CPU and master system

7.4 Online diagnostics of the bus system (PROFINET-IO system)

You can monitor the PROFINET-IO system using the online diagnostics. You receive diagnostic information on devices, components and network ports.

1. In the project tree within a control, click on ‘Online diagnostics of the bus system’, under ‘Decentralised periphery’, ‘PROFINET-IO system’.
   ⇒ The ‘Online diagnostics of the bus system’ dialogue window will open.

Fig. 131: Online diagnostics of the bus system
Connect devices

Online diagnostics of the bus system (PROFINET-IO system)

Fig. 132: "Online diagnostics of the bus system" dialogue window

2. Select an object from the list on the left, and then a tab, in order to show the diagnostic information for this object.
   - PROFINET-IO system – General
   - IO controller – General
   - IO controller – Interface
   - IO device – General
   - IO device – Diagnostics
   - IO device – Interface
   - IO device – Network connection
   - Port – General
   - Port – Network connection
   - IO module – General
   - IO module – Diagnostics
7.4.1 PROFINET-IO system – General

Fig. 133: Online diagnostics PROFINET-IO system: General

Bus information

‘Bus name’ – Name for the PROFINET-IO system

‘IO-system no’ – Number for the differentiation of several PROFINET-IO systems within one project

status

Status information of the PROFINET-IO system:

Examples of status information

"At least one component disturbed."

"Diagnostics messages present."

"Maintenance requirements"
7.4.2 IO controller – General

Fig. 134: Online diagnostics IO controller: General

Device information

‘Device name’ – Device name of the control (IO controller)

‘System recognition’ – Identification of the automation system

‘Diagnostic address’ – Input address (byte address) for the exchange of diagnostic data between CPU and PROFINET-IO system

‘Slot’ – PROFINET port (port number) on IO controller

Bus information

‘Bus name’ – Name for the PROFINET-IO system

‘IO-system no’ – Number for the differentiation of several PROFINET-IO systems within one project

‘Bus device name’ – PROFINET device name (IO controller)

status

Status information of the IO controller:

Examples of status information

"At least one component disturbed."

"Diagnostics messages present."

"Maintenance requirements"
7.4.3 IO controller – Interface

The table lists all interfaces of the IO controller. Each table line corresponds to an interface.

'Interface' – Rack number / Slot number / Port (port number)

'IP address' and 'Subnet mask' – Address of the accessible partner in the PROFINET-IO network

'Default router' – IP address of the router if the communication is realised beyond the PROFINET IO network (routing).

'MAC address' – Hardware address of the network adapter, for clear identification of the device
7.4.4 IO controller – Network connection

The table lists all Ethernet ports of the IO controller. Each table line corresponds to an interface.

- **'Name’** – Rack number / Slot number / Port and port number
- **'Port status’**
  - "Active": A device has been connected to the interface and the connection was established.
  - "Inactive": No device has been connected to the interface.
- **'Configurations’**
  - "Automatic" if the port status is "Active"
  - "—" if the port status is "Inactive"
- **'Mode’** – Configuration of the network adapter: Transfer rate and transfer procedures

**Details about the port**

- Click on an active port in the table.
  
  The details on the selected port are shown below the table

- **'MAC address of the interface’** – Hardware address of the network adapter
- **'Type of connection’** – Transfer medium, e.g. copper cable
- **'Neighbouring ports’** – If connected devices can be determined, they will be listed in the following way:
  - Device name.Port name, e.g. vipa053-1pn00-002.port001
  - MAC address of the network adapter of the connected device
  - Line length in meters (m) and signal run time in nanoseconds (ns)
7.4.5 IO device – General

![Image of online diagnostics IO device: General]

**Device information**

- "Device name" – Device name of the device (IO device)
- "System recognition" – Identification of the automation system
- "Diagnostic address" – Input address (byte address) for the exchange of diagnostic data between IO controller and IO device
- "Hardware version" – Output version of the hardware of the device
- "Firmware version" – Output version of the firmware of the device

**Bus information**

- "Bus name" – Name for the PROFINET-IO system
- "IO-system no" – Number for the differentiation of several PROFINET-IO systems within one project
- "Bus device name" – PROFINET device name (IO device)
- "Device number" – Configured device number

**Status**

Status information of the IO controller:

**Examples of status information**

- "Component exists"
- "Component projected but not available"
- "Component disturbed"
- "Diagnostics messages present."
- "Maintenance requirements"
7.4.6 IO device – Diagnostics

**Extended device information**

- `Manufacturer name` – Name of the device manufacturer or Vendor ID (hexadecimal)
- `Device ID` – Device ID (hexadecimal and in brackets: decimal)

**Standard diagnostics**

Manufacturer-related diagnostic texts of the IO device:

<table>
<thead>
<tr>
<th>Examples of standard diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Slot No. 3: Correct module&quot;</td>
</tr>
<tr>
<td>&quot;Slot No. 1: Module on wrong slot&quot;</td>
</tr>
</tbody>
</table>

**Channel-specific diagnostics**

Channel-related diagnostic texts for all modules of the IO device; each channel is described by the slot of the component and the channel number:

<table>
<thead>
<tr>
<th>Examples of channel-specific diagnostics</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;Slot No. 3 Subslot No. 1 Channel No. 0: Line break&quot;</td>
</tr>
<tr>
<td>&quot;Slot No. 5 Subslot No. 1 Channel No. 3: short circuit&quot;</td>
</tr>
</tbody>
</table>
7.4.7 IO device – Interface

Fig. 139: Online diagnostics IO device: Interface

**IP parameter**

The table lists all interfaces of the IO device. Each table line corresponds to an interface.

- **‘Interface’** – Rack number / Slot number / Port (port number)
- **‘IP address’** and **‘Subnet mask’** – Address of the accessible partner in the PROFINET-IO network
- **‘Default router’** – IP address of the router if the communication is realised beyond the PROFINET-IO network (routing)
- **‘MAC address’** – Hardware address of the network adapter, for clear identification of the device
7.4.8 IO device – Network connection

Fig. 140: Online diagnostics IO device: Network connection

### Physical properties

The table lists all Ethernet ports of the IO device. Each table line corresponds to an interface.

- **’Name’** – Name of the port and port number
- **’Port status’**
  - "Active": A device has been connected to the interface and the connection was established.
  - "Inactive": No device has been connected to the interface.
- **’Configurations’**
  - "Automatic" if the port status is "Active"
  - "—" if the port status is "Inactive"
- **’Mode’** – Configurations of the network adapter: Transfer rate and transfer procedures

### Details about the port

Click on an active port in the table.

- Details on the selected port are shown below the table.

- **’MAC address of the interface’** – Hardware address of the network adapter
- **’Type of connection’** – Transfer medium, e.g. copper cable
- **’Neighbouring ports’** – If connected devices can be determined, they will be listed in the following way:
  - Device name.Port name, e.g. vipa053-1pn00-002.port001
  - MAC address of the network adapter of the connected device
  - Line length in meters (m) and signal run time in nanoseconds (ns)
7.4.9 Port – General

Device information

‘Device name’ – Name of the port
‘System recognition’ – Identification of the automation system
‘Diagnostic address’ – Input address (byte address) for the exchange of diagnostic data between CPU and the port
‘Slot’ – PROFINET port (port number) on the device

Fig. 141: Online diagnostics port: General
7.4.10 Port – Network connection

**physical properties**

The table contains the following information on the port:

- **Name** – Name of the port and port number
- **Port status**
  - "Active": A device has been connected to the interface and the connection was established.
  - "Inactive": No device has been connected to the interface.
- **Configurations**
  - "Automatic" if the port status is "Active"
  - "—" if the port status is "Inactive"
- **Mode** – Configurations of the network adapter: Transfer rate and transfer procedures

**Details about the port**

The details on the selected port are shown below the table:

- **MAC address of the interface** – Hardware address of the network adapter
- **Type of connection** – Transfer medium, e.g. copper cable
- **Neighbouring ports** – If connected devices can be determined, they will be listed in the following way:
  - Device name.Port name, e.g. vipa053-1pn00-002.port001
  - MAC address of the network adapter of the connected device
  - Line length in meters (m) and signal run time in nanoseconds (ns)
7.4.11 IO module – General

Device information

‘Device name’ – Name of the module
‘System recognition’ – Identification of the automation system
‘Input addresses’ – Area of the input addresses (byte) assigned to the module
‘Output addresses’ – Area of the output addresses (byte) assigned to the module
‘Slot’ – Slot of the module
‘Hardware version’ – Output version of the hardware of the module
‘Firmware version’ – Output version of the firmware of the module

Status

Status information of the module:

Examples of status information

"Component exists"

"Component projected but not available"

"Component disturbed"

"Diagnostics messages present."
7.4.12 IO module – Diagnostics

![IO module diagnostics](image)

**Fig. 144: Online diagnostics IO module: Diagnostics**

**Standard diagnostics**

Manufacturer-related diagnostic texts of the module:

**Examples of standard diagnostics**

"Correct module"

"Module on wrong slot"

**Channel-specific diagnostics**

Channel-related diagnostic texts of the module:

**Examples of channel-specific diagnostics**

"Channel No. 0: Line break"

"Channel No. 3: short circuit"

7.5 Bus system properties (EtherCAT)

Here, you can make configurations on the EtherCAT master and the connected slaves.

*Chap. 11 'Deployment SPEED7 EtherCAT Manager' page 378*
7.6 Configure Ethernet connections

7.6.1 Insert new connection

In the ‘Devices and networking’ editor you can add Ethernet connections in order to connect devices. The devices that are to be connected must already be present in the project.

1. Right-click with the mouse button on the left connection point of the device from which the connection comes and select ‘Insert new connection’.

   The ‘Insert new connection’ dialogue window will open.

   ![Insert new connection](image.png)

   **Fig. 145: Insert new connection**

2. Select the desired ‘connection type’, e.g. S7 connection.

3. Under ‘Connection partners’, select the device you want to connect.

4. Click on ‘OK’.

   The new connection is added and the ‘Connection settings’ dialogue window will open. In this dialogue window you can configure the connection. See Chap. 7.6.2 ‘Connection settings – General’ page 196
7.6.2 Connection settings – General

Here you can configure the connection between devices.

Fig. 146: Connection settings "General"

‘End point’ – Device name
‘Name’ – Name of the connection point
‘Interface’ – Device interface
‘Address’ – IP address of the device at the device interface

7.6.3 Connection settings – Local ID

Here you can configure the "Local ID" for the connection between devices. The local ID is required for some communication function blocks. The value of the local ID must match the value of the calling interface in the communication function block.

For details on displaying connections in the 'Devices and networking' editor: Chap. 6.2.2 ‘Connections’ page 80
7.6.4 Connection settings – Special properties

You can choose here, which connection partner should be used for establishing the active connection.
7.6.5 Connection settings – Address details

"Address details" include information about the communication interface and the connection resources.
7.7 Configure OPC UA
7.7.1 Overview

With the OPC UA configuration you can set up and configure the integrated OPC UA server of a target station (CPU respectively CP).

If you create or change OPC UA configuration, you must translate this configuration as well as all blocks of the user program Chap. 8.16 ‘Compile user program’ page 268 and transfer them into the control. Chap. 8.18 ‘Transfer the hardware configuration and user program to the control’ page 272

7.7.2 Server configuration

Here you can create the OPC UA configurations.

1. Click in the project tree at ‘Device properties’. The editor of the ‘Device properties’ opens.

2. Select the area ‘Server configuration’.

Fig. 149: Connection settings “Address details”

‘Rack/Slot’ – Position of the rack and the slot in the communication interface. The values can only be changed for unspecified connection partners.

‘Connection resource’ – Address of the connection resource

‘TSAP (hex)’ – TSAP (Transport Service Access Point)
You can create a maximum of two OPC UA configurations: One configuration for the CPU and one configuration for the CP (if exists).

**Create configuration**

1. Select in the selection field ‘OPC UA Configuration’ and click on ‘Add Server’. 
   - A new OPC UA configuration is created and listed in the project tree.
2. Click in the selection field ‘Active server CP’ or ‘Active server CP’ and choose which configuration is to be assigned. With the selection ‘None’ the configuration remains saved in the project. However, it is not transferred to the device.

To swap the two configurations for CP and CPU, click on the button.

You can create a maximum of two OPC UA configurations.

**Remove server**

Right-click on the OPC UA configuration (PLC) in the project tree and select ‘Remove OPC UA server’.

### 7.7.3 Server settings - Connection

Here you can perform the connection settings of the OPC UA server.

1. Under Project tree at ‘OPC UA configuration’ click on ‘Server settings’. 
   - The ‘Server settings editor’ editor opens.
2. Select the area ‘Connection’.

**General**

You can set for the OPC UA server how a user of an OPC UA client must prove their identity for access to the server. Select at least one of the following login methods. You can also combine the two login methods with each other.

- ‘Activate anonymous login’
  - The OPC UA server does not check the authorisation of the OPC UA client.
- ‘Activate user/password login’
  - The OPC UA server checks using the user name and password whether the access of the OPC UA client is authorised. To do this, the server evaluates the role assigned to the user. Chap. 7.7.7 ‘Role management’ page 204
- ‘Allow obsolete security guideline’
  - Allows the selection of the two obsolete security guidelines ‘Basic128Rsa15’ and ‘Basic256’ (not recommended)
- ‘Application name’
  - Clear identification of the application in the OPC name space.

**Network**

- ‘End point port’
  - TCP port for binary data exchange (standard: 4840).

**Security**

Activate only security guidelines that are compatible with the protection concept for your machine or system. Deactivate all other security guidelines.
7.7.4 Server settings - Certificate

A secure connection between the OPC UA client and the server can only be established if the server classifies and accepts the client's digital certificate as trusted. Currently, the server accepts every valid client certificate. The server accepts self-signed certificates. In addition, the client also checks the server's certificate.

Here you can create, show, import or export an ITU-T standardized X.509 certificate for the OPC UA server. The certificate shown here is transferred into the OPC UA server.

1. Under Project tree at ‘OPC UA configuration’ click on ‘Server settings’.
   ⇒ The ‘Server settings’ editor opens.

2. Select the area ‘Certificate’.

The current X.509 certificate is shown in the work space. If you create or import a new certificate, the previously shown certificate is replaced.

Tools:

- **Create new certificate**: Opens the dialog window ‘Create new certificate’
- **Display certificate**: Shows information on the current certificate
- **Export certificate**: Opens the dialog window ‘Save certificate’
- **Import certificate**: Opens the dialog window ‘Open certificate’
Create new certificate

1. Click on to create a new certificate.
   ⇒ The dialog window ‘Create new certificate’ opens.

2. Enter the data for the certificate and click on ‘OK’.
   ⇒ The previously shown certificate is replaced by the new certificate.

Display certificate

Click on to show information about the current certificate.
⇒ The dialog window ‘Certificate’ opens.

Export certificate

You can export the current certificate e.g. to use it on different computers.

1. Click on.
   ⇒ The dialog window ‘Save certificate’ opens.

2. Select a directory and enter a file name.

3. Click on ‘Save’.
   ⇒ The current certificate is saved in the export file (pfx file format).

Import certificate

You can import a certificate, e.g. to use it for the current OPC UA configuration. For a successful import, the certificate must have the following characteristics:

- The certificate must be available as a PFX file.
- The ‘Common name’ and ‘Organization’ fields must be completed.
- The maximum key strength must not exceed 2048bit.
- The certificate must contain a valid Private key.

1. Click at.
   ⇒ The dialog window ‘Open certificate’ opens.

2. Select the desired certificate (pfx file format).

3. Click on ‘Open’.
   ⇒ The previously shown certificate is replaced by the imported certificate.

7.7.5 Data access

Here you can select the variables belonging to the CPU or CP (if exists) that can be accessed via OPC UA.

Under Project tree at ‘OPC UA configuration’ click on ‘Data access’.
⇒ The editor for ‘Data access’ opens.

Toolbar

Refresh variables: Apply changed filter settings to the result table.
**Filter settings**

Here you can select the operands and address ranges that will be shown in the results table.

1. Activate 'All operand areas' or individual operand ranges to be shown in the result table.
2. To limit the addresses of an operand range, enter the start and end byte addresses in the two adjacent fields, e.g. 0 to 1000.
3. Click on or activate 'Apply filter changes immediately'.
   - The result table is updated with the filter settings.

**Result**

In the results table, select the variables that are to be used in the **OPC UA** configuration. **OPC UA** clients may access these variables.

- Activate 'OPC UA' of the desired variables.

**Group operands**

For a better overview, you can sort the table entries by groups.

![Diagram showing how to sort the table entries](image)

1. Select column (hold left mouse button down)
2. Drag the column
3. Drop column in the field (release mouse button)

- Drag the desired column header into the field above the table.
  - The contents of the column will be grouped. The number of lines is shown for each group.
- Click on to open the group. Click on to close the group.

You can repeat steps 1 to 2 in order to structure the group into further sub-groups.

In order to cancel a grouping, click on the close icon next to the group name.

### 7.7.6 User management

The user management allows you to create a user list. For each user, you can define a password and a role.

1. Under **Project tree** at 'OPC UA configuration' click on 'User management'.
   - The editor for 'User management' opens.
2. Select the area 'User management'.

#### Toolbar

- **Add new user**: Input mode for new user
- **Remove user**: Deletes the selected user
- **Edit current user**: Input mode for selected user
- **Save input**: Save input Save user settings
Adding a user

1. Click on 🔄.
2. Enter the desired user name in the input field ‘Name’.
3. Enter the password in the input field ‘Password’ and repeat the input under ‘Re-enter password’.
4. Select a role for the user. With this role, the access rights to the OPC UA server are established.
5. Click on 🔄.
   ⇒ The user will be entered in the user list.

Edit user

1. In the user list, select the user whose data you want to change.
2. Click on 🔄.
3. Enter the desired changes and click on 🔄.

Removing a user

1. In the user list, select the user you want to delete.
2. Click on ✗.
   ⇒ A dialog box opens where you can choose whether the user should be deleted or not.

7.7.7 Role management 📚

Here you establish the roles and access rights that you can assign to the users. When you activate the authentication via User/password login Chap. 7.7.3 ‘Server settings - Connection’ page 200, the access rights to the OPC UA server are issued using the logged-in user and the assigned role.

Example:

Role: Operator
Username: "I myself"
Server settings: User/password login activated
The user "Me Self" receives write permission and reading rights to the OPC UA server when he has successfully logged in with the password.

1. Under Project tree at ‘OPC UA configuration’ click on ‘User management’.
   ⇒ The editor for ‘User management’ opens.
2. Select the area ‘Role management’.

Configure roles

The following two roles are currently available for selection; further roles can not be added at the moment.

- Operator: Write permission and reading rights
- Observer: Reading rights only
7.7.8 Client

With the integrated OPC UA client, you can simulate and show server elements and test the connection to the server.

To make all the settings in the client and start the client, you must first do the following:

- Configure OPC UA server
- Perform communication settings
  - Chap. 7.7.3 ‘Server settings - Connection’ page 200
- Assign digital certificate
  - Chap. 7.7.4 ‘Server settings - Certificate’ page 201
- If necessary: Select variables
  - Chap. 7.7.5 ‘Data access’ page 202
- If you create or change the OPC UA configuration, you must translate this configuration as well as all blocks of the user program.

The toolbar contains the commands for executing the OPC UA client.

**Connect**: Establish a connection from the OPC UA client to the OPC UA server

**Disconnect**: Disconnects the connection from the OPC UA client to the OPC UA server

**Refresh attributes**: Transfer current values to the attribute list

**Start server simulation**: Simulates random values in the attribute list

**End server simulation**: Stops the simulation

Make the connection and authentication settings here:

‘Server address’ — By default, the URL of the OPC UA server of the current server configuration is shown here.

‘Endpoint’ — Select the URL of the endpoint port here. This field remains empty if there are no valid connection settings and no digital certificate available.
‘Get endpoints’ – Click here if the server address or endpoint ports have changed.
‘Simulation’ – Activate this option to be able to start and stop the server simulation. The server simulation simulates random values in the attribute list.
‘Authentication’ – Anonymous or via user name and password
‘Connect’ – If the server address and endpoint are set, this button can be used to establish the connection between OPC UA server and client.

(3) OPC UA elements
The tree contains all elements of the current OPC UA configuration.
Select an element to shown the attributes and values of this element in the attribute list.

(4) Attribute list
The attribute list shows the attributes and values of the selected OPC UA element.
Click in the toolbar to refresh the values in the attribute list.

(5) Information bar
Here you will find information about the OPC UA client.
8 Creating, transferring and testing the user program

8.1 Program blocks

Different types of program blocks can be edited, configured, synchronised with the control and monitored in the block editor. The blocks include the user program (PLC program). The blocks are divided into code blocks (OB, FB and FC) and data blocks (DB and UDT).

- **Organisation blocks (OB)** form the interface between the operating system of the control and the user program. Cyclic events as well as time-controlled or interrupt-controlled events are processed in the organisation blocks. The OB1 block contains the main program. A template of OB1 with the block name "Main" is already available in the project.

- **Function blocks (FB)** are block types which are primarily used for programming. Function blocks can be parametrised on the basis of input and output variables. They may contain static or temporary local variables. All variables of a function block (except for the temporary variables) are persistently stored in the data blocks. Thus, function blocks have kind of a memory.

- **Functions (FC)** are used to process input variables in order to produce a result. They are used for recurring tasks e.g. mathematical functions. They can be parametrised on the basis of input and output variables. Functions may contain temporary local variables. The variables of a function are not persistently stored. Thus, functions do not have a memory.

- **Data blocks (DB)** contain data for the user program but no program instructions.

- **Structure blocks (UDT, User Defined Data Type)** contain data structures for the user program but no program instructions.

8.2 Device overview (PLC)

The blocks of the user program and the system blocks are displayed in a table in the device overview. Here you can select blocks and compile them or transfer them to the control.

Select one of the following options in order to open the device overview:

- **Menu bar**: Select ‘Device ➔ Device overview’.
- **Project tree**: Click on ‘Device overview’ in the control (PLC).
- **”Start page” ➔**: Click on ‘Project overview’.
Select blocks

You can select blocks and compile them or transfer them to the control.

1. Highlight the desired blocks in the first column of the device list.
2. Click on a button in the toolbar (1).
   ⇒ The selected blocks are compiled or transferred to the control.

(1) Toolbar

Send selected blocks: The blocks selected in the block list (2) are transferred to the control.

Compile selected blocks: The blocks selected in the block list (2) are compiled.
   © Chap. 8.16 ‘Compile user program’ page 268

(2) Block list

Provides a list of blocks used in the project.
‘Block’ – Block type and number
‘Version’ – Version and revision number of the block, e.g. © ‘(3) Block information’ page 219
‘Name’ – Block name
‘Author’ – Name of the responsible person, e.g. © ‘(3) Block information’ page 219
‘Size’ – Block size in the load memory in Byte
‘Modified interface’ – Date and time of the last change in the declaration section of the block
‘Modified code’ – Date and time of the last change in the declaration section of the block
‘Comment’ – Any comment e.g. remark or explanation

Opening a block in the block editor

Double-click on the desired block.
   ⇒ The selected block is opened in the block editor.
8.3 Add new block (OB, FB, FC)

If you want to create a new block, a project must be opened and a control must be contained in the project.

1. In the project tree within a control, click on ‘Add new block’ in the ‘PLC program’ at ‘Program blocks’.
   ⇒ The dialogue window ‘Add new block’ will open.

2. Select the block type OB, FB or FC.

3. ‘Name’: Enter a different block name, if required. You can access the block in the user program with this name.

4. ‘Number’: Select a free block number. Blocks that are already present cannot be selected.
   OB: You can select predefined organisation blocks from a list: Click on ‘Show selection’ and select the desired OB from the list.

5. ‘Syntax’: Select the desired PLC programming language.

The programming language can be changed later in the block editor between IL, FBD and LD. Please note that syntax conversion from one programming language to another is not always possible due to the different choice of commands.
6. Click on ‘To take some more inputs..’ if you want to enter further block details. The following details can be entered: Title, comment, version / revision numbers, control family and author. You can make or change these entries later in the block editor.

7. Click on ‘OK’.

If you select the option ‘Open block’ and click on ‘OK’, block editor will open.

The block is added and displayed in the project tree.

8.4 Editing program blocks

Different types of program blocks can be edited in the block editor. The block editor is divided into two entry sections: "Declaration section" and "Instruction section".

Declaration section

In the declaration section, you can define all variables used in the block. You can edit the input and output parameters of the block interface, the local variables, the return value of functions and the I/O addresses in the organisation blocks.

Prior to start programming in the instruction section, you should declare all variables in the declaration section.

Information on the declaration section:
- Chap. 8.5.1 'Declaration section' page 212
- Chap. 8.5.2 'Edit and use variables' page 213
- Chap. 8.5.3 'Move, copy, paste and delete variables' page 216

Instruction section

In the instruction section of the block editor you can enter the PLC instructions which are to be executed by the control. Furthermore, you can configure the block as well as each block network in the instruction section.

Information on the instruction section:
- Chap. 8.5.4 'Instruction section' page 217
- Chap. 8.5.5 ‘Create / edit symbol’ page 221

8.5 Block editor for program blocks (OB, FB, FC)

Different types of program blocks can be edited, transferred to the control, synchronised with the control and monitored in the block editor. The blocks include the user program (PLC program). Chap. 8.1 ‘Program blocks’ page 207

You can create new blocks or open existing blocks.

If you want to add a new block, please note Chap. 8.3 ‘Add new block (OB, FB, FC)’ page 209.
Select one of the following options in order to open an existing block (OB, FB, FC) in the block editor:

- **Project tree**: Double click on the desired block (block name) under ‘PLC program’, ‘Program blocks’ within a control.
- **"Device overview" editor**: Double-click on the desired block.

![Fig. 155: Block editor of a function block (FB) as an example](image)

(1) **Toolbar**

Important commands you need for editing the block are provided in the toolbar.

(2) **Declaration section**

In the declaration section, you can define all variables used in the block. You can edit the input and output parameters of the block interface, the local variables, the return value of functions and the I/O addresses in the organisation blocks.

(3) **Instruction section**

In the instruction section of the block editor you can enter the PLC instructions which are to be executed by the control. Furthermore, you can configure the block as well as each block network in the instruction section.
(4) Information bar

The information bar provides information on the block:
- User name and date of the last stored change
- Name of the control, of the CPU and of the block
- Network number of the current position of the cursor
- Line (LN) and column (COL) of the current position of the cursor
- Status of the block since the last saving (changed/unchanged)
- Connection status to the control (inactive/active/error): If you move the mouse cursor to this field, details on the connection status are displayed.

8.5.1 Declaration section

In the declaration section, you can define all variables used in the block. You can edit the input and output parameters of the block interface, the local variables, the return value of functions and the I/O addresses in the organisation blocks.

![Declaration section for a function block as an example](image)

Fig. 156: Declaration section for a function block as an example

You can define the variables of the block interface (formal parameters) as well as the data for the intermediate results (local variables) of the block in the table.

- **‘1st Column’** – Area to select the vectors of the data type ARRAY
- **‘2nd Column’** – Area to select all other data
- **‘Area’** – Defines the type of variables
- **‘Address’** – Internal automatically created address for data filing in the instance data block
- **‘Name’** – Name of the variables
- **‘Data type’** – Data type of the variables
- **‘...’** – Further configurations for the selected data type e.g. dimensions and field boundaries of the ARRAY data type
- **‘Default value’** – Initial value of the variables
- **‘Comment’** – Any comment e.g. remark or explanation

The declaration section of the organisation block differs from the declaration section of the function block and functions. Here it is not possible to enter the ‘Area’ variable type and the ‘Default value’ initial value. Therefore, there are no corresponding columns.
8.5.2 Edit and use variables

### Rules for declaration

Only use admissible identifiers for the variable name:

- An identifier is a sequence of letters, numbers and underline characters "_". Space characters are not admitted in the identifier.
- Identifiers may consist of a maximum of 24 characters.
- There is no distinction between upper and lower case letters e.g. the identifier "MAGAZINE_full" is identical with "MAGAZINE_FULL" and "magazine_full".

### Adding/declaring variables

![Fig. 157: Adding/declaring variables](image)

The variables can be declared line by line. Each line in the declaration section can contain a variable.

1. **OB:** Click on the free input field in the ‘Name’ column.
   - **FB and FC:** Select the desired variable type in the ‘Area’ column. Click on the free input field in the ‘Name’ column. Example: If you want to add input parameters, you must click on the free input field of the ‘Name’ column in the "IN" ‘Area’.

2. Enter a name for the variable e.g. `awValues`.

3. Click on the adjacent field in the ‘Data type’ column and select the desired data type e.g. "ARRAY_OF_TYPE" for data fields.

![Fig. 158: Enter dimensions and field boundaries](image)

4. Any further configurations which are possible for the selected data type, z. B. dimensions and field boundaries of the data type are displayed in the ‘...’ field. Click on the field to enter the configurations. Click on to make configurations using a dialogue window.
If you want to assign an initial value to the variables, click on the ‘Default value’ field and select a default value or enter a value.

If you want to enter a comment on the variables, click on the ‘Comment’ field and enter the comment.

Add pre-set variable

You can insert a new variable with the same properties above or below the current line in the table.

1. Click into the second column of a variable cell.
2. Right-click with the mouse button on it and select ‘Add variable before’ or ‘Add variable after’.

A new line is inserted in the table. An address will be assigned, and the variable name of the current table line will be adopted and numbered consecutively.

Changing variable properties

You can change various properties of an already declared variable.

Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

Fields highlighted in grey cannot be changed.
The variable type is indicated in the declaration section of the program block in the ‘Area’ column:

<table>
<thead>
<tr>
<th>Group</th>
<th>Variable type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IN</td>
<td>Input parameter</td>
<td>The parameter is read in the block and can only be specified in the calling block.</td>
</tr>
<tr>
<td>OUT</td>
<td>Output parameter</td>
<td>The parameter can be specified in the block and is only readable in the calling block.</td>
</tr>
<tr>
<td>IN_OUT</td>
<td>In-out parameter</td>
<td>The parameter can be read and specified in the block and in the calling block.</td>
</tr>
<tr>
<td>RETURN</td>
<td>Return value</td>
<td>The function value (return value) can be specified in the block and is only readable in the calling block.</td>
</tr>
<tr>
<td>STAT</td>
<td>Static local data</td>
<td>Variable for saving retentive intermediate results. Data are maintained for several cycles until they are redefined.</td>
</tr>
<tr>
<td>TEMP</td>
<td>Temporary local data</td>
<td>Variable for the saving of temporary intermediate results. Data are maintained for one cycle only.</td>
</tr>
</tbody>
</table>

1) Access rights: internal = in the current block, external = in the calling block, \( R \) = reading, \( W \) = writing, \( RW \) = reading and writing

2) Availability in the block type

Assigning data types

The properties and data volume of a variable is defined by the data type. For example, for binary operations, other data types are required than for floating point arithmetic.

Adding a block reference by "Drag & drop"

Drag the desired block from the catalog or the project tree to the desired position, e.g. within the area “STAT”.

⇒ The block is inserted as reference. The block name is adopted and numbered consecutively. If the block is not yet present in the project, the block is added to the project and shown in the project tree.

Accessing variables in the user program

In the declaration section, variables are declared with a variable name e.g. `Input_01`. You can access these variables in the instruction section via the variable name with the prefixed number sign “#”, e.g. `#Input_01`. 
8.5.3 Move, copy, paste and delete variables

Copy individual variable

1. Right-click with the mouse button on the second column of the variable line and select 'Copy to clipboard'.
2. Right-click with the mouse button on the position where you want to insert the variable line and select 'Paste from clipboard'.
   ⇒ The variable line is inserted.

Move individual variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.
   ⇒ The variable line is inserted.

Copy individual variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.
   ⇒ The variable line is copied and inserted. The new variable has the same properties as the initial variable. The variable name is adopted and numbered consecutively.

Move several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The variable names are adopted and numbered consecutively.
Deleting variables

1. In the second column, highlight the variable line which you want to delete.

   Individual vectors of the data type ARRAY can only be highlighted in the first column.

2. Press [Del].
   - or -
   Right-click with the mouse button on the line and select ‘Delete selected variable’.
   A dialogue window will open, where you can select whether you want to delete the variable.
   ⇒ The variable is deleted or removed from the declaration.

8.5.4 Instruction section

In the instruction section of the block editor you can enter the PLC instructions which are to be executed by the control. Furthermore, you can configure the block as well as each block network.

You can enter the instructions in the programming language (syntax) which you must select when you add a new block (OB, FB, FC). Chap. 8.3 ‘Add new block (OB, FB, FC)’ page 209

You can also select different programming languages for each network. Chap. 7 ‘Network configurations’ page 221

Programming languages:

- Instruction list (IL)
- Function block diagram (FBD)
- Ladder diagram (LD)

Fig. 162: Instruction section for the IL programming language as an example

1. Toolbar
2. Declaration section (not shown)
3. Block information
4. Input area for instructions and elements
5. Network
6. Network information
7. Network configurations
8. Add new network
Showing/hiding input areas

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area

(1) Toolbar

Important commands you need for editing the block are provided in the toolbar.

- **Compile block** [Ctrl]+[B]: The block is compiled (Chap. 8.16 ‘Compile user program’ page 268)
- **Load block into device** [Ctrl]+[L]: The block is transferred to the control. To this end, a communication connection with the control is established. A dialogue window will open, where you can select the interface connection and make further configurations.
- **Block watch On/Off** [Ctrl]+[F7]: Watching the variables of the block in the control. To this end, a communication connection with the control is established. The variable values are cyclically read from the control and displayed. (Chap. 8.21 ‘Watch block’ page 281)
- **Watch block via the calling environment ON/OFF**: If the block is called multiple times in the program, one calling can be watched here.
- **Set program status display**: Pre-configurations and selection of the variables for watching the blocks. A dialogue window will open, where you can make the desired configuration. (Chap. 8.21.1 ‘Set program status display’ page 282)
- **Load block from device**: The block is transferred from the control to the project. To this end, a communication connection with the control is established.
- **Compare blocks**: The block is compared to the block which is present in the control. To this end, a communication connection with the control is established. (Chap. 8.20 ‘Compare blocks’ page 278)
- **Search in code**: Search for text or certain character patterns in the user program
- **Replace in code**: Search for text or certain character patterns in the user program and replace
- **Block instance synchronisation**: --- in preparation --- This function is not available in this version.
- **Print**: Prints the program block and any program instructions and elements contained therein
- **Show/hide additional information**: Shows/hides information about operands. You can define whether the additional information for newly added blocks should be shown or hidden under ‘Extras ➔ Settings’.
- **Absolute/symbolic programming**: Show operands as symbolic or absolute in the block editor (temporary setting until the project is reopened). You can define “Absolute” or “Symbolic” display for all blocks in the project under ‘Extras ➔ Settings’. (Additional information in IL editor’ page 26)
- **Add several networks**: You can add several networks at a certain position.
- **Add new network**: A network is added at the block end.
- **Delete network**: The current network and any program instructions and elements contained herein are deleted.
- **Expand all Networks**: All networks are opened to show all program instructions and elements.
- **Collapse all Networks**: All networks are closed to hide all program instructions and elements.
Select programming language: You can switch between the programming languages IL, LD and FBD here. You can also select the programming language for individual networks. *(7) Network configurations’ page 221

Please note that syntax conversion from one programming language to another is not always possible due to the different choice of commands.

(2) Declaration section

In the declaration section (not shown in Fig. 162), you can define all variables used in the block. *(Chap. 8.5.1 ‘Declaration section’ page 212*

(3) Block information

Here you are provided with further information, and you can enter a title and comment on the block. The following buttons are displayed if you hover with the mouse over a field with the ‘Block information’.

Comment field: Here you can show or hide the comment field.

Advanced Configurations: Here, you can show or hide further configurations, such as author and version.

Block information: Here, you can show or hide information about the block.

History: Here, you can show or hide the display of the block versions.

(4) Input area

In the input area, you can give instructions in the IL programming language. Moreover, you can insert elements in the graphic programming languages FBD and LD.

*(Chap. 8.6.1 ‘Instruction list (IL)’ page 223*

*(Chap. 8.6.2 ‘Function block diagram (FBD)’ page 226*

*(Chap. 8.6.3 ‘Ladder diagram (LD)’ page 231*

(5) Network

In order to improve the clear structure of the user program, you can divide the program in several networks. Networks are consecutively numbered, see (6).

Context menu for network functions

Most of the commands you need for working with networks are provided in the toolbar (1). Further commands can be accessed via the context menus using the right mouse button.

For this, right-click on the network information (6).
Adding a network

Select one of the following options if you want to add one or more networks:

- Adding a network at the block end: Click on ‘Add new network’ below the last network (8).
  - or -
  Click on in the toolbar (1).
  - or -
  Select in the menu bar ‘Block \(\Rightarrow\) Networks \(\Rightarrow\) Add new network’.

- Adding a network before or after a network: Right-click with the mouse button on the network information (6) in the network and select ‘Add network before’ or ‘Add network after’.

- Add several networks: Select in the menu bar ‘Block \(\Rightarrow\) Networks \(\Rightarrow\) Add several networks’.
  - or -
  Click on in the toolbar (1).

\(\Rightarrow\) A dialogue window in which you can define the number of networks and the insertion position opens.

Deleting networks

Right-click with the mouse button on the network information (6) in the network and select ‘Delete network’.

- or -
Click on in the toolbar (1).

- or -
Select in the menu bar ‘Block \(\Rightarrow\) Networks \(\Rightarrow\) Delete network’.

\(\Rightarrow\) The network and any program instructions and elements contained herein are deleted.

Copying and pasting networks

1. Highlight the network which you want to copy. Right-click with the mouse button on the network header (6) and select ‘Copy network’.

\(\Rightarrow\) The network and any program instructions and elements contained herein are copied to the clipboard.

2. Highlight the network behind which the copied network is to be pasted. Right-click with the mouse button on the network header (6) and select ‘Paste network’.

\(\Rightarrow\) The network and any program instructions contained herein are pasted.

Cut and paste network

1. Highlight the network which you want to cut. Right-click on the network header (6) and select ‘Cut network’.

\(\Rightarrow\) The network and any program instructions and elements contained therein are deleted and copied to the clipboard.

2. Highlight the network behind which the cut network is to be pasted. Right-click with the mouse button on the network header (6) and select ‘Paste network’.

\(\Rightarrow\) The previously cut network and any program instructions contained therein are pasted.

(6) Network information

Here you are provided with further information, and you can enter a title and comment regarding the network. The following buttons are displayed if you hover with the mouse over a field with the ‘Network information’.

\(\Rightarrow\) Title: Here, you can show or hide further configurations, such as author and version.
(7) Network configurations

You can make various configurations which will have impacts on the current network:

- **Make format settings**: Here you can format or comment on the instruction lines of the program block (IL only).
- **Make zoom settings**: Here you can change the font size and/or the display size of the elements in the network.
- **Add note**: Here you can add notes and status information on the network (IL only).
- **Select programming language**: Here you can switch between the programming languages IL, LD and FBD for the network.

Please note that syntax conversion from one programming language to another is not always possible due to the different choice of commands.

8.5.5 Create / edit symbol

### Access manual symbol editing

In the block editor, you can assign a symbolic address to an operand or edit an existing symbolic address.

![Create symbol](image)

**Fig. 163: Create symbol (Example: Absolute address in the IL editor)**

- Set the cursor on the absolute address or the symbolic address and press [Ctrl]+[J].
- or -

Right-click with the mouse button on the absolute address or the symbolic address and select 'Create / edit symbol'.

⇒ The "Create/edit symbol" dialogue window will open, see ‘Configuring a symbol’ page 222.
If you activate ‘dialogue support’, under ‘Extras ➔ Settings’ in the ‘Programming’ tab, the “Create/edit symbol” dialogue window opens upon entry of a new symbolic address, see § ‘Configuring a symbol’ page 222.

**Configuring a symbol**

---

**Fig. 164: Create / edit symbol**

1. In the input field ‘Name’, enter the desired variable name (symbolic address). If the name has already been used for another variable, an error message is displayed.

2. If required, change the ‘Operand’ and the ‘Data type’.

3. If you want to assign the variable to a group, enter a new group name into the input field ‘Group’ or select an existing group.

4. Under ‘Area of validity’, select the validity of the variable:
   - To use the variable only within one block, select the desired block.
   - To use the variable in the entire user program, select “Global”.

5. Under ‘Variable table allocation’, select the variable table in which the symbol configuration should be saved.

6. To be able to use the variable in HMI images, activate the option ‘Use in Visu’. You can then copy (synchronise) this variable into the variable table of the HMI project. See Chap. 9.4 “Standard variables table” editor page 316

7. Enter a ‘Comment’, if required.

8. Click on ‘OK’.
   - The new or edited variable is added to the selected variable table and set on the position of the operand in the block editor.
8.6 Programming languages

You can select the programming language (syntax) in which you want to edit the PLC instructions already when adding a new program block. Chap. 8.3 ‘Add new block (OB, FB, FC)’ page 209

- Instruction list (IL): Textual, machine-oriented programming language
  The execution instructions for the PLC are made line by line. A complete instruction sequence may extend over several instruction lines.

- Function block diagram (FBD): Graphic programming language for signal processing
  Differing functional elements may be connected with each other in order to control the signal flow.

- Ladder diagram (LD): Graphic programming language similar to a circuit diagram
  The connection of contacts and coils describe the current flow between two contact rails.

In the instruction section of the block editor you can enter the PLC instructions which are to be executed by the control.

8.6.1 Instruction list (IL)

Instruction list (IL) is a textual and machine-orientated programming language. The execution instructions for the PLC are made line by line. A complete instruction sequence may extend over several instruction lines.

For the description of the commands, see Documentation "IL Operation".

Entering IL instructions

You can enter IL instructions in the entry section of the block editor.

Enter the instructions in a blank line and confirm your entry with [Enter].

The text is automatically aligned, and a blank line is inserted.

Automatic alignment

The individual parts of the instruction lines (label, operator, operand, comment) can be separated by spaces. After having confirmed your entry with [Enter], the individual parts are automatically aligned based on a grid.

In the first line of the following example you see the unformatted entry. The second line shows the automatic alignment:

```
1 | O i2.0 // Comment
```

Symbolic and absolute addressing

You can select whether the operands should be shown as symbolic or absolute: In addition, you can activate dialogue support for symbol input and define the prefix for automatically generated symbols, see Chap. 4.7 ‘Symbolic and absolute addressing’ page 24.

If you select the "Symbolic" type of addressing, symbolic addresses are shown. If you enter an absolute address, SPEED7 Studio replaces this address with the available symbol. If no symbol is available, SPEED7 Studio automatically generates a symbol. If you activate dialogue support, a dialogue window in which the operands, data type and other properties can be defined for the new symbol opens.

If you select the "Absolute" type of addressing, absolute addresses are shown. If a symbolic address is entered, SPEED7 Studio replaces this address with the absolute address.

You can continue to edit symbolic addresses. Chap. 8.5.5 ‘Create / edit symbol’ page 221
Automatic completion of symbolic addresses
If you enter a symbolic address without quotation marks, the quotation marks are added automatically.

Automatic completion
When you enter instructions, a selection list with input suggestions and other information will be shown as a tool tip. With each additional letter you enter, the suggestions are narrowed down.

Fig. 165: Input suggestions for local variables (input: #)

Fig. 166: Input suggestions for symbol names (input: ”)

Parameter input for block calls
If you enter an instruction for a block call, all calling parameters are added automatically. After :=, you can enter the assignments of the parameters; after //, you can enter a comment:

Opening a block from an instruction line
You can open a block directly from the CALL instruction line in order to then edit it. Select one of the following options to this end:
- Double-click on the block name.
- Right-click with the mouse button on the block name and select ‘Open block’.
- Keyboard: Set the cursor on the block name or the symbolic address and press [Ctrl] + [Alt] + [O].
Fig. 167: Example of opening blocks from an instruction line

1 Double-click opens FB1
2 Double-click opens DB5

Comment and uncomment

You can place comment signs at the start of the line to exclude instruction lines from editing temporarily:

1. Place the cursor on the lines or mark the lines you would like to comment out.
2. Press \[Ctrl\]+[Shift]+[C] or right-click on the area and select ‘Format settings \(\rightarrow\) Comment’.
   \(\Rightarrow\) The instruction lines are changed into comment lines.

To change comment lines back into instruction lines, proceed as follows:

1. Place the cursor on the comment lines or mark the comment lines for which you would like to remove the comment signs.
2. Press \[Ctrl\]+[Shift]+[U] or right-click on the area and select ‘Format settings \(\rightarrow\) Uncomment’.
   \(\Rightarrow\) The comment signs are removed.

Syntax highlighting

In order to be able to distinguish different language elements better from each other, they are displayed in different colours and font styles in the block editor.

<table>
<thead>
<tr>
<th>Language element/meaning</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown, z. B. faulty input</td>
<td><strong>unknown</strong></td>
</tr>
</tbody>
</table>
| Operators                           | **A**  
|                                     | **ON**          
|                                     | **L**           
|                                     | **JC**          |
| Operands                            | **I2.0**        
|                                     | **Q8.0**        
|                                     | **M4**          |
| Numeral literals                    | **16#FF00**     
|                                     | **2#10110110**  
|                                     | **-3.5**        
|                                     | **2E7**         |
| Time literals                       | **D#2015-04-09** |
8.6.2 Function block diagram (FBD)

Function block diagram (FBD) is a graphic programming language for signal processing. With function block diagram, different functional elements may be connected with each other in order to control the signal flow.

For the description of the commands, see Documentation "FBD Operation".
In order to be able to distinguish different elements better from each other, they are displayed in different colours in the block editor:

<table>
<thead>
<tr>
<th>Colour</th>
<th>FBD element</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Bit logic</td>
</tr>
<tr>
<td></td>
<td>Comparator</td>
</tr>
<tr>
<td></td>
<td>Converter</td>
</tr>
<tr>
<td></td>
<td>Counter</td>
</tr>
<tr>
<td></td>
<td>integer function</td>
</tr>
<tr>
<td></td>
<td>floating point</td>
</tr>
<tr>
<td></td>
<td>Move</td>
</tr>
<tr>
<td></td>
<td>Program control</td>
</tr>
<tr>
<td></td>
<td>Shift/Rotate</td>
</tr>
<tr>
<td></td>
<td>Timers</td>
</tr>
<tr>
<td></td>
<td>Word logic</td>
</tr>
<tr>
<td></td>
<td>Status bits</td>
</tr>
</tbody>
</table>

**Fig. 168: Example for function block diagram**
Adding FBD elements from the catalog

You can add FBD elements in the input area of the block editor.

1. Click on the input area.
2. In the catalog under ‘FBD elements’, open an element group, e.g. ‘Bit Logic’.
3. Drag the desired element from the catalog to the desired position in the input area.
   Note that you can add the FBD elements only to the input or output of an element or to a branch. The permitted adding position is marked in green.
   ⇒ The FBD element is added.

Enter input and output variables

Click on ‘???’ and enter the input and/or output variable.

Automatic completion

During entry, a selection list with input suggestions and other information will be shown as a tool tip. With each additional letter you enter, the suggestions are narrowed down.

Automatic completion of symbolic addresses

If you enter a symbolic address without quotation marks, the quotation marks are added automatically.

In order to jump from one parameter to the next, use the key [TAB]. With the key combination [Shift]+[TAB], you can jump back to the previous parameter.

Tool tips for the operands

If you hover the mouse pointer over an operand, a tool tip is displayed.
Symbolic and absolute addressing

You can select whether the operands should be shown as symbolic or absolute: In addition, you can activate dialogue support for symbol input and define the prefix for automatically generated symbols, see Chap. 4.7 'Symbolic and absolute addressing' page 24.

If you select the "Symbolic" type of addressing, symbolic addresses are shown. If you enter an absolute address, SPEED7 Studio replaces this address with the available symbol. If no symbol is available, SPEED7 Studio automatically generates a symbol. If you activate dialogue support, a dialogue window in which the operands, data type and other properties can be defined for the new symbol opens.

If you select the "Absolute" type of addressing, absolute addresses are shown. If a symbolic address is entered, SPEED7 Studio replaces this address with the absolute address.

You can continue to edit symbolic addresses. Chap. 8.5.5 'Create / edit symbol' page 221

Automatic completion

When you enter operands or values, a selection list with input suggestions and other information will be shown as a tool tip. With each additional letter you enter, the suggestions are narrowed down.

Fig. 170: Input suggestions for local variables (input: #)

Fig. 171: Input suggestions for symbol names (input: ”)
Add input

In some FBD elements (e.g. bit logics), you can add more inputs.

- In the FBD element, click on the ‘+’ symbol at the bottom left.
- Drag the input element from the catalog to the desired position in the input area.
- A further input is added.

Remove input

1. Click on the line of the input you want to remove.
   - The input is marked in grey.
2. Press [Del].
   - The input is removed.

Add branch

1. Click on the middle of a connecting line.
   - The connecting line is marked with two lines.
2. Right-click with the mouse button on the marking and select ‘Branch’.
   - A branch is added to the connection.

Remove branch

1. Click on the end of a branch. No FBD element may be added to this branch.
   - The branch is marked with two lines.
2. Press [Del].
   - The branch is removed.

Opening a block from the element

You can open a block directly from the CALL element in order to then edit it. Select one of the following options to this end:

- Double-click on the block name.
- Right-click with the mouse button on the block name and select ‘Open block’.
- Keyboard: Mark the CALL element and press [Ctrl]+[Alt]+[O].

Fig. 172: Example of opening blocks by double clicking
Error messages

If there is an error message, e.g. in the case of a conflict in the block call, a warning symbol is displayed in the FBD element.

1. To obtain further information about this error, hover the mouse pointer over the warning symbol.
   - The cause of error is displayed as a tool tip.

2. To remove the error, click on the block and press [CTRL]+[Alt]+[P].
   - To remove the errors of all blocks in the network, click on a free area in the network (no element may be selected) and press [CTRL]+[Alt]+[P].

   Not all errors can be automatically removed. You may have to edit the block call manually in order to remove the error.

Undo changes and restore them

With the key combination [CTRL]+[Z], you can undo the last change.

With the key combination [CTRL]+[Y], you can restore the last change which you have undone.

Watch block

If you activate the function ‘Watch block’, you can watch the variables of the current block in the block editor (monitoring).

8.6.3 Ladder diagram (LD)

Ladder diagram (LD) is a graphic programming language for signal processing. With ladder diagram, different functional elements may be connected with each other in order to control the signal flow. The presentation can be compared to a circuit diagram. The connection of contacts and coils describe the current flow between two contact rails.

Ladder diagram is designed for controls where simple elements such as make and break contacts and outputs are used. More complex elements, such as time elements or counters are displayed like in the programming language function block diagram (FBD), see figure.

<table>
<thead>
<tr>
<th>Char</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>—</td>
<td>Left of the element: input parameter (incoming value)</td>
</tr>
<tr>
<td>&gt;&gt;</td>
<td>Right of the element: Output parameter (outgoing value), signal flow has not been completed</td>
</tr>
<tr>
<td>├</td>
<td>Signal flow has been completed</td>
</tr>
<tr>
<td>???</td>
<td>Specification of the parameter is mandatory</td>
</tr>
<tr>
<td>...</td>
<td>Specification of the parameter is optional</td>
</tr>
</tbody>
</table>
Automatic completion

During entry, a selection list with input suggestions and other information will be shown as a tool tip. With each additional letter you enter, the suggestions are narrowed down.

Fig. 173: Example for input suggestions for the data type INT

Automatic completion of symbolic addresses

If you enter a symbolic address without quotation marks, the quotation marks are added automatically.

Symbolic and absolute addressing

You can select whether the operands should be shown as symbolic or absolute: In addition, you can activate dialogue support for symbol input and define the prefix for automatically generated symbols, see Chap. 4.7 'Symbolic and absolute addressing' page 24.

If you select the "Symbolic" type of addressing, symbolic addresses are shown. If you enter an absolute address, SPEED7 Studio replaces this address with the available symbol. If no symbol is available, SPEED7 Studio automatically generates a symbol. If you activate dialogue support, a dialogue window in which the operands, data type and other properties can be defined for the new symbol opens.

If you select the "Absolute" type of addressing, absolute addresses are shown. If a symbolic address is entered, SPEED7 Studio replaces this address with the absolute address.

You can continue to edit symbolic addresses. Chap. 8.5.5 'Create / edit symbol' page 221

Tool tips for the operands

If you hover the mouse pointer over an operand, a tool tip is displayed.
Error messages

If there is an error message, e.g. in the case of a conflict in the block call, a warning symbol is displayed in the LD element.

1. To obtain further information about this error, hover the mouse pointer over the warning symbol.
   ⇒ The cause of error is displayed as a tool tip.

2. To remove the error, click on the block and press [CTRL]+[Alt]+[P].
   To remove the errors of all blocks in the network, click on a free area in the network (no element may be selected) and press [CTRL]+[Alt]+[P].

Not all errors can be automatically removed. You may have to edit the block call manually in order to remove the error.

Undo changes and restore them

With the key combination [CTRL]+[Z], you can undo the last change.

With the key combination [CTRL]+[Y], you can restore the last change which you have undone.

Watch block

If you activate the function ‘Watch block’, you can watch the variables of the current block in the block editor (monitoring). Chap. 8.21 ‘Watch block’ page 281

8.7 Adding new data blocks (DB)

If you want to create a new block, a project must be opened and a control must be contained in the project.

1. In the project tree within a control, click on ‘Add new block’ in the ‘PLC program’ at ‘Program blocks’.
   ⇒ The dialogue window ‘Add new block’ will open.

Fig. 174: Adding new block via the “project tree”
Fig. 175: Dialogue window "Add new block", data block

2. Select the block type ‘DB-Block’.

3. ‘Name’: Enter a different block name, if required. You can reference the block in the user program with this name.

4. ‘Number’: Select a free block number. Blocks that are already present cannot be selected.

5. ‘Type’: Select between two types of data blocks:
   - **Global DB**: For the access to the global data range of the control. All program blocks (OB, FB, FC) have access to the data.
   - **Instance DB [FB]**: The data block contains the persistent data ranges of a certain function block (FB or SFB). Only this function block has access to the data.

6. Click on ‘To take some more inputs..’ if you want to enter further block details. The following details can be entered: Title, comment, version and revision number, control family, author and syntax language. You can make or change these entries later in the block editor.

7. Click on ‘.’.

If you select the option ‘Open block’ and click on ‘OK’, block editor will open.

The data block is added and displayed in the project tree.
Different types of data blocks (DB) can be edited, transferred to the control, synchronised with the control and monitored in this editor. Data blocks contain data for the user program (PLC program), but no program instructions. Chap. 8.1 ‘Program blocks’ page 207

You can create new blocks or open existing blocks.

If you want to add a data block, please note Chap. 8.7 ‘Adding new data blocks (DB)’ page 233.

Select one of the following options in order to open an existing data block in the block editor:

- **Project tree**: Double-click on the desired data block (block name) in the control at ‘PLC program’, ‘Program block’.
- **“Device overview” editor**: Double-click on the desired data block.

---

**Fig. 176: Block editor for data blocks (DB)**

1. **Toolbar**
2. **Block information and title**
3. **Declaration section**
4. **Information bar**

**Showing/hiding input areas**

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area

**Compile block [Ctrl]+[B]**: The data block is compiled.

**Load block into device [Ctrl]+[L]**: The data block is transferred to the control. To this end, a communication connection with the control is established. A dialogue window will open, where you can select the interface connection and make further configurations.

**Load block from device**: The data block is transferred from the control to the project. To this end, a communication connection with the control is established.
**Compare blocks:** The data block is compared to the data block which is present in the control. To this end, a communication connection with the control is established. *Chap. 8.20 ‘Compare blocks’ page 278*

**Use actual values as initial values:** All current values are transferred from the control into the ‘Initial value’ column in the project. To this end, a communication connection with the control is established.

**Initial values to take over actual values:** The values entered in the ‘Default value’ column are transferred into the control and are adopted there as actual values. To this end, a communication connection with the control is established.

**Block watch On/Off:** Watching the variables of the data block in the control. To this end, a communication connection with the control is established. The variable values are cyclically read from the control and displayed.

**(2) Block information**

Here you are provided with further information, and you can enter a title and comment on the data block. The following buttons are displayed if you hover with the mouse over a field with the ‘Block information’.

- **Comment field:** Here you can show or hide the comment field.
- **Advanced Configurations:** Here, you can show or hide further configurations, such as author and version.
- **Block information:** Here, you can show or hide information about the block.
- **History:** Here, you can show or hide the display of the block versions.

**(3) Declaration section**

The variables of the data block are defined in the declaration section.

- ‘1st Column’ – Area to select the vectors of the data type ARRAY
- ‘2nd Column’ – Area to select all other data
- ‘Address’ – Internal automatically created address for data filing in the data block
- ‘Name’ – Name of the variables
- ‘Data type’ – Data type of the variables
- ‘...’ – Further configurations for the selected data type e.g. dimensions and field boundaries of the ARRAY data type
- ‘Default value’ – Initial value of the variables
- ‘Actual value’ – Actual value of the variables read from the control if "Watch block" is switched on
- ‘Comment’ – Any comment e.g. remark or explanation

**(4) Information bar**

The information bar provides information on the data block:
- User name and date of the last stored change
- Name of the control, of the CPU and of the data block
- Status of the block since the last saving (changed/unchanged)
- Connection status to the control (inactive/active/error): If you move the mouse cursor to this field, details on the connection status are displayed.
8.8.1 Edit and use variables

**Rules for declaration**

Only use admissible identifiers for the variable name:

- An identifier is a sequence of letters, numbers and underline characters "_". Space characters are not admitted in the identifier.
- Identifiers may consist of a maximum of 24 characters.
- There is no distinction between upper and lower case letters e.g. the identifier "Magazine_full" is identical with "MAGAZINE_FULL" and "magazine_full".

**Adding/declaring variables**

![Fig. 177: Adding/declaring variables](image1)

The variables can be declared line by line. Each line in the declaration section can contain a variable.

- New variables can be declared at free positions. The symbol in the ‘Address’ column indicates that the position is free and that a variable can be declared in this line.
- After having declared a variable, a new free line is automatically added.

1. Click on the free input field in the ‘Name’ column.
2. Enter a name for the variable e.g. `awValues`.
3. Click on the adjacent field in the ‘Data type’ column and select the desired data type e.g. "ARRAY_OF_TYPE" for data fields.

![Fig. 178: Enter dimensions and field boundaries](image2)

4. Any further configurations which are possible for the selected data type, z. B. dimensions and field boundaries of the data type are displayed in the ‘...’ field. Click on the field to enter the configurations. Click on `...` to make configurations using a dialogue window.
5. If you want to assign an initial value to the variables, click on the ‘Default value’ field and select a default value or enter a value.
6. If you want to enter a comment on the variables, click on the ‘Comment’ field and enter the comment.

Add pre-set variable

You can insert a new variable with the same properties above or below the current line in the table.

1. Click into the second column of a variable cell.
2. Right-click with the mouse button on it and select ‘Add variable before’ or ‘Add variable after’.
   ⇒ A new line is inserted in the table. An address will be assigned, and the variable name of the current table line will be adopted and numbered consecutively.

Fig. 179: (1) First and (2) second column

Changing variables

You can change various properties of an already declared variable.

Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

Fields highlighted in grey cannot be changed.

8.8.2 Move, copy, paste and delete variables

Copy individual variable

1. Right-click with the mouse button on the second column of the variable line and select ‘Copy to clipboard’.
2. Right-click with the mouse button on the position where you want to insert the variable line and select ‘Paste from clipboard’.
   ⇒ The variable line is inserted.

Fig. 180: (1) First and (2) second column

This way, you can copy variables within one block but also from one block to another.

Move individual variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.
   ⇒ The variable line is inserted.

Copy individual variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.
   ⇒ The variable line is copied and inserted. The new variable has the same properties as the initial variable. The address and the variable name are adopted and numbered consecutively.
Move several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.

2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.

2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The addresses and the variable names are adopted and numbered consecutively.

Deleting variables

1. In the second column, highlight the variable line which you want to delete.

   Individual vectors of the data type ARRAY can only be highlighted in the first column.

2. Press [Del].
   - or -
   Right-click with the mouse button on the line and select ‘Delete selected variable’. A dialogue window will open, where you can select whether you want to delete the variable.
   ⇒ The variable is deleted or removed from the declaration.

8.9 Adding a new structure block (UDT)

If you want to create a new block, a project must be opened and a control must be contained in the project.

1. In the project tree within a control, click on ‘Add new block’ in the ‘PLC program’ at ‘Program blocks’.
   ⇒ The dialogue window ‘Add new block’ will open.
Block editor for structure blocks (UDT)

2. Select the block type ‘UDT’.

3. ‘Name’: Enter a different block name, if required. You can reference the data structure in the user program with this name.

4. ‘Number’: Select a free block number. Blocks that are already present cannot be selected.

5. Click on ‘To take some more inputs...’ if you want to enter further block details. The following details can be entered: Title, comment, version and revision number, control family, author and syntax language. You can make or change these entries later in the block editor.

6. Click on ‘OK’.

Fig. 182: Dialogue window "Add new block", structure block

The structure block is added and displayed in the project tree.

8.10 Block editor for structure blocks (UDT)

Different types of structure blocks (UDT, user-defined data type) can be edited, transferred to the control, synchronised with the control and monitored in this editor. Structure blocks contain data structures for the user program (PLC program), but no program instructions. ▶ Chap. 8.1 ‘Program blocks’ page 207

You can create new blocks or open existing blocks.
If you want to add a structure block, please note Chap. 8.9 ‘Adding a new structure block (UDT)’ page 239.

Select one of the following options in order to open an existing structure block in the block editor:

- **Project tree**: Double-click on the desired structure block (block name) in the control at ‘PLC program’, ‘Program blocks’.
- "Device overview" editor: Double-click on the desired structure block.

![Fig. 183: Block editor for structure blocks](image)

**Showing/hiding input areas**

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area

**1 Toolbar**

- **Re-register block**: Make UDT block known at the compiler interface

**2 Block information**

- Here you are provided with further information, and you can enter a title and comment on the structure block. The following buttons are displayed if you hover with the mouse over a field with the ‘Block information’.
  - **Comment field**: Here you can show or hide the comment field.
  - **Advanced Configurations**: Here, you can show or hide further configurations, such as author and version.
  - **Block information**: Here, you can show or hide information about the block.
  - **History**: Here, you can show or hide the display of the block versions.

**3 Declaration section**

The variables of the structure block are defined in the declaration section.
‘1st Column’ – Area to select the vectors of the data type ARRAY

‘2nd Column’ – Area to select all other data

‘Address’ – Internal automatically created address for data filing in the structure block

‘Name’ – Name of the variables

‘Data type’ – Data type of the variables

‘...’ – Further configurations for the selected data type e.g. dimensions and field boundaries of the ARRAY data type

‘Default value’ – Initial value of the variables

‘Comment’ – Any comment e.g. remark or explanation

(4) Information bar

The information bar provides information on the structure block:

- User name and date of the last stored change
- Name of the control, of the CPU and of the structure block
- Status of the block since the last saving (changed/unchanged)

8.10.1 Edit and use variables

Rules for declaration

Only use admissible identifiers for the variable name:

- An identifier is a sequence of letters, numbers and underline characters "_". Space characters are not admitted in the identifier.
- Identifiers may consist of a maximum of 24 characters.
- There is no distinction between upper and lower case letters e.g. the identifier "Magazine_full" is identical with "MAGAZINE_FULL" and "magazine_full".

Adding/declaring variables

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Data type</th>
<th>Default value</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>wStatus</td>
<td>WORD</td>
<td>W#16#0000</td>
</tr>
<tr>
<td>2.0</td>
<td>awValues</td>
<td>ARRAY_OF_TYPE</td>
<td>W#16#0000</td>
</tr>
</tbody>
</table>

Fig. 184: Adding/declaring variables

The variables can be declared line by line. Each line in the declaration section can contain a variable.

New variables can be declared at free positions. The symbol in the ‘Address’ column indicates that the position is free and that a variable can be declared in this line.

After having declared a variable, a new free line is automatically added.

1. Click on the free input field in the ‘Name’ column.
2. Enter a name for the variable e.g. awValues.
3. Click on the adjacent field in the ‘Data type’ column and select the desired data type e.g. "ARRAY_OF_TYPE" for data fields.
4. Any further configurations which are possible for the selected data type, z. B. dimensions and field boundaries of the data type are displayed in the ‘...’ field. Click on the field to enter the configurations. Click on ☰ to make configurations using a dialogue window.

5. If you want to assign an initial value to the variables, click on the ‘Default value’ field and select a default value or enter a value.

6. If you want to enter a comment on the variables, click on the ‘Comment’ field and enter the comment.

Add pre-set variable

You can insert a new variable with the same properties above or below the current line in the table.

1. Click into the second column of a variable cell.
2. Right-click with the mouse button on it and select ‘Add variable before’ or ‘Add variable after’.

   A new line is inserted in the table. An address will be assigned, and the variable name of the current table line will be adopted and numbered consecutively.

Fig. 186: (1) First and (2) second column

Changing variables

You can change various properties of an already declared variable.

   Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

Fields highlighted in grey cannot be changed.
8.10.2 Move, copy, paste and delete variables

Copy individual variable

1. Right-click with the mouse button on the second column of the variable line and select ‘Copy to clipboard’.
2. Right-click with the mouse button on the position where you want to insert the variable line and select ‘Paste from clipboard’.
   ⇒ The variable line is inserted.

Move variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.
   ⇒ The variable line is inserted.

Copy variable with "Drag & drop"

1. In the second column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.
   ⇒ The variable line is copied and inserted. The new variable has the same properties as the initial variable. The address and the variable name are adopted and numbered consecutively.

Move several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the second column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The address and the variable names are adopted and numbered consecutively.

Fig. 187: (1) First and (2) second column

This way, you can copy variables within one block but also from one block to another.
Deleting variables

1. In the second column, highlight the variable line which you want to delete.

   *Individual vectors of the data type ARRAY can only be highlighted in the first column.*

2. Press [Del].
   - or -
   
   Right-click with the mouse button on the line and select ‘Delete selected variable’.

   A dialogue window will open, where you can select whether you want to delete the variable.

   ⇒ The variable is deleted or removed from the declaration.

8.11 PLC variables

In the variable tables, you can declare, group and manage the variables and symbols pertinent to a control (CPU). For each control created in the project, the following variable tables are automatically created:

- The ‘All variables’ variable table contains all variables which are used in the project. All variable tables including ‘System hardware configuration’ and ‘Standard project configuration’ are collected in this table. ⇒ Chap. 8.11.2 ‘All variables’ page 246
- The addresses for all components of the control system are listed in the ‘System hardware configuration’. The variable names for inputs and outputs are automatically generated. ⇒ Chap. 8.11.4 ‘Variable tables and “Standard project configuration”’ page 252
- All variables excluding the hardware configuration are declared in the ‘Standard project configuration’. Additional variable tables can be added as required. ⇒ Chap. 8.11.3 ‘System hardware configuration’ page 249

8.11.1 Adding and editing a new variable table

Adding a new variable table

1. In the project tree within a control, click on ‘PLC program’ on ‘PLC variables’ ⇒ Add variable table’.

   ⇒ The dialogue window ‘Add variable table’ will open.

2. ‘Name’: Enter a different name, if required.

3. ‘Comment’: Enter a comment, if required, e.g. remark or explanation

4. Click on ‘OK’.

   ⇒ The variable table is added and displayed in the project tree.
Editing variable table

Double click on the desired variable table under ‘PLC program’, ‘PLC variables’ in the project tree within a control.

The variable table will open. Chap. 8.11.4 ‘Variable tables and “Standard project configuration”’ page 252

8.11.2 All variables

The ‘All variables’ variable table contains all variables which are used in the project. All variable tables including ‘System hardware configuration’ and ‘Standard project configuration’ are collected in this table. For each control (CPU) created in the project, a variable table with the name ‘All variables’ is automatically created. In this variable table, you can declare, group and manage all of the variables pertinent to a control.

Edit variables directly in the block editor

You can also create and edit individual variables directly in the block editor. All changes are adopted in the “Standard project configuration” variable table. Chap. 8.5.5 ‘Create / edit symbol’ page 221

To open the variable table, double click on ‘All variables’ under ‘PLC program’, ‘PLC variables’ in the project tree within a control.

Fig. 189: All variables

1. Toolbar
2. Information on the variable table
3. Add and group variables
4. Editing variable table

Showing/hiding input areas

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area
- Hide slave objects
- Show slave objects
(1) Toolbar

List group / ungroup: Presentation of the variable table grouped or ungrouped further information page 255

Print: Prints the variable table

(2) Information on the variable table

You can enter a comment on the variable table here.

(3) Add and group variable

<table>
<thead>
<tr>
<th>Group</th>
<th>Operand</th>
<th>Name</th>
<th>Data type</th>
<th>Variable table</th>
<th>Area of validity</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>MW 44</td>
<td>WORD</td>
<td>Standard project configuration</td>
<td>Global</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 190: Add variable (section)

You can make new entries in the first line of the table. You can recognise these lines by the symbol.

1. You can sort variables by groups. In order to allocate the variable to a group, click on the ‘Group’ column in the first line of the table and enter a new group name into the input field or select an existing group. If you do not select a group, then the "General" group will be used by default.

2. Click on the input field of the ‘Operand’ column and enter the operand, e.g. MW 44.

3. Click on the adjacent field in the ‘Name’ column and enter a variable name (symbolic address). If you do not enter a variable name, SPEED7 Studio automatically generates a symbolic address. Chap. 4.7 ‘Symbolic and absolute addressing’ page 24

4. Click on the adjacent field in the ‘Data type’ column and select the desired data type. Here, the permitted data types suitable for the operand are shown, e.g. "WORD" for the operand MW.

5. Click on the adjacent field in the ‘Variable table’ column and select the variable table in which the variable should be saved.

6. Click on the ‘Area of validity’ column in the adjacent field and select the validity:
   - To use the variable only within one block, select the desired block.
   - to use the variable in the entire user program, select "Global".

7. If you want to use the variable in HMI images, activate Visu.

8. Only in the case of controls with an integrated OPC UA server: If you would like to use the variable in the OPC UA configuration, activate OPC UA.

9. Enter a ‘Comment’, if required.

10. Confirm your input with [Enter].
   ⇒ The new variable is inserted into the variable table. In addition, the variable is entered in the "All variables" variable table.

(4) Variable table

‘1st Column’ – Selection area
‘Group’ – Sort and display table entries by group
‘Operand’ – Address of the variables
‘Name’ – Name of the variables (symbolic address)
‘Data type’ – Data type of the variables
‘Variable table’ – Variable table in which the variable is saved
‘Area of validity’ – Use variable in a block or in the entire user program
‘Visu’ – Use variable in HMI images  Chap. 9.4 “Standard variables table” editor page 316. You can then copy (synchronise) the variable into the variable table for the HMI project. Chap. 9.4 “Standard variables table” editor page 316

‘OPC UA’ (only in the case of controls with an integrated OPC UA server) – Use variable in the OPC UA configuration Chap. 7.7 ‘Configure OPC UA’ page 199

‘Comment’ – Any comment e.g. remark or explanation

‘Type’ – Operand area of the variables (not editable), e.g. input, output, memory

### Changing the variable/group
You can change existing variables or groups in the table.

- Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

  Fields highlighted in grey cannot be changed.

### Change variable name used
When you change a variables name (symbolic address) which is already in use, this is automatically changed in all program blocks.

### Moving a variable to another variable table
You can move variables from one variable table to another.

- Click in the ‘Variable table’ input field and select the desired variable table.

  The variable is removed from the previously specified variable table and inserted and saved in the newly selected variable table.

### Delete variable/group
1. In the first column, highlight the variable or group which you want to delete.
2. Press [Del].

  A dialogue window will open, where you can select whether you want to delete the variable or group.

  If symbols which are to be deleted are used in the program code, another dialogue window is displayed. Use [Yes] to choose to delete all variables. The program code thus becomes invalid. Use [No] to choose to delete only those variables which are not used in the program code.

  The variable or group and all the variables contained therein are deleted and removed from the declaration.

### Move variable with "Drag & drop"
1. In the first column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.

  The variable line is inserted.

### Copy variable with "Drag & drop"
1. In the first column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.

  The variable line is copied and inserted. The new variable has the same properties as the initial variable. The operand is adopted and numbered consecutively.
Move several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.

2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.

2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The operands are adopted and numbered consecutively.

Overlapping addresses

Overlapping addresses (consistency errors) occur when multiple symbol names are assigned to an operand. Overlaps are indicated in the ‘Name’ column with the symbol. Overlaps can also occur through multiple variable tables, e.g. with a symbol name at E0.0 in the system hardware configuration and another symbol name also at E0.0 in the standard project configuration.

Changing the presentation of the variable table

You can display the variable table grouped or ungrouped:

⇒ Click on the toolbar (1) to change the presentation.

In the grouped presentation, you can show or hide entire groups:

- Hide slave group
- Show slave group

8.11.3 System hardware configuration

The addresses for all components of the control system are listed in the ‘System hardware configuration’. For each control (CPU) created in the project, the system hardware configuration is automatically created. You can define the names and use of the operands in this table.

⇒ To open the system hardware configuration, double click on ‘System hardware configuration’ under ‘PLC program’, ‘PLC variables’ in the project tree within a control.
Fig. 192: System hardware configuration

1) Toolbar
2) Information regarding the system hardware configuration
3) Edit the system hardware configuration

**Showing/hiding input areas**

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area
- Hide slave objects
- Show slave objects

1) Toolbar

- **List group / ungroup**: Presentation of the system hardware configuration grouped or ungrouped further information page 255
- **Print**: Prints the system hardware configuration

2) Information regarding the system hardware configuration

You can enter a comment on the system hardware configuration here.

3) System hardware configuration

- ‘1st Column’ – Selection area
- ‘Group’ – Component name (not editable)
- ‘Operand’ – Address of the variables (not editable). For changing the I/O addresses of components, see Chap. 8.12 ‘Address overview’ page 255.
- ‘Name’ – Name of the variables (symbolic address)
- ‘Data type’ – Data type of the variables (not editable)
- ‘Visu’ – Use variable in HMI images Chap. 9.4 “Standard variables table” editor page 316. You can then copy (synchronise) the variable into the variable table for the HMI project. Chap. 9.4 “Standard variables table” editor page 316
- ‘OPC UA’ (only in the case of controls with an integrated OPC UA server) – Use variable in the OPC UA configuration Chap. 7.7 ‘Configure OPC UA’ page 199
- ‘Comment’ – Any comment e.g. remark or explanation
Adding components

When you add new components to the project, the necessary I/O address ranges are automatically assigned. The variables (symbolic addresses) for all inputs and outputs are automatically generated.

If an automatically assigned I/O address has already been entered in the variable table, this address is allocated to the system hardware configuration.

Example

The four consecutive input addresses E0.0 to E0.4 are automatically assigned for a newly added input component "DI4xDC24V".

If, for example, the input address E0.0 has already been entered in the "Standard project configuration" variable table, this entry is allocated to the system hardware configuration after the component is added. The symbol name is not changed. For all input addresses which are not yet assigned, the symbol name is automatically generated:

<table>
<thead>
<tr>
<th>Before adding the component</th>
<th>After adding the component</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operand</strong></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>E0.0</td>
<td>MyVar</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Removing components

If you remove components from the project, the corresponding variables are retained. The variables are moved into the "Standard project configuration" variable table and can continue to be used for programming.

Example

The "DI4xDC24V" input component is removed from the project. The input addresses E0.0 to E0.4 previously entered in the system hardware configuration are allocated to the "Standard project configuration" variable table.

<table>
<thead>
<tr>
<th>Before deleting the component</th>
<th>After deleting the component</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Operand</strong></td>
<td><strong>Name</strong></td>
</tr>
<tr>
<td>E0.0</td>
<td>MyVar</td>
</tr>
<tr>
<td>E0.1</td>
<td>x_DI_0_1_25</td>
</tr>
<tr>
<td>E0.2</td>
<td>x_DI_0_2_25</td>
</tr>
<tr>
<td>E0.3</td>
<td>x_DI_0_3_25</td>
</tr>
</tbody>
</table>
Changing I/O addresses

You can change the I/O addresses of components in the "address overview". Please note that changes can result in overlaps and consistency errors can thus occur, see Chap. 8.12 'Address overview' page 255.

Overlapping addresses

Overlapping addresses (consistency errors) occur when multiple symbol names are assigned to an operand. Overlaps are indicated in the 'Name' column with the symbol. Overlaps can also occur through multiple variable tables, e.g. with a symbol name at E0.0 in the system hardware configuration and another symbol name also at E0.0 in the standard project configuration.

8.11.4 Variable tables and "Standard project configuration"

In a variable table, you can declare, group and manage the variables pertinent to a control (CPU). For each control created in the project, a variable table with the name "Standard project configuration" is automatically created. You can declare all variables excluding the hardware configuration in this variable table. Additional variable tables can be added as required, see further information page 245.

Edit variables directly in the block editor

You can also create and edit individual variables directly in the block editor. All changes are adopted in the "Standard project configuration" variable table. Chap. 8.5.5 'Create / edit symbol' page 221.

All changes in variable tables are adopted in the "All variables" variable table.

To open an existing variable table, double click on the desired variable table under 'PLC program', 'PLC variables' in the project tree within a control.

Fig. 193: "Standard project configuration" variable table

1. Toolbar
2. Information on the variable table
3. Add and group variables
4. Editing variable table

Showing/hiding input areas

You can show or hide the input areas:
Shows/opens the input area
Hides/closes the input area
Hide slave objects
Show slave objects

(1) Toolbar

List group / ungroup: Presentation of the variable table grouped or ungrouped  further information page 255
Print: Prints the variable table

(2) Information on the variable table
Here you can change the name of the variable table and enter a comment.

(3) Add and group variable

<table>
<thead>
<tr>
<th>Group</th>
<th>Operand</th>
<th>Name</th>
<th>Data type</th>
<th>Area of validity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plant 1</td>
<td>MW 44</td>
<td>WORD</td>
<td></td>
<td>Global</td>
</tr>
</tbody>
</table>

Fig. 194: Add variable (section)
You can make new entries in the first line of the table. You can recognise these lines by the symbol.

1. You can sort variables by groups. In order to allocate the variable to a group, click on the ‘Group’ column in the first line of the table and enter a new group name into the input field or select an existing group. If you do not select a group, then the "General" group will be used by default.

2. Click on the input field of the ‘Operand’ column and enter the operand, e.g. MW 44.

3. Click on the adjacent field in the ‘Name’ column and enter a variable name (symbolic address). If you do not enter a variable name, SPEED7 Studio automatically generates a symbolic address. Chap. 4.7 ‘Symbolic and absolute addressing’ page 24

4. Click on the adjacent field in the ‘Data type’ column and select the desired data type. Here, the permitted data types suitable for the operand are shown, e.g. "WORD" for the operand MW.

5. Click on the ‘Area of validity’ column in the adjacent field and select the validity:
   - To use the variable only within one block, select the desired block.
   - To use the variable in the entire user program, select "Global".

6. If you want to use the variable in HMI images, activate ‘Visu’.

7. Only in the case of controls with an integrated OPC UA server: If you would like to use the variable in the OPC UA configuration, activate ‘OPC UA’.

8. Enter a ‘Comment’, if required.

9. Confirm your input with [Enter].
   The new variable is inserted into the variable table.

(4) Variable table
‘1st Column’ – Selection area
‘Group’ – Sort and display table entries by group
‘Operand’ – Address of the variables
‘Name’ – Name of the variables (symbolic address)
‘Data type’ – Data type of the variables

‘Area of validity’ – Use variable in a block or in the entire user program

‘Visu’ – Use variable in HMI images  Chap. 9.4 “Standard variables table editor” page 316. You can then copy (synchronise) the variable into the variable table for the HMI project.  Chap. 9.4 “Standard variables table editor” page 316

‘OPC UA’ (only in the case of controls with an integrated OPC UA server) – Use variable in the OPC UA configuration  Chap. 7.7 ‘Configure OPC UA’ page 199

‘Comment’ – Any comment e.g. remark or explanation

‘Type’ – Operand area of the variables (not editable), e.g. input, output, memory

Changing the variable/group

You can change existing variables or groups in the table.

1. Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

   Fields highlighted in grey cannot be changed.

Change variable name used

When you change a variables name (symbolic address) which is already in use, this is automatically changed in all program blocks.

Delete variable/group

1. In the first column, highlight the variable or group which you want to delete.
2. Press [Del].
   A dialogue window will open, where you can select whether you want to delete the variable or group.
   If symbols which are to be deleted are used in the program code, another dialogue window is displayed. Use [Yes] to choose to delete all variables. The program code thus becomes invalid. Use [No] to choose to delete only those variables which are not used in the program code.
   ⇒ The variable or group and all the variables contained therein are deleted and removed from the declaration.

Move variable with "Drag & drop"

1. In the first column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.
   ⇒ The variable line is inserted.
Copy variable with "Drag & drop"

1. In the first column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.
   ⇒ The variable line is copied and inserted. The new variable has the same properties as the initial variable. The operand is adopted and numbered consecutively.

Move several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"

1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The operands are adopted and numbered consecutively.

Overlapping addresses

Overlapping addresses (consistency errors) occur when multiple symbol names are assigned to an operand. Overlaps are indicated in the ‘Name’ column with the symbol. Overlaps can also occur through multiple variable tables, e.g. with a symbol name at E0.0 in the system hardware configuration and another symbol name also at E0.0 in the standard project configuration.

Changing the presentation of the variable table

You can display the variable table grouped or ungrouped:

⇒ Click on in the toolbar (1) to change the presentation.

In the grouped presentation, you can show or hide entire groups:

⇒Hide slave group
⇒Show slave group

8.12 Address overview

The input and output addresses (I/O addresses) of all projected devices and components assigned to a control are shown in a table in the address overview.

Select one of the following options in order to open the address overview:

⇒ Project tree: Click on ‘Address overview’ in the control.
⇒ “Devices and networking” editor: Right-click with the mouse button on the desired control and select ‘Address overview’.
The table includes all local and decentralised components of the control. The input components (I addresses) and further below the output components (O addresses) are listed at the top of the table.

‘No.’ – Consecutive number
‘Device’ – Device name [order number of the device]
‘Component’ – Component name
‘Slot’ – Slot number within the rack
‘I-Address’ – Configured input address (byte address) of an input component
‘O-Address’ – Configured output address (byte address) of an output component
‘Order number’ – Order number of the device or component

Depending on the number of channels, a component occupies a different number of byte addresses. Here are some examples on the basis of Fig. 196:

- No. 1: The "DI8xDC24V" input component occupies the input byte 0.
- No. 2: The input component "DI4xDC24V" occupies the first four bits of input byte 1. The remaining bits of input byte 1 cannot be used.
- No. 4: The communication processor "CP343" for the control occupies the 16 consecutive input and output bytes 864 to 879.
- No. 7 and 8: The PROFINET IO system for the control occupies input bytes 2043 and 2046 for the exchange of diagnostics data.
- No. 10: The "DO8xDC24V 0.5A" output component occupies the output byte 0.

When you add new components to the project, the necessary I/O address ranges are automatically reserved, shown in the address overview and entered in the "System hardware configuration".

You can change the I/O addresses of individual components:
Please note that changes to the I/O addresses can result in overlaps and consistency errors can thus occur, see ‘Overlapping addresses’ page 257

1. In the table, highlight the line with the component of which you want to change the address.

2. Enter the new address in the ‘Start address’ field.
   If this address is already occupied, a notification will appear. You can proceed as follows:
   - Enter a different start address.
   - Ignore the notification initially and then change the address or the symbol name in the variable table in which the overlap occurs. Overlaps are indicated in the variable table with the symbol.

3. Confirm your input with [Enter].
   → The address is changed. If the component occupies several byte addresses, the ‘End Address’ is automatically calculated and the complete address range is assigned to the component.

Overlapping addresses

Overlapping addresses (consistency errors) occur when multiple symbol names are assigned to an operand. Overlaps are indicated in the ‘Name’ column with the symbol. Overlaps can also occur through multiple variable tables, e.g. with a symbol name at E0.0 in the system hardware configuration and another symbol name also at E0.0 in the standard project configuration.

When you change I/O addresses, SPEED7 Studio attempts to resolve overlaps itself as specified in the following table so that no addressing conflicts occur:

<table>
<thead>
<tr>
<th>Initial situation with overlaps</th>
<th>Measures for conflict resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The symbol from the system hardware configuration is used in the program code.</td>
<td>The symbol name used in the program is preferred: SPEED7 Studio uses the symbol from the system hardware configuration and removes all other symbol declarations.</td>
</tr>
<tr>
<td>The symbol from a variable table (e.g. standard project configuration) is used in the program code.</td>
<td>The symbol name used in the program is preferred: SPEED7 Studio transfers the symbol from the variable table into the system hardware configuration and removes all other symbol declarations.</td>
</tr>
</tbody>
</table>
Initial situation with overlaps

The symbol from the system hardware configuration and the symbol from a variable table are used in the program code.

Measures for conflict resolution

SPEED7 Studio cannot resolve the conflict and reports a consistency error. The overlaps are indicated in the 'Name' column with the symbol.

The symbol is not used in the program code.

The amended symbol name is preferred:

If the automatically generated symbol name has been changed in the system hardware configuration, SPEED7 Studio uses this symbol.

If the automatically generated symbol name has not been changed in the system hardware configuration, SPEED7 Studio transfers the symbol from the variable table into the system hardware configuration.

All other symbol declarations are removed.

8.13 Cross-reference list

The cross-reference list offers an overview over all operands used in the user program. The cross-reference list is helpful in error search, e.g., in order to determine which operand should be processed in which program block with which command. You can filter those blocks and operand areas which should be displayed. Furthermore, you can jump to the references in the user program.

Cross-references can be displayed and filtered for the following block types:

- Organisation blocks (OB)
- Function blocks (FB)
- Functions (FC)

The following operand types can be displayed:

- Inputs
- Outputs
- memory
- Timers
- Counter
- Periphery inputs
- Periphery outputs
- Data blocks
- Instance data blocks
- Function blocks
- Functions
- System function blocks
- System functions
- indirect addressing
Click on ‘Cross-Reference list’ under ‘PLC program’ in the project tree within a control.

In addition, you can open the cross-reference list directly from the assignment list. Further information page 266

Fig. 197: Open cross-reference list

Fig. 198: Cross-reference list
(1) Toolbar
(2) Block selection
(3) Operand areas (= Address areas)
(4) Configurations
(5) Cross-reference list (result)

Show/hide filter settings
You can show or hide the filter settings:
- Shows/opens the area
- Hides/closes the area

(1) Toolbar
Refresh: Updates the data in the cross-reference list (result). When the data in the cross-reference list must be updated, e.g. because changes have been made in the filter settings or in the user program, this symbol is activated (green colour). When the data in the cross-reference list are up-to-date, this symbol is deactivated (grey colour).

Print: Prints the cross-reference list
(2) Block selection

Here, you can select blocks for which cross-references should be displayed.

1. Activate ‘All blocks’ or the desired blocks, e.g. ‘OB0’.
   The symbol at ‘All blocks’ shows that some blocks are marked.

2. Click on ‘Refresh’ or activate ‘Apply filter changes immediately’, in order to refresh the configuration in the cross-references.

(3) Operand areas

Here, you can select the operand types and address areas which should be displayed in the cross-reference list.

1. Activate ‘All Operand Areas’ or the desired operand type, e.g. ‘Inputs’.
   The symbol at ‘All operand areas’ shows that some operand areas are marked.

2. Enter the Start and End byte addresses in the two fields next to each other, e.g. 0 to 65535.

3. Click on ‘Refresh’ or activate ‘Apply filter changes immediately’, in order to refresh the configuration in the cross-reference list.

(4) Configurations

The configurations for the cross-reference list can be made here.

‘Apply filter changes immediately’ – If this option is enabled, changed operand areas or overlaps in the cross-reference list are refreshed automatically. If this option is not enabled, changes in the cross-reference list are only refreshed when you click on ‘Refresh’.

‘Hide Single Use’ – If this option is enabled, the cross-reference list shows only those operands where the address ranges overlap. ‘Overlaps’ page 265

‘Reset configurations’ – Selects all blocks and operand types and sets the maximum address range.

(5) Cross-reference list (result)

You receive the following display when the operands are not grouped. further information page 261

<table>
<thead>
<tr>
<th>Operand Type</th>
<th>Operand</th>
<th>Symbol</th>
<th>Block</th>
<th>Network</th>
<th>Line</th>
<th>Code Syntax</th>
<th>RW</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Inputs</td>
<td>Q0.1</td>
<td>x_DI_0.1_25</td>
<td>FB1</td>
<td>2</td>
<td>1</td>
<td>L</td>
<td>R</td>
<td>x_DI_0.1_25</td>
</tr>
<tr>
<td>2 Memory</td>
<td>MW20</td>
<td>w_MW20</td>
<td>FB1</td>
<td>1</td>
<td>1</td>
<td>L</td>
<td>R</td>
<td>w_MW20</td>
</tr>
<tr>
<td>3 Memory</td>
<td>MW20</td>
<td>w_MW20</td>
<td>FB1</td>
<td>1</td>
<td>3</td>
<td>L</td>
<td>T</td>
<td>w_MW20</td>
</tr>
<tr>
<td>4 Outputs</td>
<td>Q0.0</td>
<td>x_DO_0.0_22</td>
<td>FB1</td>
<td>2</td>
<td>2</td>
<td>L</td>
<td>W</td>
<td>x_DO_0.0_22</td>
</tr>
</tbody>
</table>

In the heading, it is shown whether the data in the cross-reference list must be updated, e.g. if changes have been made in the filter settings or in the user program: "Result (Out of date, please update)"

Click on ‘Refresh’

The data in the cross-reference list are updated and the message is no longer displayed.

The cross-reference list shows the references for each operand in the applicable program block.

‘Operand Type’ – Type of the selected operand
‘Operand’ – Address of the operand
‘Symbol’ – Symbolic address of the operand
‘Block’ – Program block, in which an operand is accessed
‘Network’ – Number of the network in the program block, in which an operand is accessed
‘Line’ – Number of the program line in the network in which the access is programmed
‘Code Syntax’ – Programming language
‘RW’ – Reading/Writing access of an operand: R = reading, W = writing
‘Code’ – IL program code of the access point

Jump to reference

You can open the program block and jump to the reference of the operand.

Right-click with the mouse button on the desired line in the cross-reference list and select ‘GoTo reference’.

The applicable program block will open and the cursor is set to the reference in the program code.

Changing the sort sequence

When calling the cross-reference list for the first time, the lines are sorted by operand types. You can also sort the data in a different order and by other criteria.

In the title line of the table, click on the term according to which you would like to sort the cross-reference list, e.g. ‘Block’.

The table entries are sorted in alphabetical or numerical order:
- In ascending order
- In descending order

Grouping operands

For a better overview, you can sort table entries by groups.

1. Drag the desired column title into the field above the table.
   - The contents of the column will be grouped. The number of lines is shown for each group.

2. Click on to open the group. Click on to close the group.

You can repeat steps 1 to 2 in order to structure the group into further sub-groups.
In order to cancel a grouping, click on the close icon next to the group name.

![Image](image1.png)

**Fig. 199: Ungroup**

## 8.14 Assignment list

In the assignment list, all operand are displayed which are used in the user program. The assignment list is helpful in error search, e.g. in order to localise multiple access to the same address (overlaps). The following operand types are displayed:

- Inputs
- Outputs
- Memory
- Timers
- Counter
- Periphery inputs
- Periphery outputs

You can filter the operand areas which should be displayed. The references can be displayed in the user program and you can localise overlaps of operands. Furthermore, you can open the cross-reference list or the variable table for each operand.

![Image](image2.png)

**Fig. 200: Open assignment list**

In the project tree within a control, click on ‘Assignment list’ in ‘PLC program’.
Fig. 201: Assignment list

(1) Toolbar
(2) Operand areas (= Address areas)
(3) Configurations
(4) Help (meaning of icons)
(5) Assignment list
(6) References

Show/hide filter settings and help

You can show or hide the area above the assignment list:

- Shows/opens the area
- Hides/closes the area

(1) Toolbar

Refresh: All saved configurations and changed operand areas are refreshed in the assignment list.

(2) Operand areas

Here, you can select the operand types and address areas which should be displayed in the assignment list.

1. Activate ‘All Operand Areas’ or the desired operand type, e.g. ’Inputs’.
2. Enter the Start and End byte addresses in the two fields next to each other, e.g. 0 to 65535.
3. Click on ‘Refresh’ or activate ‘Apply filter changes immediately’ in order to refresh the changes in the assignment list.

‘Reset configurations’ – Selects all operand types and sets the maximum address range.

(3) Configurations

Here you can make general configurations for the assignment list.

‘Apply filter changes immediately’ – If this option is enabled, changed operand areas or overlaps in the assignment list are refreshed automatically. If this option is not enabled, changes in the assignment list are only refreshed when you click on ‘Refresh’.

‘Only show overappings’ – If this option is enabled, the assignment list shows only those operands where the address areas overlap. Click on ‘Refresh’ or activate ‘Apply filter changes immediately’, in order to refresh the display in the assignment list.

‘Show references’ – Show/hide display of the references

(4) Help

The different symbols and tags in the assignment list are explained here.

(5) Assignment list

The operands are displayed in the assignment list as follows:

- Inputs, outputs, memories, periphery inputs and periphery outputs:
  Each table line corresponds to a byte, e.g. "EB2", "MB20".

- Timers and counters:
  Each table line corresponds to a word, e.g. "T1", "Z5".

- Non assigned address areas (free address gaps) in the table line are marked with "...".

‘7 ... 0’ – In these table columns, the bit access for the individual bits 7 to 0 of the operand are displayed. The following tags are possible:

<table>
<thead>
<tr>
<th>7 ... 0</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>empty row</td>
<td>Address is not assigned in the user program (free bit address)</td>
</tr>
<tr>
<td></td>
<td>Address is assigned; read access, e.g. input bit</td>
</tr>
<tr>
<td></td>
<td>Address is assigned; write access, e.g. output bit</td>
</tr>
<tr>
<td></td>
<td>Address is assigned; read and write access, e.g. memory bit</td>
</tr>
<tr>
<td></td>
<td>Currently selected variable, see column &quot;variable&quot;</td>
</tr>
<tr>
<td></td>
<td>dark grey background</td>
</tr>
</tbody>
</table>

‘B, W, D’ – These table columns display the byte, word and double word access of the operand. Example: Any tag of the column ‘W’ means that the address in the user program is used by a word access. The following tags are possible:
<table>
<thead>
<tr>
<th>B, W, D</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>![image]</td>
<td>Address is assigned; read access, e.g. input</td>
</tr>
<tr>
<td>![image]</td>
<td>Address is assigned; write access, e.g. output</td>
</tr>
<tr>
<td>![image]</td>
<td>Address is assigned; read and write access, e.g. memory, timer, counter.</td>
</tr>
<tr>
<td>![image]</td>
<td>Currently selected variable, see column &quot;variable&quot;</td>
</tr>
</tbody>
</table>

'Variable' – Symbolic address of the operand: If several variable names are present for one operand (e.g. for bit operands), you can select the desired variable in a drop down list. The selected variable is tagged in the columns '7 ... 0' or 'B, W, D' with a white dot.

'Comment' – Shows the comment of the current variable

**Overlaps**

You can localise overlaps (multiple accesses on one address area) in the assignment list.

*Filter overlaps*

If you select 'Only show overlappings' in 'Configurations', the assignment list shows only those address areas, where the operand areas overlap, see .

**Fig. 202: Example for overlaps**

The example shows a number of overlaps occurring in the memories 20 to 22:

- (A) – Multiple access via bit and word address (horizontal reading direction):
  - At memory 20, reading access to memory bit $M_{20.0}$ and reading and writing access to memory word $MW_{20}$ occurs.

- (B) – Multiple access via byte and word address (horizontal reading direction):
  - At memory 22, reading and writing access to memory byte $MB_{22}$ and reading and writing access to memory word $MW_{21}$ occurs.

- (C) – Multiple access via two word addresses (vertical reading direction):
  - At memory 20 to 22, reading and writing access to memory byte $M_{20}$ and reading and writing access to memory word $MW_{21}$ occurs.

*If you activate the option 'Show references' in 'Configurations' and click on a operand line in the assignment list, all references of the operand are displayed.*
(6) References

This table shows the points in the user program, where the operands are accessed.

1. Activate the option ‘Show references’ in ‘Configurations’.
   ⇒ Below the assignment list, the table with the references is shown.

2. Click in the assignment list onto a operand line.
   ⇒ All references of the operand are displayed.

References

<table>
<thead>
<tr>
<th>Operand Type</th>
<th>Operand</th>
<th>Variable</th>
<th>Block</th>
<th>Network</th>
<th>Line</th>
<th>RW</th>
<th>Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outputs</td>
<td>A4.0</td>
<td>x_DO_4_0_21</td>
<td>F82</td>
<td>1</td>
<td>3</td>
<td>W</td>
<td>S A 4.0</td>
</tr>
<tr>
<td>Outputs</td>
<td>A4.0</td>
<td>x_DO_4_0_21</td>
<td>F82</td>
<td>1</td>
<td>7</td>
<td>W</td>
<td>R A 4.0</td>
</tr>
</tbody>
</table>

Fig. 203: References in the assignment list

‘Operand Type’ – Type of the selected operand
‘Operand’ – Address of the operand
‘Symbol’ – Symbolic address of the operand
‘Block’ – Program block, in which an operand is accessed
‘Network’ – Number of the network in the program block, in which an operand is accessed
‘Line’ – Number of the program line in the network in which the access is programmed
‘RW’ – Reading/Writing access of an operand: R = reading, W = writing
‘Code’ – IL program code of the access point

Jump to reference

You can open the program block and jump to the reference of the operand.

⇒ Right-click with the mouse button on the desired operand line in the table with the references and select ‘GoTo reference’.
   ⇒ The applicable program block will open and the cursor is set to the reference in the program code.

Grouping operands

For a better overview, you can display table entries sorted by groups.

1. Right-click with the mouse button on any operand line in the assignment list and select ‘Grouped list view’.
   ⇒ The operands are grouped depending on the type. The number of operand lines is shown for each group.

2. Click on ↑ or ↓ to open the group. Click on ↑ or ↓ to close the group.

Switch to the cross-reference list

You can open the cross-reference list for an operand.

⇒ Right-click with the mouse button on the desired operand line in the assignment list and select ‘Go to cross-reference list’.
   ⇒ The cross-reference list will open and the relevant operands are shown.
Switch to the variable table

You can open the variable table for an operand if the operand has been defined in it.

- Right-click with the mouse button on the desired operand line in the assignment list and select ‘Go to variable table’.
  - The corresponding variable table (e.g. system hardware configuration) will open.

8.15 Check and restore consistency

If you edit blocks, inconsistencies can arise, e.g. interface conflicts between two blocks. If you transfer inconsistent blocks into the control, this can lead to processing errors in the user program.

You can check the user program for inconsistencies. In a further processing step, you can remove existing inconsistencies.

Check consistency

To check the consistency, select one of the following options:

- **Consistency messages**: In the output range of the consistency messages, click on . Chap. 4.14.5 ‘Consistency messages’ page 45
- **Menu bar**: Check ‘Project ➔ Check/correct consistency’.
- **Toolbar**: Click on .
  - The consistency is checked and the result is shown in a dialogue window.

Show consistency messages

![Fig. 204: Dialogue window with consistency messages](image)

1. Filter consistency messages
2. Consistency messages
3. Select individual blocks for the correction
4. Select several blocks for the correction
You can filter the consistency messages shown. Use the ‘area filter’ (1) to select the consistency messages that are to be shown:

- **All** – consistency messages of the user programs of all CPUs are shown.
- **CPU...** – Only the consistency messages of the user program of the selected CPU are shown.

⇒ The filtered consistency messages are shown (2). If all blocks are consistent, the ‘Consistency messages’ field is empty.

1. **Select the blocks for which you want to restore consistency in the next step:**
   - Individual blocks: Highlight [✓] the desired consistency messages or blocks (3).
   - Consistency errors, e.g., interface conflicts: Select [✓] ‘All consistency errors’ (4). All blocks with consistency errors are highlighted.
   - Consistency messages, e.g., changed, non-compiled blocks: Select [✓] ‘All consistency messages’ (4). All blocks with consistency messages are highlighted.

2. **Click on ‘Next’**.

⇒ The consistency of the selected blocks is restored. In this process, block dependencies are checked, corrected if necessary and all selected blocks are compiled. The individual steps and results are shown in the dialogue window.

   If the consistency cannot be restored, you must correct the affected blocks manually in the Block editor.

3. **Click on ‘Done’** to close the dialogue window.

### 8.16 Compile user program

A user program consists of blocks. A user program must be compiled into error-free machine code so that it can be executed by the CPU. If you have changed blocks, you must compile the block or the user program.

The compilation involves the following processes:

- **Syntax test:** The user program is searched for syntax errors. If blocks contain syntax errors, the compilation process is stopped and an error message is shown.

- **Consistency test:** The calling-interface between blocks is reviewed. If blocks have errors at the calling-interface, the compilation process is stopped and an error message is shown.

- **Compilation:** The user program is compiled into machine code (translated) that can be processed by the CPU.

All compilation errors are listed in the ‘Programming errors’ output range. Chap. 4.14.2 ‘Programming events’ page 44
To compile the user program, you have various possibilities:

- **‘Compile’**
  Only the blocks that were changed after the last compilation are compiled.
  - or -
  Individual blocks can be selected and compiled.
  - or -
  The block opened in the editor can be compiled.
  ➤ Chap. 8.16.1 ‘Compile’ page 269

- **‘Compile all’**
  All blocks of the user program are compiled.
  ➤ Chap. 8.16.2 ‘Compile all’ page 269

- Compile changed blocks directly before transferring the user program:
  – ➤ Chap. 8.18.2 ‘Transfer user program’ page 273
  – ➤ Chap. 8.18.3 ‘Transfer all’ page 274

### 8.16.1 Compile

You can compile all the blocks that have been changed since the last compilation of the user program or select and compile individual blocks.

#### Compile changed blocks

Select one of the following options:

- **Menu bar**: Select ‘Project ➔ Compile’.
- **Toolbar**: Click on .
- **Keyboard**: Press [F6].
- **Project tree**: Right-click with the mouse button on the project name and select ‘Compile’.

➤ All changed blocks are compiled. The result of the compilation process is shown in the output range.

#### Compile block opened in the editor

Click on ➤ Chap. 8.2 ‘Device overview (PLC)’ page 207 in the block editor.

➤ The block opened in the editor is compiled.

#### Compile individual blocks

In the ‘Device overview’ editor of the control, you can select and compile individual blocks. ➤ Chap. 8.2 ‘Device overview (PLC)’ page 207

### 8.16.2 Compile all

You can compile all blocks of the user program.

Select one of the following options:

- **Menu bar**: Select ‘Project ➔ Compile all’.
- **Toolbar**: Click on .
- **Keyboard**: Press [Shift]+[F6].
- **Project tree**: Right-click with the mouse button on the project name and select ‘Compile all’.

➤ All blocks are compiled. The result of the compilation process is shown in the output range.
8.17 Simulate user program

With the PLC simulation, you can test the user program on the PC before loading it into
the control.

If you want to simulate a user program, you must proceed as follows:

1. Compile the user program. Chap. 8.16 ‘Compile user program’ page 268

   6.20.2 ‘Communication settings (PLC)’ page 111

3. Open the ‘PLC simulation configurations’ dialogue window and create configura-
tions for the simulation, if necessary. Chap. 8.17.1 ‘PLC simulation settings’
   page 270

4. Start the simulation. Select one of the following options to this end:
   - **Menu bar**: Select ‘Simulation ➤ Start PLC simulation’.
   - **Toolbar**: Click on.
   - **"PLC simulation settings” dialogue window**: Click on ‘Start’.
   ⇒ The PLC simulation is started.

5. Test the user program, e.g. in the Block editor or in the ‘Watch table’ editor. You
can observe e.g. values of variables or signal states. You can overwrite variables
with values so as to simulate certain situations for program execution.

6. End the simulation. Select one of the following options to this end:
   - **Menu bar**: Select ‘Simulation ➤ End PLC simulation’.
   - **Toolbar**: Click on.
   - **"PLC simulation settings” dialogue window**: Click on ‘Stop’.

8.17.1 PLC simulation settings

Here you can create settings that influence the PLC simulation. You can also start and
end the simulation.

To open the ‘PLC simulation configurations’ dialogue window, select one of the following
options:
   - **Menu bar**: Select ‘Simulation ➤ PLC simulation configurations’.
   - **Toolbar**: Click on.
Fig. 205: PLC simulation configurations

‘PLC simulation status’ – Display of the operating mode of the simulated CPU

‘Start/Stop’ – Start/stop simulation

‘Cycle Time’ – Display of the current, the minimum and the maximum cycle time for the program processing

‘Rest period’ – Waiting period between two program processing cycles

‘Ignore non-existing SFB/SFCs’ – The simulation supports not all or none SFB/SFC. Activate this option in order to keep the simulation further in operating mode RUN, even if the SFB/SFC cannot be processed by the simulation.

‘Network interface card’ – Network adapter for the virtual communication connection: If you select "Loopback Adapter", the simulation is run on the PC without using the network adapter.

‘IP address’ – IP address for the virtual communication connection: If an IP address is already configured in the network adapter, it is shown here. For "Loopback Adapter" the IP address is always "127.0.0.1".

‘Port’ – If port "7777" of the network adapter is already being used by another function or application, enter another port number.

If you change the ‘Communication settings’, click on ‘reinitialize simulation’ afterwards.
8.18 Transfer the hardware configuration and user program to the control

To transfer the hardware configuration and the user program to the control, you have various possibilities:

- **‘Transfer hardware configuration’**
  Only the device configuration is transferred to the control.  
  ⇘ Chap. 8.18.1 ‘Transfer hardware configuration’ page 272

- **‘Transfer user program’**
  Only the user program is transferred to the control.  
  ⇘ Chap. 8.18.2 ‘Transfer user program’ page 273

- **‘Transfer all’**
  The hardware configuration and the user program are transferred to the control.  
  ⇘ Chap. 8.18.3 ‘Transfer all’ page 274

- **‘Load block into device’**
  Transfer only block opened in the editor to the control.  
  ⇘ Chap. 8.5.4 ‘Instruction section’ page 217

### 8.18.1 Transfer hardware configuration

You can transfer the device configuration created in the project to the control as system data blocks (SDB). Blocks of the user program are not transferred.

1. Select one of the following options:
   - **Menu bar:** Select ‘Device ➔ Transfer hardware configuration’.
   - **Project tree:** Right-click with the mouse button on the desired control (PLC) and select ‘Transfer hardware configuration’.
   - **"Device configuration" editor:** Click on .
   - The ‘Transfer the configuration’ dialogue window will open.

2. Click on the ‘Configurations’ button to establish the further processing:
   - ‘Overwrite existing blocks’ – All system data blocks are transferred into the control. If you deactivate this option, only the system data blocks that have been newly added are transferred.
   - ‘Delete unused blocks’ – All system data blocks that are not required are removed from the memory card of the control.
   - ‘Automatic compiling’ – All system data blocks are compiled before the transfer.

3. In the table at the top section, click on the desired interface connection, e.g. ‘Ethernet interface’.
   - If you choose the serial interface, select the desired ‘MPI-Destination’, if required.

4. If you want to check whether the programming device is connected to the control, click on ‘Test connection’.
   - SPEED7 Studio attempts to create a connection to the control via the selected interface. The individual steps and results are displayed in the dialogue window.

5. If you want to check whether your programming device is connected with the correct control, you can retrieve information from the connected control and select the desired control. Click on ‘Accessible partners’.
   - The ‘Search for accessible partners’ dialogue window will open, ⇘ Chap. 6.21 ‘Search for accessible partners’ page 115
   - If no connection can be established, check if the connection cables are connected correctly.
6. Click on ‘Transfer’.  
   ⇒ If the control is not in operating mode STOP, a dialogue window will open in which you can switch the control into operating mode STOP. After having carried out a transfer, a dialogue window will open in which you can switch the control into operating mode RUN again.
   
   The hardware configuration is transferred to the control. The individual steps and results are displayed in the dialogue window. At the same time, it is displayed whether the transfer has been successful or if an error occurred.

   ![Example of a transfer error](image)

   **Fig. 206: Example of an transfer error**

   If the process was completed successfully, the device configuration in the project harmonises with the configuration in the control.

8.18.2 Transfer user program

If you have changed blocks in the project, you can compile them and then transfer them to the control as a user program (PLC program). The hardware configuration is not transferred to the control.

**Transfer single program block**

To transfer the program block opened in the block editor, click on in the block editor. Chap. 8.2 ‘Device overview (PLC)’ page 207

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➜ Transfer user program’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Transfer user program’.
     
     ⇒ The ‘Transfer the software’ dialogue window will open.

2. Click on the ‘Configurations’ button to establish the further processing:
   - ‘Overwrite existing blocks’ – All blocks of the user program are transferred into the control. If you deactivate this option, only the blocks that have been newly added in the user program are transferred.
   - ‘Automatic compressing’ – All blocks of the user program are compressed.
   - ‘Delete unused blocks’ – All blocks that are not part of the user program are removed from the memory card of the control.
   - ‘Automatic compiling’ – All blocks of the user program are compiled before the transfer.

3. In the table at the top section, click on the desired interface connection, e.g. ‘Ethernet interface’.
   
   If you choose the serial interface, select the desired ‘MPI-Destination’, if required.

4. If you want to check whether the programming device is connected to the control, click on ‘Test connection’.
   
   ⇒ SPEED7 Studio attempts to create a connection to the control via the selected interface. The individual steps and results are displayed in the dialogue window.
5. If you want to check whether your programming device is connected with the correct control, you can retrieve information from the connected control and select the desired control. Click on ‘Accessible partners’.

   ⇨ The ‘Search for accessible partners’ dialogue window will open. Chap. 6.21 ‘Search for accessible partners’ page 115

   If no connection can be established, check if the connection cables are connected correctly.

6. Click on ‘Transfer’.

   ⇨ The user program is transferred to the control. The individual steps and results are displayed in the dialogue window. At the same time, it is displayed whether the transfer has been successful or if an error occurred.

*Compile changed blocks*

If you have not yet compiled changed blocks, they are listed. You can compile these blocks before transferring. To this end, in ‘Configurations’, activate ‘Automatic compiling’. The changed blocks are compiled. Click on ‘Transfer’ again.

---

**Fig. 207: Example of an transfer error**

---

### 8.18.3 Transfer all

If you have changed the device configuration and blocks of the user program in the project, you can transfer both to the control together.

1. Select one of the following options:

   - **Menu bar**: Select ‘Device ➔ Transfer all’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Transfer user program’.

   ⇨ The ‘Transfer all...’ dialogue window will open.

2. Click on the ‘Configurations’ button to establish the further processing:

   - ‘Overwrite existing blocks’ — All blocks of the user program, including the system data blocks, are transferred into the control. If you deactivate this option, only the blocks that have been newly added in the user program are transferred.
   - ‘Automatic compressing’ — All blocks of the user program are compressed.
   - ‘Delete unused blocks’ — All blocks that are not part of the user program are removed from the memory card of the control.
   - ‘Automatic compiling’ — All blocks of the user program, including the system data blocks, are compiled before the transfer.

3. In the table at the top section, click on the desired interface connection, e.g. ‘Ethernet interface’.

   If you choose the serial interface, select the desired ‘MPI-Destination’, if required.
4. If you want to check whether the programming device is connected to the control, click on ‘Test connection’.

   ➨ SPEED7 Studio attempts to create a connection to the control via the selected interface. The individual steps and results are displayed in the dialogue window.

5. If you want to check whether your programming device is connected with the correct control, you can retrieve information from the connected control and select the desired control. Click on ‘Accessible partners’.

   ➨ The ‘Search for accessible partners’ dialogue window will open. Chap. 6.21 ‘Search for accessible partners’ page 115

   If no connection can be established, check if the connection cables are connected correctly.

6. Click on ‘Transfer’.

   ➨ If the control is not in operating mode STOP, a dialogue window will open in which you can switch the control into operating mode STOP. After having carried out a transfer, a dialogue window will open in which you can switch the control into operating mode RUN again.

   The hardware configuration and the user program are transferred to the control. The individual steps and results are displayed in the dialogue window. At the same time, it is displayed whether the transfer has been successful or if an error occurred.

   **Compile changed blocks**

   If you have not yet compiled changed blocks, they are listed. You can compile these blocks before transferring. To this end, in ‘Configurations’, activate ‘Automatic compiling’. The changed blocks are compiled. Click on ‘Transfer’ again.

   ![Example of a transfer error](Fig. 208)

8.19 Load blocks from the device

With this function, you can transfer blocks from the control to the project. The following block types can be transferred:

- Organisation blocks (OB)
- Function blocks (FB)
- Functions (FC)
- Data blocks (DB)
- Instance data block (DI)
- System function blocks (SFB)
- System functions (SFC)
Load blocks from the device

You need to create a communication connection to the control. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

1. Select one of the following options:
   - **Menu bar**: Select ‘Device ➔ Load blocks from the device’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Load blocks from the device’.
     - The dialogue window ‘Importing online block from control’ will open.
     - SPEED7 Studio attempts to create a connection to the control. The result is displayed in the dialogue window under ‘Communication status’.
     - If no connection can be established, you cannot load the blocks from the device. Check if the connection cables are connected correctly. If required, check the communication settings. Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

2. Click on ‘Next’.
   - The blocks in the control are compared to the blocks in the project and displayed in a list. The block list will show which blocks are present in the project and can be overwritten or which blocks are not present in the project and can be added.

![SPEED7 Studio Development Line](image)

**Import of block list from PLC**

<table>
<thead>
<tr>
<th>Block Type</th>
<th>Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>OB</td>
<td>1</td>
</tr>
<tr>
<td>OB1</td>
<td></td>
</tr>
<tr>
<td>FB</td>
<td>3</td>
</tr>
<tr>
<td>FB1</td>
<td></td>
</tr>
<tr>
<td>FBDH1</td>
<td></td>
</tr>
<tr>
<td>FC</td>
<td>5</td>
</tr>
<tr>
<td>DB</td>
<td>9</td>
</tr>
</tbody>
</table>

3. Click on ▶ in the block list to show all blocks of one block type. Click on ◀ to hide blocks.
   - Select [✓] the blocks you want to load from the device into the project.
   - Activate ‘All blocks’, if you want to load all listed blocks.
4. Click on ‘Next’.

⇒ The program code of the selected blocks is read and disassembled from the control, i.e. compiled from binary coded machine language in readable program code.

**Fig. 210: Load blocks from the device: Disassembled blocks**

In the block list, the size of the IL code and the MC7 machine code is shown in kByte for each compiled block.

If a block cannot be read or compiled, an error message is displayed and the applicable block is not loaded.
5. Click on ‘Next’.
⇒ The blocks are transferred from the control to the project. Present blocks will be overwritten in this process. The result is displayed in a table.

![Fig. 211: Load blocks from the device: Result](image)

### Compare blocks

8.20

With this function, you can compare blocks in the control (online) with blocks in the projects (offline). The following block types can be compared:

- Organisation blocks (OB)
- Function blocks (FB)
- Functions (FC)
- Data blocks (DB)
- Instance data block (DI)

You need to create a communication connection to the control. 

**Chapter 6.20.2 ‘Communication settings (PLC)’ page 111**

1. Select one of the following options:

   - **Menu bar**: Select ‘Device ➞ Compare blocks’.
   - **Project tree**: Right-click with the mouse button on the desired control (PLC) and select ‘Compare blocks’.

⇒ The dialogue window ‘Determine the blocks of the control’ will open.

*SPEED7 Studio* attempts to create a connection to the control. The result is displayed in the dialogue window under ‘Communication status’.

If no connection can be established, you cannot compare the blocks. Check if the connection cables are connected correctly. If required, check the communication settings. 

**Chapter 6.20.2 ‘Communication settings (PLC)’ page 111**
2. Click on ‘Next’.

⇒ The first step of the block comparison is carried out. The blocks in the control are compared to the blocks in the project and displayed in a list. The block list displays differences in the number of blocks with the block numbers.

![Fig. 212: Compare blocks: Block list]

3. Click on ▶ in the block list to show all blocks of one block type. Click on ▼ to hide blocks.

Select [✓] the blocks you want to compare. You can only compare the blocks which are both present in the project and in the control.

Activate ‘All blocks’ if you want to compare all listed blocks.
4. Click on ‘Next’.

⇒ The second step of the block comparison is carried out. The program code of the selected blocks is read and disassembled from the control, i.e. compiled from binary coded machine language in readable program code.

**Fig. 213: Compare blocks: Disassembled blocks**

In the block list, the size of the MC7 machine code is shown in kByte for each compiled block.

If a block cannot be read or compiled, an error message is displayed and the comparison cannot be continued.

5. Click on ‘Next’.

⇒ The content of the selected blocks is compared. The result is displayed in a table.
### Result of block comparison

**Comparison of online and offline blocks**

<table>
<thead>
<tr>
<th>Block</th>
<th>Code/Data</th>
<th>Interface</th>
<th>Error</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Name</td>
<td>Time stamp</td>
<td>Size</td>
</tr>
<tr>
<td>1 OB</td>
<td>OB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 FB</td>
<td>FB1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 DB</td>
<td>DB1</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- **= Consistent**  
- **≠** = Differing

**Finished comparing blocks**

---

**Fig. 214: Compare blocks: Result of block comparison**

The table shows which properties of a block match **=** or differ **≠**.  
- `Type` – Block type  
- `Name` – Block number  
- `Time stamp (Code/Data)` – Date and time of the last change in the program code (instruction section)  
- `Size (Code/Data)` – Length of the program code (OB, FB, FC) or size of the data range (DB, DI)  
- `Content` – Program code (instruction section)  
- `Time stamp (interface)` – Date and time of the last variable change (declaration section)  
- `Size (interface)` – Size of the declaration section, number of the variables  
- `Definition` – Variable declaration (declaration section)  
- `Error` – Error message, e.g. if it wasn't possible to compile the block

### 8.21 Watch block

With this function, you can watch the variables of the current block in the block editor (monitoring).

**Switch block watch On/Off**

The block to be watched must be present in the control.
You need to create a communication connection to the control. **Chap. 6.20.2 ‘Communication settings (PLC)’ page 111**

1. Open the block (OB, FB, FC, DB) in the block editor.
2. Click on .
   - The variable values are cyclically read from the control and displayed. In monitoring mode, you cannot change the block.
3. Click on again.
   - The monitoring mode is terminated.

**Set program status display**

You can select variables for the ‘Watch block’ function and set the display of the variables. You can carry out these configurations for the current block or the entire project. **Chap. 8.21.1 ‘Set program status display’ page 282**

8.21.1 Set program status display

Here, you can select variables for the ‘Watch block’ function and set the display of the variables. You can carry out these configurations for the current block or the entire project.

**Configurations for the entire project**

In the project tree, right-click with the mouse button in the desired control at ‘PLC program’ on ‘Status configurations for blocks’.
   - A dialogue window will open; see below. All configurations will be applied to the entire project.

**Configurations for the current block or the entire project**

Click on the button in the toolbar of the block editor.
   - A dialogue window will open; see below. In this dialogue window you can choose if the configurations are applied to the current block or the entire project.
1. Only if called from the block editor: Select by means of ‘Use project configurations’ or ‘Use local configurations’ if you want to edit the project configurations or the configurations of the current block.

2. Highlight the condition and status registers that you want to watch using the "Watch block" function.

3. Select the desired ‘Display format’, if required.

If you activate the ‘Save as project setting’ option, configurations of the current block are applied to the entire project.

8.21.2 Instruction list (IL)

On the right-hand side next to each IL row, the current result of logical operation (RLO), status bit (STA) and values of the accu and status word register are displayed.
You can change the display of the number values for the current block as follows:

Right-click with the mouse button on a table column and select the desired display format.

The display of binary states in the columns RLO and STA cannot be changed.

You can also apply the display to the entire project. ☞ Chap. 8.21.1 ‘Set program status display’ page 282

Move program status display

You can move the status display to the left or right.

1. Click on the status display and hold down the mouse button.
2. Move the mouse to the left or right to the desired position.
3. Release the mouse button.

⇒ If you move the status display completely to the left, the program lines are arranged on the right-hand side of the status display.

8.21.3 Function block diagram (FBD)

If you want to watch certain areas, you can highlight networks or elements.

---

**Fig. 217: Watch block in FBD**

<table>
<thead>
<tr>
<th>Group</th>
<th>Presentation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>element</td>
<td>Green</td>
<td>Element is run through: State TRUE</td>
</tr>
</tbody>
</table>
| | Grey | Element is run through: State FALSE  
- or -  
Determination of the state not possible |
8.21.4 Data block (DB)

The current values are displayed in the column ‘Actual value (Online)’.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Data type</th>
<th>Default value</th>
<th>Actual value (Offline)</th>
<th>Actual value (Online)</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.0</td>
<td>IN</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
<td>TRUE</td>
</tr>
<tr>
<td>2.0</td>
<td>PT</td>
<td>TIME</td>
<td>T#0MS</td>
<td></td>
<td>T#505</td>
</tr>
<tr>
<td>6.0</td>
<td>Q</td>
<td>BOOL</td>
<td>FALSE</td>
<td></td>
<td>FALSE</td>
</tr>
<tr>
<td>8.0</td>
<td>ET</td>
<td>TIME</td>
<td>T#0MS</td>
<td></td>
<td>T#198944MS</td>
</tr>
<tr>
<td>12.0</td>
<td>STATE</td>
<td>BYTE</td>
<td>B#16#000</td>
<td></td>
<td>B#16#001</td>
</tr>
<tr>
<td>14.0</td>
<td>STIME</td>
<td>TIME</td>
<td>T#0MS</td>
<td></td>
<td>T#14D21H26M54S597MS</td>
</tr>
<tr>
<td>18.0</td>
<td>ATIME</td>
<td>TIME</td>
<td>T#0MS</td>
<td></td>
<td>T#14D21H27M14S541MS</td>
</tr>
</tbody>
</table>

*Fig. 218: Watch data block*

<table>
<thead>
<tr>
<th>Presentation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Data type BOOL: The current value is TRUE</td>
</tr>
<tr>
<td>Red</td>
<td>Current value</td>
</tr>
<tr>
<td></td>
<td>- or -</td>
</tr>
<tr>
<td></td>
<td>Data type BOOL: The current value is FALSE</td>
</tr>
</tbody>
</table>

8.22 Add watch table

Variables can be watched (read) and controlled (write) in the watch table. You can set which variables of a CPU you want to read and control. If necessary, you can create several watch tables.
1. In the project tree within a control, click on ‘PLC program’ on ‘Watch tables’ ➔ Add watch table’. The dialogue window ‘Add watch table’ will open.

2. ‘Name’: Enter a different name, if required.

3. ‘Comment’: Enter a comment, if required, e.g. remark or explanation

4. Click on ‘OK’.

   ➔ The watch table is added and displayed in the project tree.

---

### 8.23 Watch table

Variables can be watched (read) and controlled (write) in the watch table. You can set which variables of a CPU you want to read and control.

To watch or control variables, you must create a communication connection to the control. ➔ Chap. 6.20.2 ‘Communication settings (PLC)’ page 111

To open an existing watch table, in the project tree within a control double click on the desired watch table in the ‘PLC program’ at ‘Watch tables’.

You receive the following display when the ungrouped format is selected. ➔ ‘Grouping variables’ page 288

---

### Showing/hiding input areas

You can show or hide the input areas:

- Shows/opens the input area
- Hides/closes the input area
Watch table

(1) Toolbar

- Hide slave objects
- Show slave objects

List group / ungroup: Presentation of the watch table grouped or ungrouped  

Graphic display of the status values: The development of the status value is shown in a time diagram in the ‘Status value’ column.

Call status value(s) on a one-time basis: The status values are read from the control on a one-time basis and are shown in the ‘Status value’ column.

Call status value(s) cyclic: The status values are read from the control cyclically and are shown in the ‘Status value’ column.

DANGER!
Danger in writing control values!
Changing variables with control values during ongoing plant operations can lead to malfunctions or programming errors that can cause serious material and personal damage!
- Ensure that no dangerous conditions can occur before you write the control values.

Writing control value(s) on a one-time basis: The control values of the selected variables are transferred to the control on a one-time basis.

Writing control value(s) cyclically: The control values of the selected variables are transferred to the control with each PLC cycle.

Add address range: Adds several consecutive operands into the watch table

Configurations:
Expert mode — When this mode is activated, the prefixes to the operands and the button for displaying the history are shown.
Refresh sorting — Refreshes all line sortings  further information page 291

(2) Information on and configurations of the watch table

Here you can change the name of the watch table, enter a comment and set the refresh rate.

Comment field: Here you can show or hide the comment field.

Refresh rate: Here you can show or hide the input field for the refresh rate. You can enter the time interval in milliseconds for the cyclical display of the status values in the ‘Refresh rate’ input field.

(3) Edit watch table

In the table, you can set which variables of the CPU you want to read and control.

‘1st Column’ – Selection area
‘Name’ – Symbolic address of the variables
‘Operand’ – Address of the variables
‘Format’ – Display/input format of the status and control value
‘Status value’ – Current value of the variables read from the control  further information page 290
‘Watch’ – The status values are shown for the variables selected here.
Watch table

‘Control Value’ – Value to be written in the control § further information page 290
‘Control’ – In the control, the variables selected here are overwritten with the control value.
‘Group’ – Sort and display table entries by group § ‘Grouping variables’ page 288
‘Comment’ – Any comment e.g. remark or explanation
‘Data type’ – Data type of the variables
‘Type’ – Operand area of the variables, e.g. input, output, memory

Add variable

1. Click on the input field of the ‘Operand’ column and enter the operand, e.g. MW 40.
   - or -
   If you want to use a variable from a variable table (§ Chap. 8.11.4 ‘Variable tables and “Standard project configuration”’ page 252), click on the input field of the ‘Alias’ column and enter the alias name.
2. Click on the ‘Format’ column in the adjacent field and select the desired display/input format for the status and control value, e.g. ”Decimal”.
3. Highlight the the ‘Watch’ column if the status value for this variable is to be shown.
4. If you want to enter a comment on the variables, click on the ‘Comment’ field and enter the comment.
5. If you want to allocate the variable to a group, select the desired group in the ‘Group’ column or enter a new group name into the input field.
6. Confirm your input with [Enter].
   ⇒ The new variable is inserted into the table. If you have allocated the variable to a group, the variable is inserted within this group.

Grouping variables

You can have the table entries sorted and displayed by group.

You can create a new group along with a new variable. § ‘Add variable’ page 288

You can allocate variables to a group subsequently:
1. Click on the ‘Group’ column and select the desired group or enter a new group name into the input field.
2. Confirm your input with [Enter].
   ⇒ The variable is inserted within the group.
Changing variables
You can change existing variables in the table.
Click on the input field which you want to edit. Changes can be entered directly. For some fields, changes can be made via a selection list.

Deleting variables
1. In the first column, highlight the variable line which you want to delete.
2. Press [Del].
   A dialogue window will open, where you can select whether you want to delete the variable.
   ⇒ The variable is deleted and removed from the table.

Move variable with "Drag & drop"
1. In the first column, highlight the variable line which you want to move.
2. Press and hold the mouse button while dragging the line to the desired position.
   ⇒ The variable line is inserted.

Copy variable with "Drag & drop"
1. In the first column, highlight the variable line which you want to copy.
2. Press and hold the mouse button and the key [Ctrl] while dragging the line to the desired position.
   ⇒ The variable line is copied and inserted. The new variable has the same properties as the initial variable. The operand is adopted and numbered consecutively.

Move several variables with "Drag & drop"
1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button while dragging the lines to the desired position.
   ⇒ The variable lines are inserted.

Copy several variables with "Drag & drop"
1. Press and hold the key [Ctrl] while highlighting all desired variable lines in the first column.
   - or -
   In order to highlight a row of variable lines, press and hold the key [shift] and click on the second column of the first and the last line.
2. Press and hold the mouse button and the key [Ctrl] while dragging the lines to the desired position.
   ⇒ The variable lines are copied and inserted. The new variables have the same properties as the initial variables. The operands are adopted and numbered consecutively.
Watch variables

Variables can be watched (read) in the watch table. For this, a communication connection must be created with the control.

1. In the ‘Watch’ column, highlight all the variables you want to watch.
   - If you highlight the title row of the ‘Watch’ column, all variables in the table are watched.
2. Click on to read the data from the control on a one-time basis.
   - or -
   - Click on to read the data from the control cyclically.
   ⇒ The data are shown in the ‘Status value’ column.

<table>
<thead>
<tr>
<th>Presentation</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Trend display: The value increases</td>
</tr>
<tr>
<td>Red</td>
<td>Trend display: The value decreases</td>
</tr>
</tbody>
</table>

If you activate the graphical display of the status values, the development of the status value is shown in a time diagram.

Control variables

Variables can be controlled (written) in the watch table. For this, a communication connection must be created with the control.

DANGER!

Danger in writing control values!
Changing variables with control values during ongoing plant operations can lead to malfunctions or programming errors that can cause serious material and personal damage!
   – Ensure that no dangerous conditions can occur before you write the control values.

1. In the ‘Control’ column, highlight all the variables you want to control.
   - If you highlight the title row of the ‘Control’ column, all variables in the table are watched.
2. Enter the desired control value for all the highlighted variables in the input field of the ‘Control Value’ column.
3. Click on to write all the control values in the control on a one-time basis.
   - or -
   - Click on to write all the control values in the control with each PLC cycle.
   ⇒ The data are shown in the ‘Status value’ column.

Before control values are transferred to the control and are written there, a security notice will open and you can stop the process. If you activate the option “Don’t show message again”, this security notice does not open anymore and control values are written in the control immediately without enquiry.
Change sorting

The lines in the watch table are sorted in the order of the input. You can also sort the data in alphabetical order.

1. In the title row of the table, click on the column (e.g. “Name”) according to which you would like to sort the watch table alphabetically.

   To sort the data alphabetically in the converse (descending) order, click on this column again.

2. To switch off the sorting, click on ‘Configurations’ and select ‘Refresh sorting’.

You can sort other columns alphabetically on a subordinate basis if you press the [Ctrl] key before you click on the desired column title.

Change presentation of the watch table

You can present the watch table grouped or ungrouped:

- Click on in the toolbar (1) to change the presentation.

In the grouped presentation, you can show or hide entire groups:

- Hide slave group
- Show slave group

8.24 Logic analysis

8.24.1 Overview

This function is only included in the license SPEED7 Studio PRO and not in the license SPEED7 Studio BASIC.

With the logic analysis, you can record the signals of a control for each cycle.

In order to open the logic analysis, select ‘View ➔ Logic analysis’.
Fig. 224: Logic analysis

1. Control and block
2. Toolbar
3. Records
4. Cursors
5. Information about the record
6. Point in time/period of the record
7. Zoom-bar
8. Operand table

(1) Control and block
Here, you can select the control and the program block for the logic analysis.

(2) Toolbar
Commands you need for executing the logic analysis, are provided in the toolbar.

- Start recording: Starts recording the signal states.
- Stop recording: Terminates recording the signal states.
- Configurations: Opens the dialogue window configuration for the logic analysis.
- Show main cursor: Shows/hides the cursor to read a point in time.
- Display 2nd cursor: Shows/hides the cursor for time measurements.
- Live display: The display will automatically create an afterimage during recording as soon as the recorded signals exceed the visible area.
- Show all nodes: Scales the visible area in a way that all recorded signals are visible.
- Delete all nodes: Deletes all recorded signals.
- Load recording: Opens a stored record. Chap. 8.24.10 ‘Saving and opening a record: page 300
Save recording: Saves the last record onto a data carrier.  Chap. 8.24.10 ‘Saving and opening a record’ page 300
Delete all (reset): Deletes the operand table and all recorded signals.
Show additional information: Shows/hides information about the record.

(3) Records
In the upper record area, all operands are recorded which are bigger than one bit (e.g. BYTE; WORD). The records are shown as line diagrams.
In the lower record area, all bit operands are recorded (e.g. single inputs/outputs).

(4) Cursors
You can show two cursors within the recorded diagrams. You can move the cursors in order to read the point in time or to measure the time.
Chap. 8.24.6 ‘Show time’ page 296
Chap. 8.24.7 ‘Measure a period of time’ page 297

(5) Information about the record
Displays information about the status, the number of signals and time and duration of the current record.

(6) Point in time/period of the record
Displays time of day from the control at the moment of the record.

(7) Zoom-bar
With the zoom-bar, you can change the section from the record.
Chap. 8.24.8 ‘Change section’ page 298

(8) Operand table
You can determine operands to be recorded.
Chap. 8.24.3 ‘Edit operand table’ page 294

8.24.2 Carry out logic analysis
In order to carry out a logic analysis, proceed as follows:
1. Create and compile the user program. Chap. 8.16 ‘Compile user program’ page 268
2. Transfer the hardware configuration and the user program to the control. Chap. 8.18 ‘Transfer the hardware configuration and user program to the control’ page 272
3. Open the logic analysis via ‘View Logic analysis’.
4. Select the control and the program block for the logic analysis. Chap. 8.24.3 ‘Edit operand table’ page 294
5. Add operands. Chap. 8.24.3 ‘Edit operand table’ page 294
6. Make configurations on the logic analysis, if required, e.g. adapting the ring buffer size. Chap. 8.24.11 ‘Make configurations’ page 300
7. Start recording. Chap. 8.24.4 ‘Start recording’ page 295
 Signals are read from the control in each program cycle and are displayed as diagram.
8. Terminate recording. Chap. 8.24.5 ‘Stop recording’ page 296
9. If required, determine the point or period of time for a record.

Chap. 8.24.6 ‘Show time’ page 296

Chap. 8.24.7 ‘Measure a period of time’ page 297

8.24.3 Edit operand table

In the operand table, you can determine operands to be recorded. The following operand areas can be recorded:

- Inputs (E)
- Outputs (A)
- Memory (M)
- Data ranges (D)
- Timers (T)
- Counter (Z)

<table>
<thead>
<tr>
<th>Visible</th>
<th>Address</th>
<th>Type</th>
<th>Symbol</th>
<th>Value</th>
<th>Unit</th>
<th>Min</th>
<th>Max</th>
<th>Average</th>
<th>Colour</th>
<th>Width</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔</td>
<td>MW20</td>
<td>INT</td>
<td>195</td>
<td>0</td>
<td>255</td>
<td></td>
<td></td>
<td></td>
<td>FF2500</td>
<td></td>
</tr>
<tr>
<td>✔</td>
<td>T3</td>
<td>INT</td>
<td>49</td>
<td>49</td>
<td>50</td>
<td></td>
<td></td>
<td></td>
<td>FF2500</td>
<td></td>
</tr>
<tr>
<td>✔</td>
<td>A4.0</td>
<td>BOOL</td>
<td>FALSE</td>
<td>TRUE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>FF2500</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 225: Operand table

- Move operands, change order further information page 295

‘Visible’ – Show/hide recorded diagram
‘Address’ – Address of the operand
‘Type’ – Data type of the operand
‘Symbol’ – Symbolic name of the operand
‘Value’ – Current value of the operand during a record or value of the operand at the current cursor position (not editable)
‘Unit’ – Any measuring unit, e.g. volt, litre, metre, etc.
‘Min.’ – Smallest value of the operand within the record (not editable)
‘Max.’ – Biggest value of the operand within the record (not editable)
‘Average’ – Average value of the operand within the record (not editable)
‘Colour’ – Colour of the operand in the diagram of the record
‘Width’ – Line width of the operand in the diagram of the record

Add operands

Each line in the operand table can contain one operand.

1. Double-click on the empty input field in the ‘Address’ column.
   - or -
   Highlight the input field and press [F2] in order to edit the field.

2. Enter an operand, e.g. A4.0, EB8, MW20, T1.

3. Press [Enter].
   → The operand and the matching data type are entered into the table line. In the column ‘Colour’, the colour for the diagram of the record is determined.

4. If required, you can change further configurations, e.g. change colour or line width.
5. Finish your input with [Enter].
   ⇒ A new (empty) line will be added to the operand table.

If recording is active or if data has already been recorded, you cannot edit, delete or move operands. In the input field ‘Address’, the symbol \(\square\) is displayed.

In order to be able to edit, delete or move operands, finish the record with \(\square\) and delete all recorded data with \(\square\). ❮(2) Toolbar‘ page 292

Deleting operands
1. Click into the operand line you want to delete.
2. Press [Del].
   ⇒ The operand line is removed from the table.

Deleting all operands
Click on the \(\square\) button. ❮(2) Toolbar‘ page 292
   ⇒ The operands are removed from the table.

Move operands, change order
1. Click in the operand line you want to move onto the symbol \(\square\) and hold the mouse button pressed down.
2. Move the operand line upwards or downwards to the desired position.
3. Release the mouse button.
   ⇒ The operand line is moved. The order of the operand in the recording area is changed.

Show/hide operands
You can show or hide operands. ❮ Chap. 8.24.9 ‘Show/hide operands’ page 300

8.24.4 Start recording
To record signals, you must create a communication connection to the control. ❮ Chap. 6.20.2 ‘Communication settings (PLC)‘ page 111

Click on the \(\square\) button.
   ⇒ Additional program blocks are transferred to the control. With these blocks, the recorded values are entered into a ring buffer and read.
   The record is started. Signals are read from the control in each program cycle and are displayed in a diagram.

Memory overflow
If values are written faster than they are read, the ring buffer will flow over. Overflows are highlighted in red in the diagram and the zoom-bar.
Fig. 226: Overflow of the ring buffer
To prevent memory overflows, increase the ‘cyclic device time’ or the ‘size of the ring buffer’. Chap. 8.24.11 ‘Make configurations’ page 300

In case of time-critical applications, not all overflows are highlighted in red in the diagram and the zoom-bar.

8.24.5 Stop recording

Click on the button.

The record is stopped.

The original user program – without additional program blocks for the ring buffer – is restored in the control.

8.24.6 Show time

Fig. 227: Show and move cursor
In order to show a point in time within a record, use the cursor.

1. Click on one of the two buttons.
   - A cursor is shown.
2. Drag & drop the cursor to the left or right to the desired position.
   - At the lower end, date and time from the control of the current cursor position is shown.
   - In the record and in the column ‘value’ in the operand table, values of the current cursor position are shown for each operand.

You can insert the cursor already during recording.

8.24.7 Measure a period of time

In order to measure the time within a record, you can use both cursors.

1. Click on the left button.
2. Click on the right button.
   - Both cursors are shown.
3. Drag & drop the cursors to the left or right to the desired position.
   - At the lower end, date and time from the control of the current cursor position is shown.
   - In addition, ‘Diff:’ shows the time difference between both cursors.
   - ‘Frequency:’ shows the frequency in hertz.

Fig. 228: Show and move cursors

In order to measure the time within a record, you can use both cursors.

1. Click on the left button.
2. Click on the right button.
   - Both cursors are shown.
3. Drag & drop the cursors to the left or right to the desired position.
   - At the lower end, date and time from the control of the current cursor position is shown.
   - In addition, ‘Diff:’ shows the time difference between both cursors.
   - ‘Frequency:’ shows the frequency in hertz.
8.24.8 Change section

With the zoom-bar, you can change the visible area (y-axis) in the record.

**Fig. 229: Zoom-bar**

1. Visible area for the record
2. Not visible area for the record
3. Slider left
4. Slider right
5. Cursors (measure a period of time)

**Move visible area**

**Fig. 230: Move visible area**

1. Right-click with the mouse in the recorded diagram hold the mouse button pressed down.
2. Drag the mouse to the left or right to the desired position.
3. Release the mouse button.

- or -

1. Click in the zoom-bar into the visible area (light grey) and hold the mouse button pressed down.
2. Drag the area to the left or right into the desired position.
3. Release the mouse button.

- or -

1. Right-click with the mouse button in the zoom-bar on the desired position.
Change size of the section (resolution)

Rotate the mouse wheel in the recorded diagram upwards, in order to extend the visible area.

Rotate the mouse wheel in the recorded diagram downwards, in order to compress the visible area.

- or -

*Fig. 231: Change size of the section*

1. Click to the desired position in the recorded diagram and hold the mouse button pressed down.

2. Drag the mouse to the left or right until the desired section size is reached.
   - The section is marked in grey.

3. Release the mouse button.
   - The visible area is stretched.

- or -

1. Click in the zoom-bar on one of both sliders and hold the mouse button pressed down.

2. Drag the slider to the left or right.

3. Release the mouse button.
   - The visible area is compressed or stretched.

Show the entire record

Double-click on the recorded diagram.

- The diagrams are compressed to the length of the record.

Change the height of the diagrams

You can change the height of the diagrams (y-axis) of the upper recording area.

*Fig. 232: Change the height of the diagrams*

1. Click on the line between both recording areas and hold down the mouse button.

2. Drag the line upwards or downwards.
3. Release the mouse button.  
   ⇒ The diagrams are compressed or stretched.

You can change sections already during recording. You should switch off the live display function for this purpose. *(2) Toolbar* page 292

### 8.24.9 Show/hide operands

- Click in the upper recording area or in the operand table in the column ‘visible’ on √ or [ ].
- The diagram of the recorded operand is hidden or shown.

### 8.24.10 Saving and opening a record:

A record will remain only until the project is closed or *SPEED7 Studio* is closed. If you want to use the recorded logic analysis even afterwards, save it and reopen it.

- Click on the button in order to save the active record.
- Click on the button in order to open a saved record.

### 8.24.11 Make configurations

Before starting a recording, you can configure the logic analysis.

- Click on the button.
- The dialogue window for configuration will open.

#### General configurations

- ‘Active device’ – Shows the selected control for the logic analysis *(1) Control and block* page 292
- ‘Recording task (OB)’ – Organisation block for recording the logic analysis

**DANGER!**

Danger when changing the cyclic device time!

Changing the cyclic device time will lead to longer program processing times and might cause malfunctions or program errors that can cause serious material and personal damage!

- Ensure that no dangerous conditions can occur before you set the cyclic device time bigger than 0 ms.

- ‘Cyclic device time’ – Cycle time of the control in milliseconds: Increase the cyclic device time when memory overflows occur during recording.
- ‘Size of the ring buffer’ – Size of the ring buffer for records in byte: Increase the ring buffer when memory overflows occur during recording.
- ‘Evaluate signals at least once per second’ – If the signal state of an operand does not change during the record, the diagram draws no line for this signal. Activate this option if you want to draw a line nevertheless.
Trigger configurations

You can define the start and duration of the record with a defined event (trigger signal).

1. **Activate trigger** – Enable/disable trigger function:
   - On: Recording starts when the defined event occurs after you have clicked on the button.
   - Off: Recording starts immediately, when you have clicked on the button.

2. **Activate pre-trigger** – Record and show the progression of the signals before the trigger event

3. **Activate post-trigger** – Record and show the progression of the signals after the trigger event

4. **Number of PLC cycles** – Number of PC cycles which should be recorded and shown before the trigger event

5. **Number of PLC cycles** – Number of PC cycles which should be recorded and shown after the trigger event

You can define the event for the trigger signal here. You can enter logical operations. The record is started if the result of the logical operation (RLO) is 1 (TRUE). The record is stopped if the result of the logical operation (RLO) is 0 (FALSE).

1. Under ‘operation’, select the linking operation “And” or “Or”.
2. In order to negate the logical operation, activate the option ‘negate’.
3. Under ‘trigger source’, select the desired operand for the logical operation.
   - The logical operation is shown under ‘Step7 command’.
4. If you want to enter further conditions click on the ‘+’ button.
   - A new line for further logical operations is added.

5. If you disable the ‘Active’ option in a logical operation line, this line is not analysed.

8.25 Import S7 program

With this function, you can import Siemens STEP®7-Programs or WinPLC7 projects. Only the program blocks are imported but not the hardware configuration.

If you want to import an S7 program, a project must be open and a control must be contained in the project.

1. In the project tree, right-click with the mouse button in the desired control at ‘PLC program’ on ‘Import S7 program’.
   - The dialogue window ‘Import S7 program’ will open.

2. Under ‘Project path’, select the directory and the project (S7P file) or the library (S7L file). Click on ‘Next’.

3. Select the station if necessary and click on ‘Next’.

4. Choose blocks to import. If existing blocks in your project are to be replaced by imported blocks, select the option ‘Overwrite existing blocks’. Click on ‘Next’.
   - The import process is started and the program blocks are imported. The individual steps and results are shown in the dialogue window.

5. Click on ‘Done’.
8.26 Export ASCII sources

You can export the user program in ASCII format in order to e.g. edit it with any text editor. You can save the blocks and the variable table of the user program in an export file in ASC or SEQ format.

If you want to export a user program, a project must be open and a control must be contained in the project.

1. In the project tree, right-click with the mouse button in the desired control at ‘PLC program’ on ‘Export ASCII sources’.
   ⇒ A dialogue window will open.

2. Under ‘Choose export path’, select the directory where the files should be exported to.

3. Select further options, if required:
   - ‘Operand export mode’ – The operands can be exported as absolute address or with the symbol name.
     If you want to export all blocks into one file, enable the option ‘Write all IL sources to single file’ and determine a file name. If you want to export the blocks into several files, don’t enable this option. The file name of the export files is a combination of the block name and the block number.
     If you enable the option ‘Export the symbolic tables’, the variable tables are exported into a file.

Fig. 233: Export ASCII sources: Export path and further options

8.11.3 System hardware configuration

8.11.4 Variable tables and “Standard project configuration”
4. Click on ‘Next’.

⇒ If you have enabled the option ‘Export the symbolic tables’, the variable tables are read and displayed. ⇒ ‘Import and select symbol tables’ page 303

If you have not enabled the option ‘Export the symbolic tables’, the block files are read and displayed. ⇒ ‘Import and select block sources’ page 304

---

**Fig. 234: Export ASCII sources: Import and select symbol tables**

1. Click in the list of the symbol tables on ☑, in order to display all symbols of one area. Click on ☐ to hide symbols.

Select ☑ the symbols you want to export.

Activate ‘Select all sources’ if you want to export all listed symbols.

If you enable the option ‘Overwrite existing files’, already present export files are overwritten. If you don’t enable this option, present files remain unchanged – the symbol tables are not exported.

2. Enter a file name for the export file of the symbols. If required, select the file type ‘ASC’ or ‘SEQ’.

3. Click on ‘Next’.

⇒ The block files are read and displayed.
Export ASCII sources

Import and select block sources

Click in the list of the block sources on ☐ , in order to display all blocks of one area. Click on ☐ to hide blocks.

Select ☑ the blocks you want to export.

Activate ‘Select all sources’ if you want to export all listed blocks.

If you enable the option ‘Overwrite existing files’, already present export files are overwritten. If you don't enable this option, present files remain unchanged – the block sources are not exported.

Know-how-protected blocks cannot be selected and exported.
2. Click on ‘Next’.
   ⇒ The export process is started and the symbol tables and block sources are exported. The individual steps and results are shown in the dialogue window.

3. Click on ‘Done’ to close the dialogue window.

8.27 Import ASCII sources

You can import blocks and variable tables of the user program that have been created in ASC or SEQ format, into the project.

If you want to import a user program, a project must be open and a control must be contained in the project.

1. In the project tree, right-click with the mouse button in the desired control at ‘PLC program’ on ‘Import ASCII sources’.
   ⇒ A dialogue window will open.
Import ASCII sources

2. Under ‘Choose import path’, select the directory where the ASCII files are stored.

3. Enable ‘Importing symbols’ if you want to import variable tables on top of the program blocks. If required, select another directory and the file type ‘ASC’ or ‘SEQ’.

4. Click on ‘Next’.
   - If you have enabled the option ‘Importing symbols’, the variable tables are read and displayed. ‘Import and select symbol tables’ page 307
   - If you have not enabled the option ‘Importing symbols’, only the block files are read and displayed. ‘Import and select block sources’ page 308
Import and select symbol tables

1. Click in the list of the symbol tables on \( \downarrow \), in order to display all symbols of one area. Click on \( \uparrow \) to hide symbols.

   Select the symbols you want to import.

   Enable ‘Select all sources’ if you want to import all listed symbols.

   If you enable the option ‘Overwrite existing files’, already present variable tables in the project are overwritten. If you don't enable this option, present symbols remain unchanged – the symbol tables are not imported.

   If the symbol names are already allocated in the project, an error message is displayed. In this case, continue as follows:

   - Disable the symbols already allocated in the project and continue with the import procedure. The disabled operands are not imported.
   - or -
   - Abort the import procedure. Manually change all symbol names in the project which have already been allocated. Then restart the import procedure. All operands are imported.

2. Click on ‘Next’.

   The block files are read and displayed.
Fig. 239: Import ASCII sources: Import and select block sources

1. Click in the list of the block sources on to display all blocks of one area. Click on to hide blocks.

Select the blocks you want to import.

Enable ‘Select all sources’ if you want to import all listed blocks.

If you enable the option ‘Overwrite existing files’, already present program blocks in the project are overwritten. If you don’t enable this option, present blocks remain unchanged – the block sources are not imported.

Know-how-protected blocks cannot be selected and imported.
2. Click on 'Next'.

   The import process is started and the block sources and symbol tables are imported into the project. The individual steps and results are shown in the dialogue window.

3. Click on 'Done' to close the dialogue window.

8.28 Install block library

You can install blocks from libraries and add them to the catalog. You can then use these blocks in your projects.

If you want to install libraries, a project must be opened.

1. Select in the menu bar 'Extras ➔ Install block library'.

   The 'Installing libraries' dialogue window will open.

2. Under 'Project path', select the directory and the library (S7L file) or a Simatic project (S7P file). Click on 'Next'.

   The packages and/or stations available in the library are displayed.

3. Select the desired package and/or the desired station. If symbolic identifiers from the library are to be adopted into the project, select the option 'Install symbols'. Click on 'Next'.

   If symbol tables are entered into the library, these are displayed.

4. If necessary, select the symbols you want to install. Click on 'Next'.
5. If necessary, select the blocks you want to install. Click on ‘Next’.
   ⇒ The import process is started and the libraries are imported. The individual steps and results are shown in the dialogue window.

6. Click on ‘Done’.
   ⇒ The libraries are installed in the SPEED7 Studio catalog.

Use installed blocks

1. Open the desired block group in the ‘Blocks’ register of the catalog.
2. Drag the desired block into the ‘Program blocks’ section of the project tree.
   ⇒ The block is added to the current project.
### 8.29 Keyboard commands in the block editor

<table>
<thead>
<tr>
<th>Keyboard command</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl]+[1]</td>
<td>Switch according to ladder diagram (LD)</td>
</tr>
<tr>
<td>[Ctrl]+[2]</td>
<td>Switch according to instruction list (IL)</td>
</tr>
<tr>
<td>[Ctrl]+[3]</td>
<td>Switch according to function block diagram (FBD)</td>
</tr>
<tr>
<td>[Ctrl]+[A]</td>
<td>Select/mark all (empty lines in the declaration section are not selected)</td>
</tr>
<tr>
<td>[Ctrl]+[C]</td>
<td>Copy selection</td>
</tr>
<tr>
<td>[Ctrl]+[X]</td>
<td>Cut selection</td>
</tr>
<tr>
<td>[Ctrl]+[V]</td>
<td>Insert selection</td>
</tr>
<tr>
<td>[F3]</td>
<td>Find Next in block</td>
</tr>
<tr>
<td>[Ctrl]+[H]</td>
<td>Replace in block</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[O]</td>
<td>Open block</td>
</tr>
<tr>
<td>[Del]</td>
<td>Deleting networks</td>
</tr>
<tr>
<td>[Ctrl]+[C]</td>
<td>Copy network</td>
</tr>
<tr>
<td>[Ctrl]+[V]</td>
<td>Paste copied network</td>
</tr>
<tr>
<td>[Ctrl]+[R]</td>
<td>Add new network</td>
</tr>
<tr>
<td>[Ctrl]+[J]</td>
<td>Create new symbol</td>
</tr>
<tr>
<td>[Alt]+[R]</td>
<td>Reset data sorting</td>
</tr>
<tr>
<td>[Alt]+[E]</td>
<td>Switch expert mode on/off</td>
</tr>
</tbody>
</table>

#### Programming language IL

- [Ctrl]+[Shift]+[C]: Places comment signs at the start of the current line and/or the marked lines
- [Ctrl]+[Shift]+[U]: Resets comment signs at the start of the current line and/or the marked lines
- [Ctrl]+[Shift]+[B]: Formats the instructions of the entire network
- [Ctrl]+[Alt]+[P]: Updates block calls whose interface is not consistent. If no block is marked, all blocks of the network are updated. If one of the blocks is marked, only this block is updated.

#### Programming language LD and FBD

- [Alt]+[3]: FBD only: Adds a negation to a binary input or output
- [Alt]+[4]: LD and FBD: Adds a branch to a connection

#### Watch table

- [Insert]: Add new variable after the current line
- [Ctrl]+[Insert]: Add new variable before the current line
- [Ctrl]+[F2]: Move marked variable to the value 1
- [Ctrl]+[F3]: Move marked variable to the value 0
- [Ctrl]+[Shift]+[F2]: Move marked variable to the specified control value
9 Creating a visualisation

9.1 WebVisu and Movicon projects

In a WebVisu project, you can edit images with a graphic editor. Ready-made elements provided in a library allow for very easy design. You can also create elements or import graphics and manage them in the library. All texts in the images can be translated into multiple languages.

Alternatively, you can create an HMI device with the Movicon functionality. A Movicon project can be edited in an external Movicon application.

WebVisu projects

You can create and edit WebVisu projects if the control has an integrated web server for web visualisation.

Before you create a visualisation, you need to create configuration settings and edit the variable table. For this, please see the following chapters:

- Chap. 6.20.3 ‘Server configuration’ page 114
- Chap. 9.4 ‘Standard variables table’ editor page 316

Movicon projects

You can create an HMI device with the Movicon functionality. You can thus use the HMI device in a SCADA (Supervisory Control and Data Acquisition) system. For this, please see the following chapters:

- Chap. 6.4 ‘Add new device (HMI/Movicon)’ page 82

If you want to edit the Movicon project subsequently, please see the following chapters:

- Chap. 9.14 ‘Movicon projects’ page 333
- Chap. 9.4 ‘Standard variables table’ editor page 316

9.2 “Device overview” editor (HMI device)

This editor is only available for HMI devices.

In the ‘Device overview’ editor, images of the HMI device are displayed in a table. Here you can change the name, the image title and the image description of the image.

If a project is opened and an HMI device is included, you can open the ‘Device overview’:

- **Project tree**: Click on ‘Device overview’ in the HMI.

![Fig. 241: Device overview of an HMI device](image)

‘Name’ – Image name: With this name, the image is displayed in the project tree.

Click on the image name for change.
‘Image title’
Click on the image title for change.

‘Width (Pixel)’ and ‘Height (Pixel)’ – The image size depends on the screen resolution of the HMI device and cannot be changed.

‘Image description’ – Any comment e.g. remark or explanation
Click on the image description for change.

Changing the sort sequence
You can sort the images in the device overview in alphabetical order according to image names or image titles.

Click on the ‘Name’ or ‘Image title’ field in the title row of the table.
⇒ The table entries are sorted in alphabetical order:
  ▶ Alphabetically in ascending order
  ▶ Alphabetically in descending order

9.3 “Device properties” editor (HMI device)
This editor is only available for HMI devices.

General information on and configurations of the HMI device are displayed in the ‘Device properties’ editor. Here you can change the device name and the comment as well as make communication settings and further configurations.

If a project is opened and an HMI device is included, you can open the ‘Device properties’:

- Project tree: Click on ‘Device properties’ in the HMI.
- “Devices and networking” editor: Right-click with the mouse button on the HMI device and select ‘Device properties’.

The ‘Device properties’ editor is divided into three sections.

9.3.1 General device properties
To display or change the device properties of the HMI device, you must proceed as follows:

You have accessed the ‘General’ section in the ‘Device properties’ editor of the HMI device. Chap. 9.3 “Device properties” editor (HMI device) page 313
9.3.2 Communication settings

The communication settings are used to configure the interface for the data exchange between the programming device and the HMI device.

For communication settings, you must proceed as follows:
You have accessed the ‘Communication’ section in the ‘Device properties’ editor of the HMI device.

1. ‘Active PC interface’: interface for the data exchange between the programming device and the HMI device
   ⇒ If an IP address is already configured in the network adapter, it is shown under the input field.

2. ‘PC interface’: Select the network adapter for the communication connection from the list.
   ⇒ If an IP address is already configured in the network adapter, it is shown under the input field.

3. ‘HMI interface’: Select the desired interface of the HMI device from the list.
   ⇒ If an IP address is already configured in the HMI device, it is shown under the input field.

4. In order to check whether a connection between the programming device and the HMI device can be established with the selected communication setting, click on ‘Verify connection’.
   ⇒ You can see in the status line, whether the connection could be established successfully.

9.3.3 Configurations

Here you can change further properties of the HMI device. For configurations, you must proceed as follows:

You have accessed the ‘Configurations’ section in the ‘Device properties’ editor of the HMI device.
9.4 "Standard variables table" editor

Via the standard variables table, you can use the variables belonging to the CPU in images:

- You can use the already declared variables of the system hardware configuration or of the standard project configuration (synchronise variable table).
- If necessary, you can add further variables (e.g. from data blocks) for use in images.

Before you can use control variables in images, these must be entered in the standard variables table.

In the project tree within a visualisation project under ‘Variables’, double-click on ‘Standard variables table’.
Synchronise variable table:

You can transfer the variables declared in the CPU to the variable table. All variables marked ✔ in the system hardware configuration, the standard project configuration and the data blocks in the ‘Visu’ column are transferred from there.

Click on ✔.

The variables are copied into the variable table.

Changes to the system hardware configuration, the standard project configuration or the data blocks are not automatically adopted into the variable table. You need to synchronise the variable table in order to adopt the changes into the HMI project.

Print variable table The dialogue window "Print" will open.

(2) Filter settings

With the filter settings, you can always select specifically which variables shall be transferred to the variable table. All variables marked ✔ in the system hardware configuration, the standard project configuration and the data blocks in the ‘Visu’ column are transferred from there.

1. Select the area to be transferred under ‘Pre-selection’, e.g. data blocks.

2. Select the table or block from which the variables shall be transferred under ‘Filter’, e.g. DB1.
3. Click on 🔄.
   - The variables from the selected table or the selected data block are copied to the variable table.

**Add new variable**

1. Under ‘Current variable table’, select the section from which you want to use control variables, e.g. “Data blocks” for variables from a data block.
2. You can make new entries in the first line of the table. You can recognise these lines by the ⬤ symbol.
   - Click on the input field of the ‘Name’ column and enter a name (symbolic address) for the control variable in the HMI project.
3. Click on the adjacent field in the ‘Type’ column and select the desired data type.
4. If you want to enter a comment on the variables, click on the ‘Comment’ field and enter the comment.
5. Click on the ‘PLC variable’ column in the adjacent field and select the desired control variable from the list.
   - Only the variables from the system hardware configuration and the standard project configuration which are marked ✅ in the ‘Visu’ column are displayed from there.
6. Confirm your input with [Enter].
   - The new variable is inserted into the table.

**(3) Variable table**

- ‘Name’ – Name of the control variable (symbolic address) for use in HMI images.
- ‘Type’ – Data type for the use in images
- ‘Comment’ – Any comment e.g. remark or explanation
- ‘PLC variable’ – Name of the control variables (symbolic address), as declared in the system hardware configuration, the standard project configuration or in the data block.
  - The name cannot be changed.
- ‘Address’ – Address of the variables
- ‘Data type’ – Data type of the variables
- ‘Source’ – Operand area of the variables, e.g. input, output, memory, DB
- ‘Comment’ – Comment from the system hardware configuration, the standard project configuration or the data block. The comment cannot be changed.

**9.5 HMI elements**

HMI elements are, for example, graphics or visual control elements (controls) that you can use in images. The HMI elements are available in file format SVG (Scalable Vector Graphics) and can be enlarged or made smaller without losses.

**Using HMI elements in an image**

Ready-made HMI elements can be found in the catalog ( Chap. 4.10 ‘Catalog’ page 34) under the ‘HMI elements’ register.

1. Under ‘HMI elements’, open an element group, e.g. ‘Controls’.
2. Drag the desired element from the catalog to any place in the drawing field.
   - The element is inserted in the image.

 Chap. 9.9.2 ‘Inserting elements from the catalog’ page 322
9.6 HMI library

You can create HMI elements and manage them in the HMI library to use them in images. In addition, you can import graphics in file format SVG (Scalable Vector Graphics) into the HMI library and use them in images.

9.6.1 Create, edit and use new element

Create new element

1. In the catalog under ‘HMI library’, ‘Catalog’, right-click with the mouse button and select ‘Create new element’.
   ⇒ A dialogue window will open.

2. Enter a name for the element and select the desired size of the element.

3. Click on ‘OK’.
   ⇒ The element is inserted under ‘Catalog’.

Edit element

1. Under ‘Catalog’, double-click on the desired element.
   ⇒ The editor for editing HMI elements will open.

2. Edit the element in the editor. The editing functions, shapes and graphical elements of the editor for images are available to you. "Chap. 9.9 “Image” editor" page 321

3. Save the project.

Using element in an image

You can use the element in images.

Drag the element from the HMI library to the desired location in the image (drag & drop).

9.6.2 Importing and using resources

Resources are, for example, graphics or visual control elements (controls) that you can use in images. Resources can exist in different graphic file formats. Resources in file format SVG (Scalable Vector Graphics, Version Tiny 1.2) can be enlarged or made smaller without losses.

Import resource

1. In the catalog under ‘HMI library’, ‘Catalog’, right-click with the mouse button on ‘Import resource’.
   ⇒ A dialogue window will open allowing you to select a graphic file.

2. Select a graphic file and click on ‘Open’.
   ⇒ The file is inserted as an element under ‘Catalog’.

Using resource in an image

You can use the element in images.

Drag the element from the HMI library to the desired location in the image (drag & drop).
9.6.3 Delete element

You can delete an element from the HMI library.

1. In the catalog under ‘HMI library’, ‘Catalog’, right-click with the mouse button on the desired element and select ‘Delete element’.
   ⇒ A dialogue window will open, where you can select whether you want to delete the element.

2. Click on ‘Yes’.
   ⇒ The element is removed from the HMI library and from the images in which it is used.

9.7 Add new sub display

You can add a new image to the project. Each new image is added in the project tree as a so-called sub display underneath an image.

1. In the project tree, within the visualisation project, under ‘Images’, click on ‘Add new sub display’.
   ⇒ A dialogue window with image configurations will open.

2. Create configurations, if necessary, and click on ‘OK’.
   ⇒ The image is added and displayed in the project tree.

9.7.1 Configurations

Here you can make the configurations for the image.

‘Image name’ – With this name, the image is displayed in the project tree.

‘Image title’

‘Image description’ – Any comment e.g. remark or explanation

‘Image size’ – The image size depends on the screen resolution or on the resolution of the process images and can be changed afterwards.

9.7.2 Background

Here you can set the background for the image. You can select a graphic file as the background image or you can select a background colour.

If you click on ‘Reset’, the background colour is set to white.

9.8 Delete image

You can delete an image from the project.

1. In the project tree, within the visualisation project, under ‘Images’, right-click with the mouse button on the image and select ‘Delete image’.
   ⇒ A dialogue window will open, where you can select whether you want to delete the image.

2. Click on ‘Yes’.
   ⇒ The image is deleted and removed from the project tree.
9.9 "Image" editor

Individual images can be edited for the visualisation in the ‘Image’ editor. Different shapes and graphical elements are available to you to illustrate processes of your machine or system.

Create a new image (Chap. 9.7 ‘Add new sub display’ page 320) or select an image for editing.

Fig. 246: "Image" editor

1 Toolbar
2 Drawing field
3 Image
4 Information bar

9.9.1 Drawing a shape

You can insert shapes directly at the desired position and in the desired size in the drawing field.
Then you can change the shape:

- **Chap. 9.9.4 'Edit object' page 323**
- **Chap. 9.9.5 'Edit object properties' page 325**

1. In the toolbar, click on the desired shape under ‘Shapes’.

2. **Draw line**: Click on the position in the drawing field where you want the line to start. Drag the line and click again to set the end point of the line.

- **Draw rectangle**: Click on the position in the drawing field where you want the shape to start. Press and hold the mouse button. Drag the mouse until the shape has the desired size and then let go of the mouse button.

  When you press and hold the [Ctrl] button while drawing the shape, a square is drawn.

- **Draw ellipse or circle**: Click on the position in the drawing field where you want the shape to have its centre point. Press and hold the mouse button. Drag the mouse until the shape has the desired size and then let go of the mouse button.

- **Draw polygon or polyline**: Click on the position in the drawing field where you want the shape to start. Drag the line and click several times to set the individual points. Double-click with the mouse button to set the last point.

- **Draw Bézier curve**: Click on the position in the drawing field where you want the shape to start. Drag the line and click several times to set the individual points. Press and hold the mouse button to define the curvature. Double-click with the mouse button to set the last point.

- **Add text box**: Click on the position in the drawing field where you want the shape to start. Enter your text.

- **Add image**: A dialogue window will open allowing you to select a graphic file. Select a graphic file and click on ‘Open’. The graphic is inserted at position x: 0, y: 0.

### 9.9.2 Inserting elements from the catalog

You can insert elements from the catalog directly at the desired position in the drawing field. You can use ready-made or self-created HMI elements:

- **Chap. 9.5 ‘HMI elements’ page 318**
- **Chap. 9.6 ‘HMI library’ page 319**

Then, you can change the element and assign control variables:

- **Chap. 9.9.4 ‘Edit object’ page 323**
- **Chap. 9.9.5 ‘Edit object properties’ page 325**

1. In the catalog under ‘HMI elements’, open an element group, e.g. ‘Controls’.

   If the properties are displayed instead of the catalog, you must click on ‘Catalog’ at the lower screen edge.

2. Drag the desired element from the catalog to any place in the drawing field.

   The element is added to the image and is saved in the project tree as a graphic file under ‘Resources’.

### 9.9.3 Align and arrange objects

You can align and arrange objects you have inserted in an image.
Align

1. Select the desired object.
2. In the toolbar under ‘Align’, click on a button to align the object at the top, at the bottom, vertically centred, left-hand, right-hand or horizontally centred.

Arrange

When the objects are inserted in the image, they are positioned on top of each other in the order in which they are created. You can change this order and move the objects to the front or to the back.

In addition, you can group several objects in order to apply changes to all objects included in this group.

1. Select the desired object.
2. In the toolbar under ‘Arrange’, click on a button to arrange the object:
   - Bring forward: Moving object by one position to the front
   - Send backward: Moving object by one position to the back
   - Bring to front: Move object to the foremost position
   - Send to back: Move object to the rearmost position
   - Group: Group several selected objects to an object group
   - Ungroup: Disband object group
   - Horizontally distributed: Distribute several selected objects horizontally in the image
   - Vertical distributed: Distribute several selected objects vertically in the image

9.9.4 Edit object

You can subsequently edit and change any inserted objects.

Change size (scale)

1. Select the desired object.
2. Click on one of the green squares and hold down the mouse button.
3. Drag the mouse until the object has the desired size and then let go of the mouse button.

If the option ‘Catch on grid’ is enabled, the object size is aligned to the grid.

When you press and hold the [Ctrl] key while drawing the square, the object size is changed proportionately.
Change edges, segments and points

1. Double-click on the desired shape.
   - Handles are shown as red squares.
2. Click on a square and hold down the mouse button.
3. Drag the mouse until the object or the object section has the desired shape and then let go of the mouse button.

If the option ‘Catch on grid’ is enabled, the shape is changed step by step based on the grid.

Rotate

1. Select the desired shape or the desired element.
2. If necessary, you can move the home position (yellow square) to change the centre of rotation.
3. Click on a button in the toolbar under ‘Rotate’. You can rotate the object by 90°, 180°, 270° or by a value selected with the slider.
   - The object is rotated around the home position.

Change lines and contours

1. Select the desired shape.
2. In the toolbar under ‘Lines’, click in a selection field or on a button to change the line or the contour:
   - Line type: Solid lines or broken lines
   - Line width: Line width in pixels
   - Outline: Line colour
   - Line end: Flat, round or square
   - Connection: Angular, rounded or bevelled

Use a template

You can apply pre-defined layouts to a shape.

1. Click on ‘Format templates’ in the toolbar.
2. Select the desired layout.

Transfer formatting

1. In the toolbar, under ‘Shapes’, click on ‘Transfer formatting’.
2. Click on the shape to which you want to transfer the formatting.
9.9.5 Edit object properties

Properties of an Element

You can edit the properties of objects in images to change the presentation. You can assign control variables to certain pre-defined elements.

Fig. 247: Properties of a marked element

Fig. 248: Properties of a marked shape
Select the desired object in the image.
⇒ The properties of the object are displayed.
If the properties are not displayed, select ‘View ⇒ Properties’ or press [Ctrl]+[Shift]+[M].
If the catalog is displayed instead of the properties, you must click on ‘Properties’ at the lower screen edge.

**Edit properties**

Different properties are presented depending on the shape or element type, e.g.:
- ‘General’ – Assign control variable (not for shapes) ⇐ further information page 326
- ‘Format’ – Position, size and rotation
- ‘Composition’ – Colours
- ‘Text formatting’ – Formatting of text
- ‘Limits’ – Limit values

**Assign control variable**

1. To assign a control variable to the element, under ‘General’, click on the ‘...’ button next to the input field ‘Variable’.
⇒ A dialogue window for assigning control variables to the HMI element will open.
   If no control variables are shown (empty list), you must first edit the ‘Standard variables table’. ⇐ Chap. 9.4 “Standard variables table” editor ⇐ page 316
2. Select the desired variable from the list and click on ‘OK’.
⇒ The variable is entered in the input field.
   If you open the “Typed representation” window, all variables are listed therein. ⇐ Chap. 4.16 ‘Typed representation’ page 49

**Insert control variables as an element**

You can use the mouse to insert control variables into the image using the “Typed representation” window, thereby creating a new element. ⇐ Chap. 4.16 ‘Typed representation’ page 49

**Change colours**

For certain objects, you can define different colours, e.g. for the background, contour and filling of an object, for the font or the presentation of limit values.

To change a colour, enter the hexadecimal value in the input field as follows:
- RGB value without transparency: #rrggbb, e.g. #0080FF
- RGB value with transparency (alpha channel): #aarrggbb, e.g. #C00080FF
  - or -
  Next to the input field, click on the colour field to open the dialogue window for the colour selection.

**Edit dynamic samplings**

You can dynamise elements so as to stimulate process flows in images. ⇐ Chap. 9.9.6 ‘Edit dynamic samplings – “Simple dynamics”’ page 326

### 9.9.6 Edit dynamic samplings – “Simple dynamics”

You can dynamise elements so as to stimulate process flows in images. The ‘Simple dynamics’ dialogue window contains pre-defined animations that you can assign to an element in the image.
You can define several dynamic samplings per element. If, for example, you want to stimulate the level of a container, you can "Scale" the dynamic sampling for the visualisation of the level and also use "Colour" dynamic sampling to present limit values.

9.9.6.1 Add dynamic sampling

If you want to dynamise an element, you must proceed as follows:

1. Highlight the desired element in the image.

2. Right-click with the mouse button on the lower section of the ‘Properties’ and select ‘Add’.

If the properties are not displayed, select ‘View ➔ Properties’ or press [Ctrl]+[Shift]+[M].

If the catalog is displayed instead of the properties, you must click on ‘Properties’ at the lower screen edge.

 ⇒ The ‘Simple dynamics’ dialogue window will open.
Creating a visualisation

You must create the following configurations for the dynamic sampling of an element:

- Event that triggers the dynamic sampling, e.g. the value of a variable, a click of the mouse, timer
- Action to be executed when the event takes place, e.g. colour, size of position of the element

**Define event**

1. To assign an event to the element, click in section ‘1. Event’ on the desired event that triggers the dynamic sampling, e.g. ‘condition’.
2. Create further settings to narrow down the event further, e.g. select control variable.
Example: Select control variable

1. Select the event 'Node' (change of a certain attribute of a variable) or 'Condition' (value of a variable).

2. Click on the ‘...' button.
   - A dialogue window for selecting control variables will open.
   - If no control variables are shown here (empty list), you must first edit the 'Standard variables table'. Chap. 9.4 "Standard variables table" editor page 316

3. Select the desired variable from the list and click on 'OK'.
   - The variable and an ID number are entered in the input field.

Define action

1. To stimulate the element, click in section '3. Action' on the desired action, e.g. 'colour'.

2. Create further settings to adapt the action, e.g. select control variable.

3. Close the dialogue window 'Simple dynamics'.
   - The dynamic sampling is added to the 'Properties'.

9.9.6.2 Edit dynamic sampling

To display or change the dynamic sampling of an element, you must proceed as follows:

1. Highlight the desired element in the image.

2. In the lower section of the 'Properties', right-click with the mouse button on the desired dynamic sampling and select 'Edit'.
   - The 'Simple dynamics' dialogue window will open.

3. Change the configurations of the dynamic sampling, if necessary.

4. Close the dialogue window 'Simple dynamics'.

9.9.6.3 Copying and pasting dynamic sampling

You can copy the dynamic sampling of an element and add it to another element:

1. Highlight the desired element in the image.

2. In the lower section of the 'Properties', right-click with the mouse button on the desired dynamic sampling and select 'Copy'.

3. Highlight the element in the image that is to receive the same dynamic sampling.

4. Right-click with the mouse button on the lower section of the 'Properties' and select 'Paste'.
   - The marked element receives the same dynamic sampling as the first selected element.
9.9.6.4 Delete dynamic sampling

To delete the dynamic sampling of an element, you must proceed as follows:

1. Highlight the desired element in the image.
2. In the lower section of the ‘Properties’, right-click with the mouse button on the desired dynamic sampling and select ‘Delete’.
   ⇒ A dialogue window will open where you can select whether you want to delete the dynamic sampling.
3. Click on ‘Yes’.
   ⇒ The dynamic sampling is removed from the element.

9.10 Add new enumeration

An enumeration is a list of texts that can be displayed, instead of values, in HMI elements. You can use enumerations in certain HMI elements.

1. In the project tree within the visualisation project, under ‘Enumerations’, click on ‘Add new enumeration’.
   ⇒ A dialogue window will open.
2. Enter a name for the enumeration.
3. Select the type of enumeration:
   - BOOL for two texts instead of the two states TRUE and FALSE
   - NUMERIC for texts instead of numerical values
   - STRING for character strings instead of values
4. Click on ‘OK’.
   ⇒ The enumeration is added to the project tree, and the editor to edit the enumeration is opened.

9.11 Edit and use enumeration

In the project tree within a visualisation project under ‘Enumerations’, double-click on the desired enumeration.
⇒ The enumeration is opened in the editor.

**Enumeration of the BOOL type**

1. Enter the desired text for the values TRUE and FALSE in the ‘Text’ input fields.

**Enumeration of the NUMERIC type**

1. Enter the desired text in the first line of the table in the ‘Text’ input field.
2. Enter a numerical value in the ‘Value’ input field.
3. Confirm your input with [Enter].
   ⇒ The enumeration element is inserted in the table.
4. You can add further enumeration elements.

**Enumeration of the STRING type**

1. Enter the desired text in the first line of the table in the ‘Text’ input field.
2. Enter a value in the ‘Value’ input field.
3. Confirm your input with [Enter].
   ⇒ The enumeration element is inserted in the table.
4. You can add further enumeration elements.

Using an enumeration in an image

You can use the enumeration in certain HMI elements. During run-time, the filed texts instead of the values are displayed in the HMI elements.

1. Highlight the desired element in the image.
   ⇒ The properties of the element are displayed. Chap. 9.9.5 ‘Edit object properties’ page 325
2. Under ‘General’, select the ‘Mode’ "Enumeration".
   ⇒ If the property ‘Mode’ is not displayed, the enumeration cannot be applied to this HMI element.

9.12 Translations

You can translate all texts in the images into as many languages as desired.

⇒ Click on ‘Translations’ in the project tree within a visualisation project.
   ⇒ The ‘Translations’ editor will open.

Fig. 250: Translations
(1) Toolbar
(2) Editor for translations (translation table)

(1) Toolbar
Add language: Add new language column ↗ further information page 332
Import: Import translation table into the HMI project ↗ further information page 332
Export: Export translation table to a translation file ↗ further information page 332
(2) Editor for translations (translation table)

The first column of the translation table contains the texts of the standard language. This column displays all texts that are contained in the text boxes of images. You can add a new column for each desired language and edit the texts.

Add language

1. Click on the button.  
   ⇒ A dialogue window will open.
2. Enter the desired language.  
   ⇒ The new language is inserted into the table. The text boxes for this language are empty.

Change language columns

You can rename, delete as well as show and hide individual language columns.

Right-click with the mouse button on the desired language column in the header and select the desired function.

Edit texts

Double-click in the desired table line and edit the text.

As long as a text box has not been edited, the symbol is displayed.

Delete text lines

You can delete individual lines.

1. Highlight the table line which you want to delete.
2. Press [Del].  
   - or -
   Right-click with the mouse button on the line and select ‘Delete highlighted line...’.

Export translation table

You can export the translation table in XML format (VTR file) in order to e.g. edit it with any editor.

1. Click on the button.  
   ⇒ A dialogue window will open.
2. Select a directory and enter a file name.  
   ⇒ The translation table is exported.

Import translation table

You can import translation tables into the HMI project.

1. Click on the button.  
   ⇒ A dialogue window will open.
2. Select the desired VTR file.  
   ⇒ The translation table is imported into the HMI project.

9.13 User management

The user management allows you to create a user list. For each user, you can define a password and write permission.
Adding a user

1. Click on .
2. Enter the desired user name in the input field ‘Name’.
3. Enter the password in the input field ‘Password’ and repeat the input under ‘Re-enter password’.
4. Click on ‘Apply’.  
   ⇒ The user will be entered in the user list.
5. To allow the user to modify HMI images, activate ✓ the option ‘Write permission’.

Removing a user

Right-click with the mouse button on the user line and select ‘Delete user’.

- or -
Left-click with the mouse button on the user line and then press [Del].

⇒ A dialogue window will open, where you can select whether the user should be deleted or not.

9.14 Movicon projects

You can create an HMI device with the Movicon functionality. You can thus use the HMI device in a SCADA (Supervisory Control and Data Acquisition) system. For this, please see Chap. 6.4.1 ‘Adding a Movicon project’ page 84.

You can open an existing Movicon project and change the project path.

9.14.1 Opening a Movicon project

Click on ‘Open Movicon project’ within the HMI at ‘HMI Movicon project’.

⇒ The external Movicon application will be started (if available) and the Movicon project will be opened.
9.14.2 Changing the project path

Right-click with the mouse button on ‘HMI Movicon project’ within the HMI and select ‘Change project path’.

⇒ A dialogue window will open where you can reassign the project path.

9.15 Simulate HMI visualisation

With the HMI simulation, you can test the images in the web browser of your PC before you load the project into the visualisation device or into the control.

If you want to simulate the HMI visualisation, you must proceed as follows:

1. Create and save all images in your HMI project.
2. Start the PLC simulation if necessary in order to execute the user program. [Chap. 8.17 ‘Simulate user program’ page 270]
3. In the toolbar, select the web browser in which the HMI simulation is to be executed.
4. Start the HMI simulation. Select one of the following options to this end:
   - **Toolbar**: Click on .
   - **Project tree**: In the HMI project, right-click with the mouse button on ‘Images’ and select ‘Dynamic Simulation’.
   - **Image editor**: Click on the ‘Preview’ button.

⇒ The start image is opened in the web browser.

5. Test the HMI visualisation. For example, you can test whether dynamic samplings work correctly.
6. If you want to reload the HMI simulation into the web browser with the start image, click on .
7. End the HMI simulation. To this end, click on .
8. If you have executed the PLC simulation, end it.
### 9.16 Keyboard commands in "Image" editor (HMI)

<table>
<thead>
<tr>
<th>Keyboard command</th>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>[Ctrl]+[+]</td>
<td>Zoom in</td>
<td>Increases the zoom factor</td>
</tr>
<tr>
<td>[Ctrl]+[-]</td>
<td>Zoom out</td>
<td>Decreases the zoom factor</td>
</tr>
<tr>
<td>[Shift]+[Tab]</td>
<td>Select next element</td>
<td>Selects the next element in the image (jump to the next element)</td>
</tr>
<tr>
<td>[Ctrl]+[A]</td>
<td>Select all elements</td>
<td>Selects all elements in the image</td>
</tr>
<tr>
<td>[Esc]</td>
<td>Reset selection</td>
<td>Reset selected elements (= no element is selected)</td>
</tr>
<tr>
<td>[Ctrl]+[C]</td>
<td>Copy</td>
<td>Copy selected elements</td>
</tr>
<tr>
<td>[Ctrl]+[X]</td>
<td>Cut</td>
<td>Cut selected elements</td>
</tr>
<tr>
<td>[Ctrl]+[V]</td>
<td>Paste</td>
<td>Paste selected elements</td>
</tr>
<tr>
<td>[Ctrl]+[Z]</td>
<td>Undo</td>
<td>Undo last change</td>
</tr>
<tr>
<td>[Ctrl]+[Y]</td>
<td>Redo</td>
<td>Restore last undone change</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[B]</td>
<td>Bold</td>
<td>Changes the text of the selected element to &quot;bold&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[I]</td>
<td>Ital</td>
<td>Changes the text of the selected element to &quot;italics&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[U]</td>
<td>Underline</td>
<td>Changes the text of the selected element to &quot;underline&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[B]</td>
<td>Font colour</td>
<td>Changes the font colour of the selected element</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[+]</td>
<td>Increase font size</td>
<td>Increases the font size of the selected element</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[-]</td>
<td>Decrease font size</td>
<td>Decreases the font size of the selected element</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[D]</td>
<td>Delete formatting</td>
<td>Restores the standard formatting of the selected element</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[1]</td>
<td>Draw line</td>
<td>Sets the mode of the editor to &quot;Draw line&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[2]</td>
<td>Draw rectangle</td>
<td>Sets the mode of the editor to &quot;Draw rectangle&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[3]</td>
<td>Draw circle</td>
<td>Sets the mode of the editor to &quot;Draw circle&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[4]</td>
<td>Draw polygon</td>
<td>Sets the mode of the editor to &quot;Draw polygon&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[5]</td>
<td>Draw polyline</td>
<td>Sets the mode of the editor to &quot;Draw polyline&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[6]</td>
<td>Draw ellipse</td>
<td>Sets the mode of the editor to &quot;Draw ellipse&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[7]</td>
<td>Add text box</td>
<td>Sets the mode of the editor to &quot;Add text&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[8]</td>
<td>Add image</td>
<td>Opens the dialog in order to add a new image</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[9]</td>
<td>Bézier curves</td>
<td>Sets the mode of the editor to &quot;Draw circle&quot;</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[Image ⬇]</td>
<td>Bring forward</td>
<td>Element is brought forward a level</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[Image ⬆]</td>
<td>Send backward</td>
<td>Element is sent backward a level</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[←]</td>
<td>Align left-aligned</td>
<td>Selected elements are aligned left-aligned</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[→]</td>
<td>Align right aligned</td>
<td>Selected elements are aligned right aligned</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[↙]</td>
<td>Arrange below</td>
<td>Selected elements are aligned towards the lower edge of the lowest-positioned element</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[↑]</td>
<td>Arrange above</td>
<td>Selected elements are aligned towards the upper edge of the highest-positioned element</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[Pos 1]</td>
<td>Align vertically</td>
<td>Selected elements are cantered vertically</td>
</tr>
<tr>
<td>Keyboard command</td>
<td>Function</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[End]</td>
<td>Align horizontally</td>
<td>Selected elements are centerized horizontally</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[H]</td>
<td>Horizontally distributed</td>
<td>Selected elements are aligned horizontally with the same spacing</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[V]</td>
<td>Vertical distributed</td>
<td>Selected elements are aligned vertically with the same spacing</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[←]</td>
<td>Shift to the left</td>
<td>Selected elements are shifted to the left, aligned towards the grid</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[→]</td>
<td>Shift to the right</td>
<td>Selected elements are shifted to the right, aligned towards the grid</td>
</tr>
<tr>
<td>[Ctrl]+[G]</td>
<td>Group</td>
<td>Selected elements are grouped</td>
</tr>
<tr>
<td>[Ctrl]+[U]</td>
<td>Ungroup</td>
<td>Grouping of elements is removed</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[R]</td>
<td>Rotate 90°</td>
<td>Rotate clockwise 90 degrees</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[T]</td>
<td>Rotate 270°</td>
<td>Rotate element clockwise 270 degrees (= 90 degrees anticlockwise)</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[P]</td>
<td>Preview in web browser</td>
<td>Rotate clockwise 90 degrees</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[X]</td>
<td>Toggle Grid</td>
<td>Switch visibility of the grid: visible/not visible</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[Q]</td>
<td>Configure grid</td>
<td>Opens the dialog ‘Configure grid’</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[A]</td>
<td>Align towards the grid</td>
<td>Selected elements are aligned towards the grid</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[N]</td>
<td>Change line end</td>
<td>Change line end: flat/round/square</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[M]</td>
<td>Change connection</td>
<td>Change connection: angular/rounded/bevelled</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[G]</td>
<td>Colour gradient</td>
<td>Opens the dialog ‘Colour gradient’</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[Y]</td>
<td>Clone style</td>
<td>Save formatting of the selected element for transfer to another element</td>
</tr>
<tr>
<td>[Ctrl]+[Alt]+[S]</td>
<td>Open configurations</td>
<td>Opens the dialog ‘Configurations’ &amp; Chap. 9.7.1 ‘Configurations’ page 320</td>
</tr>
<tr>
<td>[Ctrl]+[Shift]+[S]</td>
<td>Save HMI library element</td>
<td>Saves the HMI library element currently processed in the editor</td>
</tr>
</tbody>
</table>
10 Motion Control

10.1 Functions of Motion Control

Functions of Motion Control are supported by VIPA CPUs of the series SLIO CPU iMC7 (e.g. SLIO-CPU 015-CEFNR00). The control communicates via the communication protocol EtherCAT with the drive modules.

- You can choose drive modules from the catalog and configure them.
- You can call up further tools, such as YASKAWA SigmaWin+ or YASKAWA DriveWizard.
- You can add and configure axes.
- With the Motion Control library, you can program machine functionalities.

10.2 Add drive

Functions of Motion Control are supported by VIPA CPUs of the series SLIO CPU iMC7 (e.g. SLIO-CPU 015-CEFNR00). The control communicates via the communication protocol EtherCAT with the drive modules.

![Diagram of adding a slave via "Catalog"

Fig. 252: Adding slave via "Catalog"

(1) Select drive module (hold left mouse button down)
(2) Drag drive module
(3) Drop the drive module at a suitable place (release the mouse button)
(4) The drive module is added
1. Select one of the following options if you want to add a drive module:

- **Catalog**: Drag the desired drive module from the ‘Device templates’ register of the catalog (Chap. 4.10 ‘Catalog’ page 34) to the connecting line of the EtherCAT bus system in the ‘Devices and networking’ editor. Fig. 59
The drive module is directly added and displayed in the project tree.

- **Project tree**: Within the PLC under ‘Decentralised periphery’, ‘EC master system’, click on ‘Add new device’. Fig. 60

- **Editor “Devices and networking”**: Right-click with the mouse button on the connecting line of EC master system and select ‘Add new device’.

![Image](image.png)

Fig. 253: “Add new device” (drive) dialogue window (drive)

2. Select ‘Drives’.

3. Select the desired device template from the list.

4. ‘Device name’: Enter a device name, if required.

5. Click on ‘OK’.

   ⇒ The drive module is added and displayed in the project tree.

If you enter a value in the ‘Number’ box, several structurally identical drive modules are added.
10.2.1 Adaptation of the Sigma 5/7 drives, which are integrated via ESI file

With each version of the SPEED7 Studio the catalog data of the Sigma 5/7 drives are updated. You can also update the data of your Sigma 5/7 drives in the catalog by means of an ESI files.

Please note that system-specific default values are changed in the input/output PDOs. These must be adapted with the SPEED7 EtherCAT Manager as described below! Otherwise, you will receive a mapping error during commissioning.

**Inputs: 1st Transmit PDO**

<table>
<thead>
<tr>
<th>Name</th>
<th>Index single / double axis module 1</th>
<th>Index double axis module 2</th>
<th>Bit length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status word</td>
<td>0x6041:00</td>
<td>0x6841:00</td>
<td>16bit</td>
</tr>
<tr>
<td>Position actual internal value</td>
<td>0x6063:00</td>
<td>0x6863:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Position actual value</td>
<td>0x6064:00</td>
<td>0x6864:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Torque actual value</td>
<td>0x6077:00</td>
<td>0x6877:00</td>
<td>16bit</td>
</tr>
<tr>
<td>Following error actual value</td>
<td>0x60F4:00</td>
<td>0x68F4:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Modes of operation display</td>
<td>0x6061:00</td>
<td>0x6861:00</td>
<td>8bit</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>0x60FD:00</td>
<td>0x68FD:00</td>
<td>32bit</td>
</tr>
</tbody>
</table>

**Inputs: 2nd Transmit PDO**

<table>
<thead>
<tr>
<th>Name</th>
<th>Index single / double axis module 1</th>
<th>Index double axis module 2</th>
<th>Bit length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Touch probe status</td>
<td>0x60B9:00</td>
<td>0x68B9:00</td>
<td>16bit</td>
</tr>
<tr>
<td>Touch probe 1 position value</td>
<td>0x60BA:00</td>
<td>0x68BA:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Touch probe 2 position value</td>
<td>0x60BC:00</td>
<td>0x68BC:00</td>
<td>32bit</td>
</tr>
</tbody>
</table>

**Outputs: 1st Receive PDO**

<table>
<thead>
<tr>
<th>Name</th>
<th>Index single / double axis module 1</th>
<th>Index double axis module 2</th>
<th>Bit length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control word</td>
<td>0x6040:00</td>
<td>0x6840:00</td>
<td>16bit</td>
</tr>
<tr>
<td>Target position</td>
<td>0x607A:00</td>
<td>0x687A:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Target velocity</td>
<td>0x60FF:00</td>
<td>0x68FF:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Modes of operation</td>
<td>0x6060:00</td>
<td>0x6860:00</td>
<td>8bit</td>
</tr>
<tr>
<td>Touch probe function</td>
<td>0x60B8:00</td>
<td>0x68B8:00</td>
<td>16bit</td>
</tr>
</tbody>
</table>

**Outputs: 2nd Receive PDO**

<table>
<thead>
<tr>
<th>Name</th>
<th>Index single / double axis module 1</th>
<th>Index double axis module 2</th>
<th>Bit length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target Torque</td>
<td>0x6071:00</td>
<td>0x6871:00</td>
<td>32bit</td>
</tr>
<tr>
<td>Torque Slope</td>
<td>0x6087:00</td>
<td>0x6887:00</td>
<td>32bit</td>
</tr>
</tbody>
</table>
10.3 Start SigmaWin+ or DriveWizard

If you have installed tools for the configuration of YASKAWA drives on your PC, you can call up the tools via the drive modules.

In the editor "Devices and networking" right-click with the mouse button on the drive module and select the desired tool, e.g. ‘Start SigmaWin+’ for servo drives or ‘Start DriveWizard’ for frequency converters.

The configuration tool is started for the drive module.

Tools which have not been installed are highlighted in grey and cannot be called up.

10.4 Editor "Motion Control Overview"

In the editor ‘Motion Control Overview’, you can change the configurations of the Motion Control functions.

If a project is open and a control is included which supports Motion Control functionalities, you can open the ‘Motion Control Overview’ editor:

- **Project tree**: Within the PLC under ‘Motion Control’, click on ‘Motion Control Overview’.

The ‘Motion Control Overview’ editor is divided into three sections.

10.4.1 General settings

You have selected the ‘General settings’ section in the ‘Motion Control Overview’ editor.
Activate under Motion Control application the option ‘Motion control enabled’.

- By activating Motion Control, the following directories and blocks are created by SPEED7 Studio in the project tree under ‘program blocks’:
  - Directory ‘MC_APP’ with data blocks for the Motion Control user program
  - Directory ‘MC_SYSTEM’ with system blocks for the Motion Control user program
  - Organisation blocks for Motion Control, e.g. OB1, OB60 and OB61, including precall and postcall of the motion control system and synchronisation settings in the OB61.

Moreover, a synchronisation-enabled bus system (e.g. EtherCAT master system) is entered in the ‘IO-system’ field.

‘Cycle time’ – Cycle time in microseconds, adjustable in the configurator of the IO system

‘IO-system’ – Used IO system

‘Bus system properties’ – Open the dialogue window for the properties of the used IO system

Select Motion Control functions

All available Motion Control functions are grouped and listed under the ‘Motion Control library’.

1. Activate the Motion Control groups or individual functions you want to use in the Motion Control user program, e.g. ‘MC_Power’.

2. Click on ‘Add blocks’.

By activating Motion Control functions, SPEED7 Studio creates the directory ‘MC_LIB’ and within the function block, matching the activated Motion Control function, in the project tree under ‘Program blocks’, e.g. "MC_Power [FB700]".
If you delete the function block of an activated Motion Control function from the directory ‘MC_LIB’, this function block is added automatically when you compile the user program the next time.

10.4.2 Axis overview

In the axis overview, all configured axes are listed in a table. For each axis, the table lists the input and output parameters of the cyclic communication, the user units and limit values.

Detailed information on the parameters is available at:

- Chap. 10.6.1 ‘Basic settings’ page 345
- Chap. 10.6.2 ‘User units’ page 346
- Chap. 10.6.3 ‘Limit values’ page 349

In the ‘Expert View’, more details are shown than in the ‘Smart View’, e.g. further parameters and calculated values.

Fig. 255: Motion Control Axis Overview
10.4.3 Diagnostics

With the Motion Control diagnostics, you can check OB callings, execution and cycle times and see information on the axes during operation.

Fig. 256: Motion Control Diagnostics

(1) Switch on/off diagnostics
(2) OB callings and number of axes
(3) Run time behaviour of the OB61 and Motion Control cycle
(4) Information on the axis

In order to start the Motion Control diagnostics, you must proceed as follows:

1. Configure all axes. Chap. 10.5 ‘Add new axis’ page 344
2. Create and compile the user program. Chap. 8.16 ‘Compile user program’ page 268
3. Transfer the hardware configuration and the user program to the control. Chap. 8.18 ‘Transfer the hardware configuration and user program to the control’ page 272
4. Click on ‘Start diagnostics’. Motion Control diagnostics will be started.
5. End the Motion Control diagnostics. Click on ‘Stop diagnostics’ for this purpose.
(2) Diagnostics display, OB callings and number of axes

This shows whether the diagnostics is running and the organisation blocks OB1, OB60 and OB61 are run through. Moreover, the number of the configured axes is shown here.

(3) Run time behaviour of the OB61 and Motion Control cycle

The following information relating to the cycle time and execution time of the OB61 is shown in tables and as bar diagrams:

- Max. measured time since the start of the Motion Control diagnostics
- Min. measured time since the start of the Motion Control diagnostics
- Average value since the start of the Motion Control diagnostics
- Currently measured time

The pie chart displays the entire Motion Control cycle time in micro seconds. The individual pie sections display the current execution duration of the program processing of the OB61:

- Start OB61 – Internal CPU time for the preparation of the program processing
- Read PAE – Inputs reading
- Execution time – Processing user program
- Write PAA – Outputs writing
- Terminate OB61 – Internal CPU time for terminating the program processing
- Remaining time – Idling time

(4) Information on the axis

Click left on the desired axis.

- Configured data (set values) and current states (actual values) are displayed for the selected axis.

10.5 Add new axis

You can add new axes to a control with the Motion Control functionality axes. In the user program, you can control axes and thus move the drive.

In order to be able to add axes, a control which supports Motion Control functions must already be present in the project. "Motion Control" must already be activated in the "Motion Control overview". "Motion Control" must already be activated in the "Motion Control overview". "Motion Control" must already be activated in the "Motion Control overview".

"Motion Control" must already be activated in the "Motion Control overview". "Motion Control" must already be activated in the "Motion Control overview".

1. In the project tree within the control under 'Motion Control', 'Motion Control axes', click on 'Add new axis'.
   - A dialogue window will open.

2. 'Name of axis': Enter an axis name, if required. You can reference the axis in the user program with this name.

3. Click on 'OK'.
   - The axis is added and displayed in the project tree. Additionally, SPEED7 Studio creates a data block with the same name under 'Program Blocks', 'MC_APP'.

If you select the option 'Open Motion Control configuration' and click on 'OK', "Motion Control axis" editor will open.
10.6 Editor "Motion Control axis"

In the 'Motion Control axis' editor, you can make configurations at an axis of the drive.

In order to open the editor of a Motion Control axis, proceed as follows:

- **Project tree**: In the control under 'Motion Control', 'Motion Control axes', double click on the desired axis.

The 'Motion Control axis' editor is divided into three sections.

10.6.1 Basic settings

![Basic settings](image)

**Fig. 258: Motion Control axis: Basic settings**

Depending on the axis type, different setting possibilities are displayed.

- **Name of axis** – Is displayed in the project tree and used in the user program
- **Axis type** – Virtual axis, position or speed controlled axis, axis on external sensor/encoder
- **Output device** – Assign the axis to a drive module e.g. EtherCAT drive module
- **Motor type** (only for axis type "positioning axis") – Select motor according to the type designation or select "User defined" and set corresponding sensor resolution
- **Sensor resolution** (only for axis type "positioning axis") – resolution of the encoder: The suitable resolution is set automatically depending on the motor type. If you select "User defined" as motor type, you have to set the resolution manually.
- **absolute** / **incremental** – Encoder type: Absolute encoder or incremental encoder
- **Number of bits for revolution** (only for axis type "External encoder") – Resolution of the used encoder per motor revolution
- **Number of bits for multi turns** (only for axis type "External encoder") – Number of available bits, if the encoder is ready for multi turn. If the encoder is not ready for multi turn, enter value 0.

1. First, select the **Axis type**.
2. If you have selected a real axis or an external encoder, assign an **Output device**.
3. If an I/O allocation of the drive module does not match the used axis type, a dialogue window will open where you can choose whether SPEED7 Studio should correct the I/O allocation (IO mapping) automatically.

If this dialogue window will open, click on ‘Yes’.

4. Select the used motor with the ‘Motor type’. If no suitable motor is listed, select ‘User defined’, the ‘Sensor resolution’ and ‘absolute’ or ‘incremental’.

Details

1. Click on ‘Details’ in order to display the parameters for the cyclic communication.

2. If required, change the configuration for the cyclic reading and writing access of the axis.

10.6.2 User units

Here you can determine the areas and units of the axis. You can change the transmission ratio of the axis. The selected unit will be used for the input and output parameters of the Motion Control function blocks.
Fig. 259: Motion Control axis: User units

‘Unit’ – Unit for displays, e.g. in the motion diagram of the cam editor: The unit has no influence on the calculation of motions.

Axis type

‘Modulo’:
- For endless positioning in positive direction (exceeding "maximum") or negative direction (exceeding "minimum")
- The maximum value (e.g. 360 degrees) corresponds to the minimum value (e.g. 0 degrees).
‘Limited’:
- For positioning within the limits "Minimum" and "Maximum"
- If the axis is driven across the limits, the position will be set to invalid.
- The maximum value (e.g. 360 degrees) doesn’t correspond to the minimum value (e.g. 0 degrees).

**Machine cycle**

Traversing range of the axis: The values can be used for the calculation of a motion, examples see below.

- **'Maximum'** – Upper limit value for the traversing range
- **'Minimum'** – Lower limit value for the traversing range

---

**CAUTION!**
The axis can run out of control!
A limited axis is not stopped, even if the configured traversing range is left!

Program the Motion Control function blocks (e.g. MC_MoveVelocity, MC_GearIn, etc.) in a way that the configured traversing range is not exceeded! Use the monitoring function of the positioning and the function block MC_ReadAxisInfo for that purpose. [further information page 350](#)

---

**Motor resolution**

- **'Increments', 'Motor revolution'**– Resolution of a motor revolution: The value displays the number of increments per motor revolution of the used drive. The motor resolution can be set via the motor type and the sensor resolution. *Chap. 10.6.1 'Basic settings'* page 345

**Gear ratio**

Transmission ration of the gear: The number of motor revolutions corresponds to the number of revolutions of the output (on the load side, e.g. on the drive output), see example below.

- **'Motor revolutions'** – Number of motor revolutions: The value is used for the transmission ratio of a motion.
- **'Revolutions drive'** – Number of revolutions of the output side: The value is used for the calculation of a motion.

If no drive is used on the axis (transmission ratio 1:1), select "Motor revolutions = 1" and "Revolutions drive = 1".

**Mechanics**

Relation between the mechanics and the user units: The number of the **'Revolutions drive'**, corresponds to the value of **'User units'**, see example below.
The total motion (working travelling distance) of a linear axis should be max. 2,000 mm in an area between -1,000 mm and +1,000 mm. A drive with a transmission ratio of 2:1 is used. For three revolutions on the load side (output) a distance of 100 mm is travelled.

Select the following configurations for this example:

- Unit: mm
- Axis type: limited
- Machine cycle – Maximum: 1,000, Minimum: -1,000
- Gear ratio – Motor revolutions: 2, revolutions output: 1
- Mechanics – revolutions output: 3, User units: 100

Click on ‘Details’ in order to display an overview over the calculated values, e.g. velocity, acceleration and jerk.

10.6.3 Limit values

Fig. 260: Motion Control axis: Limit values

Operation settings

Here, you can enter the maximum limit values of the axis for velocity, acceleration, delay and jerk. The values are used for the input and output parameters of the Motion Control function blocks.
Positioning

You can monitor the traversing range of a limited axis. "Software limit switches" can be programmed via the user program.

1. Enable the option 'Monitoring minimum position' or 'Monitoring maximum position'.

2. Enter the limit values into the input fields 'Min. position' or 'Max. position'. The values must be within the configured traversing range. ⇒ 'Machine cycle' page 348

⇒ Motion Control function block MC_ReadAxisInfo displays if a limit value has been exceeded via the parameters LimitSwitchNeg or LimitSwitchPos.

CAUTION!
The axis can run out of control!
A limited axis is not stopped, even if the configured traversing range is left!

Program the Motion Control function blocks (e.g. MC_MoveVelocity, MC_GearIn, etc.) in a way that the configured traversing range is not exceeded! Use the monitoring function of the positioning and the function block MC_ReadAxisInfo for that purpose.

Details

Click on 'Details' in order to display an overview over the calculated values.

10.7 Create cams

10.7.1 The "Electronic cam"

Irregular motions can be created with mechanical cam gears. If a change of a motion sequence is required, the system must be retooled and the cam must be exchanged. "Electronic cams" have the advantage that motion sequences can be changed in a real short time, even during operation, without the necessity to retool the system.

Electronic servo drives will assume the function of the "Electronic cam". Those drives can carry out very complex motions. Information on the motion can be found in a "data point table". You can set the data points with the cam editor and reproduce and develop mechanical cams. The data points are stored in a data block and are transferred from the control to the drive via the function block "MC_CamIn".

10.7.2 Add new cam

You can add new cams to a control with the Motion Control functionality and edit them in the cam editor.

In order to be able to add cams, a control which supports Motion Control functions must already be present in the project. ⇒ Chap. 10 'Motion Control' page 337
In addition, at least two axes must be present in the project. 

1. In the project tree within the control under 'PLC program', 'Cams', click on 'Add new cam'.
   - A dialogue window will open.
2. 'Name': Enter a cam name, if required.
3. 'Master axis': Select the desired master axis (or leading axis, reference axis). You can use virtual or real axes.
4. 'Slave axis': Select the desired slave axis. You can use virtual or real axes.
5. Click on 'OK'.
   - The cam is added and displayed in the project tree. Additionally, SPEED7 Studio creates a data block with the same name under 'Program Blocks', 'MC_APP'.

You can change the master axis and following axis afterwards. 

10.7.3 Cam editor

In the cam editor, you can set the data points of the "Electronic cam".

In order to open the cam editor, proceed as follows:

- **Project tree**: Within a control, double click on the desired cam under 'PLC program', 'Cams'.
Create cams > Cam editor

Fig. 262: Cam editor

(1) Toolbar
(2) Motion diagram
(3) Motion characteristics
(4) Properties of a motion segment
(5) Overview over motion segments
(6) Properties of the cam

(1) Toolbar

Editing mode: Edit selected motion segment  further information page 354

Create new curve: The data points are recalculated and stored in the data block.

Have the motion function inserted automatically  Chap. 10.7.3.5 ‘Auto-complete the curve’ page 358

In order to insert and draw motion functions:  Chap. 10.7.3.4 ‘Draw segments’ page 356.

For an overview over the motion functions:  Chap. 10.7.4 ‘Motion functions’ page 363

Insert motion function "Straight line"

Insert motion function "Polynomial 5. grade"

Insert motion function "Inclined sine"

Insert motion function "Modified acceleration trapezium (PP)"

Insert motion function "Modified acceleration trapezium (PR)"
Insert motion function "Modified acceleration trapezium (RP)"
Insert motion function "Modified sine (VV)"
Insert motion function "Modified sine (VR)"
Insert motion function "Modified sine (RV)"
Insert motion function "Sine-straight-combination"
Show/hide motion characteristic velocity (v)
Show/hide motion characteristic acceleration (a)
Show/hide motion characteristic jolt (j)
Export cam profile: Save all data from the cam profile in a VPCAM file (XML format)
Import cam profile: Load cam profile from a VPCAM file into the cam editor

In the motion diagram (or motion plan) of the cam editor, you can edit the total motion graphically.

Chap. 10.7.3.1 ‘Motion diagram’ page 353

This diagram shows the development of the velocity, the acceleration and the jerk.

Chap. 10.7.3.6 ‘Motion characteristics’ page 358

You can display and edit all data of a motion segment here.

Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

You can display and edit all data of the motion segment of the cam profile here.

Chap. 10.7.3.8 ‘Overview over motion segments (profile overview)’ page 361

You can display and edit general data about the cam profile and the selected master and slave axes here.

Chap. 10.7.3.9 ‘Properties of the cam (profile properties)’ page 362

In the motion diagram (or motion plan) of the cam editor, you can edit the total motion graphically.

- The total motion (or cam profile) is divided into individual successive motion segments. The motion diagram includes the individual segments of the total motion.
- Individual motion function (or motion laws) can be included into the motion diagram.
- Shockproof and jolt free motions can be guaranteed between the motion segments via matching conditions (or boundary value conditions).
10.7.3.2 Insert segments

In the motion diagram of the cam editor, you can insert successive motion segments in order to create the total motion of the cam.

Select/highlight segment

You can highlight a segment in the motion diagram.

Left-click on the desired motion segment.

- The segment will be displayed highlighted.

The properties of the highlighted motion segment are shown in the tab ‘segment’. Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

For pasting and editing of motion segments:

- Chap. 10.7.3.2 ‘Insert segments’ page 354
- Chap. 10.7.3.4 ‘Draw segments’ page 356
- Chap. 10.7.3.8 ‘Overview over motion segments (profile overview)’ page 361
- Chap. 10.7.3.5 ‘Auto-complete the curve’ page 358

Empty motion diagram

For a newly created cam, no motion segments are available – the motion diagram is empty.

Right-click with the mouse button on the motion diagram and select ‘Add new section’.

- A motion segment with the motion function "Polynomial 5. grade" will be inserted.
In order to change the motion function: Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

Insert segment before

You can insert another segment in front of a motion segment.

Fig. 264: Insert segment in front

(1) highlighted segment
(2) original, shortened segment
(3) new segment

Right-click with the mouse button on the desired motion segment in the motion diagram and select ‘Insert segment in before’.

⇒ The starting point of the highlighted segment will be moved to the centre. A motion segment with the motion function "Polynomial 5. grade" will be inserted at the free position. The boundary points of the two segments are connected in order to create a closed curve.

In order to change the motion function: Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

Insert segment behind

You can insert another segment behind a motion segment.

Fig. 265: Insert segment behind

(1) highlighted segment
(2) new segment
(3) original, shortened segment

Right-click with the mouse button on the desired motion segment in the motion diagram and select ‘Insert segment after’.

⇒ The end point of the highlighted segment will be moved to the centre. A motion segment with the motion function "Polynomial 5. grade" will be inserted at the free position. The boundary points of the two segments are connected in order to create a closed curve.

In order to change the motion function: Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359
10.7.3.3 Delete segment

Right-click with the mouse button on the desired motion segment in the motion diagram and select ‘Delete section’.

The motion segment will be deleted.

Starting and end points of the neighbouring segments are moved into the centre of the deleted segment to avoid a closed curve being interrupted.

![Fig. 266: Delete motion segment](image)

(1) highlighted segment
(2) neighbouring segments after deletion

10.7.3.4 Draw segments

In the motion diagram of the cam editor, you can insert motion functions and move boundary points.

**Insert and draw motion functions**

If the cam profile is not complete, i.e. if there are free segments in the motion diagram, you can select motion functions via the toolbar and draw diagrams.

![Fig. 267: Insert and draw motion functions](image)

(1) select motion function
(2) free motion segment
(3) draw motion functions
1. Select the desired motion function in the toolbar of the cam editor. For an overview over the motion functions:  
   Chap. 10.7.4 'Motion functions' page 363

2. Left-click with the mouse in the free segment of the motion diagram and hold the mouse button pressed down.
   ⇒ The starting point of the motion function will be set.

3. Drag the mouse to the right, e.g. up to the starting point of the following segment, in order to connect both segments.
   ⇒ The end point of the motion function will be moved.

4. Release the mouse button.

**Auto-complete the curve**

Between motion segments which are not connected, you can have the motion function "Polynomial 5. Grade" inserted automatically.  
Chap. 10.7.3.5 'Auto-complete the curve \(A\)' page 358

**Move boundary points**

You can move the starting, end, or connection points of a motion function in the motion diagram.

![Fig. 268: Boundary points](image)

(1) End point
(2) Starting point
(3) Connection point (starting and end point)

1. Highlight the desired motion segment in the motion diagram.
   ⇒ The segment will be displayed highlighted.

2. Left-click with the mouse on the boundary point which you want to move hold the mouse button pressed down.

3. Drag the mouse in order to move the boundary point.

4. Then release the mouse button.

**Connect and disconnect boundary points**

Boundary points are "magnetic":

- If you drag an end point onto the starting point of the following segment, both points will be connected.
- If you drag a starting point onto the end point of the previous segment, both points will be connected.
- If you drag a connection point slowly, the connection will stay intact.
- If you drag a connection point fast, the connection will be disconnected.
The increment when moving the points depends on the display size of the motion diagram and the screen resolution. Under ‘Properties of the motion segment’, you can enter accurate values for the starting points and end points. ☑ Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

10.7.3.5 Auto-complete the curve

Between motion segments which are not connected, you can have the motion function “Polynomial 5. Grade” inserted automatically.

Fig. 269: Auto-complete the curve

Select ‘Auto-complete the curve’ in the toolbar of the cam editor.

☞ On free positions, motion segments with the motion function "Polynomial 5. Grade" will be inserted. The boundary points of all segments are connected in order to create a closed curve.

In order to change the motion function: ☑ Chap. 10.7.3.7 ‘Properties of the motion segment’ page 359

10.7.3.6 Motion characteristics

This diagram of the cam editor shows the development of the velocity, the acceleration and the jolt.

If the desired motion characteristic is not displayed, you have to select it via the toolbar of the cam editor. ☑ (1) Toolbar page 352
Fig. 270: Motion diagram

(1) motion characteristic velocity (v)
(2) motion characteristic acceleration (a)
(3) motion characteristic jolt (j)
(4) x- and y-coordinate of the current mouse pointer position
(5) absolute maximum value of the characteristics
(6) select scale of the y-axis for a motion characteristic

10.7.3.7 Properties of the motion segment

You can display and edit all data of a motion segment here.
Fig. 271: Properties of the motion segment

Select segment

All configurations in this tab correspond to the highlighted motion segment. You can highlight the desired segment in the motion diagram, in the ‘profile overview’ ( Chap. 10.7.3.8 ‘Overview over motion segments (profile overview)’ page 361) or here, via the two buttons:

- Select previous motion segment
- Select following motion segment

Properties

- ‘Name’ – Automatically created name of the motion segment. Change the name of the segment, if required.
- ‘Function’ – Motion function of the segment ( Chap. 10.7.4 ‘Motion functions’ page 363)
- ‘Starting point’ – x- and y-coordinates for the starting point of the motion segment
- ‘End point’ – x- and y-coordinates for the end point of the motion segment
**Boundary value conditions**

In the input fields you can set the velocity (v) and the acceleration (a) for starting point and end point. The entered value is normed, i.e. it refers to the geometrical conditions. In the display fields below, the calculated physical values are displayed, e.g. "mm/s" or "degree/s" for velocity.

**Parameter**

The parameters are not displayed for all motion functions.

‘_l_’ – Reversal point for asymmetric motion functions (or inflection point parameter): The entered value is normed, i.e. it refers to the geometrical conditions.

‘_c_’ – Synchronous line segment: The entered value is normed, i.e. it refers to the geometrical conditions.

**Characteristic values**

The characteristic values of the motion segment are displayed here. The characteristic values are evaluation criteria for the operational behaviour of a cam gear.

‘_Cv_’ – Characteristic value for velocity

‘_Ca_’ and ‘_Ca^*_’ – Characteristic values for acceleration

‘_Cj_’ and ‘_Cj^*_’ – Characteristic values for jolt

‘_Cmdyn_’ and ‘_Cmdyn^*_’ – Characteristic values for dynamic torque

**Overview over motion segments (profile overview)**

You can display and edit all data of the motion segment of the cam profile here.

**Fig. 272: Overview over motion segments**

Each line of the profile overview contains the data of a motion segment.

‘_x_’ – x-coordinate of the starting point of the segment

‘_y_’ – y-coordinate of the starting point of the segment

‘_Function_’ – Motion function of the segment © Chap. 10.7.4 ‘Motion functions’ page 363

the last line of the profile overview contains the x- and y-coordinates of the end point of the last motion segment.

**Highlight/select segment**

Left-click with the mouse in a line of the profile overview.

⇒ The segment will be displayed highlighted.
Change boundary points

You can change the starting point, endpoint, or connecting point of a motion segment.

Enter the desired x- or y-coordinate into the input field or click on the button ▲/▼.

The boundary point will be moved. If the starting point is connected to the end point of the previous motion segment, this end point is set on the same coordinate. The connection between motion segments remains intact.

Insert segment before

1. Right-click with the mouse button in a line of the profile overview and select ‘Insert section before’.

The starting point of the highlighted segment will be moved to the centre. A motion segment with the motion function "Polynomial 5. grade" will be inserted at the free position. The boundary points of the two segments are connected in order to create a closed curve.

2. Change the motion function, if necessary.

Insert segment behind

1. Right-click with the mouse button in a line of the profile overview and select ‘Insert section after’.

The end point of the highlighted segment will be moved to the centre. A motion segment with the motion function "Polynomial 5. grade" will be inserted at the free position. The boundary points of the two segments are connected in order to create a closed curve.

2. Change the motion function, if necessary.

10.7.3.9 Properties of the cam (profile properties)

You can display and edit general data about the cam profile and the selected master and slave axes here.

![Fig. 273: Properties of the cam](image)
Properties

‘Name’ – Name of the cam: If you change the name, a dialogue window will open where you can choose if SPEED7 Studio should adapt the name of the corresponding data block and the program code as well.

‘Vmax’ – Velocity of the master axis, number of pulses per minute: \( V_{\text{max}} \) influences the values of the derivatives velocity, acceleration, and jolt and the dynamic characteristic values.

‘Number of data points’ – Resolution of the master encoder: Number of data points which are stored in the data block and which are transferred from the control to the drive via the function block “MC_CamIn”.

Master axis

To add axes: Chap. 10.5 ‘Add new axis’ page 344.

To determine the measurement and user units of the axes: Chap. 10.6.2 ‘User units’ page 346

‘MC axis’ – Master axis (or leading axis, reference axis): x-axis in the motion diagram

‘Min’ – Minimum value of the x-axis: The value is always 0.

‘Max’ – Maximum value of the x-axis

‘Unit’ – Unit of the x-axis: The unit has no influence on the calculation of motions.

Slave axis

To add axes: Chap. 10.5 ‘Add new axis’ page 344.

To determine the measurement and user units of the axes: Chap. 10.6.2 ‘User units’ page 346.

‘MC axis’ – Slave axis: y-axis in the motion diagram

‘Min’ – Minimum value of the y-axis: The value is always 0.

‘Max’ – Maximum value of the y-axis

‘Unit’ – Unit of the y-axis: The unit has no influence on the calculation of motions.

10.7.4 Motion functions

Motion states

Depending on the velocity (v) and the acceleration (a), the following motion states result:

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>State</th>
<th>Boundary condition</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Pause</td>
<td>Velocity (v) = 0, Acceleration (a) = 0</td>
</tr>
<tr>
<td>G</td>
<td>Velocity (constant)</td>
<td>Velocity (v) ≠ 0, Acceleration (a) = 0</td>
</tr>
<tr>
<td>U</td>
<td>Reversal</td>
<td>Velocity (v) = 0, Acceleration (a) ≠ 0</td>
</tr>
<tr>
<td>B</td>
<td>Motion</td>
<td>Velocity (v) ≠ 0, Acceleration (a) ≠ 0</td>
</tr>
</tbody>
</table>
Motion task

A motion task describes the transition from one motion state to another (or motion transition).

Example: The drive should maintain a constant velocity after the initial acceleration. The motion task is "motion in velocity", abbreviated "(MV)".

Motion tasks and applicable motion functions

Generally, the entire motion of a cam consists of several motion segments. At the segment boundaries (boundary points), several motion functions (or motion laws) can be connected with each other. The following table lists the usable motion functions for different motion tasks. At least one applicable motion function can be used for each possible combination of motion tasks.

Example: The motion task "Velocity in reversal (VR)" can be realised with the motion function "Polynomial 5. grade" or "Modified sine".

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pause</strong></td>
<td>✓ Straight line</td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Polynomial 5. grade</td>
</tr>
<tr>
<td></td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Inclined sine</td>
<td>✓ Modified sine</td>
<td>✓ Modified acceleration trapezium</td>
</tr>
<tr>
<td></td>
<td>✓ Inclined sine</td>
<td>✓ Modified sine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>✓ Modified sine</td>
<td>✓ Modified acceleration trapezium</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Velocity</strong></td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Straight line</td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Polynomial 5. grade</td>
</tr>
<tr>
<td></td>
<td>✓ Modified sine</td>
<td>✓ Polynomial 5. grade</td>
<td>✓ Modified sine</td>
<td>✓ Modified sine</td>
</tr>
<tr>
<td></td>
<td>✓ Modified sine</td>
<td>✓ Modified sine</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 274: Motion states

(1) Motion
(2) Velocity (constant)
(3) Reversal
(4) Pause
10.7.4.1 Straight line

The motion task "Straight line" can be used for synchronous line segments. The following motion tasks can be connected with the motion function "Straight line":

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td></td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td>●</td>
<td></td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Reversal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

10.7.4.2 Polynomial 5. grade

Motion function "Polynomial 5. grade" can be used for all motion tasks.

Benefits:
- Low characteristic values $C_v$, $C_a$ and $C_{mdyn}$ – i.e. low forces and torques

Disadvantages:
- The $C_j$ value is higher than for "Inclined sine".
With the motion function "Polynomial 5. grade", all motion tasks can be connected to each other:

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Velocity</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Reversal</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
<tr>
<td>Motion</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td>●</td>
</tr>
</tbody>
</table>
10.7.4.3 Inclined sine

Benefits:
- Very low $C_j$ value
- Low-vibration motion
- Suitable for high speeds

Disadvantages:
- The characteristic values $C_v$, $C_a$ and $C_{mdyn}$ are higher than for "Polynomial 5. grade".
With the motion function "Inclined sine", the following motion tasks can be interconnected:

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reversal</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Fig. 280: Velocity "Inclined sine"
10.7.4.4 Modified sine

Benefits:
- Very low characteristic values $C_v$, $C_a$ and $C_{mdyn}$ – i.e. very low forces and torques
- Suitable for high speeds

Disadvantages:
- The $C_j$ value is higher than for "Inclined sine".

Fig. 281: Acceleration "Inclined sine"

Fig. 282: Motion "Modified sine"

With the motion function "Modified sine", the following motion tasks can be interconnected:
This motion form is also called "Harmonic combination".

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td>●</td>
<td>●</td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Reversal</td>
<td>●</td>
<td>●</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Velocity in velocity (VV)

Fig. 283: Velocity "Modified sine (VV)"

Fig. 284: Acceleration "Modified sine (VV)"

Velocity in reversal (VR)
Fig. 285: Motion "Modified sine (VR)"

Fig. 286: Velocity "Modified sine (VR)"

Fig. 287: Acceleration "Modified sine (VR)"
Reversal in velocity (RV)

Fig. 288: Motion "Modified sine (RV)"

Fig. 289: Velocity "Modified sine (RV)"
10.7.4.5  Modified acceleration trapezium

Benefits:
- Very low $C_a$ value
- Low inertia forces

Disadvantages:
- The $C_j$ value is higher than for "Inclined sine".

With the motion function "Modified acceleration trapezium", the following motion tasks can be interconnected:

<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td>●</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
</tr>
</tbody>
</table>
Pause in pause

Fig. 292: Velocity "Modified acceleration trapezium (PP)"

Fig. 293: Acceleration "Modified acceleration trapezium (PP)"

Fig. 294: Jolt "Modified acceleration trapezium (PP)"
Pause in reversal (PR)

Fig. 295: Velocity "Modified acceleration trapezium (PR)"

Fig. 296: Acceleration "Modified acceleration trapezium (PR)"

Fig. 297: Jolt "Modified acceleration trapezium (PR)"
10.7.4.6 Sine-straight-combination

Benefits:
- Very low $C_v$ value
- Low-vibration motion
- Suitable for high speeds

Disadvantages:
- the $C_a$ value is higher than for "Simple sine".

You will get the motion function "Simple sine" if you use the motion function "Sine-straight-combination" and set the parameter $c=1$. 

You can find more details in "Properties of the motion segment" page 359.
<table>
<thead>
<tr>
<th></th>
<th>Pause</th>
<th>Velocity</th>
<th>Reversal</th>
<th>Motion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pause</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Velocity</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reversal</td>
<td></td>
<td></td>
<td>●</td>
<td></td>
</tr>
<tr>
<td>Motion</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Fig. 300: Velocity "Sine-straight-combination"**

**Fig. 301: Acceleration "Sine-straight-combination"**
11 Deployment SPEED7 EtherCAT Manager

11.1 Overview

Properties
- Serves to configure EtherCAT master.
- Is called within the SPEED7 Studio.
- Synchronizes the address areas with the SPEED7 Studio.
- Saves the configuration in the SPEED7 Studio project.
- Expanded functionality by choose-able ‘Expert’ mode.

Functions
- Automatic configuration
- Manual configuration
- Diagnosis

Starting the SPEED7 EtherCAT Manager
In SPEED7 Studio you can call via the ‘Project tree’, ‘Field periphery’ of the EtherCAT CPU the SPEED7 EtherCAT Manager with ‘Bus system properties’.

Exit the SPEED7 EtherCAT Manager
By clicking at [X] in the SPEED7 EtherCAT Manager, the dialog is closed and the configuration is taken to the SPEED7 Studio.

Work environment of the SPEED7 EtherCAT Manager
The work environment of the SPEED7 EtherCAT Manager is divided into the following parts:
1. Tool bar: Here you can switch between Configuration and Diagnosis.
2. Project explorer: Here master and slave stations of your system are listed.
3. Device editor: Properties dialog of a device (parameter) respectively information area.
4. Selection of the view: In Classic View all the subordinate stations are shown indented. In Flat View all the subordinate stations are shown at the same level.
5. Here all the messages are listed.
6. In this section you can find the number of networks and slave stations.
7. Status area: With an online connection the 2 Status LEDs flash alternately. At Modus it is shown whether you are in operating mode Diagnosis or Configuration, followed by the selected dialog sight Standard respectively Expert.

**‘Expert mode’**

In SPEED7 Studio you can call via the ‘Project tree’, ‘Field periphery’ of the EtherCAT CPU the SPEED7 EtherCAT Manager with ‘Bus system properties (Expert)’. When enabled, the properties dialogs are extended accordingly. In ‘Expert mode’ you will have the full scope of the SPEED7 EtherCAT Manager. Additionally in the status area ‘Expert’ is shown.

**Input area - numeric format**

Some input fields have [Dec] respectively [Hex] buttons. By selecting the corresponding button you can select the input format decimal respectively hexadecimal for the input field.

11.2 Automatic configuration of a slave system

**Precondition**

The automatic configuration assumes that your EtherCAT system is mounted and can be reached on-line.
There are the following possibilities for on-line connection:

- **Slaves connected to the local system**
  - You are directly connected to a slave station via EtherCAT by means of a separate network adapter. Here the on-line connection is established by specifying the *Network Adapter*.

- **Slaves connected to remote system**
  - You are connected to the Ethernet PG/OP channel of your CPU and can use this to access the EtherCAT master. The on-line connection is established by specifying *IP Address*, *Port* and *Master Instance*. With VIPA CPUs *Port* 6000 and *Master Instance* 0 is to be set.

### Proceeding

1. Open if not already done the *SPEED7 EtherCAT Manager*
2. Click in the ‘*Project Explorer*’ at ‘*EC-Mastersystem*’
3. Set depending on the on-line access in the ‘*Device Editor > Master*’ as follows:
   - If you are directly locally connected to a slave station via EtherCAT by means of a separate network adapter, select your *Network adapter* and click at [Select].
   - If you are connected to the Ethernet PG/OP channel of your CPU, please enter *IP Address*, *Port* and *Master Instance* and click at [Select]. With VIPA CPUs set *Port* to 6000 and *Master Instance* to 0.

   > The *SPEED7 EtherCAT Manager* uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.

   **When called from the SPEED7 Studio the IP address is taken from your project. If you change the IP address you need to adjust this in your project and start the SPEED7 EtherCAT Manager again!**

4. Click in the ‘*Project Explorer*’ at ‘*EC-Mastersystem*’ and select from the context menu ‘*Scan EtherCAT network*’
   - You might be asked if you want to delete the existing slaves. Confirm with [Yes].

   Then the master is listed with its slaves and the associated PDO configuration in the ‘*Project Explorer*’, which was found by the network scan. The system can now be configured accordingly.

   **If there is no connection possible with the local master, the an anti virus software could block the connection. Then disabling the packet filter of the protocols of the network card in the anti virus software could help.**
11.3 Manual configuration of a slave system

Precondition
With the manual configuration the system need not be built and connected online. The system can freely be configured in the SPEED7 EtherCAT Manager.

Proceeding
1. Open if not already done the SPEED7 EtherCAT Manager.
2. Click at the ‘Project Explorer’ at ‘EC-Mastersystem’ and select ‘Context menu Append Slave(s)’.
   - A dialog opens to insert slave systems
3. Select the according slave from the list, enter the number of slaves and confirm with [OK].
   - The corresponding slave systems are inserted and can be configured now.

11.4 Configuration - EC-Mastersystem

11.4.1 Preparation
Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’. As soon you have configured at least one slave station, the following registers are available:

- Chap. 11.4.2 ‘Master’ page 382
- Chap. 11.4.3 ‘Process Data Image’ page 383
- Chap. 11.4.4 ‘Advanced Options (Expert mode)’ page 383
- Chap. 11.4.5 ‘Distributed Clocks (Expert mode)’ page 386
- Chap. 11.4.6 ‘I/O Address Overview’ page 387
11.4.2 Master

Here you can perform master and bus-specific settings.

- **General**
  - Unit Name: Name of the master
  - Cyclic time: Interval in µs, in which the process data are read and written (PDO cycle time). Here you can choose between different values.

- **Slaves connected to local system**
  - You are directly connected to a slave station via EtherCAT by means of a separate network adapter. Here the on-line connection is established by specifying the **Network Adapter**.

- **Slaves connected to remote system**
  - You are connected to the PG/OP channel of your CPU and can use this to access the EtherCAT master. The on-line connection is established by specifying **IP Address**, **Port**, and **Master Instance**.
    - **IP Address**: Enter the IP Address of the PG/OP channel of the remote CPU.
    - **Port**: Port, over which the communication takes place with the remote CPU. With VIPA CPUs use Port 6000.
    - **Master-Instance**: Serves for the master instance of the remote system. With VIPA systems the master instance is 0.

With [Select] the **SPEED7 EtherCAT Manager** uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.

When called from the **SPEED7 Studio** the IP address is taken once from your project. If you change the IP address you need to adjust this in your project and then start the **SPEED7 EtherCAT Manager** again.
Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of all the slave stations. The ‘S7 address’ corresponds to the address in the address area of the CPU. By entering a new ‘Start Address’ you can adjust the S7 addressing of the input and output areas of the modules accordingly.

Information about the assignment of the in/output area can be found in the manual of your module.

The ‘I/O Addresses EtherCAT’ are only visible in ‘Expert mode’! ‘I/O Addresses EtherCAT’ are the offset addresses, which are used within the EtherCAT process image. You cannot change the address. You can use the addresses e.g. for EtherCAT network analysis.

If you have activated "Isochronous mode" via the feature set ‘Motion Control + ... axes’, you can use the ‘Process image’ to place the address area of the corresponding module of a slave station in the OB61 process image. Otherwise, the address area is located in the OB1 process image or in the I/O area.
This dialog is only visible in the ‘Expert mode’! In this dialog the parameters of the master system can be adjusted and the default settings for all the slave stations can be defined.

- **Master Settings**
  - Init Command Retries: Number of retries, beyond which a transmission error is returned. (default: 3)
  - MasterStateChangeTimeout: Here you can define a timeout for the state change of the master and its slave stations (default: 60000ms). If the MasterStateChangeTimeout is too short, the EtherCAT master reports the error message 0xED21.

- **Slave Settings**
  - In this area default parameters can be applied for all the slave stations. The settings are applied for all slave stations as default setting by clicking on [Apply changes (to all slaves)]. By selecting the slave station in the ‘Project Explorer’ you always have the possibility to customize the slave parameters via the register ‘Advanced Options’.

---

**Slave Settings**

- **Start-up checking:**
  Here you can define the items, the EtherCAT master has to check during the transition ‘Init→Pre-Op’ (Vendor ID, Product code, Revision number).
  - Revision number can be verified:
    - "==" → High word is equal, Low word is equal
    - ">=" → High word is equal or greater, Low word is equal or greater
    - "LW ==" → Low word is equal
    - "LW ==, HW >=" → Low word is equal, High word is equal or greater
    - "HW ==" → High word is equal
    - "HW ==, LW >=" → High word is equal, Low word is equal or greater

- **Identification checking:**
  - With these parameters, you determine via which HotConnect address the EtherCAT master should identify the slave station.
  - ‘Check identification’: When activated, the text box below shows the current HotConnect address, which the EtherCAT master has to use to identify the slave station.
  - For identification via the address set on the address switch of the slave station (Explicit Device ID), you have to activate ‘Check identification’ and enter the corresponding ESC register address for addressing via the address switch at ‘Select local address’.
  - For identification via SSI (Configured Station Alias) you have to activate ‘Check identification’ and enter the corresponding ESC register address for SSI activation at ‘Select local address’. In this case, the Configured Station Alias address must be specified via ‘EEPROM’ of the slave station in diagnostics mode. In addition, you must specify the Configured Station Alias address in your configuration in ‘Group’ by means ‘Identification value’.

  © Chap. 11.8.4 ‘EEPROM (Expert mode)’ page 411
  © Chap. 11.9.3 ‘Create Hot Connect group’ page 417

---

For more information about the ESC register addresses, refer to the manual for your slave station.
Process Data Mode:
Here you specify the command that should be used for process data access.
- ‘LRW activate’: With one Logical-Read-Logical-Write command inputs are read and also outputs are set. This needs 1 frame.
- ‘LRW deactivate’: ‘Lrd/LWR’: Read access with Logical-Read command to inputs and write access with Logical-Write command to outputs. This needs 2 frames.

Overwrite Watchdog:
Writes the configured value in the relevant register of the slave station. Here among others you can set the time of the ‘SM Watchdog’ (SyncManager-Watchdog).
- ‘Set Multiplier’: Writes the configured value to the corresponding slave register: 0x0400
- ‘Set PDI Watchdog’: Writes the configured value to the corresponding slave register: 0x0410
- ‘Set SM Watchdog’: Writes the configured value to the corresponding slave register: 0x0420

Please note that even if a watchdog is present, this need not be indicated in the ESI file and this is shown as inactive!

Timeouts:
- ‘SDO Access’: Internal master timeout for SDO access
- ‘Init ➔ Pre-Op’: Internal master timeout for slave state change from Init to Pre-Op
- ‘Back to Pre-Op, Init’: Internal master timeout for slave state change to Pre-Op and Init

Mailbox Mode:
The ‘Mailbox’ is an a-cyclic communication channel. Here mostly ‘Emergencies’ messages and ‘SDOs’ are buffered. The way of accessing the just unread mailbox data can be specified here.
- ‘Cyclic’: Interval in ms within which the mailbox is to be read (polling mode). If you want short interrupt response times, you should select the mode ‘Cyclic’ and set a short time e.g. 1ms.
- ‘State change’: The mailbox is read only on a state bit change.

Overwrite Mailbox Size
- ‘Output Size’: Overwrites mailbox output size
- ‘Input Size’: Overwrites mailbox input size

Please note that even if a watchdog is present, this need not be indicated in the ESI file and this is shown as inactive!

When changing the ‘Process Data Mode’ you have to refresh the addresses in the Register ‘Process Image’.
- If the Process Data Mode ‘LRW’ is used, the input and the output address of the EtherCAT process image must be identical. Here address leaks can occur between slave stations. If an EtherCAT address exceeds the maximum address area of the CPU, the current configuration gets invalid. You need to reduce the configuration or change to process data mode ‘LRD/LWR’.
- If you use long cycle times (> 100ms) you should always accordingly raise the ‘SM Watchdog’. Otherwise your slave station changes after laps of ‘SM Watchdog’ time to Safe-Op and releases OB 86. From now on you can only manually set the slave to Op!
11.4.5 Distributed Clocks (Expert mode)

Due to the hardware, with local connections the function ‘distributed clocks’ is not supported.

Reference Clock

Name

Clock Adjustment

- Master Shift (EtherCAT Master Time controlled by Reference Clock)
- Bus Shift (Reference Clock controlled by EtherCAT Master Time)
- External Mode (Reference Clock controlled by External Sync Device)

Options

- Continuous Propagation Compensation
- Sync Window Monitoring
- Show 64Bit System Time

Slaves with active DC

This dialog is only visible in the ‘Expert mode’! Here you can adjust the clock functionality accordingly. In EtherCAT "Distributed Clocks" means a logical combination of "clocks", which are located in the EtherCAT devices. With this there is the possibility to locally provide a synchronized time in each bus device. If an EtherCAT device supports the Distributed Clocks functionality, it has its own clock. After PowerON this first locally works, based on an own pulse generator. By selecting an EtherCAT slave station, which has to provide the reference time, the distributed clocks can be synchronized. This reference clock so represents the system time.

- Reference clock: Here you get information about the clock, which provides the reference time.
  - Name: Name of the reference clock. Per default this is always the 1. slave station, which supports the "Distributed Clock (DC)" functionality.
- Clock adjustment
  - Master Shift: The EtherCAT master time is synchronized by the reference clock.
  - Bus Shift: The reference clock is synchronized by the EtherCAT master time.
  - External Mode: The reference clock is controlled by an external master
Options
- Continuous Propagation Compensation: A command (datagram) will be inserted in the cyclic frame which allows the EtherCAT master to measure and compensate the propagation delay time by time.
- Sync Window Monitoring: A command (datagram) will be inserted in the cyclic frame to read the ESC registers 0x092C. If this is selected the master will throw a notification about the state (sync respectively out-of-sync) of your system.
- 64bit system time: Master supports slaves with 32bit and 64bit system time register (0x0910). If this is selected he will interpret it as 64bit system time.

Slaves with active DC
- Shows a list of all slave stations with active DC

11.4.6 I/O Address Overview

Here you have a list of addresses that are used by the I/O components of all the modules in the address area of the CPU. By entering a new ‘Start address’ you can adjust the addressing of the input and output areas accordingly. You can edit ‘Name’ and ‘Comment’ by clicking at the corresponding entry.

Information about the assignment of the in/output area can be found in the manual of your module.
11.5 Configuration - slave station

11.5.1 Preparation

Click in the Toolbar at [Configuration] and select the Slave-Station ‘Slave_...’ in the ‘Project Explorer’. The following registers are available now:

- Chap. 11.5.2 ‘General’ page 389
- Chap. 11.5.3 ‘Modules’ page 390
- Chap. 11.5.4 ‘PDO Mapping’ page 391

Group - if a group exists for this slave station

- Chap. 11.9 ‘Grouping logic’ page 414
- Chap. 11.5.5 ‘Advanced Options (Expert mode)’ page 394
- Chap. 11.5.6 ‘Ethernet (EoE)’ page 397
- Chap. 11.5.7 ‘Distributed Clocks (Expert mode)’ page 398 - if supported
- Chap. 11.5.8 ‘Init Commands (Expert mode)’ page 399
- Chap. 11.5.9 ‘CoE Object Dictionary (Expert mode)’ page 401
- Chap. 11.5.10 ‘Process Image’ page 402
- Chap. 11.5.11 ‘I/O Address Overview’ page 402
- Chap. 11.5.12 ‘Parameter’ page 403
11.5.2 General

Here you can perform slave-specific settings such as assignment of name and address to a station. It is also possible to change the connection to the station.

- **Address**
  - Station Address: EtherCAT address of the slave station.

- **Information**
  - Name: Name of the slave station can be assigned accordingly.
  - Description: Description of the slave station.
  - Vendor: Name of the vendor.
  - Product Code: Internal product code of the slave station.
  - Revision Number: Internal revision number of the slave station.
  - ESI File: Path and name of the device file, in which the data of the slave station is stored.
  - Identification Value: Identification Value of the slave station

- **Ports**
  - Connected Devices: List of connected slave stations.
  - Predecessor Device: Name of the predecessor device.

If topology should be changed, please use the ‘Edit Topology’ dialog.
11.5.3 Modules

In this dialog you can assign modules to the appropriate slot.

- **Connect module to slot ("<<")**
  Select your module from the list on the right and add it to a selected slot ‘Terminals’ in the left list by clicking [<<]. This takes place according to the following rules:
  - If no modules are configured, the module is connected to the highlighted slot.
  - Each additional module is inserted below.
  - If modules are already exist, the module is added to the highlighted slot and the following modules are moved accordingly.

- **Disconnect module from slot ("X")**
  - Select from the left list the appropriate slot, which you want to disconnect from the module again and click at ["X"].

- **Option field - ‘Download slot configuration’**
  When enabled, an Init Command is created, which contains the slot configuration with the unique module identifier. During start-up of the slave station the slot configuration serves for comparison between configured and inserted modules. This can prevent misconfigurations.

- **‘Load modules’**
  With this function you can load the configuration from the EtherCAT master for the selected slave station.

---

Additional settings

- Download Slot Configuration

---

With an E-Bus slave this dialog is hidden. Chap. 11.9 ‘Grouping logic’ page 414

---

Additional settings

- Download Slot Configuration

---
11.5.4 PDO Mapping

11.5.4.1 Description

This dialog shows a list of the assigned PDOs. With some slave stations it is possible to activate respectively de-activate certain PDO configurations.

- **Select the Inputs**
  - If your slave station supports it, you can hide the corresponding input PDO from the configuration by disabling the checkbox.

- **Select the Outputs**
  - If your slave station supports it, you can hide the corresponding output PDO from the configuration by disabling the checkbox.

- **Only ‘Expert mode’**
  - **Add / Delete / Edit:**
    Used for changing the lists, if it is allowed by the ESI. First the list, which you want changed, must be selected.
  - **Up / Down:**
    Moving the selected PDO in the selected list up or down.
  - **Load PDO information:**
    Here you can load PDO information directly from the slave station.
11.5.4.2 Add or edit PDO (Expert mode)

PDOs can only be edited in the ‘Expert mode’! Otherwise, the functions are hidden. With [Edit] the dialog ‘Edit PDO’ opens.

- **General**
  - Name: Name of the PDO
  - Index: Index of the PDO (can be entered in hexadecimal or decimal)

- **Flags**
  - Mandatory: If activated the PDO cannot be deleted.
  - Fixed Content: If activated the content of the PDO is write protected. To create new or to edit existing PDOs you have to disable ‘Fixed Content’.
  - Virtual PDO: If activated the PDO has no entries.

- **Direction**
  - TxPDO: Send PDO of the slave station for input data.
  - RxPDO: Receive PDO of the slave station for output data.

- **Sync Manager**
  - Selected the sync manager, which should be used. The selection is only visible if more than one sync manager can be used.

- **Optional**
  - Exclude: Select the PDOs which cannot be activated if this PDO is activated.

- **Entries**
  - Here is the list of configured PDO entries shown.
After editing the PDOs, the addresses need to be re-calculated! For this jump to register ‘Process Image’ and click at [Recalculate].

11.5.4.3 Add PDO (Expert mode)

Via the following dialog the user add a PDO entry.

- General
  - Name: Name of the PDO entry
  - Comment: Comment of the PDO entry
  - Swapping: Swapping mode of the PDO entry

- Settings
  - Index: Index of the PDO entry (can be entered in hexadecimal or decimal)
  - Subindex: Subindex of the PDO entry (hexadecimal)
  - Datatype: List of available datatypes
  - Bit Length: Length of the PDO entry in bits

- CoE Object-Dictionary (loaded only if Object-Dictionary is supported by slave)

11.5.4.4 Edit PDO (Expert mode)

Via the following dialog the user edit a PDO entry.

- General
  - Name: Name of the PDO entry
  - Comment: Comment of the PDO entry
  - Swapping: Swapping mode of the PDO entry
11.5.5 Advanced Options (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you can make further adjustments to the slave station.

### Slave Settings

- **Start-up checking:**
  
  Here you can define the items, the EtherCAT master has to check during the transition ‘Init→Pre-Op’ (Vendor ID, Product code, Revision number).
  
  - Revision number can be verified:
    
    - "==" → High word is equal, Low word is equal
    - ">=" → High word is equal or greater, Low word is equal or greater
    - "LW ==, HW >=" → Low word is equal, High word is equal or greater
    - "HW ==, LW >=" → High word is equal, Low word is equal or greater

- **Identification checking:**
  
  - With these parameters, you determine via which HotConnect address the EtherCAT master should identify the slave station.
  
    - ‘Check identification’: When activated, the text box below shows the current HotConnect address, which the EtherCAT master has to use to identify the slave station.
    
    - For identification via the address set on the address switch of the slave station (Explicit Device ID), you have to activate ‘Check identification’ and enter the corresponding ESC register address for addressing via the address switch at ‘Select local address’.
    
    - For identification via SSI (Configured Station Alias) you have to activate ‘Check identification’ and enter the corresponding ESC register address for SSI activation at ‘Select local address’. In this case, the Configured Station Alias address must be specified via ‘EEPROM’ of the slave station in diagnostics mode. In addition, you must specify the Configured Station Alias address in your configuration in ‘Group’ by means of ‘Identification value’.

  Chap. 11.8.4 ‘EEPROM (Expert mode)’ page 411
  
  Chap. 11.9.3 ‘Create Hot Connect group’ page 417
For more information about the ESC register addresses, refer to the manual for your slave station.

Process Data Mode:
Here you specify the command that should be used for process data access.
- 'LRW activate:' With one Logical-Read-Logical-Write command inputs are read and also outputs are set. This needs 1 frame.
- 'LRW deactivate:' ‘LRD/LWR:' Read access with Logical-Read command to inputs and write access with Logical-Write command to outputs. This needs 2 frames.

Overwrite Watchdog:
 Writes the configured value in the relevant register of the slave station. Here among others you can set the time of the ‘SM Watchdog’ (SyncManager-Watchdog).
- ‘Set Multiplier’: Writes the configured value to the corresponding slave register: 0x0400
- ‘Set PDI Watchdog’: Writes the configured value to the corresponding slave register: 0x0410
- ‘Set SM Watchdog’: Writes the configured value to the corresponding slave register: 0x0420

Please note that even if a watchdog is present, this need not be indicated in the ESI file and this is shown as inactive!

Timeouts:
- ‘SDO Access’: Internal master timeout for SDO access
- ‘Init→Pre-Op’: Internal master timeout for slave state change from Init to Pre-Op
- ‘Back to Pre-Op, Init’: Internal master timeout for slave state change to Pre-Op and Init

Mailbox Mode:
The ‘Mailbox’ is an a-cyclic communication channel. Here mostly ‘Emergencies’ messages and ‘SDOs’ are buffered. The way of accessing the just unread mailbox data can be specified here.
- ‘Cyclic’: Interval in ms within which the mailbox is to be read (polling mode). If you want short interrupt response times, you should select the mode ‘Cyclic’ and set a short time e.g. 1ms.
- ‘State change’: The mailbox is read only on a state bit change.

Overwrite Mailbox Size
- ‘Output Size’: Overwrites mailbox output size
- ‘Input Size’: Overwrites mailbox input size
– When changing the ‘Process Data Mode’ you have to refresh the addresses in the Register ‘Process Image’.
– If the Process Data Mode ‘LRW’ is used, the input and the output address of the EtherCAT process image must be identical. Here address leaks can occur between slave stations. If an EtherCAT address exceeds the maximum address area of the CPU, the current configuration gets invalid. You need to reduce the configuration or change to process data mode ‘LRD/LWR’.
– If you use long cycle times (> 100ms) you should always accordingly raise the ‘SM Watchdog’. Otherwise your slave station changes after laps of ‘SM Watchdog’ time to Safe-Op and releases OB 86. From now on you can only manually set the slave to Op!

Distributed Clocks: ‘Potential Reference Clock’
– Every slave station can be used as a ‘Potential Reference Clock’ if the slave supports the DC registers. The setting is used, when you remove the slave with activated ‘Potential Reference Clock’ e.g. via ‘Hot Connect’, then the master searches for a slave station where ‘Potential Reference Clock’ is activated. If no slave is available, the first DC slave is used.
11.5.6 Ethernet (EoE)

Here you activate or change EoE (Ethernet over EtherCAT) the settings.

- **Ethernet (activates EoE support)**
  - Virtual MAC address: Virtual MAC address. If ‘Auto’ is checked, the Virtual MAC address will be generated from the Station Address, e.g. Station Address is “1010” (= 0x03F2), will generate the Virtual MAC address: “01 00 00 03 F2”
  - Time Stamp Requested: Slave station will response with the exact send time and the same Frame number and he should response as soon as possible.
  - Port Mode: Slave station can be run in ‘Switch Port’ or ‘IP Port’ mode.

- **Override IP Settings**
  - All IP settings will be overwritten from master like IP Address, Subnet Mask, Default Gateway, DNS Server and DNS Name.
11.5.7 Distributed Clocks (Expert mode)

This dialog is only visible in the ‘Expert mode’ if this is supported by your slave station! Here you can adjust the settings for Distributed Clocks accordingly. In EtherCAT "Distributed Clocks" (DC) means a logical combination of "clocks", which are located in the EtherCAT devices. With this there is the possibility to locally provide a synchronized time in each bus device. If an EtherCAT device supports the Distributed Clocks functionality, it has its own clock. After PowerON this first locally works, based on an own pulse generator. By selecting an EtherCAT slave station, which has to provide the reference time, the distributed clocks can be synchronized. This reference clock so represents the system time.

- Reference clock
  - Operation Mode: Here you can set the operation mode of the reference clock. More may be found in the manual of your slave station.
  - Sync Unit Cycle: Cycle time of the master. ☞ Chap. 11.4 ‘Configuration - EC-Mastersystem’ page 381
- Sync Units
  - Sync Unit 0
    - Cycle Time: Here you can specify the cycle time in relation to the ‘Master Cycle’ or ‘User defined’.
    - Time Shift: Specify here a time shift. This is used for fine adjustment.
  - Sync Unit 1
    - Cycle Time: Here you can specify the cycle time in relation to the ‘Master Cycle’, to the cycle of Sync Unit 0 ‘Sync 0 Cycle’ or ‘User defined’.
    - Time Shift: Specify here a time shift. This is used for fine adjustment.

Due to the hardware with a local connection Distributed Clocks (connection via network adapter) is not supported!
11.5.8 Init Commands (Expert mode)

11.5.8.1 Description

This dialog is only visible in the ‘Expert mode’!

For each parameter of a slave station or module, which differs from the standard setting you have to create an Init command!

If a write access to an object in the configuration mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init Commands’. % Chap. 11.5.9 ‘CoE Object Dictionary (Expert mode)’ page 401

Here you can see a list of the current configured Init Commands and if it is allowed you can also add/edit/delete the commands.

- Init Commands: Init Commands come from the ESI file or are automatically generated on write access to CoE objects or can be created by the user. You either have full-access (RW = Read/Write) or only read access (RO = Read-only). Init commands from ESI files are automatically listed here. These cannot be changed or deleted.

- Edit Init Commands
  - New, Copy, Edit, Delete: Used for changing Init Commands.
  - Move Up, Move Down: Moving the selected Init Command up or down.
11.5.8.2 CoE Init Command (Expert mode)

This dialog is only visible in the ‘Expert mode’! With [New] the dialog ‘Add CoE Init Command’ opens. This dialog also opens to edit CoE Init Commands, which just exist.

- **General**
  - Index/Subindex: CoE-Index respectively Subindex of the Init Command
  - Value: Value of the Init Command, which should be written in the chose transition (only available if ‘Direction’ is set to ‘Download’). If type of data is unknown, the hex format must be used. (Example: "0011 2233 …").
  - Comment: Here you can comment your Init Command.

- **Transition**
  - Determines in which transition the Init Command will be executed.

- **Further Settings**
  - Complete Access: Determines if the complete SDO object should be written/read.

- **Direction**
  - Download: Writes value to slave station.
  - Upload: Reads value from slave.

- **CoE Object Dictionary**: Select here the value in the CoE Object Dictionary of the slave station, you want to edit.
11.5.9 CoE Object Dictionary (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the ‘Flags’ of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.

Description of the flags: "AA BB (CC DD EE)"

- **AA, BB**
  - Rx: Mapping as receive PDO
  - Tx: Mapping as send PDO
  - --: Mapping not allowed

- **CC:**
  - Access rights for state PreOp (RO, WO, RW)

- **DD:**
  - Access rights for state SafeOp (RO, WO, RW)

- **EE:**
  - Access rights for state Op (RO, WO, RW)
    - Chap. 11.10 ‘EtherCAT State Machine’ page 419

- **Edit Value**
  - Write: Changes the selected entry
  - Reset: Resets the selected entry to ESI default

If a write access to an object in the configuration mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init Commands’. Chap. 11.5.8 ‘Init Commands (Expert mode)’ page 399
11.5.10 Process Image

Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of the slave system. The ‘S7 address’ corresponds to the address in the address area of the CPU. By entering a new ‘Start address’ you can adjust the S7 addressing of the input and output areas of the modules accordingly.

Information about the assignment of the in/output area can be found in the manual of your module.

The ‘I/O addresses EtherCAT’ are only visible in ‘Expert mode’! ‘I/O addresses EtherCAT’ are the addresses, which are used within the EtherCAT bus. You cannot change the address. You can use the addresses e.g. for EtherCAT network analysis.

11.5.11 I/O Address Overview

Here you have a list of addresses, which are used by the I/O components of the modules of the selected slave system in the address area of the CPU. By entering a new ‘Start address’ you can adjust the addressing of the input and output areas accordingly. You can edit ‘Name’ and ‘Comment’ by clicking at the corresponding entry.

Information about the assignment of the in/output area can be found in the manual of your module.
11.5.12 Parameter

If the parameters of the slave station can be determined such as a System SLIO slave station, the slave parameters can be set here. With [Reset], the parameters of the slave station are reset to their default values.

More information about the parameters can be found in the manual of your slave station.

11.6 Configuration - modules

11.6.1 Please note

With an E-Bus slave the dialog of the module configuration are hidden!

Chap. 11.9 ‘Grouping logic’ page 414

11.6.2 Preparation

Select in the configuration mode in the ‘Project Explorer’ the module of the according slave station. The following registers are available now:

Chap. 11.6.3 ‘MDP Slot Properties’ page 404
Chap. 11.6.4 ‘Process Image’ page 404
Chap. 11.6.5 ‘I/O Address Overview’ page 405
Chap. 11.6.6 ‘Parameter’ page 405
11.6.3 MDP Slot Properties

Here you can see the MDP Slot Properties of the corresponding module. This dialog serves for information. You cannot change something.

- **General**
  - **Vendor**: Name of the vendor of the module.
  - **ESI file**: Path and name of the device file, in which the data of the module and the associated slave station is stored.

- **Slot**
  - **Name**: Name of the slot
  - **Number**: Number of the slot

- **Module**
  - **Name**: Name of the module
  - **Type**: Order number of the module
  - **Class**: Module class
  - **Identificator**: Identification number of the according module class.

Here you can see the MDP Slot Properties of the corresponding module. This dialog serves for information. You cannot change something.

**I/O addresses**

<table>
<thead>
<tr>
<th>No.</th>
<th>Bus address</th>
<th>Slave</th>
<th>Module</th>
<th>Slot</th>
<th>S7 input address</th>
<th>S7 output address</th>
<th>EtherCAT input address</th>
<th>EtherCAT output address</th>
<th>Ty</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1</td>
<td>Slave</td>
<td>Module1</td>
<td>1</td>
<td>8-11</td>
<td>8-11</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of all the slave stations. The ‘S7 address’ corresponds to the address in the address area of the CPU. By entering a new ‘Start Address’ you can adjust the S7 addressing of the input and output areas of the modules accordingly.

**Information about the assignment of the in/output area can be found in the manual of your module.**
The ‘I/O Addresses EtherCAT’ are only visible in ‘Expert mode’! ‘I/O Addresses EtherCAT’ are the addresses, which are used within the EtherCAT bus. You cannot change the addresses. You can use the addresses e.g. for EtherCAT network analysis.

11.6.5 I/O Address Overview

Here you have a list of addresses that are used by the module in the address area of the CPU. By entering a new ‘Start address’ you can adjust the addressing of the input and output areas accordingly. You can edit ‘Name’ and ‘Comment’ by clicking at the corresponding entry.

<table>
<thead>
<tr>
<th>Address</th>
<th>Name</th>
<th>Data type</th>
<th>Comment</th>
</tr>
</thead>
<tbody>
<tr>
<td>EW 6</td>
<td>w_AL_CH01_715</td>
<td>WORD</td>
<td>E 8 - AI2x12Bit 0.20mA, 4.20mA - ISO [Device Slave_001, Slot 1, Rack 0]</td>
</tr>
<tr>
<td>EW 30</td>
<td>w_AL_CH02_715</td>
<td>WORD</td>
<td>E 10 - AI2x12Bit 0.20mA, 4.20mA - ISO [Device Slave_001, Slot 1, Rack 0]</td>
</tr>
</tbody>
</table>

Information about the assignment of the in/output area can be found in the manual of your module.

11.6.6 Parameter

If there is a parametrizable module, whose parameters can be determined such as a System SLIO module, the module parameters can be set here. Here also the necessary Init command for the EtherCAT slave station is generated \( \text{Chap. 11.5.8 ‘Init Commands (Expert mode)’ page 399} \). With [Reset], the parameters of the module are reset to their default values.

More information about the parameters can be found in the manual of your module.
11.7 Diagnostics - EC-Mastersystem

11.7.1 Preparation

To use the ‘Diagnostics’ functions, you must be connected online with your EtherCAT system.

1. Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’.

2. Activate in the ‘Device editor’ the register ‘Master’.

3. Set depending on the on-line access in the ‘Device Editor > Master’ as follows:
   - If you are directly connected to a slave station via EtherCAT by means of a separate network adapter, select your Network Adapter and click at [Select].
   - If you are connected to the PG/OP channel of your CPU, please enter IP Address, Port and Master Instance and click at [Select]. With VIPA CPUs Port 6000 and Master Instance 0 is to be set.

   The SPEED7 EtherCAT Manager uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.

4. Click in the Toolbar at [Diagnosis Mode].

   An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project Explorer’.

   With an online connection the 2 LEDs flash alternately in the ‘Status area’. In addition ‘Modus’ switches to ‘Diagnosis’.

5. Click in the ‘Project Explorer’ at Master.

   The following registers are available now:
   - Chap. 11.7.2 ‘General’ page 406
   - Chap. 11.7.3 ‘CoE Object Dictionary’ page 408
   - Chap. 11.7.4 ‘History (Expert mode)’ page 408

11.7.2 General

The state of the state machine can be determined via the color according to the following specifications:

**Colors and states**

The state of the state machine can be determined via the color according to the following specifications:
Here you will get master and bus-specific information.

- **State Machine**
  - **Current State**: Shows the current state of the master. 
  - **Requested State**: Shows the currently requested state of the master which was requested by ‘Change State’.
  - **Change State**: Here you can change the state of the master.

- **Information**
  - **Number of found slaves**: Shows number of found slave stations at the bus.
  - **Number of slaves in configuration**: Shows number of configured slave stations at the bus.
  - **Number of DC slaves**: Shows the number of slave stations, which support distributed clocks functionality (DC).
  - **DC in-sync**: If distributed clocks is configured you can find here information about the synchronization status of the system.
  - **Topology OK**: The ‘Topology’ is OK (‘Yes’), if the number of configured matches the number of found slave stations. Here only the mandatory slaves stations are considered.
  - **Link Connected**: Here you will find ‘Yes’, if there is a physical connection to the configured slave stations.
  - **Slaves in Master State**: Here you will find ‘Yes’, if every configured slave station is in master state.

- **Frame Counter**
  - **Sent frames**: Number of sent frames since the last power cycle.
  - **Lost frames**: Number of lost frames since the last power cycle.
  - **Cyclic frames**: Number of cyclic frames since the last power cycle.
  - **Acyclic frames**: Number of acyclic frames since the last power cycle.

<table>
<thead>
<tr>
<th>Color</th>
<th>State of the state machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>- red</td>
<td>Init / Bootstrap</td>
</tr>
<tr>
<td>- blue</td>
<td>Pre-Op</td>
</tr>
<tr>
<td>- yellow</td>
<td>Safe-Op</td>
</tr>
<tr>
<td>- green</td>
<td>Op</td>
</tr>
</tbody>
</table>
11.7.3 CoE Object Dictionary

Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the 'Flags' of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.

11.7.4 History (Expert mode)

In this dialog box, you can access all the diagnostic messages in the master and edit them if necessary. Via 'Settings' they may be filtered accordingly.
11.8 Diagnostics - slave station

11.8.1 Preparation

To use the ‘Diagnostics’ functions, you must be connected online with your EtherCAT system.

1. Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’.

2. Activate in the ‘Device editor’ the register ‘Master’.

3. Set depending on the on-line access in the ‘Device Editor > Master’ as follows:
   - If you are directly connected to a slave station via EtherCAT by means of a separate network adapter, select your Network Adapter and click at [Select].
   - If you are connected to the PG/OP channel of your CPU, please enter IP Address, Port and Master Instance and click at [Select]. With VIPA CPUs Port 6000 and Master Instance 0 is to be set.

   ⇒ The SPEED7 EtherCAT Manager uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.

4. Click in the Toolbar at [Diagnosis Mode].

   ⇒ An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project Explorer’

   With an online connection the 2 LEDs flash alternately in the ‘Status area’. In addition ‘Modus’ switches to ‘Diagnosis’.

5. Click in the ‘Project Explorer’ at the according slave station ‘Slave_…’

The following registers are available now:

- Chap. 11.8.2 ‘General’ page 409
- Chap. 11.8.3 ‘ESC Register (Expert mode)’ page 410
- Chap. 11.8.4 ‘EEPROM (Expert mode)’ page 411
- Chap. 11.8.5 ‘Extended Diagnosis (Expert mode)’ page 411
- Chap. 11.8.6 ‘DC Diagnosis (Expert mode)’ page 412
- Chap. 11.8.7 ‘CoE Object Dictionary’ page 412

11.8.2 General

The state of the state machine can be determined via the color according to the following specifications:

Colors and states
State Machine
- Current State: Shows the current state of the state machine of the slave station. (Chap. 11.10 ‘EtherCAT State Machine’ page 419)
- Requested State: Shows the requested state of the slave station.
- Change State: Here you can change the state of the state machine of the slave station.

Error State
- Current: Slave error which occurred during state transition.

11.8.3 ESC Register (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you can directly access the registers of the EtherCAT ASIC. You should not make any changes here!
11.8.4 EEPROM (Expert mode)

This dialog is only visible in the 'Expert mode'! Here you can access the contents of the EEPROM of the slave station. Currently you can only change the parameter 'Configured Station Alias'. This can be used for forming groups. § Chap. 11.9 'Grouping logic' page 414

CAUTION!
Please regard that your slave station can get unusable by entering incorrect values especially in 'Hex view'! In this case, any warranty of the vendor is excluded!

11.8.5 Extended Diagnosis (Expert mode)

This dialog is only visible in the 'Expert mode'!
Common Error Counter
- Processing Unit Error Counter: Number of received frames by the slave station, which are no EtherCAT frames.
- PDI Error Counter: Number of PDI access errors (Process Data Interface). These are physical errors, which were detected by the PDI at the EtherCAT bus.
- With [Clear Error Counters] the error counters can be reset.

Port 0...3
- Invalid Frame Counter: Number of invalid frames from Port y (access at register 0x300+y*2)
- RX Error Counter: Number of RX errors from Port y (access at register 0x300+y*2+8bit)
- Lost Link Counter: Number of lost connections from Port y (access at register 0x310+y)
- Forwarded RX Error Counter: Number of forwarded RX errors from Port y (access at register 0x380+y)

11.8.6 DC Diagnosis (Expert mode)
This dialog is only visible in the 'Expert mode'! Here status information for the distributed clock of your slave station is shown. More may be found in the manual of the slave station.

11.8.7 CoE Object Dictionary
Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the 'Flags' of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.
If a write access to an object in the diagnosis mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init commands’. 

This dialog is only visible in the ‘Expert mode’:

- Designation from ESI
  - By selecting this function the designations are loaded from the ESI file.
- Designation from slave
  - By selecting this function the designations are loaded from the slave station.
- Single Object
  - With this function you have read and write access to a single object in the object dictionary by specifying index and subindex.

11.8.8 FoE Download/Upload

With this function you have the possibility to transfer files between PC and slave station (if this is supported by the device). If the slave station is in state Bootstrap, a firmware update of the slave station can be established via ‘FoE Download’. Here you have to enter the file name without extension. 

- Local filename: Name of the file at the PC.
- Slave filename: Name of the file at the slave station.
- Password: Password to access the slave station.
- Timeout: Maximum time for data transfer.
- Max. file size: Maximum size of the file, which is to be transferred from the slave station to the PC.
11.9 Grouping logic

11.9.1 Overview

With EtherCAT, the following slave types are distinguished:

**MII slave**
- MII corresponds to Media Independant Interface. An MII slave has an EtherCAT interface to connect to EtherCAT for integration into a system bus (backplane bus) for connecting peripheral modules. The MII slave receives data via EtherCAT and passes them through its backplane to the according peripheral module. Conversely, it reads the input data and passes it via EtherCAT. The System SLIO 053-1EC0x e.g. is a MII-Slave.

**E-Bus slave**
- In an E-Bus slave the EtherCAT protocol is used for communication on the backplane bus. For this reason, the attached peripheral modules are also shown as a slave station in the *SPEED7 EtherCAT Manager*.

### Possibilities

The EtherCAT Manager supports the following ways to group the individual slave stations. Each group may consist of 1 .. n slave stations. Group nesting is not supported:

- Chap. 11.9.2 ‘Create group with pinned process data offset’ page 416
- ‘Hot Connect group with Dynamic Position in Topology’ page 418
- ‘Hot Connect group with Fixed Position in Topology’ page 418
- ‘Hot Connect group with Pinned or Dynamic Process Data Offset’ page 418

Please consider that Hot Connect groups are not possible with E-Bus slaves!

### Create Group

1. Click in the Toolbar of the *SPEED7 EtherCAT Manager* at [Configuration].
2. Click in the Project Explorer at the slave station and select ‘Context menu ➔ Create Group’.
   - The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary save stations are automatically selected.

With the ‘Create Group’ functionality you have two different functions:

- You can create a new group if the selected slave station is not yet part of a group.
- If the selected slave station is already part of a group, the current group is divided into two sub-groups from the selected slave station.
After creating a group, the ‘Device Editor’ of the slave station is extended with the register ‘Group’. Here you can adjust the group properties accordingly.

The new group can be selected by selecting this group via ‘Cut Slave(s)’ be changed.

If you want to connect this group to another slave station on the network, you can detach the current connection by ‘Detach HC Group’.

To remove a group click in the SPEED7 EtherCAT Manager at a slave station and select ‘Context menu ➔ Remove Group’.

The group is removed. Depending on the group, the previously grouped slave stations are reintegrated into the topology or remain at the current position.
11.9.2 Create group with pinned process data offset

Procedure

This group may start at any slave station and either end at himself, at a following slave station, at a following group or at the last slave station. The group functionality is possible with each slave type. The slave stations of this group are pinned at a fix position in the topology.

Create Group

1. Click in the Toolbar of the SPEED7 EtherCAT Manager at [Configuration].
2. Click in the Project Explorer at the slave station and select ‘Context menu ➔ Create Group’.

⇒ The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary slave stations are automatically selected.

Pinned group

1. Choose from ‘Select the slaves’ the slave stations, which you want to include in the ‘Pinned group’.

⇒ The dialog is closed, the slave station is marked as group in the ‘Project Explorer’ and a tab “Group” is created in the ‘Device Editor’.

2. Enable the option ‘Pinned Group’.
3. Enable the option ‘Input Offset = Output Offset’ if the input and output addresses are identical.

⇒ The group is now defined as Pinned Group.
11.9.3 Create Hot Connect group

11.9.3.1 Proceeding

In a *Hot Connect group* several slave stations can be located, which must only be available at the EtherCAT bus. So you have the possibility to take or add pre-configure sections from the traffic before starting the system or during the operation. This can be done by disconnecting/connecting the communication path or enabling/disabling the participant.

Please consider that the first slave station after the EtherCAT master must not be optional!

To use the hot connect function with E-Bus slave stations, the E-Bus head station and the connected slave stations must be in the same group! % Chap. 11.9 ‘Grouping logic’ page 414

Create Group

1. Click in the Toolbar of the *SPEED7 EtherCAT Manager* at [Configuration].

2. Click in the *Project Explorer* at the slave station and select ‘Context menu ➔ Create Group’.

   The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary save stations are automatically selected.
Hot connect group

1. Choose from ‘Select the slaves’ the slave stations, which you want to include in the ‘Hot connect group’.

   ⇒ The dialog is closed, the slave station is marked as group in the ‘Project Explorer’ and a tab “Group” is created in the ‘Device Editor’.

2. Enable the option ‘Hot connect group’.

3. Enter an ‘Identification value’: This is the Station-Alias-Address, which you have to assign before to the slave station in the ‘Diagnosis’ Mode. § Chap. 11.8.4 ‘EEPROM (Expert mode)’ page 411

   Please regard that the slave station takes the new address after a power-cycle.

4. For a fix position of the group in the topology the option ‘Pinned group’ can be enabled.

11.9.3.2 Combination possibilities

Hot Connect group with Dynamic Position in Topology

The group must start with a MII slave. Here, all slave stations below the selected are automatically added to the group. This group ends at himself, at a following slave station, at a following group or at the last slave station.

Hot Connect group with Fixed Position in Topology

The group is fix coupled to a predecessor slave station and its port. You always have the possibility to change the link to the previous slave station via the dialog box. If the group is removed, the slave stations remain in place.

A Hot Connect group with Fixed Position in Topology cannot be removed, if the slave stations before are a part of another Hot Connect group with Fixed Position in Topology!

Hot Connect group with Pinned or Dynamic Process Data Offset

This group does not depend on slave station or port. The group has no predecessor slave station and is moved to the end of the tree when created. When the group is removed it is searched for a suited free port starting from the end of the main tree. If there is no suited slave station available, the group will be rejected! Due to the system the group has no predecessor slave station, the connection cannot be changed via the dialog box.
11.10 EtherCAT State Machine

**States**

In each EtherCAT communication device a *state machine* is implemented. For each state there is defined which communication service is active via EtherCAT. The state machine of the slave station is controlled by the state machine of the EtherCAT master.

![State Machine Diagram]

- **Init - 01h**
  - After power-on the EtherCAT members are in state *Init*. There is neither mailbox nor process data communication possible. The EtherCAT master initializes the SyncManager channels 0 and 1 for the mailbox communication.

- **Pre-Operational (Pre-Op) - 02h**
  - The EtherCAT master initializes the SyncManager channels for process data (starting with SyncManager channel 2), the FMMU channels and the PDO mapping respectively the SyncManager PDO assignment. Further in this state the settings for process data transfer and the module-specific parameters, which deviate from the default values are transferred. During the transition from *Init* to *Pre-Op* the EtherCAT slave checks whether the mailbox was correctly initialized. In the state *Pre-Op* mailbox communication and Ethernet over EtherCAT (EoE) are possible but the process data communication is blocked.

- **Safe-Operational (Safe-Op) - 04h**
  - In *Safe-Op* the input data are cyclically updated but the outputs are de-activated. With the transition from *Pre-Op* to *Safe-Op* the EtherCAT slave checks if the SyncManager channels for process data communication are correct. Before it acknowledges the state change, the EtherCAT slave copies current input data to the corresponding DP RAM areas of the EtherCAT slave controller. In the state *Safe-Op* mailbox and process data communication is possible.

- **Operational (Op) - 08h**
  - In the state *Op* the input data are cyclically updated and the EtherCAT master sends output data to the EtherCAT slave. The EtherCAT slave copies the output data of the master to its outputs and return input data to the EtherCAT master. In this state process data and mailbox communication is possible.

- **Bootstrap - option (Boot) - 03h**
  - In state *Boot* the firmware of an EtherCAT slave may be updated via the EtherCAT master. This state may only be reached via *Init*. In the state *Boot* is mailbox communication via the protocol File-Access over EtherCAT (FoE) possible. Other mailbox and process data communications are de-activated.
11.11 Firmware update - VIPA System SLIO IM 053-1EC0x

Current firmware at www.vipa.com

The latest firmware versions are to be found in the service area at www.vipa.com. Load the Px000xxx.pkg file.

**CAUTION!**

- When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the slave station, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the von YASKAWA hotline!
- Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Precondition

- There is an Ethernet respectively remote connection between the PC and the VIPA EtherCAT slave station, where a firmware update is to be established.

Proceeding

Below the proceeding is shown by the example of the VIPA System SLIO slave station. For other devices, please follow the procedures described in the according manual.

1. Open if not already done the SPEED7 EtherCAT Manager.
2. Click in the ‘Project Explorer’ at ‘EC-Mastersystem’.
3. Select in ‘Device Editor > Master’ at ‘Network Adapter’ your network card and enter at ‘IP Address’ the IP address of the PG/OP channel of the CPU and click at [Select].
4. Click in the Toolbar at [Diagnosis Mode].
   - An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project explorer’.
5. Click in the ‘Project explorer’ at the master.
6. Select in the register ‘General’ at ‘State Machine’ the state ‘Init’. Wait, until all slave station response the state ‘Init’.
7. Click in the ‘Project explorer’ at the slave, where the firmware update is to be established.
8. Select in the register ‘General’ at ‘State Machine’ the state ‘Bootstrap’.
9. Enter in the register ‘FoE ’ at ‘FoE Download’ as follows:
   - Filename: Px000xxx
   - Password (hex): 0x00000000
   - Timeout (ms): 60000
   - Max File Size (kb): 3000
10. Click at [Download].
   - A dialog for file selection opens.
11. Select the file. The transfer starts with [OK].
   - There will be a progress bar displayed, which informs you about the transfer state.
12. After successful download bring your slave in the ‘Init’ state.
   - With this operation the firmware file is taken.
12 Index

A
Absolute addresses ........................................... 24, 67
Accumulator ....................................................... 282
Add
  Axis (Motion Control) ........................................ 344
  Block ............................................................ 209
  Cam (Motion Control) ......................................... 350
  Component ....................................................... 106
  Device ............................................................ 81, 82
  Drive (Motion Control) ......................................... 337
  Slave ................................................................... 85
Address ............................................................... 212
Address overview ................................................. 255
Address register ................................................... 282
Addressing ............................................................ 24
All connections ..................................................... 80
All variables ......................................................... 246
Archive ............................................................... 136, 137
Area of operations ................................................ 38
ASC file .............................................................. 302, 305
ASCII sources ...................................................... 302, 305
Assignment list ..................................................... 262
Async. error interrupt ............................................ 123
Automatic completion ............................................ 59
Axes (Motion Control) ............................................. 344

B
B-Stack ............................................................... 145
Basic parameters .................................................. 131
Block
  Check consistency .............................................. 267
  compare ................................................................ 278
  compile ............................................................ 268
  edit ................................................................... 210, 235, 240
  export ............................................................... 302, 305
  List .................................................................... 139, 208
  load from device ............................................... 275
  print ................................................................... 71
  Stack .................................................................. 145
  synchronisation ............................................... 218, 235
  transfer ................................................................ 218, 235, 272
  watch .................................................................. 218, 235, 281
  Block editor ....................................................... 210, 235, 240
  Block interface ................................................... 212, 267
  Block list ........................................................... 139, 208
  Block stack ......................................................... 145
  Block variables ................................................... 212

C
Cam ................................................................. 350
Catalog ............................................................... 34
Certificate ........................................................... 201
Changing IP address ............................................ 115
Channel ............................................................... 131
Clock ................................................................. 125
Clock memory ...................................................... 122
Close
  Project ................................................................ 67
Code block .......................................................... 207
Cold start ............................................................. 120
Communication error ............................................ 44
Communication events ......................................... 44
Communication information (CPU) ....................... 140
Communication interrupt ....................................... 123
Communication settings ......................................... 111, 314, 315
Comparison
  Blocks ................................................................ 278
  Compile ............................................................ 268
  Component
    add ................................................................ 106
    Labelling strip .................................................. 109
    Properties ......................................................... 118, 131, 134
    removing .......................................................... 108
    State .................................................................. 138
  Component properties ........................................... 118, 131, 134
  Component state .................................................. 138
  Configure
    CPU .................................................................. 118
  Configuring
    Device ............................................................. 109
    Configuring the drive ......................................... 337
    Connect devices ............................................... 195
    Connections ...................................................... 80
    Consistency ....................................................... 267
    Consistency messages .......................................... 45
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Context menu</td>
<td>53</td>
</tr>
<tr>
<td>Control</td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>81</td>
</tr>
<tr>
<td>print</td>
<td>71</td>
</tr>
<tr>
<td>Copy</td>
<td>33</td>
</tr>
<tr>
<td>Copying from RAM to ROM</td>
<td>137</td>
</tr>
<tr>
<td>CPU</td>
<td></td>
</tr>
<tr>
<td>Advanced Configurations</td>
<td>126</td>
</tr>
<tr>
<td>Basic parameters</td>
<td>131</td>
</tr>
<tr>
<td>Blocks</td>
<td>139</td>
</tr>
<tr>
<td>Channel</td>
<td>131</td>
</tr>
<tr>
<td>Clock</td>
<td>125, 147</td>
</tr>
<tr>
<td>Clock memory</td>
<td>122</td>
</tr>
<tr>
<td>Communication</td>
<td>140</td>
</tr>
<tr>
<td>Configuring the server</td>
<td>114</td>
</tr>
<tr>
<td>Connection resources</td>
<td>140</td>
</tr>
<tr>
<td>Control centre</td>
<td>49</td>
</tr>
<tr>
<td>Cycle</td>
<td>122, 145</td>
</tr>
<tr>
<td>Cyclic interrupts</td>
<td>124</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>125, 143</td>
</tr>
<tr>
<td>Firmware</td>
<td>138</td>
</tr>
<tr>
<td>General</td>
<td>128</td>
</tr>
<tr>
<td>I/O addresses</td>
<td>128</td>
</tr>
<tr>
<td>Inputs (analogue)</td>
<td>130</td>
</tr>
<tr>
<td>Inputs (digital)</td>
<td>130</td>
</tr>
<tr>
<td>Intermittents</td>
<td>123</td>
</tr>
<tr>
<td>Local data</td>
<td>123</td>
</tr>
<tr>
<td>Memory</td>
<td>142</td>
</tr>
<tr>
<td>Memory reset</td>
<td>149</td>
</tr>
<tr>
<td>Monitoring time</td>
<td>120</td>
</tr>
<tr>
<td>Motion Control</td>
<td>120</td>
</tr>
<tr>
<td>MPI</td>
<td>119</td>
</tr>
<tr>
<td>Name</td>
<td>119</td>
</tr>
<tr>
<td>Outputs (analogue)</td>
<td>130</td>
</tr>
<tr>
<td>Outputs (digital)</td>
<td>130</td>
</tr>
<tr>
<td>Parameter</td>
<td>131</td>
</tr>
<tr>
<td>PG/OP</td>
<td>128</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td>120</td>
</tr>
<tr>
<td>Properties</td>
<td>118</td>
</tr>
<tr>
<td>Protection</td>
<td>125</td>
</tr>
<tr>
<td>Retentive memory</td>
<td>123</td>
</tr>
<tr>
<td>RUN</td>
<td>49</td>
</tr>
<tr>
<td>Select interrupt</td>
<td>131</td>
</tr>
<tr>
<td>Serial number</td>
<td>138</td>
</tr>
<tr>
<td>Stack</td>
<td>145</td>
</tr>
<tr>
<td>Start-up</td>
<td>120</td>
</tr>
<tr>
<td>State</td>
<td>138</td>
</tr>
<tr>
<td>STOP</td>
<td>49, 145</td>
</tr>
<tr>
<td>Store project on MMC/SD</td>
<td>137</td>
</tr>
<tr>
<td>Synchronous cycle interrupts</td>
<td>121</td>
</tr>
<tr>
<td>Time of day interrupts</td>
<td>124</td>
</tr>
<tr>
<td>Version</td>
<td>138</td>
</tr>
<tr>
<td>Create communication connection</td>
<td>111, 314</td>
</tr>
<tr>
<td>Create new</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>65</td>
</tr>
<tr>
<td>Creating a visualisation</td>
<td>321</td>
</tr>
<tr>
<td>Cross-reference list</td>
<td>258</td>
</tr>
<tr>
<td>Cycle</td>
<td>122</td>
</tr>
<tr>
<td>Cycle times</td>
<td>145</td>
</tr>
<tr>
<td>Cyclic interrupt error</td>
<td>126</td>
</tr>
<tr>
<td>Cyclic interrupts</td>
<td>124</td>
</tr>
<tr>
<td>D</td>
<td></td>
</tr>
<tr>
<td>Data block</td>
<td>233, 235</td>
</tr>
<tr>
<td>Data type</td>
<td>212</td>
</tr>
<tr>
<td>Date/time</td>
<td>147</td>
</tr>
<tr>
<td>DB</td>
<td>233, 235</td>
</tr>
<tr>
<td>Declaration section</td>
<td>212</td>
</tr>
<tr>
<td>Default value</td>
<td>212</td>
</tr>
<tr>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>68</td>
</tr>
<tr>
<td>Device</td>
<td></td>
</tr>
<tr>
<td>add</td>
<td>81, 82</td>
</tr>
<tr>
<td>configuring</td>
<td>109</td>
</tr>
<tr>
<td>duplicate</td>
<td>93</td>
</tr>
<tr>
<td>removing</td>
<td>93</td>
</tr>
<tr>
<td>Device configuration</td>
<td>101, 102, 104, 105, 272</td>
</tr>
<tr>
<td>Device description file</td>
<td>93</td>
</tr>
<tr>
<td>Device name</td>
<td>119</td>
</tr>
<tr>
<td>Device overview</td>
<td>77, 207, 312</td>
</tr>
<tr>
<td>Device properties</td>
<td>110, 313</td>
</tr>
<tr>
<td>Devices and networking</td>
<td>77, 79, 80</td>
</tr>
<tr>
<td>Diagnostic buffer</td>
<td>143</td>
</tr>
<tr>
<td>Diagnostics</td>
<td>125</td>
</tr>
<tr>
<td>Direct addresses</td>
<td>24</td>
</tr>
<tr>
<td>DOC file</td>
<td>74</td>
</tr>
<tr>
<td>Documentation</td>
<td>74</td>
</tr>
<tr>
<td>Drag &amp; drop</td>
<td>54</td>
</tr>
</tbody>
</table>
### Drive
- add .................................... 337

### Dynamic sampling (HMI) .......................... 326

### E
#### Editor
- Address overview ............................................ 255
- Assignment list .................................................. 262
- Block .......................................................... 210, 235, 240
- Block list ......................................................... 208
- Cam ........................................................... 351
- Communication settings ........................................ 111, 314
- Connections ...................................................... 80
- Cross-reference list .............................................. 258
- DB .......................................................... 235
- Declaration section ............................................. 212
- Device configuration ......................................... 101, 102, 104, 105
- Device overview ................................................. 77, 207, 312
- Device properties ................................................. 110, 313
- Devices and networking .......................................... 77, 79, 80
- FB .......................................................... 210
- FC .......................................................... 210
- HMI configurations ............................................. 315
- Image (HMI) ..................................................... 321
- Instruction section ............................................... 217
- List of devices .................................................... 76
- Local components (= local modules) ..................... 79
- Motion Control axis ............................................ 345
- Motion Control Overview ...................................... 340
- OB .......................................................... 210
- Project overview ................................................ 76
- Search / Replace in block ..................................... 46
- Translations (HMI) ............................................... 331
- UDT .......................................................... 240
- User program .................................................... 217
- Variable table ................................................... 245
- Watch table ....................................................... 285

#### Editors
- ............................. 38
- Electronic cam .................................................. 350
- Enumeration (HMI) .............................................. 330
- ESI file .......................................................... 99

#### EtherCAT
- Configurations ................................................. 194
- ESI file .......................................................... 99

#### EtherCAT messages ........................................ 46
#### Ethernet connection ......................................... 195
#### Ethernet interface ........................................... 111, 116, 314
#### Examples ......................................................... 14
#### Export ......................................................... 70, 302, 332
#### Export all (WLD) ............................................... 136
#### External source files .......................................... 302, 305

### F
#### FB .......................................................... 207, 209, 210
#### FBD .......................................................... 223, 226
#### FC .......................................................... 207, 209, 210
#### Feature Sets .................................................... 120
#### Find controls ................................................... 115
#### Find devices .................................................... 115
#### Find PROFINET devices ...................................... 115
#### Firmware version .............................................. 138
#### Formal parameter ............................................... 212
#### Function ......................................................... 207, 209, 210
#### Function block ............................................... 207, 209, 210
#### Function block diagram ...................................... 223, 226

### G
#### Group .......................................................... 212
#### GSD file ......................................................... 94, 96

### H
#### Hardware configuration
  - archive ......................................................... 137
  - transfer ....................................................... 272
#### Help .......................................................... 60
#### HMI .......................................................... 312
#### HMI configurations ............................................ 315
#### HMI device
  - add .......................................................... 82
  - print ........................................................ 71
#### HMI elements .................................................. 318
#### HMI library ..................................................... 319
#### HMI simulation ................................................ 334
#### Hungarian notation ............................................ 24

### I
#### I device ......................................................... 90
#### I-Slave ........................................................ 86
#### I/O addresses .................................................. 128, 132, 135
<table>
<thead>
<tr>
<th>Section</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Icons</td>
<td>14</td>
</tr>
<tr>
<td>in the manual</td>
<td></td>
</tr>
<tr>
<td>IL</td>
<td>223</td>
</tr>
<tr>
<td>Image</td>
<td>320, 321</td>
</tr>
<tr>
<td>Import</td>
<td>70, 301, 305, 309, 332</td>
</tr>
<tr>
<td>Import an STEP7 program</td>
<td>301</td>
</tr>
<tr>
<td>Importing WinPLC7 project</td>
<td>301</td>
</tr>
<tr>
<td>IN</td>
<td>215</td>
</tr>
<tr>
<td>IN_OUT</td>
<td>215</td>
</tr>
<tr>
<td>Input help</td>
<td>55</td>
</tr>
<tr>
<td>Inputs</td>
<td></td>
</tr>
<tr>
<td>analogue</td>
<td>130</td>
</tr>
<tr>
<td>digital</td>
<td>130</td>
</tr>
<tr>
<td>Installation</td>
<td>18</td>
</tr>
<tr>
<td>Instruction list</td>
<td>223</td>
</tr>
<tr>
<td>Instruction section</td>
<td>217</td>
</tr>
<tr>
<td>Interface</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>119</td>
</tr>
<tr>
<td>Ethernet</td>
<td>116</td>
</tr>
<tr>
<td>HMI</td>
<td>314, 315</td>
</tr>
<tr>
<td>MPI</td>
<td>111, 119</td>
</tr>
<tr>
<td>PLC</td>
<td>111</td>
</tr>
<tr>
<td>Programming device</td>
<td>111, 119</td>
</tr>
<tr>
<td>Select adapter</td>
<td>24</td>
</tr>
<tr>
<td>serial</td>
<td>111, 119</td>
</tr>
<tr>
<td>Simulation</td>
<td>111</td>
</tr>
<tr>
<td>Interruption stack</td>
<td>145</td>
</tr>
<tr>
<td>Interrupts</td>
<td>123</td>
</tr>
<tr>
<td>K</td>
<td></td>
</tr>
<tr>
<td>Keyboard commands</td>
<td>61</td>
</tr>
<tr>
<td>Block editor</td>
<td>311</td>
</tr>
<tr>
<td>HMI</td>
<td>335</td>
</tr>
<tr>
<td>L</td>
<td></td>
</tr>
<tr>
<td>L-Stack</td>
<td>145</td>
</tr>
<tr>
<td>Labelling strip</td>
<td>109</td>
</tr>
<tr>
<td>Ladder diagram</td>
<td>223, 231</td>
</tr>
<tr>
<td>Language</td>
<td>23, 24, 331</td>
</tr>
<tr>
<td>LD</td>
<td>223, 231</td>
</tr>
<tr>
<td>Leading axis</td>
<td>362</td>
</tr>
<tr>
<td>LED state</td>
<td>49</td>
</tr>
<tr>
<td>Libraries</td>
<td>309</td>
</tr>
<tr>
<td>Licence</td>
<td>18</td>
</tr>
<tr>
<td>List of devices</td>
<td>76</td>
</tr>
<tr>
<td>Load</td>
<td>69, 272</td>
</tr>
<tr>
<td>Load memory</td>
<td>142</td>
</tr>
<tr>
<td>Local components (= local modules)</td>
<td>79</td>
</tr>
<tr>
<td>Local data</td>
<td>123</td>
</tr>
<tr>
<td>Local data stack</td>
<td>145</td>
</tr>
<tr>
<td>Location designation</td>
<td>119</td>
</tr>
<tr>
<td>Logic analysis</td>
<td>291</td>
</tr>
<tr>
<td>M</td>
<td></td>
</tr>
<tr>
<td>Master axis</td>
<td>362</td>
</tr>
<tr>
<td>MC blocks</td>
<td>340</td>
</tr>
<tr>
<td>Memory</td>
<td>142</td>
</tr>
<tr>
<td>Memory reset</td>
<td>149</td>
</tr>
<tr>
<td>Menu commands</td>
<td>61</td>
</tr>
<tr>
<td>Messages</td>
<td>55</td>
</tr>
<tr>
<td>MMC</td>
<td>137</td>
</tr>
<tr>
<td>Module (component)</td>
<td>106</td>
</tr>
<tr>
<td>Monitoring</td>
<td>281</td>
</tr>
<tr>
<td>Monitoring time</td>
<td>120</td>
</tr>
<tr>
<td>Motion Control</td>
<td>337</td>
</tr>
<tr>
<td>Add axis</td>
<td>344</td>
</tr>
<tr>
<td>Add cam</td>
<td>350</td>
</tr>
<tr>
<td>Add drive</td>
<td>337</td>
</tr>
<tr>
<td>Application</td>
<td>340</td>
</tr>
<tr>
<td>Function blocks</td>
<td>340</td>
</tr>
<tr>
<td>Library</td>
<td>340</td>
</tr>
<tr>
<td>Overview</td>
<td>340</td>
</tr>
<tr>
<td>Motion Control axis</td>
<td>345</td>
</tr>
<tr>
<td>Motion diagram</td>
<td>353</td>
</tr>
<tr>
<td>Motion functions</td>
<td>363</td>
</tr>
<tr>
<td>Motion laws</td>
<td>363</td>
</tr>
<tr>
<td>Mouse operation</td>
<td>53, 54</td>
</tr>
<tr>
<td>Move</td>
<td>33</td>
</tr>
<tr>
<td>Movicon</td>
<td>82, 312</td>
</tr>
<tr>
<td>MPI</td>
<td></td>
</tr>
<tr>
<td>Address</td>
<td>126</td>
</tr>
<tr>
<td>Baud rate</td>
<td>126</td>
</tr>
<tr>
<td>MPI interface</td>
<td>119</td>
</tr>
<tr>
<td>Multi Point Interface</td>
<td>119</td>
</tr>
<tr>
<td>Multimedia Card</td>
<td>137</td>
</tr>
<tr>
<td>N</td>
<td></td>
</tr>
<tr>
<td>Network (block)</td>
<td>217</td>
</tr>
</tbody>
</table>

**List of devices**

**Load**

**Load memory**

**Local components (= local modules)**

**Local data**

**Local data stack**

**Location designation**

**Logic analysis**

**Motion Control**

**Motion diagram**

**Motion functions**

**Motion laws**

**Motion Control axis**

**Motion diagram**

**Motion functions**

**Motion laws**

**Motion Control**

**Motion diagram**

**Motion functions**

**Motion laws**

**Motion Control**

**Motion diagram**

**Motion functions**

**Motion laws**

**Motion Control**

**Motion diagram**

**Motion functions**

**Motion laws**
<table>
<thead>
<tr>
<th>Network adapter</th>
<th>24</th>
</tr>
</thead>
<tbody>
<tr>
<td>Networking</td>
<td>195</td>
</tr>
<tr>
<td>Notes</td>
<td>14</td>
</tr>
<tr>
<td><strong>O</strong></td>
<td></td>
</tr>
<tr>
<td>OB</td>
<td>207, 209, 210</td>
</tr>
<tr>
<td>OB 28</td>
<td>126</td>
</tr>
<tr>
<td>OB 29</td>
<td>126</td>
</tr>
<tr>
<td>OB 61</td>
<td>121</td>
</tr>
<tr>
<td>OB 80</td>
<td>126</td>
</tr>
<tr>
<td>OB 85</td>
<td>122</td>
</tr>
<tr>
<td>OP connection</td>
<td>140</td>
</tr>
<tr>
<td>OPC UA</td>
<td>114, 199</td>
</tr>
<tr>
<td>Open</td>
<td></td>
</tr>
<tr>
<td>Project</td>
<td>66</td>
</tr>
<tr>
<td>Operand areas (= Address areas)</td>
<td>139</td>
</tr>
<tr>
<td>Operating instructions</td>
<td>14</td>
</tr>
<tr>
<td>Operating mode</td>
<td>49</td>
</tr>
<tr>
<td>Operating panel</td>
<td></td>
</tr>
<tr>
<td>CPU</td>
<td>49</td>
</tr>
<tr>
<td>Organisation block</td>
<td>207, 209, 210</td>
</tr>
<tr>
<td>OUT</td>
<td>215</td>
</tr>
<tr>
<td>Output</td>
<td>43</td>
</tr>
<tr>
<td>Output current (SLIO module)</td>
<td>104</td>
</tr>
<tr>
<td>Output range</td>
<td>43</td>
</tr>
<tr>
<td>Outputs</td>
<td></td>
</tr>
<tr>
<td>analogue</td>
<td>130</td>
</tr>
<tr>
<td>digital</td>
<td>130</td>
</tr>
<tr>
<td>Overview</td>
<td></td>
</tr>
<tr>
<td>Keyboard commands</td>
<td>61</td>
</tr>
<tr>
<td>Menu commands</td>
<td>61</td>
</tr>
<tr>
<td>User interface</td>
<td>26</td>
</tr>
<tr>
<td><strong>P</strong></td>
<td></td>
</tr>
<tr>
<td>Panel user management (HMI)</td>
<td>315</td>
</tr>
<tr>
<td>Parameter</td>
<td>131, 134, 136</td>
</tr>
<tr>
<td>Password</td>
<td>125</td>
</tr>
<tr>
<td>Paste</td>
<td>33, 54</td>
</tr>
<tr>
<td>PD connection</td>
<td>140</td>
</tr>
<tr>
<td>PDF file</td>
<td>74, 109</td>
</tr>
<tr>
<td>PDU size</td>
<td>128</td>
</tr>
<tr>
<td>pfx file</td>
<td>201</td>
</tr>
<tr>
<td>PG/OP Ethernet</td>
<td>128</td>
</tr>
<tr>
<td>Plant designation</td>
<td>119</td>
</tr>
<tr>
<td>PLC program</td>
<td>207, 272</td>
</tr>
<tr>
<td>PLC variable</td>
<td>212</td>
</tr>
<tr>
<td>PLC variables</td>
<td>245</td>
</tr>
<tr>
<td>Power consumption (SLIO module)</td>
<td>104</td>
</tr>
<tr>
<td>Power module</td>
<td>104</td>
</tr>
<tr>
<td>Prefix</td>
<td>24</td>
</tr>
<tr>
<td>Presentation</td>
<td>14</td>
</tr>
<tr>
<td>Print</td>
<td>71</td>
</tr>
<tr>
<td>Print Preview</td>
<td>74</td>
</tr>
<tr>
<td>Process image</td>
<td>121, 122</td>
</tr>
<tr>
<td>Process interrupt</td>
<td>123</td>
</tr>
<tr>
<td>PROFIBUS</td>
<td></td>
</tr>
<tr>
<td>Add I-Slave</td>
<td>86</td>
</tr>
<tr>
<td>Configurations</td>
<td>153</td>
</tr>
<tr>
<td>Control (CPU) as slave</td>
<td>86, 120</td>
</tr>
<tr>
<td>GSD file</td>
<td>94, 96</td>
</tr>
<tr>
<td>Online diagnostics</td>
<td>161</td>
</tr>
<tr>
<td>PROFINET</td>
<td></td>
</tr>
<tr>
<td>Adding an I device</td>
<td>90</td>
</tr>
<tr>
<td>Configurations</td>
<td>168</td>
</tr>
<tr>
<td>Online diagnostics</td>
<td>181</td>
</tr>
<tr>
<td>Program</td>
<td>207</td>
</tr>
<tr>
<td>Program block</td>
<td>207, 209, 210</td>
</tr>
<tr>
<td>Program processing</td>
<td>145</td>
</tr>
<tr>
<td>Programming error</td>
<td>44</td>
</tr>
<tr>
<td>Programming events</td>
<td>44</td>
</tr>
<tr>
<td>Programming language</td>
<td>223</td>
</tr>
<tr>
<td>Project</td>
<td>65</td>
</tr>
<tr>
<td>archive</td>
<td>136</td>
</tr>
<tr>
<td>Check consistency</td>
<td>267</td>
</tr>
<tr>
<td>close</td>
<td>67</td>
</tr>
<tr>
<td>compile</td>
<td>268</td>
</tr>
<tr>
<td>create new</td>
<td>65</td>
</tr>
<tr>
<td>delete</td>
<td>68</td>
</tr>
<tr>
<td>export/import</td>
<td>70, 301, 309</td>
</tr>
<tr>
<td>open</td>
<td>66</td>
</tr>
<tr>
<td>print</td>
<td>71</td>
</tr>
<tr>
<td>rename</td>
<td>68</td>
</tr>
<tr>
<td>save</td>
<td>68</td>
</tr>
<tr>
<td>save as</td>
<td>68</td>
</tr>
<tr>
<td>transfer</td>
<td>69</td>
</tr>
<tr>
<td>Project logbook</td>
<td>45</td>
</tr>
<tr>
<td>Project overview</td>
<td>76</td>
</tr>
<tr>
<td>Project tree</td>
<td>28</td>
</tr>
</tbody>
</table>
Index

Properties .................................. 37
Protection .................................. 125
Protection level ............................. 125
PtP ...................................... 126

R
Reference axis ............................. 362
Register ................................. 38, 282
Rename
  Project .................................. 68
Replace .................................... 46
Resource (HMI) ............................. 319
Restart ................................... 120
Result of logical operation ................. 281, 282
Retentive memory ....................... 123, 126
RETURN .................................. 215
RLO .................................. 281, 282
RS485 .................................... 126
RUN ...................................... 49

S
S7L file ............................... 301, 309
S7P file ................................... 301
Safety notes ................................ 14
Save
  Project .................................. 68
SCADA ................................ 82, 312
Search .................................... 46
Search for accessible partners ................. 115
SEQ file ............................... 302, 305
Serial number ................................ 138
Server .................................... 114
Simatic project .............................. 309
Simulation ................................. 270
  HMI .................................. 334
Slave
  add ..................................... 85
Slave axis ................................ 362
Software version .......................... 13, 17
SPEED7 EtherCAT Manager
  Colors and states ....................... 406, 409
  Configuration automatic ................ 379
  Configuration EC-Mastersystem ........ 381
  Configuration manual ................... 381
Configuration modules ..................... 403
Configuration slave station ................. 388
Create group with fix IP address .......... 416
Diagnostics EC-Mastersystem ............... 406
Diagnostics slave station .................. 409
Distributed clocks ........................ 383
Distributed Clocks ........................ 386, 398
E-Bus slave ................................ 414
Expert mode ................................ 379
Firmwareupdate slave station ............... 420
Grouping logic ............................ 414
Hot Connect group ........................ 417
MII slave ................................ 414
Numeric format Dec/Hex .................... 379
Overview ................................ 378
State machine ................................ 419

SPEED7 Studio
  Activate .................................. 18
  Area of operations ........................ 38
  Catalog ................................ 34
  Communication events ..................... 44
  Consistency messages .................... 45
  Context menu ................................ 53
  CPU control centre ....................... 49
  Drag & drop ................................ 54
  Editors .................................... 38
  end ..................................... 23
  EtherCAT messages ....................... 46
  Help ..................................... 60
  installation ................................ 18
  Keyboard commands ....................... 61
  Language ................................ 23, 24
  Licence .................................. 18
  Menu commands ................................ 61
  Messages ................................ 55
  Mouse operation .......................... 53, 54
  Operation ................................ 52
  Output ................................... 43
  Output range ................................ 43
  Programming events ....................... 44
  Project logbook .......................... 45
  Project tree ................................ 28
  Properties ................................ 37
  Register ................................ 38

426
### Index

<table>
<thead>
<tr>
<th>Page Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>23</td>
<td>start</td>
</tr>
<tr>
<td>49</td>
<td>Typed representation</td>
</tr>
<tr>
<td>26</td>
<td>User interface</td>
</tr>
<tr>
<td>17</td>
<td>Version</td>
</tr>
<tr>
<td>281, 282</td>
<td>STA</td>
</tr>
<tr>
<td>145</td>
<td>Stack</td>
</tr>
<tr>
<td>252</td>
<td>Standard project configuration</td>
</tr>
<tr>
<td>340</td>
<td>Start DriveWizard</td>
</tr>
<tr>
<td>315</td>
<td>Start image (HMI)</td>
</tr>
<tr>
<td>41</td>
<td>Start page</td>
</tr>
<tr>
<td>340</td>
<td>Start SigmaWin+</td>
</tr>
<tr>
<td>120</td>
<td>Start-up</td>
</tr>
<tr>
<td>215</td>
<td>STAT</td>
</tr>
<tr>
<td>281, 282</td>
<td>Status bit</td>
</tr>
<tr>
<td>49, 145</td>
<td>STOP</td>
</tr>
<tr>
<td>239, 240</td>
<td>Structure block</td>
</tr>
<tr>
<td>26</td>
<td>Structure of the user interface</td>
</tr>
<tr>
<td>223</td>
<td>Structured Control Language</td>
</tr>
<tr>
<td>320</td>
<td>Sub display</td>
</tr>
<tr>
<td>319</td>
<td>SVG file</td>
</tr>
<tr>
<td>24, 60, 67, 128, 132, 135, 221</td>
<td>Symbolic addresses</td>
</tr>
<tr>
<td>125</td>
<td>Synchronisation</td>
</tr>
<tr>
<td>121</td>
<td>Synchronous cycle interrupts</td>
</tr>
<tr>
<td>24, 223</td>
<td>Syntax</td>
</tr>
<tr>
<td>249</td>
<td>System hardware configuration</td>
</tr>
<tr>
<td>134</td>
<td>System MICRO - General</td>
</tr>
<tr>
<td>135</td>
<td>System MICRO - I/O addresses</td>
</tr>
<tr>
<td>136</td>
<td>System MICRO - Parameter</td>
</tr>
<tr>
<td>134</td>
<td>System MICRO - Properties</td>
</tr>
<tr>
<td>132</td>
<td>System SLIO - General</td>
</tr>
<tr>
<td>132</td>
<td>System SLIO - I/O addresses</td>
</tr>
<tr>
<td>134</td>
<td>System SLIO - Parameter</td>
</tr>
<tr>
<td>131</td>
<td>System SLIO - Properties</td>
</tr>
<tr>
<td>258, 262</td>
<td>Used operands</td>
</tr>
<tr>
<td>272, 275</td>
<td>Transfer - Blocks</td>
</tr>
<tr>
<td>272</td>
<td>Transfer - Device configuration</td>
</tr>
<tr>
<td>69</td>
<td>Transfer - Project</td>
</tr>
<tr>
<td>272</td>
<td>Transfer - SDB</td>
</tr>
<tr>
<td>272</td>
<td>Transfer - User program</td>
</tr>
<tr>
<td>268</td>
<td>Translate</td>
</tr>
<tr>
<td>331</td>
<td>Translations</td>
</tr>
<tr>
<td>49</td>
<td>Typed representation</td>
</tr>
<tr>
<td>14</td>
<td>U - Tips</td>
</tr>
<tr>
<td>145</td>
<td>U-Stack</td>
</tr>
<tr>
<td>239, 240</td>
<td>UDT</td>
</tr>
<tr>
<td>258, 262</td>
<td>User program - archive</td>
</tr>
<tr>
<td>267</td>
<td>User program - Check consistency</td>
</tr>
<tr>
<td>278</td>
<td>User program - compare</td>
</tr>
<tr>
<td>268</td>
<td>User program - compile</td>
</tr>
<tr>
<td>207</td>
<td>User program - Create</td>
</tr>
<tr>
<td>258, 262</td>
<td>User program - display used operands</td>
</tr>
<tr>
<td>302, 305</td>
<td>User program - export</td>
</tr>
<tr>
<td>301</td>
<td>User program - import</td>
</tr>
<tr>
<td>24</td>
<td>User program - Language (mnemonics)</td>
</tr>
<tr>
<td>275</td>
<td>User program - load from device</td>
</tr>
<tr>
<td>71</td>
<td>User program - print</td>
</tr>
<tr>
<td>46</td>
<td>User program - Search / Replace in block</td>
</tr>
<tr>
<td>270</td>
<td>User program - simulate</td>
</tr>
<tr>
<td>272</td>
<td>User program - transfer</td>
</tr>
<tr>
<td>281</td>
<td>User program - watch</td>
</tr>
<tr>
<td>17</td>
<td>User qualification</td>
</tr>
<tr>
<td>221, 245, 316</td>
<td>V - Variable table</td>
</tr>
<tr>
<td>215</td>
<td>V - Variable type</td>
</tr>
<tr>
<td>212, 221</td>
<td>V - Variables (block)</td>
</tr>
<tr>
<td>132, 135</td>
<td>V - Variables (component)</td>
</tr>
<tr>
<td>128</td>
<td>V - Variables (CPU)</td>
</tr>
<tr>
<td>49, 316</td>
<td>V - Variables (HMI)</td>
</tr>
</tbody>
</table>
Index

Version (CPU) ........................................ 138
Version (SPEED7 Studio) ...................... 13, 17
Visualisation device ............................. 312
VPP file ........................................... 70
VPZ file ........................................... 70
VTR file ........................................... 331

W
Warm restart ........................................ 120
Warm start ......................................... 123
Watch table ........................................ 285
WebVisu ............................................ 114, 312
Window of the user interface ............... 26
WLD file ............................................ 136, 137
Working memory ................................ 142, 149